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Get started with Torrent Suite™

Software

Torrent Suite™ Software allows you to view sequencer activity, plan and monitor
sequencing runs, and review sequencing data for an Ion PGM™ Sequencer or Ion
Proton™, Ion S5™, Ion S5™ XL, and Ion GeneStudio™ S5 Series sequencers.

Torrent Suite™ Software is organized in these sections, which appear as tabs:
• Home — View sequencer activity and learn about new software releases and

product launches.
• Plan — Access both Planned Run templates (reusable experiment designs) and

Planned Runs (executable instructions for individual sequencing runs). Select the
experimental design for a Planned Run template that can be reused multiple
times for sequencing runs.

• Monitor — View the status of your system and running jobs, including
thumbnail quality graphs for current runs. The quality graphs provide near real-
time information on your runs, so that you know early on about any instrument
problems.

• Data — View summaries of completed runs, detailed run reports, and plugin
results. Also download output files, download the run report, review the Planned
Run settings, and group result sets into projects for data management such as
archiving or pruning of result files.

Install Torrent Suite Software

IMPORTANT! During this upgrade, you must use the same user account for both
Torrent Server and Ion systems (Ion PGM™ Instrument, Ion Chef™ System, Ion S5™

System, Ion S5™ XL System, and Ion GeneStudio™ S5 Systems.

Use these steps to install Torrent Suite™ Software:

1. Log on to the Torrent Browser as an ionadmin user.

2. Click  (Settings). Ensure that there are no active jobs running.

3. Click  (Settings)4Configure4Admin Interface.

4. Click Update Server.

5. Click Check for updates.

6. When the Available message appears, click Update Server to start the update
process.
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7. On the User Agreement (EULA) screen, scroll down to read and then accept
terms to begin the update.

8. When finished, ensure that the "Upgrade completed Successfully!" message
appears.

Dashboard at a glance

You can open the dashboard to see active and recent sequencing runs. The dashboard
provides an overview of activity on all of your sequencers. Click Home tab, then click
Dashboard.

1

2

3

1 Summary section
2 Run Report section
3 Instruments section

The Summary section includes:
• Software link – Opens the Releases screen, where you can click Update to update

your software when new versions are released.
• Instruments column – Shows the number of instruments connected, offline, and

those that have alerts.
• Services column – Reports statuses, such as services that are running, nodes

down, and RAID storage statuses.
• Data Management column – Reports disk usage and data management activity.
• Stop Refresh stops the Auto Refresh function, which occurs every 30 seconds by

default. Stop the refresh function to review the screen without interruption from
the refresh cycle.

Get started with Torrent Suite™ Software
Dashboard at a glance
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The Runs section shows information that is available through the Data, Plan, and
Monitor tabs; however, it is a subset of only the most recent information. It includes:

• Run Name link – Takes you to the name of the run or the run report.

Note: The link is not functional until the run report is completed.
• Samples  information icon – Shows names of and information about barcodes

for samples.
• The third column shows the stage of the run, with the date that the run

information was either last updated or completed.
• The fourth column shows progress of sequencing runs and plugin use. Blue

circles denote normal progress and red circles denote sequencing or plugin
errors.

• The fifth column provides links to thumbnail reports and run reports.
• The Activity dropdown list allows you to select a time interval for viewing

sequencer activity. Choices include: Last Hour, Today, Last 24 Hours, and Last 7
days.

• The Run Report links to completed run reports for the time interval you selected.
The link becomes active when the run report is complete.

• The Thumbnail Report is an early run report that helps you determine the
quality of a run in progress.

The Instruments section shows instrument statuses, which may include:
• Alerts – Instruments with an operational error.
• Analyzing – Instruments currently in use.
• Cleaning – Instruments currently undergoing a cleaning process.
• Idle – Instruments connected, but not currently in use.
• Offline – Instruments that are no longer connected. These instruments are shown

when run reports for runs on these instruments exist in Torrent Suite™ Software.

Note: Click  Alert information to see details about an operational error. Then,
resolve the issue on the sequencer.

Thermo Fisher Scientific makes announcements about new products, software
releases and other news in the News screen. Click Home tab, then click News.

User (Staff) versus Administrator (Superuser) roles

In Torrent Suite™ Software, the User (Staff) role allows the creation and execution of
Planned Runs on a sequencing instrument. The Administrator (Superuser) role also
allows the creation and execution of Planned Runs, but also allows server
configuration, user configuration, base caller configuration, reference management,
and data management. See “Software administration“ on page 285 for more
information on Administrator functions.

News

Get started with Torrent Suite™ Software
User (Staff) versus Administrator (Superuser) roles
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Plan a run

The following steps describe how to use Planned Run templates and Planned Runs
that fit into your Ion S5™, Ion S5™ XL, Ion PGM™, or Ion Proton™, and Ion
GeneStudio™ S5 System sequencing workflows.

1. Decide on your sequencing application and sequencing product (such as an Ion
AmpliSeq™ panel).

2. Select a pre-installed template with defaults for your application and sequencing
product, or create your own template from scratch to customize your template.

3. Create new Planned Runs from your templates, adding the names of the samples
to be sequenced.
Plan templates and Planned Runs allow you to enter run information through
the Torrent Suite™ Software instead of directly on the Ion sequencer. The use of
templates and Planned Runs reduces the chance of error and wasted runs,
reduces setup time on the sequencing instrument, and increases instrument
throughput.

4. Start run on sequencer.
On the sequencer, information for a Planned Run is applied to the current Run
Info screen automatically, or by selecting the Planned Run from a menu list of
Planned Runs. You can also overwrite (change) Planned Run information directly
on the sequencer.

Register for a new account

Each new account requires administrator approval. It is not active until approval is
granted.

Follow these steps to register for a new user account:

1. On the sign in page for Torrent Suite™ Software, click Register.

2. Enter the new user information, then click Submit.
Upon the approval of an administrator, the new account is created.

Get started with Torrent Suite™ Software
Plan a run
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Samples and Sample Sets

Samples in Torrent Suite™ Software are files that store information about genetic
material from a single source. Samples contain information, or attributes, that
sequencing instruments use to process the genetic material during instrument runs.
After sample sequencing is complete, software programs, such as Ion Reporter™

Software, use sample information for data analyses.

You can pre-select the attributes that you want to associate with each sample before
you start to plan your templating and sequencing runs, and then organize samples
into Sample Sets that you can select and then reuse when you create Planned Runs.
This enables you to enter the information for the Sample Set just once, then reuse the
Sample Set. See “Plan by Sample Set“ on page 55 for more information.

Grouping samples into Sample Sets is also helpful for using barcodes that have
attributes assigned to each individual barcode. See “Barcodes and barcode sets“ on
page 262 for more information. If you create Sample Sets prior to planning the run,
you can enter barcodes and the barcode attributes just once when you create the
Sample Set, and then select one or more Sample Sets when you create the Planned
Run. This can save data entry time and reduce the likelihood of errors.

There are two ways to enter samples into Torrent Suite™ Software. You can enter
information individually for each sample, or import samples from a CSV file that
contains the sample information.

You can search for and find samples in the software, add Sample Sets to your Planned
Runs, and view details about how the sample libraries were prepared if the run used
an Ion AmpliSeq™ library preparation kit. If you want to change the sample files, you
can also edit information in the samples, update Sample Sets and delete samples and
Sample Sets.
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Create a Sample Set manually

You can use Torrent Suite™ Software to create a Sample Set by manually entering
sample information into the software without the use of external CSV files. This
process is useful for small Samples Sets. For Sample Sets that contain numerous
samples, import samples as described in “Import samples with a CSV file“ on
page 19. To create a Sample Set manually, enter individual samples into the Torrent
Suite™ Software, and then create a new Sample Set to add your samples to.

Alternatively, you can add your new samples to an existing Sample Set.

1. In the Plan tab, click Samples, then click Enter Samples Manually.

2. Click Enter New Sample.
a. In the Add Sample dialog box, complete the fields as described in “Sample

information“ on page 20.

Note: Sample Name is the only required field. Use the Relationship Group
field to designate a group of related samples within the Sample Set. For
example, DNA and RNA samples from the same sample would have the
same Relationship Group number.

b. Click Done.
Your new samples and their attributes appear in the Enter Samples list.

c. Enter additional samples as needed.

CAUTION! The Sample Set is not saved until you click Save Sample
Set. If you log out of the Torrent Server and do not save the Sample
Set, the new sample(s) will not be saved.

3. Click Save Sample Set.

Samples and Sample Sets
Create a Sample Set manually
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4. In the Save Samples dialog box:

• Select a Sample Set in the list to which you want to add the sample.
• Click Add Sample Set to create a new Sample Set, then complete the Sample

Set information fields:

Field Description

Sample Set Name (Required) Enter a name for your Sample Set.

Group Type (Optional) Select the Group Type that describes your
Sample Set.

Library Prep Type (Optional) Specify how your library was prepared.

Library Prep Kit (Optional) Select the Library Prep Kit used to prepare
your library.

PCR Plate Serial Number (Optional) Enter PCR Plate Serial Number.

Description (Optional) Provide a unique description for your
Sample Set.

5. Click Save.
Your new sample(s) are now added to the Sample Sets list. You can now use
your Sample Set to create a Planned Run. The information from your Sample Set
and individual samples within your Sample Set will be pre-populated in the
fields of the Planned Run workflow bar steps and Planned Run template. See 
“Plan by Sample Set“ on page 55 for more information.

Samples and Sample Sets
Create a Sample Set manually
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Import samples with a CSV file

If you have a large number of samples, you can import new samples into Torrent
Suite™ Software, or update existing samples with a CSV file that contains sample
information. If you do not yet have a sample file, you can create a new one from a
template that is available in Torrent Suite™ Software. During this process, you can also
create a new Sample Set for the samples.

1. In the Plan tab, click Samples, then click Import Samples from File.

2. (Optional) To create a new sample file from the sample CSV file that is available
in Torrent Suite™ Software:

a. In the Import Samples section, click Sample File Format to download a
sample CSV template.

Note: The sample file format CSV contains the version of the CSV file in the
top row, and sample attributes in separate columns. You must use a CSV file
format that was downloaded from Torrent Suite™ Software 5.2, or later.
Earlier software versions used a different format. To create a new CSV file,
copy and paste the contents of your existing sample CSV file into the new
file format.

b. Open the CSV template and enter sample information into the cells, then
save it to your computer. See “Sample information“ on page 20 for more
information.

3. Upload the sample file and optionally add a new Sample Set to receive the
samples:

a. In the Import Samples section, click Select file then navigate to and upload
the sample import file.

b. Click a Sample Set CSV file, then click Open.

c. Select a Sample Set to receive the samples.

To optionally add a new Sample Set to receive the samples, click Add
Sample Set, and then complete the Sample Set information fields:

Field Description

Sample Set Name (Required) Enter a name for your Sample Set.

Group Type (Optional) Select the Group Type that describes your
Sample Set.

Library Prep Type (Optional) Specify how your library was prepared.

Library Prep Kit (Optional) Select the Library Prep Kit used to
prepare your library.

Samples and Sample Sets
Import samples with a CSV file
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Field Description

PCR Plate Serial
Number

(Optional) Enter PCR Plate Serial Number.

Description (Optional) Provide a unique description for your
Sample Set.

4. Click Save & Finish.
The system loads, parses, and validates the file, then saves the samples and
Sample Sets if no errors are found.

Sample information

This table describes the fields that you use to enter sample attribute information when
you create a Sample Set manually, or import samples with a CSV file.

Note: All fields are optional except Sample Name. Some fields, however, are
required if you transfer data to Ion Reporter™ Software, as described in the following
table.

Field Description

Sample Name An open text entry field that allows any combination of
alphanumeric characters plus spaces, periods (.), hyphens (-), and
underscores (_). There is a 255‑character limit.

Note: These character limits must be followed for Ion Reporter™

Software name validation. If you are using Ion Reporter™ Software,
and the actual sample name already exists in that software, a
string such as _v1 or _v2, etc., is added to the sample name.

Sample External ID (Optional) If you manage samples in an external system (for
example, a LIMS), you can enter the identifier from that system in
this field.

PCR Plate Position (Optional) The well number of the sample in the PCR plate.

Barcode Kit The name of the barcode kit used to make a library from the
sample. The same barcode kit must be used for all samples in a
Sample Set.

Barcode The name of the specific barcode in the selected barcode kit.
Assign a unique barcode to each sample in a Sample Set.

Control Type The control type used when preparing the sample. Leave this field
blank if no control is used.

Basic Annotations

Description An open text entry field.

DNA/RNA/Fusions The type of library created from a sample.

Samples and Sample Sets
Sample information
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Field Description

Gender The gender of the sample.

IMPORTANT! If you are using Ion Reporter™ Software, do not
leave this field blank. Select Unknown if the gender is not known.
Several workflows in Ion Reporter™ Software (for example, copy
number variation detection and genetic disease research) are
limited when the gender is not known. The workflows can return
unexpected results when the gender is incorrectly specified for a
sample.

Type The relationship type for this sample, used by Ion Reporter™

Software. Type is used in conjunction with the Relationship Group
field, described below. For example, a relationship group can
contain two samples, one with a type Tumor and another with a
type Normal. The following sample relationships are supported by
Ion Reporter™ Software:

• Self

• Tumor, Normal

• Control, Sample

• Father, Mother, Self

Note: Self is used both for a single sample and for the proband
sample in a trio. A single sample is not related to other samples
and is analyzed by itself.

Relationship Group A whole number used to define a sample as part of a relationship
group. It is used in conjunction with the Type field, described
above. For example, a Sample Set can contain 6 samples,
consisting of 3 groups of 2 related samples each (of types Tumor
and Normal). In this case, you would designate the two samples in
each group as part of group 1, 2, or 3. This is identical to the Set ID
in the IonReporterUploader plugin.

Extra Annotations (used for specialized applications, such as preimplantation genetic
screening (PGS) research or oncology research)

Cancer Type The type of cancer in the sample.

Cellularity % The percentage of tumor cells in the sample.

Biopsy Days The timepoint post-fertilization at which the biopsy was taken from
an embryo.

Cell Number The cell count of the biopsied material.

Couple ID An identifier for use with the Reproductive research application.

User-defined Attributes

<user defined>​ If you create additional sample attributes, each attribute will be
listed here and in the CSV file. Attributes that are marked as
mandatory must be entered for each sample. If you create an
attribute of type Integer, only numeric characters (whole numbers)
can be entered into the field for that attribute.

Samples and Sample Sets
Sample information
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Sample attributes

When you add a sample to a Sample Set in Torrent Suite™ Software, you must enter
information to describe and identify each sample, with characteristics such as gender,
sample origin, or relationship group. This sample information is referred to as
Sample Attributes. You can add user-defined attributes to the sample attributes that
are available in the Torrent Suite™ Software. Each attribute that you add will appear
in:

• Lists of samples and Sample Sets on the Torrent Server.
• The Add Sample dialog box in the Torrent Suite™ Software.
• The CSV file that is used to import sample information.

A sample attribute can be made mandatory, in which case the user is required to enter
the attribute information for each new sample. After the attribute is added to the
Sample Attributes list, you can edit or delete user-defined attributes. You can also
choose whether the attribute is displayed or hidden from the sample listings and Add
Sample dialog box.

Note: The attributes that you create are applied to individual samples and not to the
Sample Sets.

You can view details about a Sample Set and review sample attributes for each sample
that is in a Sample Set.

Some sample attributes are passed from Torrent Suite™ Software for use in Ion
Reporter™ Software. Trio is an example of a Sample Set grouping that is used in an Ion
Reporter™ Software workflow. If you select the Trio Sample Set grouping, Torrent

View Sample Set
attributes

Samples and Sample Sets
Sample attributes
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Suite™ Software will automatically select a Trio Ion Reporter™ Software workflow
when you create a Planned Run.

In a Trio Sample Set, you can view attributes that include:
• Gender is the gender of the sample.
• Type is the Ion Reporter™ Software relationship type used for Example Sample

Set.
• The Group number is the Sample Set mechanism to mark the samples as related.

(Related means that in the eventual Ion Reporter™ Software analysis, these
samples are analyzed in one analysis with a defined relationship between the
samples, such as Tumor and Normal.)

1. In the Plan tab, click Samples.

2. In the Sample Sets table, find a sample set that you want to view. For more
information on locating your sample set, see “Find a Sample Set“ on page 26
and “Sort Sample Sets“ on page 27.

In this example, a Trio Sample Set, named Example Sample Set, is shown

Each column in the Sample Sets table lists a specific attribute for that Sample Set.

3. Click the arrow in the row of the Sample Set to expand the table and view all
samples within the Sample Set.

Each column in the expanded table lists a specific attribute for each sample
within the selected Sample Set.

1. In the Plan tab, click Samples, then click Sample Attributes4Add.Add a sample
attribute

Samples and Sample Sets
Sample attributes
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2. In the Add Attribute dialog box, enter the following:
• Attribute Name
• Attribute Type

Note: If the Attribute Type is set to Integer, you can only enter numeric
characters (whole numbers) for this attribute.

• (Optional) Description

3. (Optional) Select the Is Mandatory checkbox if you want the attribute to be
required for every sample.

4. Click Save.

If you add user-defined sample attributes to the Torrent Server, you can:
• Edit sample attributes.
• Choose whether the attributes are displayed or hidden from the list of samples,

Sample Sets, and Add Sample dialog box.
• Delete sample attributes.

1. In the Plan tab, click Samples, then click Sample Attributes4Manage.

Manage sample
attributes

Samples and Sample Sets
Sample attributes
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2. In the Sample Attributes list, click  (Actions) in the row of the attribute that
you want to manage, and then click one of the following:

Action Description

Edit • In the Edit Attribute dialog box, you can edit one or all of the
following fields:

a. Attribute Name

b. Attribute Type

c. Attribute Description

• You can also change whether the attribute is required or optional
by selecting or deselecting the Is Mandatory check box.

Note: The attribute that is mandatory will be designated by the
selected check box in the Required column of the Sample
Attributes table. An absence of the selected check box designates
the attribute as optional.

Show/Hide • If you hide an attribute, that attribute no longer appears in the list
of samples, Sample Sets, and Add Sample dialog box.

Note: The attribute that is shown will be designated by the
selected check box in the To Show column of the Sample Attributes
table. An absence of the check box designates the attribute as
hidden.

• If you hide a mandatory attribute, that attribute is no longer
mandatory.

Delete Deleting a sample attribute permanently deletes that attribute from the
Torrent Server.

Samples and Sample Sets
Sample attributes
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View Ion AmpliSeq™ library preparation on an Ion Chef™ System run

You can view a summary of details about how the libraries were prepared for a
completed run on an Ion Chef™ Instrument that used an Ion AmpliSeq™ library
preparation kit. This information can be useful for troubleshooting an Ion Chef™

Instrument run.

Note: This information is not available if a Library Prep Kit is not selected when the
sample is created, of if the run did not use an Ion AmpliSeq™ library preparation kit.

1. In the Plan tab, click Samples.

2. In the row that contains the Sample Set of interest, click  (Actions)4Library
Prep Summary.
The following information is listed for the Sample Set:

• Library Prep Type
• PCR Plate Type
• PCR Plate Serial Number
• Combined Library Tube Label
• Chef Last Updated
• Chef Instrument Name

• Tip Rack Barcode
• Library Kit Type
• Reagent Lot Number
• Solution Part Number
• Solution Expiration
• Chef Script Version
• Chef Package Version

Note: The Chef Script Version lists the version of the software script for the
Ion Chef™ Instrument and Chef Package Version lists the software package that
is used by the Torrent Server. The release version for these scripts can differ if the
Torrent Suite™ Software was updated with an off-cycle release.

Find a Sample Set

To find a Sample Set:

1. In the Plan tab, click Samples.

2. In the text field, enter a search term for the Sample Set name, or a Combined
Tube Label (Sample Tube Label).

3. Click , then select Sample set name or Combined library tube label.

4. Click Go.
The search results appear in a new table.

5. Click Clear to return to the complete list of Sample Sets.

Samples and Sample Sets
View Ion AmpliSeq™ library preparation on an Ion Chef™ System run

26 Torrent Suite™ Software 5.10 User Guide



Sort Sample Sets

To sort Sample Sets:

1. In the Plan tab, click Samples.

2. In the Samples Sets table, click any column header to sort the sample rows
alphabetically or numerically.

Note: Click the column header again to reverse the order of the column contents.

3. Click Clear to undo the sort.

Edit a Sample Set

To edit a Sample Set:

1. In the Plan tab, click Samples.

2. Click   (Actions)4Edit Set in the row of the Sample
Set that you want to edit.

3. In the Edit Sample Set dialog box, make any desired
changes in the following fields, then click Done.

• Sample Set Name
• Group Type
• Library Prep Type

• Library Prep Kit
• PCR Plate Serial
• (Optional) Description

4. To edit an individual sample in a Sample Set,

a. Click the triangle to the left of the
Sample Set name to expand the Sample
Set, then click   (Actions)4Edit
Sample in Set in the row of the sample
that you want to edit.

b. In the Edit Sample dialog box, edit or
enter information in the following fields
if needed, then click Done.

• Sample Name
• Sample External ID
• PCR Plate Position
• Barcode Kit
• Barcode

Samples and Sample Sets
Sort Sample Sets
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• Control Type
• Basic Annotations:

– Description
– DNA/RNA/Fusions
– Gender
– Type
– Relationship Group

c. To delete a sample from a set, click   (Actions)4Remove Sample from
Set in the row of the sample that you want to delete, then click Yes, Delete!.

Delete a Sample Set

To delete a Sample Set:

1. In the Plan tab, click Samples.

2. Click  (Actions)4Delete Set in the row of the Sample Set you want to delete.

3. Click Yes, Delete!.

Note: To delete a sample from a Sample Set, see “Edit a Sample Set“.

Samples and Sample Sets
Delete a Sample Set
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Create an Ion AmpliSeq™ on Ion Chef™ Sample Set

Ion AmpliSeq™ on Ion Chef™ samples can be automatically tracked in Torrent Suite™

Software from library preparation through sequencing and data analysis. First create
a Sample Set in the Torrent Browser, then use it to set up a library preparation run on
the Ion Chef™ Instrument. Sample information is then automatically transferred to the
Planned Run when templating and sequencing the combined library.

To create a Sample Set, you can either import samples from a file, or enter them
manually. The following is an example of importing samples from a file.

1. In the Plan tab, click Samples, then click Import Samples from File.

2. In the Import Samples dialog, click Sample File Format button.

A CSV template downloads.

3. Open the file, then enter sample names, PCR Plate positions, and Barcodes used.
Save to your computer.

Note: You can also enter sample names in the CSV file, then supply the plate
position, barcode, and other information later from dropdown lists by editing the
Sample Set in the Sample Sets screen. See “Edit a Sample Set“ on page 27 for
further information.

4. Click Select File, select your CSV file, then click Open.

Samples and Sample Sets
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5. Click Add Sample Set.

6. In the Add Sample Set dialog:
a. Enter a Sample Set name.

b. Select the appropriate Group Type.

c. Set Library Prep Type to AmpliSeq on Chef.

d. Set Library Prep Kit to Ion AmpliSeq Kit on Chef DL8.

e. Enter or scan the PCR plate serial number.

f. Enter any optional information in the Description field, then click Save &
Finish.

A new Sample Set is created.

Samples and Sample Sets
Create an Ion AmpliSeq™ on Ion Chef™ Sample Set
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7. In the Plan tab, click Samples.

The Sample Sets table lists the Sample Set run status in the Status column,
indicating whether the Sample Set is ready for a library preparation run, a
library preparation run with the Sample Set is currently running, or the
combined library is ready for a template run.

Status Indication

libPrep_pending New Sample Set ready for a library prep run.

libPrep_reserved The Sample Set is currently running on an
Ion Chef™ Instrument. You can monitor the run
status at Monitor4Ion Chef.

libPrep_done The Ion Chef™ Instrument has finished the library
prep run and the combined library is ready for a
template run.

8. When the status of your Sample Set shows libPrep_done,
click  (Actions) in the row of the Sample Set, then select
Plan Run.

9. In the dialog box that appears, select an existing Planned
Run template from the dropdown list, or create a new
template by selecting Add new template.
The sample information in the Sample Set automatically
populates your new Planned Run.

See “Plan and execute an instrument run“ on page 32 for further information on
how to create or edit a Planned Run template.

Samples and Sample Sets
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Plan and execute an instrument run

Planned Runs are the digital instructions for the sequencing instrument that contain
specifications for sample preparation, sequencing, data export, and post-sequencing
data analysis. Some key details that you can specify in a Planned Run include:

• Library barcodes
• Sample information
• Template kit
• Chip type
• Reference library
• Target and hotspot region BED files
• Plugins

Torrent Suite™ Software is pre-loaded with many Planned Run templates that contain
pre-defined settings for common sequencing applications. A Planned Run template is
a reusable experimental design that can be saved and used to create many Planned
Runs. Planned Run templates play an important role in enabling rapid throughput
across your sequencing instrument. Templates also help reduce the chances of errors,
because information is stored and then applied to Planned Runs, rather than entered
manually for each run.

Planned Run templates

Planned Run templates are categorized into research applications that describe the
sequencing techniques, or specialized products, for which each template is used.
Some templates are found in more than one category.

Research application Contains templates for . . .

AmpliSeqDNA Ion AmpliSeq™ research applications (DNA and
exome), including the Ion AmpliSeq™ On‑Demand
Panels, and Ion AmpliSeq™ Made-to-Order and
Community Panels.

AmpliSeqRNA Ion AmpliSeq™ research applications (RNA),
including the Oncomine™ Immune Response
Research Assay.

AmpliSeq HD Ion AmpliSeq™ HD libraries (DNA and RNA).

DNA and Fusions Ion AmpliSeq™ research applications such as
Oncomine Focus Fusions, Oncomine Focus DNA &
Fusions, Colon and Lung Research Panel v2.
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Research application Contains templates for . . .

Generic Sequencing Applications that do not fit in the other categories.
Use this research application to provide all the
choices for the experiment. The choices are not
restricted based on a common application workflow.

Human Identification Applied Biosystems™ Human Identification panels.

Immune Repertoire Ion AmpliSeq™ Immune Repertoire Research Assay.

Inherited Disease Ion AmpliSeq™ Inherited Disease Panel and
Oncomine BRCA research panels.

Mutation Load Oncomine™ Tumor Mutation Load Assay.

Oncology – HemeOnc All blood-related oncology research applications. For
example, Oncomine™ Myeloid Research Assay.

Oncology – ImmunoOncology All ImmunoOncology research applications. For
example, Oncomine™ Immune Response Research
Assay.

Oncology – Liquid Biopsy Liquid biopsy oncology research assays.

Oncology – Solid Tumor Solid tumor oncology research assays.

Pharmacogenomics Ion AmpliSeq™ Pharmacogenomics Research Panels
imported from AmpliSeq.com.

Reproductive Ion ReproSeq™ PGS kits for Aneuploidy Detection.

RNA Seq RNA sequencing research assays.

TargetSeq TargetSeq™ research applications, with parameters
optimized for hybridization-based target enrichment.

Whole Genome Whole genome sequencing research applications,
such as Ion ReproSeq™ Aneuploidy, which do not
assume enrichment and do not require a target
regions file.

16S rRNA Sequencing Ion 16S™ Metagenomics kit.

16S Target Sequencing Ion 16S™ Metagenomics kit.

Plan and execute an instrument run
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Create a custom Planned Run template

We recommend that you create a customized Planned Run template for reuse when
the same conditions can be used for multiple runs. To create a custom Planned Run
template, copy an existing system template then edit the settings to meet the
requirements for your Planned Run.

IMPORTANT! Before you create a custom Planned Run template, we recommend that
you upload the most current Reference Library, Target Regions, and Hotspot
Regions BED files on the Torrent Server. See “Reference Management“ for more
information. Contact your local service representative to obtain the most current BED
files.

1. In the Plan tab, click Templates, then select the desired Research Application
from the left navigation menu.

2. In the Planned Run list, find the system Planned Run template from which you
want to create your custom Planned Run, then click  (Actions)4Copy.
The Copy Template workflow bar opens to the Save step.

3. Enter or select the required information in each field in the Save step.

Field Description

Template Name (required) Enter a name for you custom Planned Run template.

Set as Favorite Select the Set as Favorite checkbox to add your custom
template to the Favorites list.

Analysis Parameters Select the Default radio button to accept default
analysis parameter settings (recommended). Advanced
users can customize analysis parameters by selecting
the Custom radio button and editing appropriate
analysis fields. For more information, see “Create and
select an analysis parameter set“ on page 348.

Reference Library Select the reference library file appropriate for your
sample. Depending on your application, you may have
to select separate DNA, RNA, and Fusions reference
library files.

Target Regions[1] Select the Target Regions BED file appropriate for your
sample. Depending on your application, you may have
to select separate DNA and Fusions Target Regions file.

hotspots[2] Select the hotspots (BED or VCF) file appropriate for
your sample.

[1] Check with your service representative for updates to ensure the most current files are being used. See 
“Upload a target regions file“ on page 240 for BED file installation instructions.

[2]  See “Upload a hotspots file“ on page 242 for BED file installation instructions.

Note: As you make your selections, your settings are updated in the Summary
pane.

Plan and execute an instrument run
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4. In the Copy Template workflow bar, click the Ion Reporter step, then set up the
transfer of the completed run results to a specified Ion Reporter™ Server. See “Ion
Reporter™ step in the workflow bar“ on page 38 for more information.

5. Click Next.

6. In the Research Application step, ensure that the correct Research Application
and Target Technique are selected. See “Research Application step in the
workflow bar“ on page 40 more information, then click Next.

7. In the Kits step, enter or select the required information. See “Kits step in the
workflow bar“ on page 41 for more information.

8. Click Next.

9. In the Plugins step (see “Plugins step in the workflow bar“ on page 44 for more
information), select from the available plugins, and configure the selected
plugins as required (see “Plugin configuration“ on page 113 for more
information). Click Next.

10. In the Projects step, select the project or projects to receive data from the runs
that use this template, then click Next. See “Projects step in the workflow bar“ on
page 45 for more information.

11. In the Save step, click Copy Template to save the new Planned Run template.

The customized template is now available in the Templates screen within the
Research Application group from which you copied the system template. If you set
your customized template to favorites, it also appears in the Favorites list.

Create a Planned Run from a template

You can create Planned Runs from preinstalled or custom templates of run settings.
Preinstalled Planned Run templates are included in the software for standard research
applications and kits, such as Ion AmpliSeq™ or Oncomine™ workflows. Custom
Planned Run templates can be created by users as described in “Create a custom
Planned Run template“ on page 34.

Note: When creating a Planned Run from a template, some settings and fields are
already defined by the template and some remain to be selected or filled in. The fields
and settings that are predefined can vary between templates. You can change any of
the settings to create your Planned Run, even those that were predefined in the
template.

Plan and execute an instrument run
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Follow the steps below to create a Planned Run from a template.

1. In the Plan tab, click Templates, then select the desired research application from
the left navigation menu, or click Favorites if you have added the template to
your favorites list.

2. Click on the template name in the Template Name column of the templates table.

The Create Plan workflow bar opens to the Plan step.

3. The Run Plan Name field is pre-populated with the template name. Enter new
text to create a unique Planned Run name.

4. Fill out additional fields in the Plan step as necessary. See “Plan step in the
workflow bar“ on page 45 for more information about the individual settings.

Note: As you make your selections, your settings are updated in the Summary
pane. You can also use the information in this pane to review the settings that are
predefined by the template.

5. Click on other steps in the workflow bar to enter or change settings as needed.

6. When you have completed your selections, review the settings in Summary
pane, then click Plan Run at the bottom of the Plan step.
The Planned Run is added to the list on the Planned Runs screen.

Create a Planned Run without a template

You can create a Planned Run with no predefined settings, as described in this section.

Note: We recommend creating Planned Runs from preinstalled or custom templates
in Torrent Suite™ Software. Planned Run templates contain predefined settings for
preparing multiple runs of the same type (for example, if you are performing the
same type of sequencing analysis using the same instruments and reagents on
multiple samples). See “Create a custom Planned Run template“ on page 34 and 
“Create a Planned Run from a template“ on page 35 for more information.

To create a Planned Run without a template, follow the steps below.

1. In the Plan tab, in the Templates screen, click Plan New Run.

The Create Plan wizard opens to the Ion Reporter step.

Plan and execute an instrument run
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2. In the Ion Reporter step, set up the transfer of the completed run results to a
specified Ion Reporter™ Server. See “Ion Reporter™ step in the workflow bar“ on
page 38 for more information.

Note: As you make your selections, your settings are updated in the Summary
pane.

3. Click Next.

4. In the Research Application step, ensure that the correct Research Application
and Target Technique are selected. See “Research Application step in the
workflow bar“ on page 40 for more information, then click Next.

5. In the Kits step, enter or select the required information. See “Kits step in the
workflow bar“ on page 41 for more information.

6. Click Next.

7. In the Plugins step (see “Plugins step in the workflow bar“ on page 44 for more
information), select from the available plugins, then configure the selected
plugins as required (see “Plugin configuration“ on page 113 for more
information).

8. Click Next.

9. In the Projects step, select the project or projects that will receive data from the
runs that use this template. See “Projects step in the workflow bar“ on page 45
for more information.

10. Click Next.

11. In the Plan step, enter a name for the plan in the Run Plan Name field, specify
the reference and BED files, and enter or upload your sample information. See 
“Plan step in the workflow bar“ on page 45 for more information about the
individual settings.

12. When you have completed your selections, review the settings in the Summary
pane, then click Plan Run at the bottom of the Plan step.
The Planned Run is added to the list on the Planned Runs screen.

Steps in the workflow bar

Torrent Suite™ Software guides you through steps to provide the information required
to create Planned Runs and templates, and then execute a Planned Run. You can use
the steps in the following ways:

• Create a Planned Run that is based on a template that is pre-populated with
information specific for your instrument run.

• Create custom Planned Run templates that fit your sequencing needs, and save
the templates to reuse for future Planned Run creation.

• Create a unique Planned Run that is not based on a template.

Note: Most templates have a corresponding Ion AmpliSeq™ or Oncomine panel.

Plan and execute an instrument run
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When you create a Planned Run from a template, the Create Plan workflow bar opens
in the last page, so that if you accept all the template settings, you only need to supply
a run plan name and sample names to create a Planned Run.

• Create Plan workflow bar:

• Create Template workflow bar:

After a Planned Run is created in the Torrent Suite™ Software, it is sent to the Ion
Torrent™ sequencer to be executed.

Note: You can also download a CSV file and customize it to create multiple Planned
Runs without using the workflow bar. See “Create multiple Planned Runs“ on
page 61 for more information.

Note: Selections on this page apply only to Ion Reporter™ Software users. The Ion
Reporter™ Software is not included with Torrent Suite™ Software and is available
under separate license. See “Integration with Ion Reporter™ Software“ on page 172
for more details.

When you create a Planned Run or a Planned Run template, you can add settings to
automatically transfer run results to Ion Reporter™ for further analysis and
visualization. You can directly transfer results in one of the following ways:

• If you select an Ion Reporter™ account and a workflow, then also select the option
to automatically upload after run completion, an Ion Reporter™ analysis is
launched immediately after the run. Successful analyses are then available in Ion
Reporter™ Software when you sign in to the selected account.

• You can also transfer the output files (BAM files and VCF files) from the run to
Ion Reporter™ without selecting an Ion Reporter™ Software workflow. In this
case, you can then launch the analysis manually in Ion Reporter™. This approach
is commonly used to annotate the VCF files by using the Annotation-only
workflow in Ion Reporter™ Software . For details, see the Ion Reporter™ Software
Help (Pub. No. MAN0017204).

In the Ion Reporter™ step in the workflow bar, you can select the Ion Reporter™

Software account to receive data from the completed run. If you are creating a
Planned Run template, select the Ion Reporter™ Software account to receive data from
every run that is created from this template.

1. In the Ion Reporter step in the workflow bar, select the Ion Reporter™ account
that you want to transfer output files to for analysis. The selected account is the
one that you will use to view and further analyze the files in Ion Reporter™

Software.

Note: If the Ion Reporter™ account is not configured, click Configure to add
another account. See “Set up an account for IonReporterUploader plugin“ on
page 173 for more information.

2. Select a Sample Grouping that corresponds to the sample relationship in Ion
Reporter™ Software. When you select a Sample Grouping, the workflow menu
in Ion Reporter™ Software displays only workflows that are appropriate for the
sample.

Ion Reporter™

step in the
workflow bar
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3. Select an option in the Existing Workflow dropdown list:

Option Description

Select Upload Only Use this option to transfer only the output files from the
sequencing run to Ion Reporter™ Software. If you use this
option, you can access the samples in Ion Reporter™ Software.
VCF files are also available, if you run the variantCaller
plugin.

Select an Ion
Reporter™ Software
workflow for your
sample type.

The workflow is automatically launched in Ion Reporter™ with
the sample data from the run. Successful analyses are
available in Ion Reporter™ Software with the account and
organization that you selected.

4. (Optional) If you want to create a new workflow, click Create New Workflow to
open Ion Reporter™ Software in a new browser window. In Ion Reporter™

Software, create your new workflow, then save it. When you return to your
Torrent Suite™ Software, refresh your browser. You can then select the newly
created workflow in the Existing Workflow list.

5. Select an Ion Reporter Upload Option:

Option Description

Review results after
run completion, then
upload to Ion Reporter

Use this option if you want to review the completed run
results and then manually upload the data to Ion Reporter™

Software.

IMPORTANT! You must review the results in Completed
Runs & Reports, then click Upload to IR4Upload as
Planned to upload the data to Ion Reporter™ Software.

Automatically upload
to Ion Reporter after
run completion

Run results are automatically uploaded to Ion Reporter™

Software. If you select a workflow, an Ion Reporter™

analysis is launched immediately after the run. Successful
analyses are then available to you in Ion Reporter™ when
you sign into Ion Reporter™ Software with the account used
in the setup.

6. Click Next in the workflow bar to continue with the Planned Run or template
creation.

Plan and execute an instrument run
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In the Research Application step, select your Research Application and Target
Technique.

Note: Available choices in subsequent steps are restricted to those compatible with
the selected Research Application and Target Technique.

1. Select the Research Application.

Research Application Description

DNA Detects and annotates low frequency (to 0.5% limit of
detection) somatic variants (SNPs, InDels and CNVs) from
targeted DNA libraries using Ion AmpliSeq™ HD
technology. This is compatible with DNA purified from
tumor or liquid biopsy research samples.

DNA and Fusions
(Separate Libraries)

Detects and annotates low frequency (to 0.5% limit of
detection) somatic variants (SNPs, InDels and CNVs) from
targeted DNA libraries, as well as gene fusions from
matching targeted RNA libraries using Ion AmpliSeq™ HD
technology. This is compatible with DNA and RNA purified
separately from tumor or liquid biopsy research samples.

DNA and Fusions (Single
Library)

Detects and annotates low frequency (to 0.5% limit of
detection) somatic variants (SNPs, InDels, CNVs and
fusions) from targeted nucleic acid libraries using Ion
AmpliSeq™ HD technology. This is compatible with DNA
and RNA purified together from tumor or liquid biopsy
research samples.

Fusions Detects and annotates gene fusions from targeted RNA
libraries using Ion AmpliSeq™ HD technology. This is
compatible with RNA purified from tumor or liquid biopsy
research samples

Human Identification For templates to run Applied Biosystems™ Precision ID
set of panels.

Immune Repertoire For use with the Ion AmpliSeq™ Immune Repertoire
panel.

Metagenomics Reserved for future use with Ion Reporter™ Software.

Mutation Load For use with the Oncomine™ Tumor Mutation Load Assay
panel.

Oncology - Liquid
Biology

For use with liquid biopsy oncology research panels.

Pharmacogenomics For Ion AmpliSeq™ Pharmacogenomics Research Panels
that are imported from ampliseq.com.

RNA For use with RNA (Fusions) libraries.

Typing For use when performing molecular fingerprinting to
detect viral or bacterial strains for research purposes.

Research
Application step in
the workflow bar
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2. Select the Target Technique.
• AmpliSeq DNA
• AmpliSeq Exome
• AmpliSeq HD - DNA
• AmpliSeq HD - DNA and Fusions (single library)
• AmpliSeq HD - DNA and Fusions (separate libraries)
• Other
• TargetSeq
• Whole Genome
• AmpliSeq DNA and Fusions
• AmpliSeq RNA
• 16S Targeted Sequencing
• Tag Sequencing
• RNA Sequencing

This step is used to set up all information needed for sample preparation and
sequencing, including the chip and kits used. Selections in this step will also influence
how the data is analyzed post-sequencing.

1. In the Kits step in the workflow bar, enter or select the following information.

Field Selection

Instrument Select the sequencing instrument system being used
(for example, Ion GeneStudio™ S5 Systems).

Sample Preparation Kit (Optional) Select the sample preparation kit used.

Library Kit Type Select the kit used to prepare the library (for example,
Ion AmpliSeq™ Library Kit Plus).

Template Kit 1. Select the instrument system used: OneTouch,
IonChef, or IA.

2. From the list, select the templating kit that was
used.

Sequencing Kit Select the sequencing kit used (for example, Ion S5™

Sequencing Kit).

Chip Type Select the sequencing chip type that will be used (for
example, Ion 540™ Chip).

Control Sequence (Optional) Select the control sequence added to the
library preparation. Leave blank if not used.

Barcode Set Select the barcode set used (for example, IonXpress).

Flows Enter the number of nucleotide reagent flows required
to complete the sequencing run (for example, 400).

Kits step in the
workflow bar
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Field Selection

Mark as duplicate reads Marks duplicate reads in the BAM file, after a run is
completed. Do not use with Ion AmpliSeq™ data. See 
“About the Mark as Duplicates Reads option“ on
page 43 for details.
To remove duplicates from the BAM file, select the
FilterDuplicates plugin in the Plugins step in the
workflow bar. See “Plugins step in the workflow bar“ on
page 44 for more information.

Enable Realignment Select this option to perform realignment, an optional
step that is executed immediately after TMAP. This
steps adjusts the alignment, primarily in the CIGAR
string. See “TMAP Modules“ on page 360 for more
information.

2. (Optional) Customize the Advanced Setting parameters. See “Advanced Settings
– Kits step in workflow bar“ on page 42 for more information.

IMPORTANT! We recommend using the default settings. Consult your local field
representative before modifying any Advanced Setting.

Advanced Settings – Kits step in workflow bar

IMPORTANT! We recommend using the default settings. Consult your local field
representative before modifying any parameters.

1. In the Kits step in the workflow bar, expand the Advanced Settings box, then
select Customize.

2. Edit one of the following parameters.

Setting Description

Templating
Protocol

Script the Ion Chef™ Instrument follows to perform the
templating reaction. We recommend you do NOT change this
setting.

Forward Library
Key

Select your forward library key. If you have a custom forward
library key, select it here.

Test Fragment Key Enter your test fragment key.

Plan and execute an instrument run
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Setting Description

Base Calibration
Mode

Select one of the following options:

• Default Calibration – allows a random subset of wells to
be used for base calibration. This option uses TMAP to
align the training subset of wells and is recommended if a
good reference for the template is available.

• Enable Calibration Standard – allows wells belonging to
the Calibration Standard to be selected as the training
subset.

• Blind Calibration – uses the same random subset of
wells as Default Calibration but does not require an
alignment step to generate the calibration model. This
option is recommended if the template does not align well
to a reference genome or if no reference is specified.

• No Calibration

See your template kit user guide for more details.

Forward 3' Adapter Select your forward 3' adapter.

Flow Order Select the flow order. See ““ on page 371 for additional
details.

About the Mark as Duplicates Reads option

For some applications, duplicate reads coming from PCR cause problems in
downstream analysis. The presence of duplicate reads may create the appearance of
multiple independent reads supporting a particular interpretation, when some of the
reads are in fact duplicates of each other with no additional evidence for the
interpretation.

Torrent Suite™ Software uses an Ion-optimized approach that considers the read start
and end positions by using both the 5' alignment start site and the flow in which the 3'
adapter is detected. Duplicate reads are flagged in the BAM in a dedicated field. Use
of the Torrent Suite™ Software method is recommended over other approaches which
consider only the 5' alignment start site.

Marking duplicate reads is not appropriate for Ion AmpliSeq™ data, because many
independent reads are expected to share the same 5' alignment position and 3' adapter
flow as each other. Marking duplicates on an Ion AmpliSeq™ run risks inappropriately
flagging many reads that are in fact independent of one another.

Plan and execute an instrument run
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Plugins expand the analysis capabilities of in Torrent Suite™ Software. The plugin
results are added to the run report and can be used for a variety of purposes. You can
set the plugin to run automatically after every run if you add the plugin, and
configure it if required, to the Planned Run or Planned Run template.

In the Plugins step in the workflow bar, select the plugins to include in a Planned
Run, or a Planned Run template. Plugins run automatically during run analysis, and
plugin analysis results appear in the run report.

Note:
· The list of available plugins depends on which plugins are active on the Torrent

Server that is connected to the instrument you use. Plugins that are installed,
configured, and enabled on your Torrent Server are active, and are available in this
list.

· The IonReporterUploader plugin does not appear in this list because it is
configured in the IonReporterUploader step.

· When you enable some plugins, such as variantCaller and coverageAnalysis
plugins, a Configure link appears for that plugin. For information on configuring
each plugin, see “Pre-installed plugins“ on page 120.

· If you select the IonReporterUploader plugin and the Planned Run does not use a
predefined configuration, you must click the Configure link to configure the plugin
before you can proceed to the next step or save the Planned Run or Planned Run
template. For details about how to configure the IonReporterUploader plugin, see 
“Variant calls in Torrent Suite Software“ on page 191.

Plugins step in the
workflow bar
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In the Projects step in the workflow bar, select one or more projects to receive data
from the completed run. When you create a Planned Run template, select the projects
to receive data from every run that is created from this template.

For more information about projects, see “Organize run results with projects“ on
page 82.

In the scrolling list, select the checkbox next to each project name. You can also search
for or add projects as described below.

Note: The list includes all projects that are created on the Torrent Server.

Option Description

Search for
projects

(Optional) To search for projects, enter a case-sensitive search term or
partial search term in the field below the list, then click Search.

Add projects (Optional) To create a new project or projects, click Add Project, then
enter a name in the field, or enter multiple names that are separated
by commas.

Remove added
projects

(Optional) To remove an added project or projects from the field, click
Remove New Projects.

1. In the Plan step in the workflow bar, enter or select the required information in
each of the following fields.

Field[1] Description

Run Plan Name
(required)

Enter a name for the Planned Run.

Analysis
Parameters

Select the Default radio button to accept default analysis
parameter settings (recommended). Advanced users can
customize analysis parameters by selecting the Custom radio
button and editing appropriate analysis fields. For details, see 
“Create and select an analysis parameter set“ on page 348.

Reference Library Select the reference library file appropriate for your sample.
Depending on your application, you may have to select
separate DNA, RNA, and Fusions reference library files.

Target Regions[2] Select the Target Regions BED file appropriate for your
sample. Depending on your application, you may have to select
separate DNA and Fusions Target Regions file.

Hotspots[3] Select the hotspots (BED or VCF) file appropriate for your
sample.

[1] Depending on your sequencing application, fields can vary.
[2] Check with your service representative for updates to ensure the most current files are being used. See 

“Upload a target regions file“ on page 240 for BED file installation instructions.
[3]  See “Upload a hotspots file“ on page 242 for BED file installation instructions.

2. Select the Use same reference & BED files for all barcodes checkbox if you are
using the same reference, Target Regions, and hotspots files across all of your
barcoded samples in the Planned Run. If you are using different reference and/or
BED files for one or more of your barcoded samples, deselect the Use same
reference & BED files for all barcodes checkbox.

Projects step in
the workflow bar

Plan step in the
workflow bar
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3. (Optional) For DNA and Fusions application, select the Same sample for DNA
and Fusions checkbox when using the same sample for both DNA and Fusions
libraries.

4. Depending on your application, fill out the following fields:

Option Description

Number of
barcodes

For barcoded samples, enter the number of barcodes to be used in
this run in the Number of barcodes field, then click  to the right
of this field.
Alternatively, click on the first barcode and  appears. Click 
and all subsequent barcodes will be numbered from the first
barcode value.

Number of
chips

For non-barcoded samples, enter the number of chips to be used in
this run in the Number of chips field, then click .

The Samples Table is populated with barcode information or chip number for
each sample.

5. In the Sample Tube Label field(s), scan or enter the barcode of the Ion Chef™

sample tubes to be used in the run.

6. In the Chip Barcode field, scan or enter the barcode that is printed on the chip
that is used for this run.

7. (Optional) Select a radio button next to the sequencing application (such as
"Oncology" or "Pre-implantation Genetic Screening") to populate required
sample information fields into the Samples Table.

8. Complete the following fields in the Samples Table.

• Save the samples table to a CSV file, fill out all required sample information,
then upload the samples table to automatically populate the Samples Table.

a. Click Save Samples Table to save the CSV file to your computer.
b. Edit the CSV file by entering all required sample information into the

appropriate sample information columns, then save the CSV file to your
computer.

c. Click Load Samples Table, then select an appropriate CSV file
containing sample information specific for this Planned Run.

d. Click Load to populate the Samples Table in Torrent Suite™ Software
with sample information that is supplied by the CSV file.

• Alternatively, manually enter sample information into the Samples Table
using the Torrent Suite™ Software.

Field[1] Description

Barcode For barcoded samples, select a barcode from the dropdown
list.

Sample (required) Enter a unique sample name for each sample. Do not
duplicate sample names.

Plan and execute an instrument run
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Field[1] Description

Control Type (Optional) Click the Control Type column header to expand the
Control Type column, then select the control type from the
dropdown list.

Sample ID (Optional) Enter a sample ID for each sample.

Sample Description (Optional) Enter a sample description for each sample.

DNA/Fusions For DNA and Fusions application, select DNA or Fusions from
the dropdown list for each sample.

Reference If using different reference and BED files for one or more
samples, click the Reference column header to expand the
Reference sections, then select Reference, Target Regions,
and hotspots files from the dropdown list for each sample.

Annotations Click the Annotations column header to expand the annotation
fields specific for your application (e.g., cancer type or Embryo
ID) and complete the required field information.

Ion Reporter
workflow

Select the Ion Reporter™ workflow specific for your run from
the dropdown list. If you do not see your workflow, select the
Show All Worklows checkbox in the column header.

Relation Select sample relationship group.

Gender Select "Male", "Female", or "Unknown" from the dropdown
list.

IR Set ID The IR Set ID is set to the same value for related samples.
After file transfer, in Ion Reporter™ Software, samples with the
same Set ID are considered related samples and are launched
in the same analysis (e.g, normal sample and its
corresponding tumor sample). Do not give unrelated samples
the same Set ID value even if the value is zero or blank.

[1] Depending on your sequencing application, fields can vary.

9. (Optional) Add a note about your Planned Run in the Add a note field.

10. (Optional) If using LIMS meta data, enter the text that is associated with the
Torrent Suite™ Planned Run in the Add LIMS Meta Data field.

11. (Optional) In the Monitoring Theresholds pane, adjust Bead Loading (%), Key
Signal (%), and Usable Sequence (%) minimum thresholds for your Planned Run.
If Monitoring thresholds are not met, the run will still be processed and an alert
message will be shown on the run report page after analysis is complete.

12. When you are finished with all of your selections, scroll to the bottom of the
screen, then click Plan Run.
The Planned Run is added to the Planned Runs list in the Planned Runs screen.
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Export a Planned Run template

You can export the settings from a Planned Run template to a CSV file. You can then
transfer the file to a different Torrent Server and import the template into Torrent
Suite™ Software on that server (see “Import a Planned Run template“ on page 48).
You can also open the file in a spreadsheet application such as Microsoft™ Excel™ and
edit the settings before import, but be careful to preserve the column headings and
layout.

In the Plan tab, in the Templates screen, locate the template that you want to export.
Click  (Actions) in the row of the template, then select Export.

Depending on your browser settings, the CSV file may be created and downloaded
automatically, or you may be prompted to save the file.

Note: Exported templates have "exported" appended to the front of the original
template name, unless you edit the name in the CSV file.

Import a Planned Run template

You can import Planned Run template settings that have been exported to a CSV file.
This is useful for transferring settings between different Torrent Servers. (To export
the settings, see “Export a Planned Run template“ on page 48.)

Note: You can change the settings in an exported CSV file and then import, but be
careful to preserve the column headings and layout.

To import a CSV file containing template settings:

1. In the Plan tab, in the Templates screen, select the research application group
that you want to import the template into.

2. Click Upload4Upload Template.

Plan and execute an instrument run
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3. In the Import Plan Template dialog box, click Choose File, select the CSV file to
import, then click Load.
The template appears listed in the application group. Exported templates have
"exported" appended to the front of the original template name, unless the name
has been edited in the CSV file.

4. (Optional) Edit the template name, by clicking  (Actions)4Edit.

Review the Planned Run settings

You can review the Planned Run settings of a completed run.

1. In the Data tab, click Completed Runs & Reports, then select a run of interest.

2. In the Summary section, click Report Actions4Review Plan.
A Review Plan summary lists the details of the Planned Run.

Category Subcategories

Application Research Application

Research Category

Sample Grouping

Target Technique

Sample Set

Kits Sample Preparation Kit

Library Kit

Library Key

3' Adaptor

Flow Order

Template Kit

Templating Protocol

Sequencing Kit

Control Sequence

Library Read Length

Flows

Chip Type

Barcode Set

Mark as PCR Duplicates

Base Calibration Mode

Enable Realignment

Barcodes & Samples Sample Tube Label

Chip Barcode

Plan and execute an instrument run
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Category Subcategories

Barcode

Analysis Parameters Used (Default) BeadFind Args

Analysis Args

Pre-BaseCaller Args for Calibration

Calibration Args

BaseCaller Args

Alignment Args

IonStats Args

History Log of system actions

Monitoring Bead Loading (%)

Key Signal (1-100)

Usable Sequence

Reference Reference Library

Target Regions

Hotspot Regions

Plugins & Output Plugins

Projects

Uploaders

Notes

LIMS Meta Data

Plan Meta Data TS version when created

Plan created via

Import panel files and parameters from AmpliSeq.com

You can import panel files and parameters for an Ion AmpliSeq™ Ready-to-Use, On-
Demand, or Made-to-Order design. The package includes primer pool results panel
file, hotspot BED files, and JSON parameters files required to produce your
sequencing results. For Ready-to-Use and Community Panels (but not Made-to-Order
Panels), parameter settings that are optimized for the variantCaller plugin are
included in your new template; you can configure the variantCaller plugin with these
settings when you create the Planned Run, if desired. For details, see “variantCaller
plugin configuration“ on page 194. Human, animal, and plant reference BED files are
also available for import. Before importing, you need to link your Torrent Server
account with your AmpliSeq.com account. For more information about Ion
AmpliSeq™, see Ion AmpliSeq™ Designer: Getting Started User Guide (Pub. No.
MAN0010907).

Plan and execute an instrument run
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To import a Planned Run template from AmpliSeq.com into Torrent Suite™ Software,
you must first link your Torrent Server account to AmpliSeq.com. Linking your
Torrent Server account is a one-time requirement.

1. In the Torrent Browser, click  (Settings)4Accounts.

2. If needed, update or enter any account information in the User Profile/Account
Information section, then click Submit.

3. Click Link to AmpliSeq.

Note: You may need to scroll down the screen
to view the link button.

4. Enter your AmpliSeq.com sign in information, then click Save.

Your Torrent Server account is now linked and import of panel information from
AmpliSeq.com is enabled.

Note: To unlink your Torrent Server account, click Unlink username@domain.com.

1. In the Templates screen, click AmpliSeq.com , then select from the
dropdown list the type of panel you want to import: AmpliSeq DNA, AmpliSeq
Exome, or AmpliSeq RNA.

Link your Torrent
Server account to
AmpliSeq.com

Import Planned
Run template
parameters from
AmpliSeq.com
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2. In the next screen, select your instrument and chip type, then select a panel or
panels from the list of available panels.

Note:
· Some panels do not have optimized variantCaller plugin parameters available

for all chips and sequencers. A warning identifies panels for which optimized
variantCaller parameters have not been developed for the selected chip type.

· If you have ordered Ion AmpliSeq™ Made-to-Order designs, a list for selecting
the panel files for import also appears on this screen.

· If you have downloaded a panel's ZIP archive from AmpliSeq.com to your
computer, you can also create a Planned Run template by manually uploading
the archive on the right pane of this screen.

3. Click Import Selected.

4. The Torrent Browser opens a download and progress dialog box. Refresh your
browser to track the progress. When the Status column shows "Complete",
return to the Templates screen.
The new template is listed.
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You can upload panel files from AmpliSeq.com that are saved in a storage location to
Torrent Suite™ Software. Use this procedure when only part of the panel files are
available from the compressed archive, rather than the complete set of panel files.

Note: If the entire compressed directory of panel files from AmpliSeq.com are
available, see instead “Import Planned Run template parameters from
AmpliSeq.com“ on page 51.

1. In the Plan tab, click Templates.

2. Click Upload4Upload Design/Panel Zip Archive and the Import Panel from
Zip Archive dialog box opens.

a. Click Select File and browse to your compressed panel file.

b. Select instrument type and chip type.

c. Click Upload Panel from Zip Archive.

3. Close the upload dialog box.

4. To check the status of the upload, click (Settings)4Reference, then click
Upload History.

Note: If you don't choose the correct chip type you will receive a validation
error.

Upload panel files
from
Ampliseq.com
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Search for a template

You can search, sort, or filter the Templates list to find a template of interest.

1. In the Plan tab, click Templates.

To… Actions…

Search the
list

1. Click All in the research applications menu on the left to search
all templates. Alternatively, select a research application from
the menu to search for templates within a specific research
application.

2. Enter a search term in the Search by Template Name field, then
click Go.

Sort the list Click on any bolded column header in the list of templates to sort the
order in which the templates are displayed. Click on the column
header a second time to reverse the sort order.

Limit the list
to recent
runs

In the Date field select a preset range, or click Date Range, then
select Start and End dates.

Filter the
list

Select from one or more Filter dropdown lists to limit the list of
templates. Click More Filters to see all available filters. Within a
Filter, enter text into the Find field to limit the filter choices. To
remove a filter, de-select the filter choice or click Clear in the Filter
dropdown list.

Note: In some cases, you can select more than one choice within a
single filter category.

2. Click Clear All to remove filters and restore all results.
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Save a Planned Run template to Favorites

You can save Planned Run templates to Favorites to make it easier to locate your
frequently used templates within the Torrent Suite™ Software.

1. In the Plan tab, click Templates, then search for a template (see “Search for a
template“ on page 54) you want to add to Favorites.

2. In the row of the template, click  (Actions)4Set as Favorite to add your
Planned Run template to the Favorites list.

3. In the Plan tab, click Templates, then click Favorites at the top of the research
applications list to display the list of favorite Planned Run templates that are
saved on your Torrent Server.

Plan by Sample Set

You can define samples and pre-select the attributes that you want to associate with
each sample before you start to plan your templating and sequencing runs. You can
then organize samples into Sample Sets that are available to select and reuse when
you create Planned Runs.

This approach, known as Plan by Sample Set, can save time when you plan your
instrument runs if:

• Your samples include many attributes.
• You want to use the same Sample Sets for many instrument runs.
• Your laboratory assigns tasks such as planning and defining sample attributes to

individuals who have specific areas of expertise.
• Your samples include attributes for use with Ion Reporter™ Software. For

example, if you include select the Sample Set group type Trio, only Trio
workflows are available to choose when you configure a Planned Run for use
with Ion Reporter™ Software.

• You want to set up multi-sample analyses in Ion Reporter™ Software.
• Your Torrent Server is connected to a LIMS.

Plan and execute an instrument run
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If you set up your samples before you plan an instrument run, you can add one or
more Sample Sets to your Planned Run.

Sample Sets must correspond to AmpliSeq™ library preparations and use the same
barcode kit to be included in a single Planned Run.

1. In the Plan tab, in the Samples screen, find the Sample Set(s) that you want to
add to the Planned Run.

2. Select one or more Sample Sets to add to the Planned Run.

• To plan a run using one Sample Set, click  (Actions) 4Plan Run in the row
of the Sample Set.

• To plan a run using multiple Sample Sets, select the checkboxes next to the
Sample Sets you want to add to the Planned Run, then click Plan Run.

IMPORTANT! Ensure that all Sample Sets used in the Planned Run use the
same barcode kit. To verify the barcode kit used, expand the Sample Set entry
to view its details.

The Select a Run Template to apply to this experiment dialog lists Planned Run
templates that support your Sample Set.

3. Select a Run Template to use for the experiment, then click Plan Run.

Create a Planned
Run with Sample
Sets

Plan and execute an instrument run
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Note: If you do not see the template that you are looking for, select Show All
Templates, then look again for the template.

The Create Plan workflow opens to the Barcoding step with the Sample Sets that
you selected:

4. In the Barcoding step in the workflow bar, enter or select the required
information in each of the following fields.

Field[1] Description

Analysis Parameters Select the Default radio button to accept default analysis
parameter settings (recommended). Advanced users can
customize analysis parameters by selecting the Custom radio
button and editing appropriate analysis fields (see “The
Command Line Args (Advanced) tab“ on page 349.

Reference Library Select the reference library file appropriate for your sample.
Depending on your application, you may have to select
separate DNA, RNA, and Fusions reference library files.

Target Regions[2] Select the Target Regions BED file appropriate for your
sample. Depending on your application, you may have to
select separate DNA and Fusions Target Regions file.

hotspots[2] Select the hotspots (BED or VCF) file appropriate for your
sample.

[1] Depending on your sequencing application, fields can vary.
[2] Ensure that you are using the current BED or VCF files

5. Select the Use same reference & BED files for all barcodes checkbox if you are
using the same reference, Target Regions, and hotspots files across all of your
barcoded samples in the Planned Run. If you are using different reference and/or
BED files for one or more of your barcoded samples, deselect the Use same
reference & BED files for all barcodes checkbox.

6. In the Sample Tube Label field(s), scan or enter the barcode of the Ion Chef™

sample tubes that will be used in the run.

7. In the Chip Barcode field, scan or enter the barcode printed on the chip used for
this run.

Plan and execute an instrument run
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8. Fill out or select the following fields in the Samples Table.

• You can save the samples table to a CSV file, fill out all required sample
information, and then upload the samples table to automatically populate the
Samples Table.

a. Click Save Samples Table button to save the CSV file to your computer.
b. Edit the CSV file by entering all required sample information into the

appropriate sample information columns, then save the CSV file to your
computer.

c. Click Load Samples Table, then select an appropriate CSV file
containing sample information specific for this Planned Run.

d. Click Load to populate the Samples Table in Torrent Suite™ Software
with sample information supplied by the CSV file.

• Alternatively, manually enter sample information into the Samples Table
using the Torrent Suite™ Software.

Field[1] Description

Barcode For barcoded samples, select a barcode from the dropdown
list.

Sample (required) Select a sample that is a part of the selected sample set(s)
from the dropdown list.

Control Type Click on the Control Type column header to expand the
Control Type column, then select the control type from the
dropdown list.

Sample ID (Optional) Review sample ID information for each sample. To
edit Sample ID, you must edit the Sample Set as described in 
“Edit a Sample Set“ on page 27.

Sample Description (Optional) Review sample description for each sample. To
modify sample description, you must edit the Sample Set as
described in “Edit a Sample Set“ on page 27.

DNA/Fusions For DNA and Fusions application, select DNA or Fusions from
the dropdown list for each sample.

Reference If using different reference and BED files for one or more
samples, click the Reference column header to expand the
Reference sections and select Reference, Target Regions,
and hotspots files from the dropdown list for each sample.

Annotations Click the Annotations column header to expand the
annotation fields specific for your application (e.g., cancer
type or Embryo ID) and complete the required field
information.

Ion Reporter
workflow

Select the Ion Reporter™ workflow specific for your run from
the dropdown list. If you do not see your workflow, select the
Show All Worklows checkbox in the column header.

Relation Select sample relationship group.

Plan and execute an instrument run
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Field[1] Description

Gender Select Male, Female, or Unknown from the dropdown list.

IR Set ID Set the IR Set ID to the same value for related samples. After
file transfer, in Ion Reporter™ Software, samples with the
same Set ID are considered related samples and are
launched in the same analysis (e.g, normal sample and its
corresponding tumor sample). Do not give unrelated samples
the same Set ID value even if the value is zero or blank.

[1] Depending on your sequencing application, fields can vary.

9. Continue with the steps to create the Planned Run. See “Steps in the workflow
bar“ on page 37 for more information.

10. Click Save & Finish.

The Planned Run is added to the Planned Runs table and can be used in an
instrument run.

To plan a run for DNA and Fusion sample pairs and several individual Fusion or
DNA samples, start with a fusions template, then alter it to accommodate single
samples on the same chip. The example that follows is a mixed Sample Set consisting
of two sample pairs, one DNA-only sample and two Fusion-only samples.

1. In the Plan tab, click Templates, then click the DNA and Fusions research
application.

2. Identify a DNA and Fusions template for the instrument system you use, then in
that row click  (Actions) 4Copy.

3. Enter a Template Name and a DNA Target Regions file, then click Copy
Template.

4. Return to the Templates screen, click the DNA and Fusions research application,
then select the copied template.

5. In the Ion Reporter step of the workflow bar, select an Ion Reporter account and
workflow, ensure the DNA and Fusions Sample Grouping is selected, then click
Next.

6. Ensure that the DNA and Fusions Research Application and AmpliSeq DNA
and Fusions Target Technique is selected, then click Next.

7. Click Plan in the workflow bar.

8. Enter the number of barcodes, then click .

9. Deselect the Same sample for DNA and Fusions option.

Create a Planned
Run for mixed
samples with a
template
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10. Rename the samples if desired. To rename the samples, click on the sample name
in the Samples table, then enter a new name in the text field.

11. Change DNA/Fusions selections to match samples. To change the DNA/Fusions
selection for a sample, navigate to the DNA/Fusions column in the Samples
Table and select DNA or Fusions from the dropdown list in the row of the
sample.

12. (Optional) Select a Cancer Type for each sample.

Plan and execute an instrument run
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13. Select the appropriate Ion Reporter workflows. To select an Ion Reporter
workflow, click on the existing selection in the Samples Table, then select from
the dropdown list.

14. Select a Relation andGender in the Samples Table, then click Plan Run. See 
“Create a Planned Run with Sample Sets“ on page 56 for more information.

Create multiple Planned Runs

To facilitate running the same sequencing run multiple times you can use a template
CSV file to create multiple Planned Runs at one time. The template CSV file for batch
planning is available for download in the Torrent Suite™ Software. In Torrent Suite™

Software 5.4 and earlier, each row of the CSV batch planning template contained data
for an individual Planned Run. In Torrent Suite™ Software 5.6 and later, each column
in the CSV file represents an individual Planned Run. Each row contains the run
parameters for each individual Planned Run. In Torrent Suite™ Software 5.4 and later,
you can add sample information to Planned Runs that is required for Ion Reporter™

Software analyses, including account, workflow, and workflow-related attributes such
as gender, relation, and IR Set ID.

Note: The latest CSV batch planning template file indicates the version of the
template in the top row. This version number is required. When you download the
template from the Torrent Suite™ Software, the version is automatically included.

You can create multiple Planned Runs with a template CSV file. To create multiple
Planned Runs for individual non-barcoded libraries, a single batch planning template
CSV file is required.

1. In the Plan tab, click Templates.

2. In the row for the template that you want
to use to create multiple Planned Runs,
click  (Actions)4 Plan Multiple.

Create multiple
Planned Runs for
non‑barcoded
libraries
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3. In the Plan Runs from Template dialog, enter the number of Planned Runs that
you want to create, then click Download CSV for batch planning.

4. Save the batch planning template CSV file to your drive, then open the file.

In this example, the template creates four Planned Runs with non-barcoded
libraries.

5. Enter the plan parameters for each Planned Run. The following parameters are
required:

• Template name (auto-populated)
• Plan name
• Sample
• Templating Kit name (auto-populated)
• Chip type

6. Name, then save the CSV file.

Plan and execute an instrument run
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7. In the Plan tab, in the Templates
screen, click Upload4Upload Plans.

8. In the Upload Plan Runs dialog,
click Choose File, select the edited
CSV template, then click Open.

9. Click Upload CSV for batch
planning.

The system parses the files, then creates the Planned Runs.

To create multiple Planned Runs for multiplex sequencing of barcoded libraries, two
batch planning template CSV files are required:

• A master CSV file that is used to specify the plan name, kits, chips, projects, and
plugin selections.

• A sample CSV file for each Planned Run.

1. In the Plan tab, click Templates.

2. In the row for a barcoded template that
you want to use to create multiple
Planned Runs, click  (Actions)4 Plan
Multiple.

3. In the Plan Runs from Template dialog
box, enter the number of Planned Runs
that you want to create, then click
Download CSV for batch planning.

4. Unzip the downloaded archive file, then save the files to your drive.

Create multiple
Planned Runs for
barcoded libraries
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5. Open the tsPlan file appended with master.csv, enter the Template name, Plan
name, Sample, and Chip type.

In this example, the template creates four barcoded Planned Runs.

6. Save the CSV file.

7. Open each tsPlan file appended with samples.csv, enter the sample parameter
information for each barcoded sample, including Sample Name, Sample ID,
Sample Description, and so on, then save each file.

8. Add the Master CSV template and all Sample CSV template files to a compressed
(zipped) folder.

9. In the Plan tab, in the Templates
screen, click Upload4Upload Plans.

10. In the Upload Plan Runs dialog,
click Choose File, select the edited
CSV template, then click Open.

11. Click Upload CSV for batch
planning.
The system parses the files, then
creates the Planned Runs, that are then available for use in the Plan tab, in
Planned Runs screen.
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Planned Runs list

The Planned Runs screen under the Plan tab lists Planned Runs that are ready to
execute on an Ion Chef™ Instrument or sequencer. Planned Runs are listed by date,
and the table includes basic information about each run, including its status in the
sequencing workflow (see “Planned Run status“ on page 67).

The screen includes tools for searching, sorting, editing, copying, and deleting
Planned Runs, and transferring them to another Torrent Server.

Click Planned Runs under the Plan tab to access the functions listed below.

To... Do the following...

View all Planned
Runs

Click All above the list.

View Planned Runs
that were created
from a template

Click by Template above the list.

View Planned Runs
that were created
from a sample set

Click by Sample above the list.

Search the list 1. In the search field above the Planned Runs list, click 
(Search By) and select the search type from the options.

2. Enter your search terms in the field, then click Go.

Filter the list Select your filter criteria from the dropdown lists above the list of
Planned Runs.

Clear all search and
filter settings and
display the complete
list

Click Clear All above the list.

Sort the list Click a column header to sort the list by the information in that
column. Only column headers in bold font are clickable.

View multiple pages
in the list

Click the page number and scroll buttons below the list.

Manage Planned
Runs
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To... Do the following...

Display a list of the
samples in the
Planned Run

Hover over the  (Info) icon in the Sample column.

Display a list of
projects that the run
results will be
transferred to

Hover over the  (Info) icon in the Project column.

Delete Planned Runs Select the checkbox next to each Planned Run, then click Delete
Selected below the list. Alternatively, click  (Actions) in the
Planned Run row, then select Delete.

Note: You cannot delete Planned Runs with a status of Reserved.

Edit a Planned Run 1. Click  (Actions) in the Planned Run row, then select Edit.
The Edit Plan workflow will open.

2. Edit the settings in any of the steps, then click Update Plan in
the Save step.

Review all the
settings in a Planned
Run

Click  (Actions) in the Planned Run row, then select Review.

Copy a Planned Run 1. Click  (Actions) in Planned Run row, then select Copy.
The Copy Plan workflow will open.

2. Edit the settings in any of the steps, enter the name of the
new plan in the Run Plan Name field, then click Copy Plan in
the Save step.

Transfer a Planned
Run to another
Torrent Server

See “Transfer a Planned Run to another Torrent Server“ on
page 70.
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The following status types are displayed in the Status column of the Planned Runs
list.

Note: When you select a Planned Run on a sequencer and begin sequencing, the
Planned Run is removed from the list.

Status Description

Pending The Planned Run is available and ready for use by an
Ion Chef™ Instrument. It is unavailable for sequencing until
the Ion Chef™ run is complete.

Note: The software determines whether a run is Pending
on an Ion Chef™ Instrument based on the template kit
selection when you create the run.

Reserved The Planned Run is in use by an Ion Chef™ Instrument, and
is unavailable for use until the current Ion Chef™ run
completes.

Planned The Planned Run is available and ready for use by a
sequencing instrument.

Voided The Ion Chef™ run is canceled through the Ion Chef™

screen.

Note: You can change the status of an Ion Chef™ run under specific circumstances.
See “Manually change an Ion Chef™ Instrument run status“ on page 67.

Manually change an Ion Chef™ Instrument run status

An Ion Chef™ Instrument run must have a status of Planned before a sequencer can
start a sequencing run. If the connection between an Ion Chef™ Instrument and
Torrent Suite™ Software is temporarily lost or interrupted, the status of the Ion Chef™

run might be marked as Reserved, even if the run has completed. To resolve this
problem, you can manually change the status to Planned and enable the run for
sequencing.

1. In the Plan tab, click Planned Runs.

2. Locate the Planned Run of interest (with a status of Reserved), then click 
(Actions)4Completed on Chef.
The status for the Ion Chef™ Instrument Run on the Planned Runs screen
changes from Reserved to Planned. The sequencer can now use the Planned Run
to start a sequencing run.

Planned Run
status

Plan and execute an instrument run
Planned Runs list
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A Planned Run is listed in the Planned Runs screen until it is executed on a
sequencer. To execute the run, you select it on the sequencer touchscreen, after which
the run is removed from the Planned Runs list.

Depending on your sequencing system, follow these steps to select a Planned Run and
start a sequencing run:

• For the Ion PGM™ System, press Run in the home screen, then follow the on-screen
instructions. Pending run information is populated into the Run info screen. Press
the Browse button to select a different Planned Run from the Planned Runs list, if
needed. Press Next --> when you are ready to start your sequencing run.

You can also type the Planned Run short code (for example, ITHWQ) into the
Planned Run: text field on the run information dialog:

• For the Ion Proton™ System, press Run in the home screen, then follow the on-
screen instructions. In step 9 of the workflow, select a Planned Run from the
dropdown list, scan or enter the chip barcode, then press Next ►. Pending run
information is populated into the next screen. Follow the on-screen instructions to

Execute a Planned
Run on a
sequencer

Plan and execute an instrument run
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confirm the run information, load and calibrate the chip, and start the sequencing
run.

• For the Ion GeneStudio™ S5 System and Ion S5™ System, select your run from the
Run Selection screen, then press Review. On the Select Run screen, ensure that
the run selections are correct, then press Start run.

Plan and execute an instrument run
Planned Runs list
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If you have multiple Torrent Servers and sequencers on a network, you can create a
Planned Run on one server, then transfer it to a different Torrent Server to perform the
run. This is useful if a Ion Chef™ Instrument or sequencer associated with a particular
sever is offline or busy. A network administrator or field service representative must
first set up this networking capability.

IC 3

TS 1
(origin)

IC 2IC 1 PGM 1 PGM 2 PGM 3

TS 2
(destination)

TS 3
(destination)

Network

For example, as shown in the diagram, a Planned Run can be set up on the first
Torrent Server (TS 1) and run on its associated Ion Chef™ Instrument (IC 1). But if the
associated Ion PGM™ Sequencer (PGM 1) is busy or offline, you can transfer the
Planned Run to TS 3 or TS 2 to perform the run on those associated sequencers (PGM
2 or PGM 3).

To transfer a Planned Run:

1. In the Planned Runs screen, find the Planned Run that you want to transfer.

Note: The status of the Planned Run listed in the Status column must be either
Pending (for runs to be sent to an Ion Chef™ Instrument) or Planned (for runs to
be sent to a sequencer). You cannot transfer runs that are in progress on an
Ion Chef™ Instrument (status is Reserved).

2. Click  (Actions) for the selected Planned Run, select Transfer, then select the
name of the destination Torrent Server on the network.

Transfer a
Planned Run to
another Torrent
Server
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3. Click Transfer to confirm.

• If the transfer is successful, a green confirmation message appears.
• If any files or other settings required for the run are missing on the

destination server, a red message displays what is missing. Edit the
transferred Planned Run on the destination server to add the files or other
missing settings to perform the sequencing run.

Note:
· You can no longer access the Planned Run on the origin server after it has

transferred.
· To move the results of a sequencing run to a different Torrent Server, use the

RunTransfer Plugin. See “RunTransfer plugin“ on page 152 for more information.

Plan and execute an instrument run
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Monitor instrument runs

Monitor the sequencing run

In Torrent Suite™ Software you can monitor information about instrument runs
through reported metrics, thumbnail graphs, and other indicators. You can also
review the Planned Run settings for a sequencing run that is currently in progress on
the instrument.

Note: Active sequencing runs and all runs completed within the previous 7 days are
available to view.

View the thumbnail graphs and metrics of an sequencing run in progress to quickly
determine whether to abort or continue the sequencing run.

In the Monitor tab, click Runs in Progress, then view run metrics in List View.

During a sequencing run, a temporary thumbnail entry is generated that displays run
metrics and a heatmap image of chip loading as they become available. You can see at
a glance in the heatmap image, and in the thumbnail graphs if any run quality metrics
are flagged ( ) as falling below the thresholds defined in your Planned Run.

Metric Description

Loading Addressable wells on the chip which have detectable loading.

Live ISPs Loaded wells which have a live signal.

Library ISPs Live wells with a library template.

Key Signal Average 1-mer signal in the library key.

Usable Seq Percentage of the sequence available for analysis after filtering.

Flow Transfer Progress of the sequencing run expressed as number of the total
number of flows completed.

See “Stop a sequencing run“ on page 285 for more information if you decide to abort
the sequencing run based on the chip loading metrics observed.
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Monitor an Ion Chef™ run

In the Monitor tab, you can view details about Ion Chef™ runs from the previous 7
days.

Note: The Planned Runs screen also contains information about the status of
Ion Chef™ runs. See “Planned Run status“ on page 67.

In the Monitor tab, click Ion Chef to view the following parameters.

Parameter Definition

Last Updated Date and time of the currently displayed run status.

Sample Set See “Samples and Sample Sets“ on page 16 for more
information.

Plan Ion Chef™ run plan in progress.

Chef Instrument Identity of the Ion Chef™ Instrument in use.

Library Prep Progress Shows the progress of an Ion AmpliSeq™ library
preparation run. For an Ion AmpliSeq™ on Ion Chef™ run
only.

Library Prep Status Displays the current stage of the library preparation run.
(Not started, In progress, or Complete)

Template Prep Progress Shows the progress of a template preparation run.

Template Prep Status Displays the current stage of the template preparation run.
(Not started, In progress, or Complete)

Estimated Time Remaining Estimated time remaining until the run is completed.

Estimated Time Until User
Intervention

Estimated time and date when the run pauses for QC, or is
completed.

Note: For an Ion Chef™ run in progress, check the Estimated Time Remaining or
Estimated Time Until User Intervention to see the time remaining before you can
remove ISP samples at the QC pause or remove loaded chips for sequencing.

View data for runs in progress

You can view data for runs in progress on the Monitor tab in Ion Reporter™ Software.

This section has two views:
• List View has 20 runs per page, with details shown for each run.
• Table View has 1 run per row in columns that you can sort by clicking a column

head. This view displays only the parameters that are associated with each
report.

Monitor instrument runs
Monitor an Ion Chef™ run
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Note: Both the List View and Table View show 20 runs at a time. If you have more
than 20 runs, multiple pages are shown.

1. In the Monitor tab, click Runs in Progress.

2. To monitor details about Ion Chef™ runs, click Ion Chef in Table View.

Auto Refresh the Monitor tab

Auto Refresh updates your Runs in Progress page every 20 seconds. Without Auto
Refresh, the page is a static display of information at the time you opened the page.

• To set the Runs in Progress page to automatically refresh:
a. In the Monitor tab, click Runs in Progress4Auto Refresh.

b. Click Stop Refresh to turn the Auto Refresh feature off.

• To refresh the Ion Chef page:

Note: The Ion Chef page does not automatically refresh.

a. In the Monitor tab, click Ion Chef4Auto Refresh.

b. Click Stop Refresh to turn the Auto Refresh feature off.

Monitor instrument runs
Auto Refresh the Monitor tab
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Review the Planned Run settings

In the Monitor tab you can review the Planned Run settings for a run in progress.

1. In the Runs in Progress List View, click Review Run Plan for the run of interest.

The Review Planned Run dialog displays the Planned Run information and
settings.

2. Click Close to return to the Monitor tab, Runs in Progress screen.

Monitor instrument runs
Review the Planned Run settings
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Manage Completed Runs and
Reports

Search for a Run report

You can search, sort, or filter the Completed Runs & Reports list to find a Run report
of interest.

1. In the Data tab, click Completed Runs & Reports.

To… Steps…

Search the
list.

Enter a search term in the Search field, then click Go.

Sort the list. Select a sort order from the Sort dropdown list (List View or Table
View), or click on any bolded column header (List View only). Click on
the column header a second time to reverse the sort order.

Limit the list
to recent
runs.

In the Date field select a preset range, or click Date Range, then
select a Start and End date.

Filter the
list.

Select from one or more Filter dropdown lists to limit the Completed
Runs & Reports list. Click More Filters to see all available filters.
Within a Filter enter text into the Find field to limit the filter choices.
To remove a filter, de-select the filter choice or click Clear in the
Filter dropdown list.

View
favorites.

Click  adjacent to the Search field to limit the list to completed
Runs designated as favorites.

2. Click Clear All to remove filters and restore all results.

Reanalyze a run

You can reanalyze a run to correct a setup error such as a default reference alignment,
or assigned barcode, or to optimize analysis parameters.

1. In the Data tab, click Completed Runs & Reports.

2. Search, filter, or sort the list to find your run report of interest.
See “Search for a Run report“ on page 76 for more information.
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3. In Table View mode, in the row of the run of interest, click
 (Actions)4Reanalyze.

Alternatively, switch to List View, find your run of interest, then click Reanalyze.

4. Enter a Report Name, then select from the available options:

Option Description

Thumbnail only: Select to reanalyze only the thumbnail report. This option is
available only for Ion Proton™ System, Ion S5™ System and Ion
GeneStudio™ S5 Systems data.

Start reanalysis
from:

• Select Signal Processing to reanalyze from DAT files.
Does not use the Use data from previous report field, but
reprocesses from the DAT files. You can optionally use both
the Analysis args and Basecaller args fields.

• Select Base Calling (default) to reanalyze from 1.wells files.
Uses the Use data from previous result: field and optionally
the Basecaller args field, but reprocesses from the 1.wells
file. Does not use the Analysis args field.

Use data from
previous result:

Select the previous result from the dropdown list if more than
one result is available. This option applies only when starting
reanalysis from Base Calling.

Analysis
Parameters:

See “Create and select an analysis parameter set“ on page 348
for more information.

5. (Optional) In the menu, click Analysis Options, then edit the fields if needed.

Field Description

Library Key: The sequence that is used to identify library reads.

TF Key: The sequence that is used to identify test fragment reads.

3′ Adapter: The sequence of the 3′ Adapter used.

Mark as Duplicate
Reads:

Select to have PCR duplicates flagged in the BAM file.

Base Calibration Mode: Base calibration allows for empirical alignments to
influence flow signals to achieve better homopolymer
calibration to improve overall accuracy.

Enable Realignment: Select to use an optional analysis step to adjust the
alignment, primarily in the CIGAR string.

Manage Completed Runs and Reports
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6. (Optional) In the menu, click Reference & Barcoding, then edit the fields to set
the default options, if needed.

Option Description

Default Alignment
Reference:

Select the default reference file from the dropdown
list.

Default Target Regions BED
File:

Select the default Target Regions BED file from the
dropdown list.

Default Hotspot Regions
BED File:

Select the default Hotspot Regions BED file from the
dropdown list.

Barcode Set: Select the default barcode set from the dropdown list.

7. (Optional) In the menu, click Plugins.
a. Select the plugin to include in the reanalysis.

b. (If needed) Configure the plugin, then click Save Plugin Settings.
See “Plugin configuration“ on page 113, or the configuration topic specific
to the selected plugin.

c. Repeat steps a and b to include additional plugins in the reanalysis.

8. Click Start Analysis.

Use the following procedure to change the default alignment reference for an
analysis.

1. In the Data tab, click Completed Runs & Reports.

2. In either Table View or List View, find the run of interest.
See “Search for a Run report“ on page 76 for help finding an individual run.

3. Click  (Actions)4Reanalyze in the row of the run that you want to reanalyze.

4. In the Reanalysis screen for the run, click Reference & Barcoding.

Change the
default alignment
reference
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5. Select a new reference from the Default Alignment Reference dropdown list.

Note: If different references were selected for each barcode in the first run, use
the per-barcode reference selection utility here as well.

6. Click Start Analysis.
See “Create a custom configuration for the variantCaller plugin“ on page 197,
and “Run the variantCaller plugin manually“ on page 193 for more information.

Edit a Run report

You can edit a completed Run report to correct a setup error or optimize parameters
for all future reanalyses.

Note: System default Run templates cannot be edited. Create a copy of the Run
template to make changes.

1. In the Data tab, click Completed Runs & Reports.

2. Search, filter, or sort the list to find your run report of interest.
See “Search for a Run report“ on page 76 for more information.

3. Open the Edit Run wizard.

• In Table View, click  (Actions)4Edit in the row of the Run report that you
want to edit.

• In List View, identify the Run report of interest, then click Edit.

Note: The Edit Run wizard opens to the Save screen.

Manage Completed Runs and Reports
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4. Click a step in the workflow bar to access the respective screens where edits can
be entered.

Workflow step Description

Ion Reporter Select the Ion Reporter Account, Sample Grouping, and Ion
Reporter Upload Options.

Research Application Select the Research Application and Target Technique.

Plugins Select the plugins to be included in the run.

Projects Select the Project for the run data.

Save Enter a Run Plan Name, then edit fields if needed.

5. Click Update Run, or Update Run & Reanalyze to start the reanalysis
immediately.

You can change barcoding when you set up a reanalysis, but you can also change
barcoding for all future reanalyses. Use the Edit option to:

• Add barcoding to a completed sequencing run.
• Change the barcode set for a completed sequencing run.
• Remove barcoding from a completed sequencing run.

In each case, you must reanalyze the run after editing the barcode information. These
steps apply only to completed runs.

1. In the Data tab, click Completed Runs & Reports.

2. In table or list view, navigate to your run of interest.
See “Search for a Run report“ on page 76 for help finding an individual run.

3. Click  (Actions)4Edit in the row of the run.
The Edit Run screen appears.

4. Edit the Run Plan Name if desired, make the appropriate barcoding changes,
then click either Update Run, or Update Run & Reanalyze.

Add or change
barcoding for a
completed run
report
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Set the Completed Runs & Reports page to automatically refresh

Auto Refresh updates your Completed Runs & Reports page every 20 seconds.
Without Auto Refresh, the page is a static display of information at the time you
opened the page.

1. In the Data tab, click Completed Runs & Reports4Auto Refresh.

2. Click Stop Refresh to turn the Auto Refresh feature off.

Observation Possible cause Recommended action

Failed status for a run It is not clear whether the
sequencing run data transfer
completed and you can access
the sequencer.

Go to the sequencer Data Management screen
to confirm complete data transfer. If you are
not sure the data set was transmitted, you can
re-transfer it.

The run report was successful
but you are not sure whether
the data was transferred.

In Torrent Suite™ Software, under the Data tab,
click Completed Runs & Reports to view the
run report and ensure that the file transfer was
complete. Also, check if there are any error
messages, such as User Aborted on the report
itself. Look for a status of Error or Pending.

You cannot determine the
cause of the failed run status.

Reanalyze the run. See “Reanalyze a run“ on
page 76 for more information.

You can send the customer support archive to
your Thermo Fisher Scientific support contact
for review. See “Get technical support files“ on
page 108 for more information.

Manage Completed Runs and Reports
Set the Completed Runs & Reports page to automatically refresh
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Organize run results with projects

Projects are groups of result sets that you can use to organize results into unique
categories that are useful for your organization. A project might contain run results
for the same laboratory project or results from completed runs that you want to
combine. Projects also allow you to combine run results into a single run report. When
you open a list of projects, you can:

• Quickly find and view details for a group of run results.
• Search the list by project name or partial name, or by date (date range, current

month, current week, current day, or specific date).
• Rename, or delete a project.
• View a history log for a project.

1. In the Data tab, click Projects to see the list of projects.

2. Select a project in the list to view the result sets that are included in the project.

82 Torrent Suite™ Software 5.10 User Guide



Search for projects by name

The following instructions apply to both, Projects and Result Sets lists.

1. (Optional) To display a Result Sets list, click on the name of the project
containing your result set in the Projects table.

2. To find the projects or result sets or of your interest, you can search, sort, and
filter the Projects and Result Sets lists:

To... Steps...

Search the
list

Enter your search term into the Search names field, then click Go.
The displayed information in the table is limited only to the names
that match or contain the search string.

Note: The Search names field takes a complete or partial name. For
example, the following project names match the search string "mpli":
amplicon, amplicon33, AmpliSeq, Samplier. The search is not
case‑sensitive, however, wildcards are not supported in the search
string.

Sort the list Click on any bolded column header in the table to sort the order in
which the projects or result sets are displayed. Click on the column
header a second time to reverse the sort order.

Filter the
list by date

• In the Last Modified field select a preset range (e.g., last 7 days,
or this month).

• Click Date Range, then select Start and End dates to limit your
search to projects or result sets modified within the selected
date range.

• Click Older than Date or Newer than Date to limit your search to
project or result sets modified before or after the selected date.

3. Click Clear to remove all search criteria and display unfiltered list of projects or
result sets.

Organize run results with projects
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Add a project to a Planned Run

You can designate which result sets are included in projects before runs are completed
when you add a project to Planned Run or a run template.

When you create a Planned run, search for and enter project names in the Projects
step in the Workflow bar:

See “Plan and execute an instrument run“ on page 32 for more details.

1. In the Data tab, click Projects to see the list of projects.

2. Click on the project name in the Name column of the Projects table to view the
list of result sets in the project.

Add selected
results to another
project

Organize run results with projects
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3. Select the checkboxes in the row of the result sets that you want to add to one or
more other projects, then click Process Selected4Add to Project.

4. Select the checkbox for each project that the result sets are to be copied to, then
click Add projects.

Compare reports of runs in a project

You can compare report metrics for multiple runs side-by-side if the reports are
assigned to a Project.

1. In the Data tab, click Projects.

2. Select a project.

3. Click Compare All to view all the runs in the project side-by-side.

4. (Optional) Click Customize.
The Show and Hide dialog box appears.

5. (Optional) In the Run Info column, un-check metadata to remove it from view.

Organize run results with projects
Compare reports of runs in a project
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6. (Optional) In the Result Name column, un-check runs to remove them from view.

7. Click Apply.

8. Review the reports for all of the runs in the project.

9. (Optional) Export the results.

• Click Download PDF to create a PDF report.
• Click Download CSV to create a CSV file of the results.

Organize run results with projects
Compare reports of runs in a project
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Manage data for result sets in projects

You can export, archive, or delete data from results that are included in a project.

1. In the Data tab, click Projects to see the list of projects.

2. Select a project from the list to view the result sets in the project.

3. Click Process Selected4Data Management.
For details on how to export, archive or delete data results in the project, see 
“Manually export run data“ on page 275, “Manually archive run data“ on
page 276 and “Manually delete run data“ on page 277.

Combine aligned reads from multiple run reports

If you are running an application that requires better coverage than the coverage
provided by a single chip, you can:

• run multiple chips with the same sample and library
• combine aligned reads from multiple sequencing reports

The combined aligned reads can be treated the same way as results from a single run.
For example, it can be exported or used as an input for a plugin.

1. In the Data tab, click Projects to see the list of projects.

2. Select a project in the list to view the result sets in the project.

3. Select the result set or sets that you want to combine into a single run result set.

4. Click Combine Selected4Combine Alignments.

5. In the Combine Selected dialog box, enter a new report name.

Organize run results with projects
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6. Make appropriate selections:

Option Description

Mark as
duplicate

If you select Mark as duplicate, Torrent Suite™ Software flags
duplicate reads in the BAM file.
For some applications, duplicate reads coming from PCR cause
problems in downstream analysis. The presence of duplicate reads
can create the appearance of multiple independent reads supporting
a particular interpretation, when some reads are in fact duplicates of
each other with no additional evidence for the interpretation.

Note: Marking duplicate reads is not appropriate for Ion AmpliSeq™

data, because many independent reads are expected to share 5'
alignment position and 3' adapter flow as each other. Marking
duplicates on an Ion AmpliSeq™ run risks inappropriately flagging
many reads that are in fact independent of one another.

Overwrite
sample
name

If your combined samples have duplicate names, you can select
Overwrite Sample Names and rename them.

7. Click Launch.

8. (Optional) Click Report to open the summary of the report, or Log to open the log
for the report.

The combined report is added to the project from which the combine action was run.

Download a CSV file of metrics

You can download a CSV file of analysis metrics for one or more result sets, then
compare results across analyses.

1. In the Data tab, click Projects, then click a project name to open the list of result
sets for the project.

2. Select the checkboxes for the analyses, then click Download Selected CSV.
The analysis metrics file is downloaded through your browser to a directory on
your computer, based on your browser settings.

Organize run results with projects
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In the analysis metrics file, each line represents a Torrent Suite™ Software analysis run;
within each line, information fields are separated by a comma. Each comma-separated
field is listed in a separate column. You can open the files with a spreadsheet software
such as Microsoft™ Office Excel™ or OpenOffice.org.

The file has many fields per entry, as described in the following table:

Field Description

Report Name of the analysis run report

Status Status of the analysis (e.g., Started,
Complete)

Flows Number of flow cycles from the actual
sequencing run

TF Name* Test Fragment Name

Q10 Mean* Average Q10 read length

Q17 Mean* Average Q17 read length

System SNR* System Signal-to-Noise Ratio

50Q10 Reads* Number of TF Ion Sphere™ Particles (ISP) at
50+ bp at Q10

50Q17 Reads* Number of TF Ion Sphere™ Particles (ISP) at
50+ bp at Q17

Keypass Reads* Number of reads that have test fragment
keys

TF Key Peak Counts* Signal strength of the first three bases of
the TF key

Total_Num_Reads Total number of reads

Library_50Q10_Reads Reads of length at least 50bp with 90% or
greater accuracy

Library_100Q10_Reads Reads of length at least 100bp with 90% or
greater accuracy

Library_200Q10_Reads Reads of length at least 200bp with 90% or
greater accuracy

Library_Mean_Q10_Length Average length of reads with 90% or greater
accuracy

Library_Q10_Coverage Average per base coverage considering
reads with 90% or greater accuracy

Library_Q10_Longest_Alignment Longest read length amongst reads with
90% or greater accuracy

Library_Q10_Mapped Bases Total bases from reads with 90% or greater
accuracy

Analysis metrics
file fields
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Field Description

Library_Q10_Alignments Number of alignments from reads with 90%
or greater accuracy

Library_50Q17_Reads Reads of length at least 50bp with 98% or
greater accuracy

Library_100Q17_Reads Reads of length at least 100bp with 98% or
greater accuracy

Library_200Q17_Reads Reads of length at least 200bp with 98% or
greater accuracy

Library_Mean_Q17_Length Average length of reads with 98% or greater
accuracy

Library_Q17_Coverage Average per base coverage considering
reads with 98% or greater accuracy

Library_Q17_Longest_Alignment Longest read length amongst reads with
98% or greater accuracy

Library_Q17_Mapped Bases Total bases from reads with 98% or greater
accuracy

Library_Q17_Alignments Number of alignments from reads with 98%
or greater accuracy

Library_50Q20_Reads Reads of length at least 50bp with 99% or
greater accuracy

Library_100Q20_Reads Reads of length at least 100bp with 99% or
greater accuracy

Library_200Q20_Reads Reads of length at least 200bp with 99% or
greater accuracy

Library_Mean_Q20_Length Average length of reads with 99% or greater
accuracy

Library_Q20_Coverage Average per base coverage considering
reads with 99% or greater accuracy

Library_Q20_Longest_Alignment Longest read length amongst reads with
99% or greater accuracy

Library_Q20_Mapped_Bases Total bases from reads with 99% or greater
accuracy

Library_Q20_Alignments Number of alignments from reads with 99%
or greater accuracy

Library_Key_Peak_Counts Signal strength of the first three bases of
the library key

Library_50Q47_Reads Number of perfect reads of length at least
50bp

Organize run results with projects
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Field Description

Library_100Q47_Reads Number of perfect reads of length at least
100bp

Library_200Q47_Reads Number of perfect reads of length at least
200bp

Library_Mean_Q47_Length Average length of perfect reads

Library_Q47_Coverage Average per base coverage considering only
perfect reads

Library_Q47_Longest_Alignment Longest reads length amongst perfect
reads

Library_Q47_Mapped_Bases Total bases from perfect reads

Library_Q47_Alignments Number of alignments from perfect reads

Library_CF CAFIE metric: Carry forward

Library_IE CAFIE metric: Incomplete extension

Library_DR CAFIE metric: Signal/polymerase loss
(droop)

Library_SNR System Signal-to-Noise Ratio

Sample Name of the sample

Library Name of the reference genome

Notes Any additional user-provided notes

Run Name Long name of the analysis run

PGM Name Name of the Ion PGM™ or Ion Proton™

instrument where the sample was
sequenced

Run Date Date the sample was sequenced

Run Directory Location of the raw DAT files on the Torrent
Server

Num_Washouts NA

Num_Dud_Washouts NA

Num_Washout_Ambigous NA

Num_Washout_Live NA

Num_Washout_Test_Fragment NA

Num_Washout_Library NA

Library_Pass_Basecalling NA

Library_pass_Cafie NA
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Field Description

Number_Ambiguous NA

Number_Live Number of wells producing a signal

Number_Dud Number of wells with ISPs but no signal

Number_TF Number of wells containing test fragment

Number_Lib Number of wells containing library

Number_Bead Number of wells containing beads

Library_Live Number of wells containing library ISP with
signal

Library_Keypass Number of wells containing library ISP with
signal and match key

TF_Live Number of wells containing test fragment
ISP with signal

TF_Keypass Number of wells containing test fragment
ISP with signal and match key

Keypass_All_Beads Number of wells containing ISP with signal
and match key

P JSON string of plugin data

s JSON string of plugin data

Note: Rows 4-11 (marked by *) contain test fragments metrics. The other rows
contain library read metrics.

Remove result sets from project

You can remove a result set from a project.

Note: This option does not delete the selected run reports and their result sets. It only
removes them from the current project.

1. In the Data tab, click Projects to see the list of projects.

2. Click on the project name in the Name column of the Projects table to view the
list of result sets in the project.

3. Select the checkboxes in the row of the result sets that you want to remove from
the project, then click Process Selected4Remove from Project.

Organize run results with projects
Remove result sets from project
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Review run reports

A Torrent Suite™ Software run report contains statistics and quality metrics from
completed sequencing runs. You can use this information to evaluate the run. You can
also complete other tasks from the run report.

Note: For runs completed on a Ion Proton™, Ion S5™, Ion S5™ XL, or Ion GeneStudio™

S5 Series system, each run report includes one full chip report and one thumbnail
report. If the run has been reanalyzed, additional reports are available when you open
the run report. If the run was completed on an Ion PGM™ System, only a full chip
report is available.

You can also complete several tasks from the run report, including:
• Upload output files from the run report to Ion Reporter™ Software. See “Run

IonReporterUploader plugin manually“ on page 179.
• Review, edit, or copy the Planned Run settings for the sequencing run. See 

“Review the Planned Run settings“ on page 49 and “Create a custom Planned
Run template“ on page 34 for more information.

• Rerun the data analysis for the run. See “Reanalyze a run“ on page 76 for more
information.

• Archive, edit, or delete data for the run. See “Data management“ on page 268 for
more information.

• Toggle between different run reports for the same sample. See “Open a run
report“ on page 95 for more information.

• Run Torrent Suite™ Software plugins. See “Run a plugin manually from the
sequencing run report“ on page 115 for more information.

• Download the run report or plugin summary in PDF format. See “Download run
report PDF“ on page 103 and “Download plugin report PDF“ on page 116 for
more information.

Quality following alignment

You can use read alignment to evaluate the quality of the sequencing reaction and the
quality of the corresponding library when an accurate reference is available. Reads are
aligned to a reference genome sequence. Any discrepancy in alignment to a reference,
whether biological (actual variant) or technical (sequencing error) is listed as a
mismatch. Alignment performance metrics are reported using the Alignment Quality
(AQ) score, which defines the accuracy of sequencing reads when compared to a
reference genome sequence. Torrent Suite™ Software reports alignment quality using
three parameters:

• AQ17
• AQ20
• Perfect
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The aligned length of a read at a given accuracy threshold is defined as the greatest
position in the read at which the accuracy in the bases, up to and including the
position, meets the accuracy threshold. Accuracy is specified using the Phred -10log10
transformation, where 20 represents an error rate of 1%, and 17 represents an error
rate of 2%.

In Torrent Suite™ Software, the Aligned Quality (AQ) score represents alignment
quality for the total number of bases that are sequenced or for consecutive sequencing
reads. The AQ20 length is the greatest length at which the error rate is 1% or less, and
the AQ17 length is the greatest length at which the error rate is 2% or less. The ideal
length is the longest perfectly aligned segment. The AQ score for the total number of
bases represents the number of all aligned bases in the sequencing reaction that meet
a specific AQ score.

For all of these calculations, the alignment is constrained to start from position 1 in the
read - that is, no 5' clipping is allowed. The underlying assumption is that the
reference to which the read is aligned represents the true sequence that is seen.

Appropriate caution must be taken when values for the AQ score are interpreted for
situations in which the sample that is sequenced has substantial differences relative to
the reference used. For example for alignments to a rough draft genome, or for
samples that are expected to have high mutation rates relative to the reference used.
In these situations, the AQ20 and AQ17 lengths can be short even when sequencing
quality is excellent.

The AQ20 length is calculated using the following steps:
• Every base in the read is classified as being correct or not correct according to the

alignment to the reference.
• At every position in the read, the total error rate is calculated up to and including

that position.
• The greatest position at which the error rate is one percent or less is identified

and that position defines the AQ20 length.

For example, if a 100-bp read consists of 80 perfect bases that are followed by 2 errors
that are then followed by 18 more perfect bases, the total error rate at position 80 is
zero percent. At position 81 the total error rate is 1.2% (1/81), at position 82 the error
rate is 2.4%, continuing up to position 100 where it is 2 percent (2/100). The greatest
length at which the error rate is 1% or less is 80, and the greatest length at which the
error rate is 2 percent or less is 100. Therefore, the AQ20 and AQ17 lengths are 80 and
100 bases, respectively.

Torrent Suite™ Software provides a view on alignment that helps determine run and
library quality.

There are many alignment algorithms available in the marketplace. You are
encouraged to consult with a bioinformatician for the most appropriate alignment
algorithm for your downstream analysis requirements.

Alignment in Torrent Suite™ Software is performed using TMAP. TMAP is currently
an unpublished alignment algorithm, created by the authors of the BFAST algorithm.
See “TMAP Modules“ on page 360, or contact your Thermo Fisher Scientific
representative or Technical Support for more information.

Although TMAP is unpublished and a reference is not currently available, the
precursor to TMAP, BFAST, is based on the ideas in the following publications:

Aligned read
length calculation

Alignment

Review run reports
Quality following alignment
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Homer N, Merriman B, Nelson SF (2009) BFAST: An Alignment Tool for Large Scale
Genome Resequencing. PLoS ONE 4(11): e7767. doi: 10.1371/journal.pone.0007767

Homer N, Merriman B, Nelson SF (2009) Local alignment of two-base encoded DNA
sequence. BMC Bioinformatics 10: 175. doi: 10.1186/1471-2105-10-175

The alignment process involves aligning reads produced by the pipeline to a reference
sequence and extracting metrics from those alignments. By default, Torrent Suite™

Software aligns all reads to the reference; however, there may be situations,
particularly with large reference sequence, when the alignment exceeds the amount of
time that you are willing to wait. If this is the case, the Torrent Suite™ Software can
define on a per-reference basis the maximum number of reads that are aligned from a
run.

When the number of reads in a run exceeds a reference-specific maximum, a random
sample of reads is taken and results are extrapolated to represent the full run. By
sampling a random pool of reads and extrapolating the alignment quality values to
represent all reads, the Torrent Suite™ Software gives you sufficient information to
assess the quality of the sample, library, and sequencing run.

The output of the alignment process is a BAM file. The BAM file includes an
alignment of all reads, including the unmapped reads, with exactly one mapping per
read. When a read maps to multiple locations, the mapping with the best mapping
score is used. If more than one such mapping exists, a random mapping is used and a
mapping quality of zero is given.

Predicted quality (Q20)

The number of called bases with a predicted quality of Q20 is reported. The predicted
quality values are reported on the Phred scale, defined as -10 log10 (error probability).
Q20, therefore, corresponds to a predicted error rate of one percent.

Open a run report

Every sequencing run report includes at least two versions: a full chip report that
contains complete details about the run, and a thumbnail version that includes a
limited data set. If the run has been reanalyzed, additional reports are available.

The thumbnail reports use a limited set of data points to give a summary of the fully
sequenced and analyzed run and can be used to quickly determine the success of the
run or whether a run should be terminated. Thumbnail reports are appended with
_tn at the end of the report name and can be opened before the full chip reports are

Reads used for
alignment

Review run reports
Predicted quality (Q20)
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generated. The full chip reports contain all the data points and should be used for
your analysis review.

1. In the Data tab, click Completed Runs & Reports.
Completed Runs & Reports are displayed in List View layout.

2. (Optional) Click Table View to review Completed Runs & Reports details in a
table layout.

3. To open an individual run report:

• In the List View, locate the pane that contains details about your run of
interest, then click the link in the Report Name column to view details about
any of the available reports for that run.

Note: If there are more than two reports, click Show all reports to view the
list of all reports associated with your run of interest.

• In the Table View, locate the run you want to view the report for, then click
the link in the Report Name column.

Note: If you want to open another report that is associated with your run of
interest, click the Reports dropdown list, then select the report you want to
open.

Review run reports
Open a run report
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To determine the quality of the sequencing run, you can review the quality metrics for
the unaligned reads. Primary pipeline processing, base calling, and signal processing
generates these metrics. The quality metrics for unaligned reads are divided into three
categories:

• Quality of chip loading, expressed as the density of Ion Sphere™ Particles (ISPs)
loaded onto the chip.

• Quality of the ISPs that are loaded onto the chip.
• The length of sequencing reads.

1. In the Data tab, in the Completed Runs & Reports screen, find the report that
you want to review, then click the report name link in the Report Name column.

2. In the left navigation menu, click Unaligned Reads.

3. Review the unaligned read quality metrics in ISP Density, ISP Summary, and
Read Length panes.

4. (Optional) Click  to view more details about the information in each pane.

Unaligned reads metrics

This table describes the Ion Sphere™ particle (ISP) density, summary, and read length
quality metrics for the unaligned sequencing reads.

Metric Description

Density

Total Bases Number of filtered and trimmed base pairs reported in the
output BAM file.

Key Signal The reported key signal is the average signal for all ISPs
that identically match the library key.

ISP Loading Percentage of chip wells that contain a live ISP. (The
percentage value considers only potentially addressable
wells.)

ISP Summary

Total Reads Total number of filtered and trimmed reads independent of
length reported in the output BAM file.

Usable Reads The percentage of library ISPs that pass the polyclonal, low
quality, and primer‑dimer filters. This percentage is
calculated by dividing final library ISPs by library ISPs.

Loading Percentage of chip wells that contain a live ISP. (The
percentage value considers only potentially addressable
wells.) This percentage is calculated by dividing the
number of loaded ISPs by the number of potentially
addressable wells.

Review unaligned
reads
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Metric Description

Empty Wells Percentage of chip wells that do not contain an ISP. (The
percentage value considers only potentially addressable
wells.) The percentage is calculated by the number of
potentially addressable wells, minus the number of loaded
ISPs, divided by the number of potentially addressable
wells.

Enrichment Predicted number of live ISPs that have a key signal
identical to the library key signal. The Percent Enrichment
value reported is the number of loaded ISPs that are
Library ISPs, after taking out Test Fragment (TF) ISPs. This
number is calculated by dividing library ISPs by the
number of loaded ISPs minus TF ISPs.

No Template Percentage of chip wells that do not contain a DNA
template. This percentage is calculated by the number of
loaded ISPs minus TF ISPs divided by the number of
loaded ISPs plus TF ISPs.

Clonal Percentage of clonal ISPs (all library and TF ISPs that are
not polyclonal).

An ISP is clonal if all of its DNA fragments are cloned from
a single original template. All the fragments on such a
bead are identical and they respond in unison as each
nucleotide is flowed in turn across the chip. This
percentage is calculated by dividing the number of ISPs
with single beads by the number of live wells.

Polyclonal Percentage of polyclonal ISPs (ISPs carrying clones from
two or more templates). A high polyclonal percentage
indicates that library input is too high and should be
titrated down. Enrichment does not filter out polyclonal
ISPs, it only removes template-negative ISPs. This
percentage is calculated by dividing polyclonal ISPs by live
ISPs.

Final Library Percentage of reads that pass all filters and are recorded
in the output BAM file. This value can be different from the
Total Reads due to specifications associated with read
trimming beyond a minimal requirement resulting in Total
Reads being slightly less than Final Library. This
percentage is calculated by dividing final library ISPs by
clonal ISPs.

% Test Fragments Percentage of live ISPs with a key signal that is identical to
the TF key signal. This percentage is calculated by dividing
TF ISPs by clonal ISPs.

% Adapter Dimer Percentage of ISPs with an insert length of less than 8 bp.
This percentage is calculated by dividing primer‑dimer
ISPs by clonal ISPs.

% Low Quality Percentage of ISPs with a low or unrecognizable signal.
This percentage is calculated by dividing low quality ISPs
by clonal ISPs.
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Metric Description

Addressable Wells Total number of wells on the chip minus excluded wells.

With ISPs Number (and percentage) of addressable wells that were
determined to be positive for the presence of an ISP in the
well. Positive is determined by measuring the diffusion
rate of a flow with a different pH. Wells containing ISPs
have a delayed pH change due to the presence of an ISP
slowing the detection of the pH change from the solution.
This percentage is calculated by dividing the number of
wells with ISPs by total addressable wells.

Live Number (and percentage) of wells that contain an ISP with
a signal of sufficient strength and composition to be
associated with the library or Test Fragment key. This
value is the sum of the following categories:

• Test Fragment

• Library

This value is calculated by dividing live ISPs by wells with
ISPs.

Test Fragment (TF) Number (and percentage) of live ISPs with a key signal that
was identical to the Test Fragment key signal. This number
is calculated by dividing TF ISPs by live ISPs.

Library Number (and percentage) of live ISPs with a key signal that
is identical to the library key signal. This number is
calculated by dividing library ISPs by live ISPs.

Library ISPs Predicted number of live ISPs that have a key signal
identical to the library key signal (the same value as
Library).

Filtered: Polyclonal ISPs carrying clones from two or more templates. This
number is calculated by dividing polyclonal ISPs by library
ISPs.

Filtered: Low quality Low or unrecognizable signal. This number is calculated by
dividing low quality ISPs by library ISPs.

Filtered: Adapter‑dimer Insert length of less than 8 bp. This number is calculated
by dividing primer‑dimer ISPs by library ISPs.

Final Library ISPs Number (and percentage) of Library ISPs passing all
filters, which are recorded in the output BAM file. This
value can be different from the Total Reads due to
specifications associated with read trimming beyond a
minimal requirement resulting in total reads being slightly
less than Final Library reads. This number is calculated by
dividing final library ISPs by library ISPs.

Read length

Mean Read Length Average length, in base pairs, of called reads.

Review run reports
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Metric Description

Median Read Length Median length, in base pairs, of called reads.

Mode Read Length Mode length, in base pairs, of called reads.

View the aligned reads to determine the accuracy of your sequencing run.

1. In the Data tab, click Completed Runs & Reports, then select a report of interest.

2. In the left navigation menu, click Aligned Reads, then review the metrics to
determine the accuracy of your sequencing data.

Click , or on an image to open an enlarged view.

Aligned reads metrics

A completed run report in Torrent Suite™ Software includes metrics for aligned reads
that include Alignment summary, Raw Accuracy, and Alignment Quality.

Metric Description

Alignment Summary

Total Aligned Bases Total number of bases aligned to the reference sequence,
excluding the library key, barcode, and 3' adapter sequences.

Reference Coverage Ratio of the total aligned bases divided by the number of bases in
the reference sequence. Reference coverage does not account for
any enrichment that may have been done to selectively amplify a
subset of the reference sequence.

Total Reads Total number of reads after filtering.

Aligned Reads The number of reads that align to the reference sequence
expressed as a total count and percentage of the total aligned
bases.

Review aligned
reads
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Metric Description

Unaligned Reads The number of reads that do not align to the reference sequence
expressed as a total count and percentage of the total aligned
bases.

Raw Accuracy

Mean Raw Accuracy
1X

The mean raw accuracy across each individual base position in a
read calculated as, 1− (Total errors in the sequenced reads)/Total
bases sequenced.

Alignment Quality

Total Number of
Bases (bp)

The total number of bases over all positions that align with a given
error rate. (AQ17 ≤2% error rate, AQ20 ≤1% error rate, Perfect =
no measurable error)

Mean Length (bp) The average length, in base pairs, for aligned reads at a given
error rate. (AQ17 ≤2% error rate, AQ20 ≤1% error rate, Perfect =
no measurable error)

Longest Alignment
(bp)

The maximum sequence read length for a given error rate. (AQ17
≤2% error rate, AQ20 ≤1% error rate, Perfect = no measurable
error)

Mean Coverage
Depth (X)

The ratio of the depth of coverage for a given error rate at each
base in the target region to the length of the target region. (AQ17
≤2% error rate, AQ20 ≤1% error rate, Perfect = no measurable
error)

You can view and download the output files from your sequencing runs. The files
include:

• Library sequences of unaligned and aligned reads
• Barcode reports of performance metrics for each barcode included in the run, if

you used barcode adapters during the library preparation for your sample.

Output files
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Download output files

You can download the library files for unaligned and aligned reads in BAM or BAI file
formats .

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click Output Files or scroll to the Output Files
section, then click on a file type to download the following files:

Option Description

Unaligned
Reads

Nucleotide bases covered by reads that have not been aligned to
the reference. Can be downloaded as a binary aligned/mapped
(BAM) file.

Aligned Reads Number of bases covered by reads that have been aligned to the
reference. Can be downloaded as a BAM or binary
aligned/mapped index (BAI) file.

View and download barcode reports

You can view barcode reports for sequencing runs that use barcode adapters during
library preparation for samples. The reports show key performance metrics for each
barcode included in the run.

Note: The number of barcodes in the barcode report reflects the barcode set that was
used in the run and the barcodes that are present in the sample. Data is included only
for barcodes that are present in the run.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click Output Files, then scroll to the barcode section
of the run report.

The barcode section of a run report displays the following information and provides
access to downloadable files for each barcode:

Column Description

Barcode Name The individual barcode in the barcode set.

The row labeled No barcode reports on unclassified barcodes,
which are reads that could not be classified as a match for one of
the expected barcodes in the barcode set.

Sample Name of the sample that was sequenced on instrument.

Bases Post-filtering base output for each barcode.

% ≥ Q20 The percentage of reads that have a predicted quality score of Q20
or better.
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Column Description

Reads Total number of filtered and trimmed library reads (independent of
length). This number is reported in the barcode BAM file.

Mean Read Length The average read length, in base pairs (bp), of all filtered and
trimmed library reads reported in the BAM file for the barcoded
run.

Read Length
Histogram

A thumbnail histogram of the read lengths for this barcode. Click
the thumbnail histogram to open a larger image.

UBAM Download a binary file that contains unaligned or unmapped
reads. Viewing the file requires a viewer application, such as the
Integrative Genomics Viewer from the Broad Institute.

BAM Download a compressed, binary form of the SAM file. The BAM file
contains aligned reads sorted by genome reference location.

BAI Download the BAM index (BAI) file. This file speeds up the access
time for a coordinate-sorted BAM file.

You can download a run report summary in PDF format. The PDF report reflects what
is visible in the run report screen.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. Click Download PDF 4Summary PDF.
A PDF version of the run report is downloaded through the browser to a
directory on your computer that is indicated in the browser settings.

Download run
report PDF
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You can view various details about a completed sequencing run in Torrent Suite™

Software.

View test fragments for a completed run

You can view the test fragment results and determine the quality of your sequencing
run if you included key signal test fragments in your run.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link to open the report of interest.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click Test Fragments.

Parameter Description

Test Fragment Test fragment name. See “Test fragments“ on
page 260 for more information.

Reads Number of filtered & trimmed reads identified for this
test fragment.

Percentage 50AQ17 The percentage of reads for this test fragment with a
minimum of 50 base pairs in length and an error rate of
1 in 50, Phred-like 17, or better. Quality is based on
alignment, not predicted quality.

Percent 100AQ17 The percentage of reads for this test fragment with a
minimum of 100 base pairs in length and an error rate
of 1 in 100, Phred-like 17, or better. Quality is based on
alignment, not predicted quality.

Read length histogram A thumbnail histogram of trimmed lengths of all reads
present in the test fragment.

3. Click on the thumbnail histogram in the Read length histogram column to open
a larger image and review the histogram details.

The figure shows an example histogram of read lengths, represented in base pairs (bp),
that have a Phred-like score of ≥17, or one error in 50 bp (the ends only are shown
because of width considerations). Distributions skewed to the right are ideal, showing
longer read lengths (test fragments are a discrete length). It is likely that the sequence can

Details about
completed runs
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extend all the way through the test fragment, if enough flows are run, so that the
histogram displays only a maximum size based on the length of the test fragment.

View consumables used in a completed run

You can view a summary of reagent usage in an S5 Consumable Summary for
sequencing runs on Ion S5™ Systems and Ion GeneStudio™ S5 Systems.

Note: A summary of consumables that are used during a sequencing run is not
reported for sequencing runs performed on the Ion PGM™ or Ion Proton™ systems.

1. In the Data tab, click Completed Runs & Reports, then click the name of the
report to open the report of interest.

2. In the left navigation menu, click Details or scroll down to the Details section of
the run report, then click the S5 Consumables Summary tab.

3. Note the details, including remaining uses for the cleaning solution.

Detail Description

Chip Type Chip type and version.

Chip Barcode Barcode number of the chip.

Ion S5 Cleaning Solution Row includes Part Number, Lot Number, Expiration
Date, and Remaining Uses.

Ion S5 Sequencing Reagents Row includes Part Number, Lot Number, Expiration
Date, and Remaining Uses.

Ion S5 Wash Solution Row includes Part Number, Lot Number, Expiration
Date, and Remaining Uses.

View the summary for an Ion Chef™ run

You can view a summary for an Ion Chef™ Instrument from the run report.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link to open the report of interest.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click the Chef Summary tab.

The following parameters are listed.

Review run reports
Open a run report

Torrent Suite™ Software 5.10 User Guide 105



• Chef Last Updated
• Chef Instrument Name
• Chef Operation Mode
• Sample Position
• Tip Rack Barcode
• Chip Type 1
• Chip Type 2
• Chip Expiration 1
• Chip Expiration 2
• Templating Kit Type
• Chef Flexible Workflow
• Reagent Expiration

• Reagent Lot Number
• Reagent Part Number
• Reagent Cartridge Serial Number
• Solution Lot Number
• Templating Protocol Planned
• Solution Cartridge Serial Number
• Solution Expiration
• Templating Protocol Executed
• Chef Script Version
• Chef Package Version
• Start Time
• Completion Time

Review run reports
Open a run report

106 Torrent Suite™ Software 5.10 User Guide



View the calibration report for a completed run

You can review calibration settings that were applied to a run. Results can be
calibrated to TMAP, the reference genome, or the calibration standard. See “Advanced
Settings – Kits step in workflow bar“ on page 42 for more information on setting
calibration options.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link to open the report of interest.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click the Calibration Report tab.
Calibration details are displayed. If Default Calibration was selected for the run,
the tab lists the usual Pre Base and Calibration Arguments. If No Calibration or
the Calibration Standard were selected, the tab lists the control reads, total
bases, and Q20 bases.

Note: Another way to access calibration details is to click Report
Actions4Review Plan, then scroll down to Advanced Parameters. See “Review
the Planned Run settings“ on page 49 for more information.
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View analysis details for a completed run

You can view analysis details for a completed run report.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link to open the report of interest.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click the Analysis Details tab.
The parameters in the following list are available in a completed run report.

• Run Name
• Run Date
• Run Cycles
• Run Flows
• Project
• Sample
• Sample Tube Label
• Reference
• Instrument
• Flow Order
• Library Key
• TF Key

• Chip ID or Chip Barcode
• Chip Check
• Chip Type
• Chip Data
• Chip Lot Number
• Barcode Set
• Analysis Name
• Analysis Date
• Analysis Flows
• runID
• Chef Package Version
• Start Time
• Completion Time

Get technical support files

You can view the report error log when troubleshooting a completed run. If you need
further assistance, you can also generate a customer support archive that you can
share with a customer support representative.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link to open the report of interest.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click the Support tab.
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3. Click View the report log to see a list of errors.
An example error report is as follows:

4. If you are unable to resolve an issue with the error report, click Download to
download a compressed directory that contains a PDF and HTML version of the
run report, and logs that can be used for troubleshooting.

5. Email the report to your support representative. If you would like to be able to
upload these support files directly, ask your support representative how to
enable Customer Support Archive.
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View software versions used in a run

You can view version information for the Torrent Suite™ Software that was used for a
completed run.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link to open the report of interest.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click the Software Version tab.

IMPORTANT! The version numbers shown in the example may be different from
your current version of the software depending on the date of the run. See 
(Settings)4About in Torrent Suite™ Software for a complete list of modules and
version on your server. See the Torrent Suite™ Software Release Notes for details
about the versions in a specific release.

Parameter Description

Torrent Suite Version of Torrent Suite™ Software used to generate the
analysis.

Datacollect Version of the Datacollect package. This collects data
from the configuration file.

LiveView Version of the LiveView package.

Script Version of the Script package.

ion-alignment Version of the Torrent Suite™ Software alignment
module used for this analysis.

ion-analysis Version of the analysis pipeline that was used to
generate the analysis. The analysis pipeline includes
signal processing, base calling, and TMAP alignment.

ion-db reports Version of the ion-dbreports package.

ion-gpu Version of the graphics processing unit (GPU) driver.

ion-plugins Version of the pre-installed plugins.

ion-torrentR Version of the TorrentR stats package.

tmap Version of the TMAP alignment package.
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Manage plugins for data analysis

You can expand the analysis capabilities of Torrent Suite™ Software with plugins that
are pre-installed with the software. Additional plugins can be downloaded and
installed from the Thermo Fisher Cloud. The plugin results are added to the report
summary and can be used for a variety of purposes.

Install or upgrade plugins

On Thermo Fisher Cloud, you can install or upgrade the following:
• Upgrades for a plugin that is pre-installed in Torrent Suite Software. For details

about plugins that are included with Torrent Suite Software, see “Pre-installed
plugins“ on page 120.

• The RNASeqAnalysis plugin and smallRNA plugin. These plugins are supported
by Thermo Fisher Scientific, but not pre-installed in the Torrent Suite Software.

1. Sign in to the Thermo Fisher Cloud.

2. Click on the Apps icon ( ).

3. In AppConnect, under Resource Libraries, click Plugins.

4. (Optional) Click a category at the top of page.
The list of plugins is narrowed to only plugins included in the selected category.

5. Click  to download the plugin. Select the checkbox to indicate that you agree
to the terms and conditions, then click Download Plugin.
Either a compressed directory or a debian file that contains the plugin is
downloaded to your local machine.

6. Click  (Settings)4Plugins4Install or Upgrade Plugin in Torrent Suite™

Software.

7. Click Select File, then browse to the location where you downloaded the plugin
file, select the file, then click Open.

8. In the Install or Upgrade Plugin dialog box, click Upload and Install.

The plugin is now visible in Torrent Suite™ Software.
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IMPORTANT! To make a plugin available to users, you must enable the plugin. The
plugin must be installed before it can be enabled.

Follow these steps to enable an installed plugin:

1. Sign in to Torrent Suite™ Software.

2. Click  (Settings)4Plugins.
The installed plugins are listed.

3. Select the Enabled checkbox next to any installed plugin, to make it available to
users.
Changes to the settings described in this procedure take effect immediately.

To uninstall a plugin from your Torrent Suite™ Software:

1. Sign in to your Torrent Browser.

2. Click  (Settings)4Plugins. The installed plugins are listed.

3. In the row of the plugin you want to remove, click  (Actions)4Uninstall.

4. Click Yes, Uninstall! to confirm you want to uninstall the plugin.

Enable an
installed plugin

Uninstall a plugin
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Plugin configuration

Some plugins have settings that can be configured by users. For these plugins, there
are typically three different ways they can be configured:

• Global configuration: For plugins that can be configured globally, administrator-
level users can change the settings for all users of the software on a particular
server (see “Configure plugins globally“ on page 113). These default settings can
be overridden when setting up a Planned Run or Planned Run template, or when
running the plugin manually.

Note: Some plugins require configuration, and fail unless a user first enters
certain settings. For example, some plugins require that a user enter a file
directory for output files.

• Planned Run configuration: Some plugins can be configured when setting up a
Planned Run or Planned Run template. These options are available under
Plugins in the Planned Run Workflow bar. Settings that are selected here
override the global settings.

• Manual configuration: Some plugins can be configured when they are selected to
run on the data from a sequencing run after the run is complete. These plugins
can be configured and run from the Run Summary screen. Settings that are
selected here override the global settings or any Planned Run settings.

The following pre-installed plugins can be configured globally:
• Data Export
• ERCC Analysis
• File Exporter
• Ion Reporter Uploader
• Run Transfer

Note: Some plugins that cannot be configured globally can be configured when you
set up a Planned Run or Planned Run template, or if you run the plugin after a
sequencing run.

To change the global configuration of a plugin that is listed above, perform the
following steps:

1. Sign in as an administrator, then click  (Settings)4Plugins.

2. In the Manage column for the plugin of interest, click  (Actions)4Configure.

The settings in the configuration dialog vary depending on the plugin. See the
plugin-specific configuration topic for more information.

3. To save your changes, click Submit or Save Configuration.

Configure plugins
globally
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You can use the following settings for any plugin that is installed in your Torrent
Suite™ Software, whether it is pre-installed or if it is downloaded from the Thermo
Fisher Cloud.

Note: If a plugin runs automatically, you can still rerun the plugin manually after a
sequencing run is completed. For details, see “Run a plugin manually from the
sequencing run report“ on page 115.

• To set the plugin to run automatically after every run:
a. Click  (Settings)4 Plugins.

b. Ensure that the Enabled checkbox next to the plugin name that you want to
run by default is selected.

c. Select the Selected by Default checkbox next to the plugin name.

The plugin is now set to perform its function after every sequencing run.

Note: Deselect the Selected by Default checkbox to disable automatic execution
of the plugin.

• To set a plugin to run automatically as part of a Planned Run or run template (not
required if you previously set the plugin to run by default after every run):

a. Under the Plan tab, in the Templates screen, select an application in the left
navigation menu.

b. Select an existing Planned Run template from the list. Alternatively, select
Add New Template, or Plan New Run to create a new Planned Run
template or Planned Run.

c. Click Plugins in the workflow bar.

Configure a plugin
to run by default
after every run
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d. Select the plugins that you want to run automatically after a run.

Note: If Configure appears after selecting the plugin, be sure to click the
link and configure the plugin before starting the run. For detailed plugin
configuration information for available plugins, see “Pre-installed
plugins“ on page 120.

e. Click Next, or another tab in the workflow bar to make further changes to
your Planned Run.

f. When all changes to the Planned Run have been made, click Plan in the
workflow bar, then click Plan Run.

The plugin is now set to run after every sequencing run that uses the Planned
Run or Planned Run template.

Run a plugin manually from the sequencing run report

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for the completed sequencing run.

2. Click Plugins4Select Plugins to Run,
then click the name of the plugin that
you want to run.

3. Configure the plugin if needed. If
prompted, select the desired plugin
options, then click Submit to start the
analysis. Alternatively, click Close to
close dialog without running a plugin.
For detailed plugin configuration
information for available plugins, see 
“Pre-installed plugins“ on page 120.

Note: If the plugin does not require
configuration, analysis starts
immediately without a confirmation
screen. To cancel a plugin run that is in
progress, click Stop.

Manage plugins for data analysis
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Download plugin report PDF

You can download a PDF of the plugin reports.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. Click Download PDF 4Plugins PDF.
A detailed report for of the plugin reported that are included the run report is
downloaded through the browser to a directory on your computer, based on the
browser settings.

View plugin run status

After a plugin run is started, it is listed in the Plugin section of the run report. You can
view the status of a plugin run to determine whether the run has completed. You can
also stop a plugin run in progress, view a log for the plugin run, or delete the
completed plugin report.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. In the left navigation menu, click the plugin name, or scroll to the Plugins section
of the run report.

The plugin run status (Queued, Started, or Completed) is listed under the name
of each plugin.

Manage plugins for data analysis
Download plugin report PDF

116 Torrent Suite™ Software 5.10 User Guide



You can stop a plugin run that is in progress.

1. In the left navigation menu, click the name of the plugin you want to stop, or
scroll to the appropriate plugin section in the run report.

2. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

3. In the left navigation menu, click Plugins, or the name of the plugin results to be
deleted.

4. Click Stop to cancel a plugin run that has started.

If a Plugin report indicates that an error occurred during a plugin run, you can view a
log that contains details about the plugin run.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. In the left navigation menu, click Plugins, or the name of the plugin that has the
log you want to view.

3. Click View Log to the right of the plugin name.
The log for the plugin run opens.

Stop a plugin run

Open a plugin log
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You can delete plugin results from the Plugins section of the run report.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. In the left navigation menu, click Plugins, or the name of the plugin results that
you want to delete.

3. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

4. In the left navigation menu, click the plugin name, or scroll to the Plugins section
of the run report.

5. Click Delete to the right of the plugin name.
The plugin results are deleted from the run report.

Delete a plugin
result
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When you rescan a plugin, the files for the plugin are updated with any changes. For
example, if you uninstalled and reinstalled the plugin, you can rescan the plugin to
ensure that all files from the previous installation were removed.

1. Sign in to Torrent Suite™ Software.

2. Click  (Settings)4Plugins. The installed plugins are listed.

3. Click  Actions4Rescan in the row of the plugin.
You cannot complete other operations in Torrent Suite™ Software until the rescan
is complete.

Note: You can also rescan the output files from the list of reports when you view
the usage for a plugin. For details see, “View IonReporterUploader plugin status
details“ on page 182.

Rescan a plugin
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Pre-installed plugins

The following table describes the plugins that are pre-installed with Torrent Suite™

Software.

Plugin name Description

ampliSeqRNA Generates statistics, downloadable data files, and
interactive visualizations that represent targeted RNA
transcripts for sequencing runs that use the Ion
AmpliSeq™ Transcriptome Human Gene Expression Kit or
Ion AmpliSeq™ RNA panels.

For details, see “ampliSeqRNA plugin“ on page 121.

AssemblerSPAdes Performs an initial level analysis on assembly and provides
metrics. The plugin is ideal for genomes less than 50
megabases in size.

For details, see “Assembler SPAdes plugin“ on page 125.

coverageAnalysis Generates statistics and graphs to describe the level of
sequence coverage that is produced for targeted genomic
regions.

For details, see “coverageAnalysis plugin“ on page 129.

DataExport Exports data from a sequencing run to an external hard
drive or a removable media, such as a USB drive.

For details, see “DataExport plugin“ on page 139.

ERCC_Analysis Indicates whether a problem exists with library preparation
or sequencing for runs that use the ERCC RNA Spike‑In
Mix.

For details, see “ERCC_Analysis plugin“ on page 140.

FieldSupport Provides assistance with technical support. Enable and run
this plugin only under the guidance of Thermo Fisher
Scientific Technical Support. If you have questions about
this plugin, contact technical support or your Field
Application Scientist.

FileExporter Customizes the output file names of an analysis run. This
plugin allows you to rename output files. Also generates a
FASTQ format file of the analysis output, renames Variant
Caller plugin output files (when available), and compresses
output files.

For details, see “FileExporter plugin“ on page 144.

FilterDuplicates Removes duplicate reads and creates BAM files that do not
contain the duplicate reads.

For details, see “FilterDuplicates plugin“ on page 147.
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Plugin name Description

immuneResponseRNA Use the immuneResponseRNA plugin to quantify gene
expression levels for the Oncomine™ Immune Response
Research Assay.

For details, see “immuneResponseRNA plugin“ on
page 148.

IonReporterUploader Transfers run results files to Ion Reporter™ Software.

For details, see “Integration with Ion Reporter™

Software“ on page 172.

PGxAnalysis Used with the Ion AmpliSeq™ Pharmacogenomics
Research Panel, which is a targeted gene panel that allows
the interrogation of pharmacogenomics variants in
samples for genotyping and CYP2D6 copy number
detection.

For details, see “PGxAnalysis plugin“ on page 151.

RunTransfer Transfers the signal processing output of a completed
sequencing run from one Torrent Server to another Torrent
Server, then runs an analysis of the transferred files on the
receiving Torrent Server.

For details, see “RunTransfer plugin“ on page 152.

sampleID Uses sample fingerprinting to identify any cross-
contamination between samples or between barcodes in a
run.

For details, see “sampleID plugin“ on page 154.

variantCaller For details, see “variantCaller plugin“ on page 155.

The ampliSeqRNA plugin is used with the Ion AmpliSeq™ Transcriptome Human
Gene Expression Kit or Ion AmpliSeq™ RNA panels. The plugin generates statistics,
downloadable data files, and interactive visualizations that represent targeted RNA
transcripts.

Use the ampliSeqRNA plugin on runs that are aligned to the human or mouse
transcriptome references and appropriate target regions files listed below. See “Import
a preloaded reference sequence“ on page 230 for more information on the references
and “View and manage target regions files“ on page 238 for more information on
target regions files.

Reference Target Regions File

hg19_AmpliSeq_Transcriptome_ERCC_v1 hg19_AmpliSeq_Transcriptome_21K_v1

hg19_AmpliSeq_Transcriptome_V1.1 hg19_AmpliSeq_Transcriptome_21K_v1

hg19_AmpliSeq_Transcriptome_V1.2 hg19_AmpliSeq_Transcriptome_v1.2

AmpliSeq_Mouse_Transcriptome_V1 AmpliSeq_Mouse_Transcriptome_v1

ampliSeqRNA
plugin
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ampliSeqRNA plugin configuration

The configuration options for the ampliSeqRNA plugin are described in the following
table. This plugin cannot be configured globally.

Note: You can change the Reference Genome used in the plugin run, for example
from hg19 to mm10 if you edit the run report, then reanalyze the raw reads. For
details, see “Edit a Run report“ on page 79. Alternatively, you can use reanalyze the
run. For details, see “Reanalyze a run“ on page 76.

Setting Description

The following settings can be configured when you or select the ampliSeqRNA plugin
as part of a Planned Run or Planned Run template.

Filter Barcodes Select this checkbox to remove whole barcodes from
subsequent analyses if they have a relatively low number
of reads, such as those that can result from barcode
contamination. A warning appears in the barcode summary
report if any barcodes were discounted from the analysis.
This setting is ignored for runs not employing barcodes.

Typically, the Filter Barcodes option is not needed if your
Planned Run specifies which samples to associate with
specific barcodes.

ERCC Tracking Select this checkbox if your Ion AmpliSeq™ RNA targets
(amplicons) were spiked with ERCC tracking targets.

Setting Description

The following settings can be configured when you run the ampliSeqRNA plugin
manually.

Library Type ampliSeqRNA is selected automatically and is currently
the only Library Type that the ampliSeqRNA plugin is
designed to work with.

Note: If the Planned Run specified a different application, a
dialog box will warn you that the plugin may not be
appropriate for the run.

Targeted Regions This is set to the target regions file used in the Planned
Run.

Note: You can override the default Target Regions setting
that each barcode uses. This might be useful to specify a
subset of genes of interest, or to correct the original
Planned Run.

Filter Barcodes Select this checkbox to remove whole barcodes from
subsequent analyses.

Typically, the Filter Barcodes option is not needed if your
Planned Run specifies which samples to associate with
specific barcodes.

ERCC Tracking Select this checkbox if your Ion AmpliSeq™ RNA targets
(amplicons) were spiked with ERCC tracking targets.
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Review ampliSeqRNA plugin results

The ampliSeqRNA plugin generates an initial summary report that lists the samples,
the number of mapped reads, the percent of valid reads, and the percent of targets
detected. A series of log2 reads-per-million (RPM) pair correlation plots are included
for rapid correlation analysis. Microsoft™ Excel™-compatible reports are also
generated, including differential expression tables. Additional details about read
coverage are also provided on a per-barcode basis, along with a list of gene
annotations for each sequenced region.

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click ampliSeqRNA to view the plugin results.

• Click the ampliSeqRNA.html link to open the ampliSeqRNA Report –
Barcode Summary for all barcodes.

• In the barcode table, click individual barcode names to see the results for an
individual barcode.

• Click the Distribution Plots, Correlation Heatmap, Correlation Plot, and
Gene Heatmap tabs to review the data graphically.

Graphical report Description

Distribution Plots

Reads Alignment
Summary

A graphical summary of the number of mapped and
unmapped reads across barcodes, as reported in the
Barcode Summary table.
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Graphical report Description

Distribution of Gene
Reads

Distribution of genes across barcodes showing the
frequency of numbers of genes having similar log10
read counts. All curves are plotted on the same axis
scale. The counts data are fitted to a Gaussian kernel
using the default R 'density' function.

Correlation Heatmap A heatmap of Spearman correlation r-values for
comparing log2 RPM reads pair correlation barcodes,
with dendrogram reflecting ordering of barcodes as
being most similar by these values.

Correlation Plot

Barcode read pair
correlation plot

Lower panels show log2(RPM+1) values plotted for
each pair of barcodes, with linear least squares
regression line overlaid and line slope reported.
Upper panels show Pearson correlation r-values for
the regression line. Diagonal panels show the
frequency density plot for the individual log(RPM+1)
values for each barcode. (If only one barcode has
reads, a density plot is displayed.) Click the plot to
open an expanded view.

Gene Heatmap

Gene Representation
Heatmap

Displays 250 genes showing the most variation in
representation across barcodes as measured by the
coefficient of variation (CV) of normalized read counts
for genes that have at least one barcode with at least
100 RPM reads, plotted using log10 of those counts.
For this plot, barcodes are omitted if they have <105

total reads.

• Click the links at the bottom of the report to download associated report files.
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ampliSeqRNA plugin reports

The following ampliSeqRNA plugin reports are available for download from the
results screen as tab-delimited text files, compatible with Microsoft™ Excel™ or similar
applications.

Report Description

Barcode Summary Report A table listing each barcode's sample name, total reads,
aligned reads, and percent aligned.

Absolute Reads Matrix A table listing absolute reads for the genes found on each
barcode.

Absolute Normalized Reads
Matrix

A table listing absolute normalized reads for the genes
found on each barcode.

CHP files normalized by
RPM

A file format designed for use with Affymetrix™ software to
produce additional reports.

Differential Expression for
Barcode Pair

A pop-up window that allows you to compare two barcodes.
You can set a threshold for minimum read count and
exclude targets from the differential expression table.
Differential expression for each target will be represented
as the log2 of the ratio of RPM reads of the experiment
barcode to the control barcode.

The Assembler SPAdes plugin is a De-Bruijin graph assembler. The plugin breaks
sequence reads into kmers of defined length, makes a connected graph, and traverses
through that graph to produce contigs. The plugin report includes basic analysis
metrics such as number of contigs, N50, length of the longest contig, and a
downloadable FASTA file of the assembled sequences. The plugin assumes a haploid
genome, and is ideal for genomes under 50 megabases in size. For multiploid
genomes, reads from different copies of a chromosome tend to assemble into different
contigs.

Note: For de novo assembly, use a Generic Sequencing application Planned Run
template for the Torrent Suite™ Software analysis.

Assembler
SPAdes plugin

Manage plugins for data analysis
Pre-installed plugins

Torrent Suite™ Software 5.10 User Guide 125



Assembler SPAdes plugin configuration

The configuration options for the Assembler SPAdes plugin are described in the
following table.

The following settings can only be configured when you select this plugin to run
manually from the Run Summary screen. After you select the plugin, click Advanced
Settings + to display these options.

Setting Description

Fraction of reads to use The default setting of 100% is recommended, and handles
most changes in coverage. If you enter a value of less than
100%, the reads are randomly sub-sampled.

Only process barcodes By default, the plugin processes all barcodes in the
analysis and produces a separate set of contigs for each
barcode. To limit plugin analysis to only specific barcodes,
list those barcodes here (separated by commas and no
spaces. For example,
IonXpress_001,IonXpress_002,IonXpress_003).

Skip barcodes with fewer
than __ reads

The software ignores barcodes whose number of reads do
not meet the threshold specified here. The default
threshold is 500 reads. This setting is intended to filter out
barcode classification problems with noisy data.

RAM to allocate The plugin attempts to allocate the specified amount of
RAM when it runs. The default is 32 GB. With larger
amounts of memory, the plugin runs faster. With less
memory, the plugin takes longer to complete.

Note: The plugin crashes if the memory allocation fails.

SPAdes version Select the version that you prefer. Select the default of
3.1.0 if you are not sure.
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Setting Description

Assembly settings Set this menu as follows:

• Uniform coverage (default setting)—This is used for
data with average GC (35–68%) content. This setting
uses the default kmers.

• Non-uniform coverage—Choose this setting for data
with low GC (<35%) content. This setting uses the
default kmers.

• Highly non-uniform coverage—Choose this setting
for data with high GC (>68%) content. This setting
uses a different set of kmers.

• Custom…—Choose this setting to enter user-defined
K and Mode settings.

– K—Enter values (separated by commas, no
spaces) to determine the size and number of
kmers to be used in the analysis. Enter short
kmer values to improve error-prone or low-
coverage regions, long kmers to resolve
repetitive regions, or a combination of kmer
values to account for both situations.

Note: Each additional kmer adds a fixed amount
to the processing time (for example, using
2 kmers takes twice as long as 1 kmer).

– Mode—Select Multi-cell (default) for data with
average or low GC content. Select Single-cell for
data with high GC (>68%) content.

Run read correction before
doing assembly

This setting is enabled by default, which is recommended.

Skip assembly if previous
results exist

Select this checkbox to detect whether assembly results
already exist and you do not want to overwrite the results.
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Review AssemblerSPAdes plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click AssemblerSPAdes to view the plugin results.

The plugin results show assembly statistics for the selected barcode.

• To show assembly statistics for an individual barcode, select a barcode in the
View Results menu.

• To download results for all barcodes used in the run, click Downloads.
• To download a FASTA file of the assembled contigs, click Assembled Contigs

(FASTA).
• To download a FASTA file of the Assembled Scaffolds, click Assembled
Scaffolds (FASTA).

• To download a copy of the Summary Statistics, click Assembly Statistics.

Note: You can also click SPAdes Log (TXT) to view the execution file for the
AssemblerSPAdes plugin, or click QUAST report (HTML) to view a QUAST
report.
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Use the coverageAnalysis plugin to view statistics and graphs that describe the level
of sequence coverage produced for targeted genomic regions. The results in the
Summary screen for a run analyzed with the plugin vary based on the library type
that you select when you configure the plugin. You can export some charts as
graphics, such as the Amplicon and Reference Coverage charts.

coverageAnalysis plugin configuration

The coverageAnalysis plugin uses the following settings:

Setting Description

The following settings are available for all library types.

Reference Genome The reference genome selected in the Planned Run.

Library Type The default value is the library type selected in the Planned Run,
and it can only be changed if the plugin is run manually. If you
change the library type, a different report is generated.

Targeted Regions The targeted regions are selected in the Planned Run, and can
only be changed after the run is complete if the plugin is run
manually. Target regions can be overwritten by the specific
barcode targets.

Select the targeted regions file from the dropdown list. For whole
genome and Ion Total RNA-Seq sequencing runs, you typically
select None.

Barcode-specific
Targets

This option is available only when the coverageAnalysis plugin is
run manually.

Select the checkbox to assign specific target region files to
individual barcodes.

1. Select a specific barcode from the Barcode dropdown list.

2. Select the specific targeted regions file from the dropdown
list to associate with the selected barcode.

3. Click Add.

4. Repeat steps 1 through 3 to associate additional barcodes
with specific target region files.

Note: Alternatively, you can copy and paste the barcode/target file
pairs manually.

Barcodes without a target region specified above will assume the
default target specified by the Target Regions option.

For targeted applications, any barcode targets specifically set to
None, or defaulting to the Target Regions set as None, will be
omitted from subsequent analysis.

Note: When the Barcode-specific Targets option is deselected, all
barcodes will use the targets specified by the Target Regions, even
if there are barcode-specific targets listed in the text box.

coverageAnalysis
plugin
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Setting Description

Advanced options

Minimum Aligned
Length

Specify the minimum aligned length that is required to ensure that
the read is included in an analysis.

Minimum Mapping
Quality

Specify a minimum value that reads must exceed to be included in
the analysis.

Tier 1 Coverage
Depth

Specify the first-tier coverage depth at which percentage of target
coverage is reported. This value must be at least 2, because the
coverage depth output will always be specified at 1x read depth.
The default value of 20 means that the percentage of targets, total
base targets, and/or individual target bases with at least 20 reads
is reported.

Tier 2 Coverage
Depth

Specify the second-tier coverage depth at which percentage of
target coverage is reported. This value must be greater than the
value used for the first-tier coverage. The default value of 100
means that the percentage of targets, total target bases, and/or
individual target bases with at least 100 reads is reported.

Tier 3 Coverage
Depth

Specify the third-tier coverage depth at which percentage of target
coverage is reported. This value must be greater that the value
used for the second-tier coverage. The default value of 500 means
that the percentage of targets, total target bases, and/or individual
target bases with at least 500 reads is reported.

The following settings are available only with specific library types.

Uniquely Mapped
Reads

Select this option to analyze only reads that are mapped to a
unique location in the reference. Reads that are non-uniquely
mapped can have equally well-aligned reads that are mapped to
multiple locations, and are typically mapped randomly to one.

Sample Tracking The Ion AmpliSeq™ Sample ID Panel is a companion panel of
9 primer pairs that can be added to any Ion AmpliSeq™ human
gDNA panel during target amplification to generate a unique
identification tag for research samples. Select this checkbox if you
added the Ion AmpliSeq™ Sample ID Panel to your library.

Target Padding Enter a number to pad the target by the number of bases entered.
If you do not enter a number, the default of 0 is used.

Non-duplicate
Reads

Select the checkbox to avoid duplicates. The analysis must have
included alignments with Mark Duplicates enabled.

Review coverageAnalysis plugin results

The coverageAnalysis plugin generates a Coverage Analysis Report. This report
includes read statistics and several charts. The statistics and charts that are presented
depend on the library type for the analysis.

The report lists the samples, the number of mapped reads, the percentage of valid
reads, and the percentage of targets detected. A series of log2 RPM pair-correlation
plots are included for rapid correlation analysis. Microsoft™ Excel™-compatible
reports are also generated, including differential expression tables. Additional details
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regarding read coverage are also provided on a per-barcode basis, along with a list of
gene annotations for each sequenced region.

You can download statistics files and the aligned reads BAM file from the file links at
the bottom of the Coverage Analysis Report.

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click coverageAnalysis to view the plugin summary.
A summary table of the coverage analysis, by barcode, is included in the
Summary screen.

4. Click a link in the Barcode Name column of the summary table to open a
detailed Coverage Analysis Report window for that barcoded sample.
Alternatively, click the coverageAnalysis.html link to open the summary table
for all barcodes in a new window.

5. Click the links at the bottom of the Coverage Analysis Report to download
associated statistics and summary files for each barcoded sample in the run.

Reads statistics 

The library type determines which statistics are presented. This table shows the
statistics for an Ion AmpliSeq™ DNA report. Some of these statistics are not available
for other library types or can be replaced by alternative statistics. Definitions are in
tooltips.

Statistic Description

Number of mapped reads Total number of reads mapped to the reference.

Number of reads on target Total number of reads mapped to any targeted region of
the reference. A read is on target if at least one aligned
base overlaps a target region. A read that overlaps a
targeted region but where only flanking sequence is
aligned, for example, due to poor matching of 5' bases of
the read, is not counted.

Target Base Coverage Summary statistics for targeted base reads of the
reference. A base covered by multiple target regions is only
counted once per sequencing read.

Bases in target regions The total number of bases in all specified target regions of
the reference.

Percent of reads on target The percentage of reads mapped to any targeted region
relative to all reads mapped to the reference.

Total aligned base reads The total number of bases covered by reads aligned to the
reference.
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Statistic Description

Total base reads on target The total number of target bases covered by any number of
aligned reads.

Percent base reads on
target

The percent of all bases covered by reads aligned to the
reference that covered bases in target regions.

Bases in targeted reference The total number of bases in all target regions of the
reference.

Bases covered (at least 1x) The total number of target bases that had at least one read
aligned over the proximal sequence. Only the aligned parts
of each read are considered. For example, unaligned (soft-
cut) bases at the 5' ends of mapped reads are not
considered. Covered target reference bases can include
sample DNA read base mismatches, but does not include
read base deletions in the read, nor insertions between
reference bases.

Average base coverage
depth

The average number of reads of all targeted reference
bases.

Uniformity of base coverage The percentage of bases in all targeted regions (or
whole‑genome) covered by at least 0.2x the average base
coverage depth.

Average base read depth The average number of reads of all targeted reference
bases that were read at least one time.

Genome Base Coverage Summary statistics for base reads of the reference
genome.

Genome base coverage at
N x

The percentage of reference genome bases covered by at
least N reads.

Target coverage at N x The percentage of target bases covered by at least N reads.

Targets with no strand bias The percentage of all targets that did not show a bias
toward forward or reverse strand read alignments. An
individual target has read bias if it has at least 10 reads
and the percentage of forward or reverse reads to total
reads is greater than 70%.

Amplicon Read Coverage Summary statistics for reads assigned to specific
amplicons. Each sequence read is assigned to exactly one
of the amplicons specified by the targets file. Reads are
assigned to particular amplicon targets based if their (5')
mapping location being sufficiently close to the end of the
amplicon region, taking the read direction (mapping
strand) into account.

Number of amplicons The number of amplicons specified in the target regions
file.
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Statistic Description

Percent assigned amplicon
reads

The total number of reads that were assigned to individual
amplicons. A read is assigned to a particular (inner)
amplicon region if any aligned bases overlap that region. If
a read might be associated with multiple amplicons this
way it is assigned to the amplicon region that has the
greatest overlap of aligned sequence.

Average reads per amplicon The average number of reads assigned to amplicons.

Uniformity of amplicon
coverage

The percentage of bases in all targeted regions (or
whole‑genome) covered by at least 0.2x the average base
read depth.

Amplicons with at least N
reads

The percentage of all amplicons that had at least N reads.

Amplicons with no strand
bias

The percentage of all amplicons that did not show a bias
towards forward or reverse strand read alignments. An
individual amplicon has read bias if it has at least 10 reads
and the percentage of forward or reverse reads to total
reads is greater than 70%.

Amplicons reading end-to-
end

The percentage of all amplicons that were considered to
have a sufficient proportion of assigned reads (70%) that
covered the whole amplicon target from 'end-to-end'. To
allow for error, the effective ends of the amplicon region
for read alignment are within 2 bases of the actual ends of
the region.

Amplicon based composition
bias

A number that represents the proportion of amplicons
showing low representation (<.2x mean reads) in the lower
and/or upper quartiles of amplicons ordered by increasing
GC base pair content of their insert sequences. The value
is relative to that in the center 50th percentile of amplicons
and weighted by the standard deviation of representation
over all amplicons.
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Example statistics

The following is an example of the plugin statistics for an Ion AmpliSeq™ run.

Note: Almost every statistic, plot, link, and functional widget in the report provides
tooltips with definitions. Hover over a heading or description in the report to view the
tooltip.

The Reference Coverage chart is an overlay of where target regions are defined and
overlap on the reference.

Example charts

Many of the charts that are generated by the coverageAnalysis plugin include a Plot
menu that allows you to change characteristics of the chart. For example, you can
show both strands.

The  button (in the top right corner of a chart) opens the chart Viewing Options
panel. The  button opens a description of the chart.
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In the Depth of Coverage chart above, the left Y-axis (% reads) is the number of reads
at a particular read depth (or bin of read depths) as a percentage of the total number
of base reads. The right Y-axis (% cumulative reads) is the cumulative count of the
number of reads at a given read depth count is at least read depth, as a percentage of
the total number of reads. If your analysis includes a regions of interest file, this chart
reflects only target regions (reads that fall within a region of interest).

In most charts you click on a data point to open a detail panel for that data:

In this chart, the blue curve measures the cumulative reads at that read depth or
greater. Click a point on the blue curve to open the blue detail panel for that read
depth:

The following Reference Coverage Chart is shown with the Strand Base Reads
option:
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You can also zoom in on a region of interest.

Output files

You can download plugin results file from links that are contained in the File Links
section.

Note: Sometimes the file name can be too long to open in applications such as
Microsoft™ Office Excel™. To resolve this problem, you can right-click on the file and
click Save As to rename the downloaded files.

Click a question mark next to the file  to open a description of the file:

The list of files depends on the application type selected. The following list is for an
Ion AmpliSeq™ DNA run.
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File Description

Coverage statistics
summary

A summary of the statistics presented in the tables at the top of
the plugin report. The first line is the title. Each subsequent line is
either blank or a particular statistic title followed by a colon (:) and
its value.

Base depth of
coverage

Coverage summary data used to create the Depth of Coverage
Chart. This file contains these fields:

• read_depth The depth at which a (targeted) reference base
has been read.

• base_cov The number of times any base was read (covered)
at this depth.

• base_cum_cov The cumulative number of reads (coverage) at
this read depth or greater.

• norm_read_depth The normalized read depth (depth divided
by average base read depth).

• pc_base_cum_cov As base_cum_cov but represented as a
percentage of the total base reads.
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File Description

Amplicon coverage
summary

Coverage summary data used to create the Amplicon Coverage
Chart. This file contains these fields:

• contig_id The name of the chromosome or contig of the
reference for this amplicon.

• contig_srt The start location of the amplicon target region.

Note: This coordinate is 1-based, unlike the corresponding
0-based coordinate in the original targets BED file.

• contig_end The last base coordinate of this amplicon target
region.

Note: The length of the amplicon target is given as tlen =
(contig_end - contig_srt + 1).

• region_id The ID for this amplicon as given as the 4th column
of the targets BED file.

• gene_id The gene symbol as given as the last field of the
targets BED file.

• gc_count The number of G and C bases in the target region.
%GC = 100% * gc / tlen.

• overlaps The number of times this target was overlapped by
any read by at least one base.

Note: Individual reads might overlap multiple amplicons
where the amplicon regions themselves overlap.

• fwd_e2e The number of assigned forward strand reads that
read from one end of the amplicon region to the other end.

• rev_e2e The number of assigned reverse strand reads that
read from one end of the amplicon region to the other end.

• total_reads The total number of reads assigned to this
amplicon. This value equals (fwd_reads + rev_reads) and is
the field that rows of this file are ordered by (then by contig id,
srt and end).

• fwd_reads The number of forward strand reads assigned to
this amplicon.

• rev_reads The number of reverse strand reads assigned to
this amplicon.

• cov20x The number of bases of the amplicon target that had
at least 20 reads.

• cov100x The number of bases of the amplicon target that had
at least 100 reads.

• cov500x The number of bases of the amplicon target that had
at least 500 reads.
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File Description

Chromosome base
coverage summary

Base reads per chromosome summary data used to create the
default view of the Reference Coverage Chart. This file contains
these fields:

• chrom The name of the chromosome or contig of the
reference.

• start Coordinate of the first base in this chromosome. This is
always 1.

• end Coordinate of the last base of this chromosome. Also its
length in bases.

• fwd_reads Total number of forward strand base reads for the
chromosome.

• rev_reads Total number reverse strand base reads for the
chromosome.

• fwd_ontrg (if present) Total number of forward strand base
reads that were in at least one target region.

• seq_reads Total sequencing (whole) reads that are mapped to
individual contigs.

Aligned reads BAM
file

Contains all aligned reads used to generate this report page, in
BAM format. This is the same file that can be downloaded from the
main report (for the specific barcode). See the current SAM tools
documentation for more file format information.

Aligned reads BAI
file

Binary BAM index file as required by some analysis tools and
alignment viewers such as IGV. This is the same file that can be
downloaded from the main report (for the specific barcode).

Use the DataExport plugin to export data from a sequencing run to a network drive,
an external hard drive, or a removable media device, such as a USB drive. The
exported data can be used to create backups, or to transfer files to another system
quickly. When you configure the plugin, you select which file categories from the run
are included in the export.

Note: Before you use the DataExport plugin, a software administrator must configure
the path to the directory that is used for the export. The Destination Path to the
external drive is then available in the global settings for the plugin.

DataExport plugin
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DataExport plugin configuration

The DataExport plugin can be configured to set the destination path of the exported
files, as well as specify the file types to be exported.

The configuration options for the DataExport plugin are described in the following
table:

Setting Description

Destination Path Designates the location of the network drive, external hard drive
or removable media device where the files are exported to

Signal Processing
Input

Exports DAT files

Basecalling Input Exports WELLS files

Output Files Exports all output files, including BAM files, reports, and analysis
files

Intermediate Files Exports files used for troubleshooting by qualified system
engineers

Review DataExport plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the Summary, click DataExport to view the plugin summary.

After export is complete, the report appears in the DataExport pane. The following
parameters are shown.

Parameter Description

FILE CATEGORIES Lists the categories for the file types that are included in the
export.

DESTINATION Location where the files are exported to after the plugin is run.

STATUS Shows the status of the file transfer.

Use the ERCC_Analysis plugin to determine if a problem exists with either the library
preparation or the sequencing instrument run. The ERCC_Analysis plugin determines
the relative abundance of the actual versus expected number of ERCC transcript reads
for sequencing runs that include ERCC RNA Spike-in Controls.

The ERCC_Analysis plugin takes approximately 2–3 minutes to complete for
sequencing runs with ≤1,000,000 total reads, and 1–2 minutes longer for each
additional million total reads. For example, a run with 5 million total reads can take
10–15 minutes. If the Torrent Suite™ Software is busy performing additional
processing functions, plugin run times are longer.

ERCC_Analysis
plugin
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Note: You can configure the ERCC_Analysis plugin to run automatically. However,
automatic execution is not recommended, unless most of the analyses on the Torrent
Server include ERCC controls.

ERCC_Analysis plugin configuration

The configuration options for the ERCC_Analysis plugin are described in the
following table.

Setting Description

Use only forward strand
reads

Available when manually running the plugin.

Passing R-squared value (Optional) To change the R-squared value to set a default
value for the summary report screen, enter a value
between 0 and 1 as your minimum acceptable R-squared
value (a lower value is indicated by a red light in the
summary report).

The value you enter on the ERCC Plugin Configuration
screen is used when the plugin is auto-run and when a
user manually launches the plugin without entering a
value. Users can override this value on a per-run basis
when they manually launch the plugin.

Minimum transcript counts The minimum number of reads that an ERCC transcript
must have to be included in the analysis.

ERCC pool used Select the ERCC transcript pool used when preparing the
library.

Barcodes of interest IMPORTANT! If you configure a Planned Run or Planned
Run template to execute the ERCC_Analysis plugin, and
your experiment uses the Ion Total RNA-Seq Kit v2, you
must select a barcode option:

· Select IonXpressRNA if your experiment uses this kit.
· Select RNA_Barcode_None if your experiment does

not use a barcode kit

Review ERCC_Analysis plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the Completed Runs & Reports screen, click the report name to open.

3. In the Summary, click ERCC_Analysis to see the ERCC_Analysis pane. The
following settings are shown.
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4. After the analysis is complete, click the ERCC_Analysis.html link or individual
Barcode Name link to open the ERCC Report and view the analysis results. The
following table describes the settings that are shown.

Setting Description

Use only forward strand
reads

Available when manually running the plugin.

Passing R-squared value (Optional) To change the R-squared value to set a
default value for the summary report screen, enter a
value between 0 and 1 as your minimum acceptable R-
squared value (a lower value is indicated by a red light
in the summary report).
The value you enter on the ERCC Plugin Configuration
screen is used when the plugin is auto-run and when a
user manually launches the plugin without entering a
value. Users can override this value on a per-run basis
when they manually launch the plugin.

Minimum transcript
counts

The minimum number of reads that a given ERCC
transcript must have to be included in the analysis.

ERCC pool used Select the ERCC transcript pool used when preparing
the library.

Barcodes of interest Select a barcode from the dropdown list for Add a
specific barocde.

IMPORTANT! If you configure a Planned Run or
Planned Run template to execute the ERCC_Analysis
plugin, and your experiment uses the Ion Total RNA-
Seq Kit v2, you must select a barcode option.

Interpret the ERCC Dose Response plot 

The axes of the ERCC Dose Response plot are log (base 2), with the raw read counts
for each ERCC transcript on the y-axis and the known relative concentration of the
ERCC transcripts on the x-axis. In the plot, the points are color-coded—based on
mapping quality—and there is also a line of best fit, the parameters (slope, y-
intercept, and R-squared value) of which are shown in tabular form to the right of the
graph (N = the number of points (ERCC transcripts) included in the regression
analysis). Ideally, the points all fall on a straight line. However, the raw counts and
relative concentration should at least correlate with a high R-squared (e.g., ≥0.9) value.
Although there are 92 transcripts in the ERCC mix, it is not expected that all 92 are
detected. The number of transcripts detected depends on the sequencing depth.
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View ERCC transcript details

There are two ways to look at the details of a particular ERCC transcript. To view all
the details regarding a particular ERCC transcript, you should view both.

• Hover your mouse-cursor over a point in the ERCC Dose Response plot to
display a popup window that shows details regarding that transcript.
Overlapping points on the plot can be resolved by zooming in on the plot to more
easily distinguish points.

a. To zoom in on a selected area, click-drag your mouse to highlight the area of
interest.

b. Double-click in the plot, or click the Reset Zoom button to zoom out to the
full view of the ERCC Dose Response plot.

Parameter Description

log2 relative
ERCC
concentration

The log (base 2) of the relative ERCC transcript concentration.

log2 ERCC
counts

The log (base 2) of the mapped reads to an ERCC transcript.

transript The ERCC transcript identifier including length in base pairs (bp).

reads The number of reads that map to the particular transcript.

mean mapping
quality

Points in the display are color coded based on the mapping quality.

• Scroll to the particular transcript, then click the [+] next to the transcript name.

Parameter Description

Reads The number of reads that map to the particular transcript.

Coverage
Depth

The minimum and maximum number of reads covering bases in
the transcript. If coverage is 100%, the minimum value will be > 0.

Coverage The number of base positions covered by at least one read. Also
expressed as a percentage of the full length.

Start Sites The number of base positions that are the start site for a read.
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Parameter Description

Unique Start
Sites

The number of base positions that have only one read starting at
the position.

Coverage CV Coefficient of Variation for coverage = average coverage / standard
deviation coverage for the entire transcript.

Definitions

This section defines terms used in the plugin output.
• Coverage Depth—The minimum and maximum number of reads covering bases

in the transcript. If coverage is 100%, the minimum value will be >0.

• Coverage—The number of base positions covered by at least one read.

• Start Sites—The number of base positions that are the start site for a read.

• Unique Start Sites—The number of start sites that have only one read starting at
the site.

• Coverage CV—Coefficient of Variation for coverage = average coverage / stddev
coverage for the entire transcript.

ERCC resources

The External RNA Controls Consortium (ERCC) is hosted by the U.S. National
Institute of Standards and Technology.

For more information on ERCC RNA Spike-In Control Mixes (Cat. Nos. 4456739 and
4453740), see the ERCC RNA Spike‑In Control Mixes User Guide (Pub. No. 4455352).

For more information on ERCC analysis, see the ERCC_Analysis Plugin User Bulletin
(Pub. No. 4479068).

The FieldSupport plugin is used for technical support purposes only. For details,
contact Technical Support or your Field Application Scientist. Enable and run this
plugin only under the guidance of Thermo Fisher Scientific Technical Support.

IMPORTANT! Enable and run this plugin only when directed by Thermo Fisher
Scientific Technical Support or your Field Applications Scientist.

Use the FileExporter plugin to rename the output files from the Torrent Suite™

Software runs.

The plugin also offers the following options:
• Generates files of the analysis results that use BAM, VCF, XLS, or FASTQ formats.
• Renames variantCaller plugin output files (when available).
• Compresses the analysis results files.
• Provides links that allow you to download the results files.

FieldSupport
plugin

FileExporter
plugin
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Configure the FileExporter plugin

1. Select from the following options to choose the file types that you export:

Option Description

Include Select to generate a separate link for the file in the plugin results.

Archive Select Archive for each file type that you want to include in a compressed
file. You can export a standard compressed directory in a ZIP or tar.bz2
format.

For each option, you can choose to include or archive the following file types:

File types Description

BAM Native file format for data generated by Ion
instruments.

Variant Call Format (VCF) File containing only the differences between the BAM
file and a reference file.

Variant Caller File (XLS) Microsoft™ Excel™ format of VCF.

FASTQ Text format of the nucleotides.
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2. Name the file. Select one of the following:

• Select a unique file name by entering the desired name in the Custom Name
text box.

• Create a name using parameters of the run. Drag and drop components from
the selections pane onto the name pane row. The naming options are in the
blue boxes. The name appears under Example Name.

• Select the delimiter that is used between metadata fields. Support delimiters
are dot, dash, and underscore (a naming pattern uses only one delimiter).

1

1 Name pane row

3. Click Save Configuration.

Review FileExporter plugin results

After the sequencing run completes, you can download the following files after you
run the FileExporter plugin from the report summary:

• Any of the Torrent Suite™ Software Software analysis output files that use BAM,
VCF, XLS, or FASTQ formats.

• A compressed file that contains the analysis output files.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click FileExporter to view the plugin summary.

Note: The BAM files load quickly so may appear first in the list of links. The
other file formats take longer to download.

Manage plugins for data analysis
Pre-installed plugins

146 Torrent Suite™ Software 5.10 User Guide



4. Ensure that the status of the plugin run is Completed. You can click
Plugins4Refresh plugins at the top of the Summary if the status is not
completed or the list of files does not include all the files that you selected when
you configured the plugin.

5. When the list contains all the files that you want to download, click a file name
link under Output Files to download.

6. To review the parameters that were used for the files, click Show Parameters.

The FilterDuplicates plugin allows you to remove duplicate reads from merged data
after a run is completed. The removed BAM files are saved in the FilterDuplicates
directory. The original BAM files in the main analysis directory are not modified.

Note: The Mark as Duplicate Reads feature in the main analysis pipeline, enabled in
the Kits step of Planned Run creation, marks reads as duplicates but does not remove
them from the BAM files.

Review FilterDuplicates plugin results

After the sequencing run completes, review the FilterDuplicates plugin results, and
download the BAM files with duplicate reads removed.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click FilterDuplicates to view the plugin summary.

4. In the FilterDuplicates section, click FilterDuplicates.html to open the BAM
Files with Duplicate Reads Removed report in the browser.

Note: BAM files load quickly, so you may see these files first in the list of links.
The other file formats take longer to download, so you may have to wait for the
links to the VCF, XLS, and FASTQ formats to appear.

The plugin output contains links to the BAM files that have duplicate reads
removed. This table also shows the percentage of reads that were removed and
the percentage of all reads that reached the adapter.

5. To download the Filtered BAM Files, click the link for each file listed that you
want to download.
The BAM files are downloaded to the directory that you use to download files
from the browser. This location depends on your browser settings.

FilterDuplicates
plugin
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Use the immuneResponseRNA plugin to quantify gene expression levels for the
Oncomine™ Immune Response Research Assay. This plugin produces gene transcript
quantification from sequence read data. The plugin summary includes gene
expression counts (number of aligned reads to a given gene target), a data analysis
summary, and QC plots. The normalized, gene-level count data from the run are
available to download for further analyses with Affymetrix™ Transcriptome Analysis
Console (TAC) 3.1 software.

The immuneResponseRNA plugin requires a Target Regions BED file and an
associated Reference Library FASTA file. See “Reference Management“ on page 227
for more information on installing these files.

The plugin also accepts a second—optional—BED file that specifies a subset of target
genes allowing sample clustering.

immuneResponseRNA plugin configuration

The configuration options for the immuneResponseRNA plugin are described in the
following table:

Setting Value

Library Type AmpliSeqRNA

Targeted Regions ImmuneResponse_v3.1_target_designed_20160908.bed

(Optional) Add new gene list Select your target gene subset BED file in the Add genes of
interest list.

Review immuneResponseRNA plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click immuneResponseRNA to view the plugin
summary.

4. In the immuneResponseRNA section, click the immuneResponseRNA.html
link to open the immuneResponseRNA Report for all barcodes.

Note: The BAM files load quickly so may appear first in the list of links. The
other file formats (VCF, XLS and FASTQ) take longer to download.

immuneResponse
RNA plugin
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5. In the Analysis Summary, review your Mapped Reads, Valid Reads, and
Targets detected by barcode.

Column Description

Barcode Name The barcode used for the sample.

Sample Sample name as it was entered in the sequencing Run
Plan.

Mapped Reads Number of reads that map to the reference sequences.

Valid Reads Percentage of mapped reads ≥50% amplicon length.

Targets ≥1 reads Number of targets/genes with at least 1 read.

Targets ≥2 reads Number of targets/genes with at least 2 reads.

Targets ≥10 reads Number of targets/genes with at least 10 reads.

6. Click an individual barcode name to view the results for that barcode.

7. Scroll down then click the Sample Characteristics, Sample Correlation,
Analysis of Selected Targets (only present if a Genes of interest subset .bed file
was selected), or Analysis of All Targets tabs to review the data graphically.

Downloadable reports

The following reports are available for download as tab-delimited text files,
compatible with Microsoft™ Excel™ or similar applications.

At the bottom of the screen are links for downloading raw analysis output files:

Report hyperlink Description

Download Barcode
Summary Report

A table listing each barcode's sample name, total reads, aligned
reads on targets, and number of targets detected.

Download absolute
read counts data

A table listing read counts for each barcoded sample along with
gene annotations.
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Report hyperlink Description

Download RPM data
(normalized by total
read counts)

A table listing RPM (Read count Per Million mapped reads) for
each barcoded sample along with gene annotations. RPM is
calculated as:

(read count)  × 106 / total number of mapped reads

Download mean
housekeeping scaled
log2 RPM data

A table listing housekeeping-gene normalized, log2-transformed
read counts for each barcoded samples along with gene
annotations. Conceptually, these values are read count normalized
by the average expression of housekeeping (hk) genes rather than
by the total number of mapped reads as described above. The
values are calculated as:

These values are useful for differential analysis when a large
proportion of the target genes (non-housekeeping genes) are
expected to be differentially expressed or when the expression
levels of the housekeeping genes in the 2 groups differ
significantly.

Download CHP files
normalized by RPM

The RPM data is converted to CHP file format for use with
Affymetrix™ Transcriptome Analysis Console (TAC) software. The
downloaded .ZIP file contains all the CHP files from the
sequencing run. Each barcoded sample has 1 CHP file.

Download CHP files
normalized by mean
housekeeping genes

Similar to the above CHP file, but data in these CHP files are
normalized by housekeeping genes.

Download
background
expression from
genomic DNA and
H2O neg_control

A table containing background expression (in absolute read count)
from 4 experiments using genomic DNA and H2O as negative
control samples.

Analysis files that are generated in the Torrent Suite™ Software can be directly
transferred to an Ion Reporter account in Ion Reporter™ Software with the
IonReporterUploader plugin.

Ion Reporter™ Software uses the Torrent Suite™ Software output BAM file for analysis.
The Ion Reporter™ Software annotation-only workflow also accepts the VCF output
file of the variantCaller plugin. Use the IonReporterUploader plugin to transfer these
BAM and VCF output files to Ion Reporter™ Software.

For details about the IonReporterUploader plugin, see “Integration with Ion
Reporter™ Software“ on page 172

IonReporterUploa
der plugin
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The PGxAnalysis plugin analyzes sequencing output from the Ion AmpliSeq™

Pharmacogenomics panel, a hotspot panel that interrogates pharmacogenomically
relevant variants in samples for genotyping and CYP2D6 copy number detection for
research use. It requires two other Torrent Suite plugins: the variantCaller plugin for
genotyping and coverageAnalysis plugin for CYP2D6 copy number detection.

The figure below describes the pipeline of analyses.

For details about how to set up Torrent Suite™ Software Planned Runs that
incorporate the Ion AmpliSeq™ Pharmacogenomics template and the PGxAnalysis
plugin, see the following documents at the Thermo Fisher Scientific website
(thermofisher.com):

• Customization Guidelines for Ion AmpliSeq™ Pharmocogenomics Research Panels
(Pub. No. MAN0014300)

• Create a Planned Run using the Ion AmpliSeq™ Pharmocogenomics Research Panel
Plugin (Pub. No. MAN0013730)

Review PGxAnalysis plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click the PGxAnalysis link to view the plugin
summary.

4. Click the PGxAnalysis.html link to open the Pharmacogenomics Analysis
Report.

PGxAnalysis
plugin
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5. View the plugin analysis reports.

• Click the variantCaller_out link to view the Variant Caller Report. See 
“Variant calls in Torrent Suite Software“ on page 191 for details on
variantCaller plugin results interpretation.

• Click the coverageAnalysis_out link to view the Coverage Analysis Report.
See “Review coverageAnalysis plugin results“ on page 130 for details on
coverageAnalysis plugin results interpretation.

Use the RunTransfer plugin to complete the following:
• Transfer the signal processing output files from a completed run to a different

Torrent Server.
• Rerun an analysis of the transferred signal processing files on the new server. The

Run Summary that includes the transferred files is listed in the Completed Runs
& Reports for the server that receives the transfer, as if it is generated on that
server. The results of the analysis are contained in the ISP images of the Run
Summary.

Note: The files that are transferred are the BaseCaller Input category of files,
including the 1.wells file. This file contains observations from the instrument that are
captured electronically.

For Ion Proton™ analyses, you can configure the option to transfer thumbnail files
only or transfer the 96 block files in a full chip run.

RunTransfer plugin configuration

The RunTransfer plugin requires global configuration to connect to the Torrent Server
that receives transferred files.

The following configuration settings are used by the plugin:

Setting Description

IP address or fully qualified
hostname

The IP address or fully qualified host name of the receiving
Torrent Server.

Remote TS Username
(default ionadmin)

The username of the administrator-level user on the
receiving Torrent Server. The default administrator
username on a new Torrent Server is ionadmin, but this
can be changed.

Password The password of the administrator-level user on the
receiving Torrent Server.

Upload Path
(default /results/uploads/)

The path of the directory used to store transferred files and
analyses on the receiving Torrent Server.

RunTransfer
plugin
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Setting Description

Data set type Select an option based on the following considerations:

• Thumbnails/PGM: This option will transfer all files,
including thumbnails. However, the plugin will not run
if full chip sequencing runs were performed on the Ion
Proton™ System, Ion S5™ System and Ion GeneStudio™

S5 System. With this setting, a warning will be issued
and the plugin will not run, if the instrument used a
Full Chip run.

• Thumbnails/PGM and Full Chip: This option transfers
only thumbnails of Ion PGM™ System, Ion Proton™

System, Ion S5™ System, and Ion GeneStudio™ S5
System data sets. Use this option if disk space on the
destination or network bandwidth is limited.
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Review RunTransfer plugin results

After the sequencing run completes, you can review information about the run
reports that were transferred to another Torrent Server.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click RunTransfer to view the plugin summary.

4. Click the Report Name link to open the summary for your report.

5. To view the plugin summary, click the RunTransfer link.
In the RunTransfer section, you can see a list of the files that were transferred. If
the plugin is configured to use the data type set as Thumbnails/PGM, you will
see these files:
1.wells
analysis.bfmask.bin
processParameters.txt
avgNukeTrace_ATCG.txt
avgNukeTrace_TCAG.txt
bfmask.stats', 'bfmask.bin'
analysis.bfmask.stats
analysis_return_code.txt
sigproc.log
avgNukeTrace_ATCG.txt
avgNukeTrace_TCAG.txt
analysis.bfmask.stats
explog.txt
Bead_density_20.png
Bead_density_70.png
Bead_density_200.png
Bead_density_1000.png
Bead_density_raw.png
Bead_density_contour.png

Use the sampleID plugin to track samples or possibly identify misassignment or mix
up between samples and barcodes in a sequencing run. The sampleID plugin
produces a unique identification code (SampleID) for each barcode in a sample.

The plugin can be used with the Ion AmpliSeq™ Sample ID Panel is a human SNP
genotyping panel to ensure that the accuracy of samples increase confidence in
sample data management. The Ion AmpliSeq™ Sample ID Panel is composed of the
identified human sample gender and IUPAC base letters for eight high-frequency
non-coding SNPs. The Sample ID panel contains nine primer pairs that can be
combined with any Ion AmpliSeq™ Ready-to-Use or Custom Panel.

For the samples to work with this plugin, the Ion AmpliSeq™ library must have be
prepared with Ion AmpliSeq™ sample tracking amplicons.

sampleID plugin
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Note: The sampleID plugin is pre-configured and does not require input.

Review sampleID plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click sampleID to view the plugin summary.

4. Click sampleID.html to open the sampleID report in the browser tab. Then, you
can open a detail report and other data files:

5. (Optional) Scroll to the File Links table, and click on a link to:

• Download a PDF image of the report
• Download all variant calls as a table file
• Download the tracking target regions file
• Download the tracking loci regions (SNPs ) file
• Download the aligned tracking reads (BAM) file
• Download the aligned tracking reads index (BAI) file

6. (Optional) Click Download Barcode Summary Report to open the data in a
downloadable tab-separated spreadsheet, or PDF report.

7. To return to Torrent Suite™ Software, click back in the browser.

The variantCaller plugin calls single-nucleotide polymorphisms (SNPs), multi-
nucleotide polymorphisms (MNPs), insertions, deletions and block substitutions in a
sample across a reference or within a targeted subset of that reference.

This plugin provides optimized pre-set parameters for many experiment types. It can
also be customized. After you find a parameter combination that works well on your
data and that has the balance of specificity and sensitivity that you want, you can save
that parameter set and reuse it in your research. Customization is supported when
you run the plugin after a sequencing run and when the plugin is run through a
Planned Run.

For details about the variantCaller plugin, see “Variant calls in Torrent Suite
Software“ on page 191.

variantCaller
plugin
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Plugins available only on Thermo Fisher Cloud

There are two plugins that are supported by Thermo Fisher Scientific and available on
the Thermo Fisher Cloud at https://apps.thermofisher.com/apps/publiclib/#/plugins.
These plugins are not pre-installed in the Torrent Suite Software. For details about
plugins that are included with Torrent Suite Software, see “Pre-installed plugins“ on
page 120.

Plugin name Description

RNASeqAnalysis Analyzes cDNA reads. This plugin is an RNA transcript alignment
and analysis tool for use with the reference genomes hg19 and
mm10.

For details, see “RNASeqAnalysis plugin“ on page 157.

smallRNA Analysis Analyzes small RNA reads with an emphasize on micro RNA
molecules. Use with reference genome hg19 only.

Use this plugin to analyze micro RNA reads. Reads are aligned to mature micro
RNAs using the tmap or bowtie2 alignment software. Unmapped reads are further
aligned to the whole genome to rescue miRbase unaligned reads and count other
RNA molecules (tRNAs, rRNAs, mRNAs, and so on). miRNA raw counts are
generated using featureCounts software.

smallRNA plugin

The RNASeqAnalysis plugin can be configured with the either the hg19 reference
genome or the microRNA reference when you plan a run.

Setting Description

microRNA reference mirbase (build 20) Use to align against a mirBase reference,
constructed from the mirBase GFF file with 10 bp padding.

genome Use to align against the whole genome.

Rescue reference hg19

Review smallRNA plugin results

After your sequencing run completes, review plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click smallRNA to view the plugin results.

smallRNA plugin
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4. In the smallRNA section, click smallRNA.html link to open the smallRNA
Analysis Report for all barcodes.

• In the barcode table, click individual barcode names to see the results for an
individual barcode.

Report Description

Download the Statistics
Summary

An overview of read mapping statistics and smallRNA
molecules.

mirBase mapping quality
(page_)

Mapping quality output from Qualimap.

Download the mirRNA
Mature Counts

A table with per mature RNA read counts.

Download the miRNA Per
Precursor 5p-3p Counts

A table with 5p-arm and 3p-arm read counts on the
same line.

Download the miRNA
High Confidence Mature
Counts

A table with per mature read counts for miRNAs
identified as high confidence miRNAs in mirBase
build 21

Download the miRNA Per
Precursor 5p-3p Counts

A table with 5p-arm and 3p-arm read counts on the
same line. Restricted to miRNAs identified as high
confidence miRNAs in mirBase Build 21.

Download the mirBase
alignments (BAM) file
(genomic coordinates)

mirBase alignments converted to genomic
coordinates when mirBase was used as reference.

Download the mirBase
alignments index (BAI)
file

Index file for the mirBase alignment.

Download Output files
(page_)

A page that provides the ability to download all
output files individually.

• Click Download Barcode Summary Report to download the data into
downloadable tab-separated spreadsheet, or PDF report.

• Click Download absolute reads matrix to download a table that lists absolute
reads for the genes that are found on each barcode.

The RNASeqAnalysis plugin is an RNA Transcript Alignment and Analysis tool for
use with reference genomes hg19 and mm10.

Note: In order to use the hg19 or mm10 genomes with this plugin, the reference
genomes must first be imported from the preloaded references page. Also, annotation
files for the human and mouse references are available for import. See “Import a

RNASeqAnalysis
plugin
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preloaded reference sequence“ on page 230 for more information on downloading
references and annotation files.

Annotation file name Description

Human

hg19_annotation_v1.gtf Human genome annotation (hg19)

XrRNA.fasta Human auxiliary small RNA sequences
(cDNA)

Mouse

mm10_annotation_v1.gtf Mouse genome annotation (mm10)

XrRNA.fasta Mouse auxiliary small RNA sequences
(cDNA)

Use this plugin to analyze cDNA reads, as produced by RNA-Seq. Reads are aligned
to the reference genome using STAR and bowtie2 aligners to find full and partial
mappings. The alignments are analyzed by HTSeq and Picard tools to collect assigned
read counts and cufflinks to extract gene isoform representation. For barcoded data,
comparative representation plots across barcodes are created in addition to individual
reports for each barcode. All alignment, detail and summary report files are available
for download.
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RNASeqAnalysis plugin configuration

The RNASeqAnalysis plugin can be configured with either the hg19 or mm10
reference genome when you plan a run. You can also add hg19 and mm10 annotation
files.

Note: This plugin requires the use of the RNA Seq Planned Run templates for
sequencing Runs: Ion RNA - Small or Ion RNA - Whole Transcriptome. If the RNA
Seq Planned Run templates are not used when you run the plugin manually, you
receive an error.

Setting Description

Reference Genome In the Configure Plugin dialog box, select from the
dropdown list:

• hg19, or
• mm10

Regenerate indices Check to ensure any pre-generated indexing and
annotation files for the specified reference are deleted
before the analysis starts. New files will be generated as
needed, which may add several hours to the plugin run
time (~3 hours for human-sized genomes). Using this
option is necessary if the plugin previously failed during
(STAR) reference index generation of the reference
sequence was updated.

Note: To use the mouse mm10 Reference Genome with this plugin, first import the
preloaded Ion reference genome to Torrent Suite™ Software. See “Import a preloaded
reference sequence“ on page 230 for more information.

Review RNASeqAnalysis plugin run results

After your sequencing run completes, review plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.
Reports for any plugins that have completed analysis are included in the
Summary.

3. In the left navigation menu, click RNASeqAnalysis to view the plugin results.
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4. In the RNASeqAnalysis section, you can view the Barcode Summary for the
RNASeqAnalysis plugin. The summary includes columns for Barcode Name,
Sample, Total Reads, Aligned Reads, Percent Aligned, Mean Read Length, Genes
Detected, and Isoforms Detected. Click the RNASeqAnalysis.html link to open
the report in the browser tab.

• Click the RNASeqAnalysis.html link to view the RNASeqAnalysis Report
for all barcodes.

• Click the links at the bottom of the report to download associated report files:

Link name Download description

Barcode Summary
Report

A table that lists the sample name for each barcode,
total reads, aligned reads and percent aligned.

absolute reads table A table that lists absolute reads for the genes found
for each barcode.

absolute normalized
reads table

A table that lists absolute normalized reads for the
genes found for each barcode.

aligned reads
distribution table

A table that lists the distribution of genes across
barcodes to show the frequency of numbers of genes
having similar log10 read counts.

isoform FPKM values
table

The isoform gene heatmap in a table format.

Click the links at the bottom of the RNASeqAnalysis Report to download
raw analysis output files for the selected barcode. For examples, see 
“Individual barcode view“ on page 163.

Link name Raw analysis output file description

Download the Statistics
Summary

An overview of the individual barcodes from the
RNASeqAnalysis plugin results.

Gene Read Counts A table that lists the number of times a gene was
counted for the individual barcodes.

Output Files A directory for various output files for the selected
barcode.

Cufflinks Output Files A list of links to Cuflinks output files.

Click individual barcode names to see graphs for the selected barcode. For
examples, see “Downloadable reports for individual RNASeqAnalysis plugin
barcodes“ on page 161.

Link name Download description

Reference table Plot that shows the number of genes that have reads
in log10 counting bins.

Gene Mapping Summary Summary of reads mapped to genes of the annotated
reference.

Base Mapping Summary Summary of base reads aligned to genetic features of
an annotated reference.
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Link name Download description

Normalized Transcript
Coverage

A plot of normalized transcript coverage that shows
the frequence of base reads with respect to the
length of individual transcripts as they are aligned to
in the 3" to 5" orientation.

Gene Isoform Expression Box plots showing variation of isoforms expressed at
FPKM ≥ 0.3 for each set of genes grouped by the
number of anticipated (annotated) isoforms.
Whiskers are defined by points within Q1-1.5xIQR to
Q3+1.5xIQR. Only genes with 25 or less isoforms are
represented in this plot. The data and a plot for all
genes are available for download using the download
reports links at the bottom of the screen.

• Click the Distribution Plots, Correlation Heatmap, Correlation Plot, and
Gene Heatmap tabs to review the following data graphically.

Graphical report Description

Distribution Plots For details, see “Distribution Plots“ on page 165.

Correlation Heatmap For details, see “Correlation heatmap“ on page 168.

Correlation Plot For details, see “Correlation plot“ on page 168.

Gene Heatmap For details, see “Gene heatmap“ on page 169.

Isoform Heatmap For details, see “Gene heatmap“ on page 169.

Downloadable reports for individual RNASeqAnalysis plugin barcodes

You can download raw analysis output files for individual barcodes if you click the
links at the bottom of the RNASeq Analysis Report:
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Statistics Summary - Provides an overview of the individual barcodes RNA Seq
Analysis results.

Gene Read Counts - Lists the number of times a gene was counted for the individual
barcode.
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Output Files - Provides a directory for various output files for this barcode.

Cufflinks Output Files - Provides a list of links to Cufflinks output files.

Individual barcode view

Click on any barcode of interest in the RNASeqAnalysis Report to see graphs for the
selected barcode.

Reference table - Plot showing the number of genes with reads in log10 counting
bins.
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Gene Mapping Summary - Summary of reads mapped to genes of annotated
reference.

Base Mapping Summary - Summary of base reads aligned to genetic features of an
annotated reference.

Normalized Transcript Coverage - A plot of normalized transcript coverage; the
frequency of base reads with respect to the length of individual transcripts they are
aligned to in the 3' to 5' orientation.

Gene Isoform Expression - Box plots showing variation of isoforms expressed at
FPKM ≥ 0.3 for each set of genes grouped by the number of anticipated (annotated)
isoforms. Whiskers are defined by points within Q1-1.5xIQR to Q3+1.5xIQR. Only
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genes with 25 or less isoforms are represented in this plot. The data and a plot for all
genes are available for download using the download reports links at the bottom of
the screen.

Distribution Plots

Reads Alignment Summary- A graphical summary of the number of mapped and
unmapped reads across barcodes, as reported in the barcode summary table.
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Alignment Distribution - A graphical summary of the distribution of reads to
genomic features.

Normalized Transcript Coverage - An overlay of individual normalized transcript
coverage plots for each barcode.
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Distribution of Gene Reads - Distribution of genes across barcodes showing the
frequency of numbers of genes having similar log10 read counts. All curves are
plotted on the same axis scale. The counts data is fitted to a Gaussian kernel using the
default R 'density' function.

Distribution of Isoform Reads - Distribution of transcript isoforms across barcodes
showing the counts of isoforms having similar FPKM values. All curves are plotted on
the same y-axis, normalized to the highest count and scaled for FPKM values ≥0.3.
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Correlation heatmap

A heatmap of Spearman correlation r-values for comparing log2 RPM reads pair
correlation barcodes, with dendrogram reflecting ordering of barcodes as being most
similar by these values.

Correlation plot

Barcode read pair correlation plot. Lower panels show log2(RPM+1) values plotted for
each pair of barcodes, with linear least squares regression line overlaid and line slope
reported. Upper panels show Pearson correlation r-values for the regression line.
Diagonal panels show the frequency density plot for the individual log(RPM+1)
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values for each barcode. (If only one barcode has reads, a density plot is displayed.)
Click the plot to open an expanded view in a new window.

Gene heatmap

A gene representation heatmap of 250 genes showing the most variation in
representation across barcodes as measured by the coefficient of variant (CV) of
normalized read counts for genes that have at least one barcode with at least 100 RPM
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reads, plotted using log10 of those counts. For this plot, barcodes will be omitted if
they have less than 100,000 total reads.

Isoform heatmap

A transcript isoform representation heatmap of up to 250 gene transcript isoforms
showing the most variation in representation across barcodes as measured by the
coefficient of variation (CV) of FPKM values for isoforms that have an FKPM value ≥
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100 for at least one barcode, plotted using log10 of FKPM+1. Barcodes are excluded if
they have less than 1,000 isoforms detected at FPKM values ≥ 0.3.
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Integration with Ion Reporter™

Software

Ion Reporter™ Software performs analysis on BAM files that are output from Torrent
Suite™ Software. VCF output files, that result from using the variantCaller plugin, can
also be transferred and used for Ion Reporter™ Software analyses, provided that an
annotation-only workflow is used to process the files in Ion Reporter™ Software.

Note: Ion Reporter™ Software is available under separate license and is not included
with Torrent Suite™ Software.

To transfer these BAM and VCF output files to Ion Reporter™ Software, you must add
one or more Ion Reporter™ Software accounts. You can add accounts at any time, or
when you configure the IonReporterUploader plugin. After an account is configured,
there are several ways that you can transfer files to an organization in Ion Reporter™

Software.
• Torrent Suite™ Software can automatically transfer file from a completed run

report to Ion Reporter™ Software and either:
– Available as analyses in Ion Reporter™ Software. In this case, the output files

are transferred to Ion Reporter™ Software and the workflow of your choice
Ion Reporter™ Software is automatically launched on your newly transferred
samples.

– Available in Ion Reporter™ Software as BAM and VCF files that can be later
defined as samples in Ion Reporter™ Software.

• You can optionally choose to manually upload of data to Ion Reporter™ Software
Use this option if, for example, you want to upload data to Ion Reporter™

Software multiple servers. To manually upload data from Torrent Suite™ Software
to Ion Reporter™ Software, do one of the following:

– Run the plugin manually from a completed run report.
– Select the option to review results from a completed run in Torrent Suite™

Software when you create a Planned Run.

Note: When the IonReporterUploader plugin defines samples from the newly
transferred samples for Ion Reporter™ Software, sample relationships for paired and
trio samples and sample attributes are also defined. For details, see “Sample
gender“ on page 179.
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Install the IonReporterUploader plugin on a Torrent Server

The IonReporterUploader plugin is automatically installed on a Torrent Server when
you update to a new release of Ion Reporter™ Software.

To update the IonReporterUploader plugin on Ion Reporter™ Software that is
connected to the Internet, you can use the off-cycle plugin upgrade process. For
details, see “Enable off-cycle product updates“ on page 289 and “Update off-cycle
release plugins“ on page 290.

If you do not have an Internet connection, then download and install the latest version
that is named IonReporterUploader_<version>.deb from http://
iru.ionreporter.thermofisher.com/.

Note: An administrative account is not required for this procedure.

1. Click  (Settings)4Plugins.
The list of plugins opens.

2. Click Install or Upgrade Plugin.

3. Click Upload a Plugin file, then browse to and select the
IonReporterUploader.zip file that you downloaded. Click Open, click Upload
and Install.

The new IonReporterUploader plugin is added to the list of plugins in Torrent Suite™

Software.

Set up an account for IonReporterUploader plugin

Before you can transfer files to Ion Reporter™ Software with the IonReporterUploader
plugin, you must configure a valid Ion Reporter™ Software account. Torrent Suite™

Software uses the account information to transfer output files to an Ion Reporter™

Software organization.

You can add more than one account for the IonReporterUploader plugin. When you
add multiple accounts, any available account can be selected when the plugin is run,
or when you manually upload output files to Ion Reporter™ Software. You can upload
the Torrent Suite™ Software output files to any of the Ion Reporter™ Software accounts
that are available in Torrent Suite™ Software.

IMPORTANT! When you upgrade to a new version of Ion Reporter™ Software you
must reconfigure your IonReporterUploader plugin with a Ion Reporter™ Software
account that is set up for the new version of Ion Reporter™ Software. This account
must be set up before you can access the IonReporterUploader plugin from the
updated software.

1. Sign in to Torrent Suite™ Software as either an administrative user or a standard
user.

2. Click  (Settings)4 Ion Reporter Configure:
The Ion Reporter Uploader Account Configuration screen opens.
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3. Click Add Account, then select an account type:

Option Description

Ion Reporter™ Software on Thermo Fisher Cloud Select Ion Reporter Cloud

Ion Reporter™ Software on Ion Reporter™ Server Select Ion Reporter

Ion Reporter™ Software on Thermo Fisher Cloud—
China version

Select Ion Reporter Cloud -
China

4. Enter the appropriate information into the Add Ion Reporter account screen.

Note: Ask your system administrator for values for a local Ion Reporter™ Server.

Setting Description

Server Type Enable HTTPS.

Display Name Enter a name of your choice for the account. This name can be
selected when you configure a run plan template or run the
Ion Reporter Uploader plugin manually. Use only the
alphanumeric, dash, underscore, and space characters.

Server Enter: 40.dataloader.ionreporter.iontorrent.com, or the
address for your local Ion Reporter™ Software server.

Port 443 is the port number that is automatically populated.

Username Enter your Ion Reporter™ Software username (your email
address)

Password Enter the password you use to Sign in to Ion Reporter™

Software

5. Select one of the following options:

• Default The account that is configured by default in the run templates and
Planned Runs. If the main account is for file transfers, enable the Default
checkbox. You can change the default account later when you set up a
Planned Run template, or through the Upload to IR menu on the completed
run report.

• Get Versions Select an available version of the software.

Note: This option is available if multiple versions of Ion Reporter™ Software are
available and multiple accounts are configured.

6. Click Add.

7. (Optional) The IonReporterUploader plugin can manage multiple configurations.
To add another configuration, repeat the procedure.
Two email notifications are sent each time that a IonReporterUploader plugin
finishes a run. The first is sent when the plugin run starts. Another is sent when
the upload to Ion Reporter™ Software is finished. The notifications are sent to the
email address of the Ion Reporter™ Software user whose is signed in when the
IonReporterUploader plugin is launched.

When at least one account is successfully configured, the IonReporterUploader plugin
is ready to transfer output files to Ion Reporter™ Software. If you set up multiple
accounts, the accounts are listed in the Upload to IR menu in the completed run
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report that you can use to manually upload output files to Ion Reporter™ Software.
The accounts are also listed when you configure a Ion Reporter™ Software Planned
Run or Planned Run template.

Observation Possible cause Recommended action

Ion Reporter account is not configured
Red status on Ion Reporter Software account
configuration screen.

If you change your account
password, you will see a red
dot in the status column of
the IonReporterUploader
account.

When you change your
password, click Edit and enter
your new password.

If you upgrade the account,
you will see a red dot in the
status column of the
IonReporterUploader
account.

When you upgrade your
account to a new version,
click Edit, then delete your
old account and create a new
account for the new version.

Automatically transfer Torrent Suite™ Software output to Ion
Reporter™ Software

To transfer output files from a Torrent Suite Software analysis to Torrent Suite™

Software automatically, configure the IonReporterUploader plugin when you create a
Planned Run.

The results files that are transferred to Ion Reporter™ Software can be:
• Automatically defined as samples Ion Reporter™ Software that are launched in a
workflow immediately after the instrument run is complete. Successful analyses
are then available in Ion Reporter™ Software when you sign in with the account
that is included in the setup.

IMPORTANT! To set this up, you must include select the IonReporterUploader
plugin and select the Ion Reporter™ Software workflow in the Planned Run.

• Made available in Ion Reporter™ Software as output files (BAM and VCF files)
that can be later defined as samples in Ion Reporter™ Software. In this case, you
can define your samples and then launch the analysis manually in Ion Reporter™

Software. This approach is commonly used if you want to annotate the VCF files,
using the Annotation-only workflow in Ion Reporter™ Software.

Note: VCF files are available as output files if you configure the Ion Reporter™

Software plugin. For details, see “Variant calls in Torrent Suite Software“ on
page 191.

For sequencing runs that use barcoded data, select the correct barcode kit under Kits
in the workflow bar. When you select a barcode kit, a sample name field for each
barcode is generated.
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We recommend that you use the plan by Sample Set feature when you configure the
Ion Reporter™ Software in your Planned Run or template. For details, see “Plan by
Sample Set“ on page 55.

1. In the Plan tab, click Templates, then select a Research Application. For
example, AmpliSeq DNA.

2. Select a template that matches your panel. For instance, if you are using an Ion
AmpliSeq™ Exome Panel, select the AmpliSeq™ DNA template with the same
name.

3. Add samples, ensure the default settings, then enter a plan name, then select Ion
Reporter in the workflow bar.

4. Select the Ion Reporter™ account that you want to use by default for the transfer of
output files to Ion Reporter™ Software. Data files are transferred to the default
Ion Reporter™ Software account, unless you change it during run planning.

IMPORTANT! If you select None, you must transfer the Torrent Suite™ Software
manually to Ion Reporter™ Software.

If the Ion Reporter™ account is not configured, click Configure to add an account.
See “Set up an account for IonReporterUploader plugin“ on page 173 for more
information.

5. Select a Sample Grouping that corresponds to the sample relationship in Ion
Reporter™ Software. When you select a Sample Grouping, the workflow menu
in Ion Reporter™ Software displays only workflows that match the type of
workflows selected.

6. Select an option in the Existing Workflow menu:

Option Description

Select a workflow
Ion Reporter™

Software for your
sample type.

The workflow will be automatically launched Ion Reporter™

Software with the sample data from the run. Successful
analyses will be available in Ion Reporter™ Software with the
account and organization that you selected.

Select Upload Only Use this option to transfer only the output files from the
sequencing run to Ion Reporter™ Software. If you use this
option, you can access the samples in Ion Reporter™ Software.
VCF files will also be available, if you ran the variantCaller
plugin.

7. (Optional) Click Create New Workflow to open Ion Reporter™ Software in a new
browser window. In Ion Reporter™ Software, create your new workflow, then
save it.
When you return to your Torrent Suite™ Software, refresh your browser. You can
then select the newly created workflow in the Existing Workflow menu.
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8. Select an Ion Reporter Upload Option:

Option Description

Review results after
run completion, then
upload to Ion Reporter

Use this option if you want to review the completed run
report and then manually transfer the data files to Ion
Reporter™ Software.

IMPORTANT! After you review the results in
Completed Runs & Results, you must click Upload to IR
> Upload as Planned to upload the data to Ion Reporter™

Software.

Automatically upload to
Ion Reporter after run
completion

Run results are automatically uploaded to Ion Reporter™

Software. If you select a workflow, an Ion Reporter™

analysis is launched immediately after the run. Successful
analyses are then available in Ion Reporter™ when you log
into with the account that is included in the setup.

9. Continue with the steps to create the Planned Run. See “Steps in the workflow
bar“ on page 37 for more information.

10. If appropriate, enter the gender of a sample. For details, see “Sample gender“ on
page 179.

Note: If the gender of a sample is not specified or if the sample gender is
specified as "Unknown", IGV assumes that the gender of a sample is female.

11. To save the Planned Run or Planned Run template, do one of the following in the
workflow bar:

• Click Save for a new Planned Run template, enter the new template name,
and optionally mark it as a favorite.

• Click Save & Finish if you used Plan by Sample Set, then enter the new
Planned Run name.

• Click Plan Run for a new Planned Run, then enter the new run plan name
and sample information.

12. The Planned Run is ready to run on your sequencing system.
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You can reduce the number of Ion Reporter™ Software workflows that are listed when
you create a Planned Run or Run template in Torrent Suite™ Software. To do so, use
the Tag for IRU label in Ion Reporter™ Software. Only Workflows that use this tag are
listed when you plan instrument runs in Torrent Suite™ Software.

1. Sign into Ion Reporter™ Software.

2. In the Workflows tab, click Overview.

3. Select a workflow, then click Actions4Tag for IRU.

The Tag for IRU in the Details section for the workflow is changed to Yes. Only
workflows that include the Tag for IRU label are listed when you plan
instrument runs in Torrent Suite™ Software.

4. To undo, select Untag for IRU.

Manage the Ion
Reporter™

Software
workflow list

Integration with Ion Reporter™ Software
Automatically transfer Torrent Suite™ Software output to Ion Reporter™ Software

178 Torrent Suite™ Software 5.10 User Guide



Several workflows in Ion Reporter™ Software, especially copy number variation
detection and Ion AmpliSeq™ IDP trio, are limited when the sample gender is
unknown, and they return unexpected results when the gender is incorrectly
specified.

For example, in the Ion AmpliSeq™ IDP trio workflow, when the gender of the
proband is not known, variants cannot be assigned in the categories
HasMaleMaternalX and HasUnknownX.

If a sample with no gender was transferred from Torrent Suite™ Software to Ion
Reporter™ Software, go to the Sample4Sample Management screen in Ion Reporter™

Software and edit the sample to specify the gender attribute.

Note:
· You cannot edit samples that have been launched in an Ion Reporter™ Software

analysis. Instead, define new samples from the raw data files, and add the correct
gender metadata to the new samples.

· If the gender of the sample is not specified or specified as "Unknown", the
Integrative Genomics Viewer (IGV) uses female as the gender.

Run IonReporterUploader plugin manually

You can run IonReporterUploader plugin manually from a completed run report in
Torrent Suite™ Software. This process transfers data from a completed sequencing run
to Ion Reporter™ Software.

Note: For barcoded runs, you can select which barcodes that you want to include in
your plugin results. You can also select the barcode kit on the instrument prior to the
run, then run the plugin manually when the run is complete. The barcode kit that you
enter on the sequencer will be used in the run; the barcode kit that you select on the
instrument overwrites the barcode kit selected in the Planned Run.

When you run the plugin manually, you can select whether to upload only VCF files,
BAM files, or both VCF and BAM files. You might want to run IonReporterUploader
plugin manually if after a sequencing run is completed, for example, you want to
annotate variants only and therefore upload only VCF files. This option is not
available when the plugin is run from the Planned Run or run template; instead both
BAM and VCF files are uploaded to Ion Reporter™ Software.

You can also see the barcoded samples that were used the sequencing run. You have
the option to upload any barcoded sample that includes a sample name.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. Click Plugins4Select Plugins to Run link, then click IonReporterUploader.

The Configure Plugin dialog box opens.

Sample gender
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3. For runs that include barcoded samples, click Barcode Sample Settings.
You can select one or more samples to upload to Torrent Suite™ Software.

IMPORTANT! To upload a sample with a barcode, the barcode must include a
Sample name. If you select a barcode for a sample that is not named,
IonReporterUploader will not upload the sample.

a. Select the checkbox for barcodes for the sample or samples that you want to
upload. By default, all samples that include sample names are selected for
upload.

4. (Optional) To adjust speed parameters Ion Reporter™ Uploader that change the
rate at which files are uploaded, click Advanced Settings.

a. Set the Number of Parallel Streams to Default (the recommended optimal
speed) or select 1-5 to slow down upload.

b. Set File Segment Size to Default (recommended), or 16MB, 32MB, 64MB, or
128MB.

5. In the Upload Options section of the Configure Plugin dialog box, select the file
types that you want to upload: BAM, VCF, or BAM and VCF. Then click Launch
IRU in the row next to the Ion Reporter™ Software account that you want to use
for the upload.

6. Click Yes to confirm that you want to upload the data.
Your upload begins. Upload times vary depending on the speed of your internet
connection and the size of the dataset being transferred. You will receive an email
notification when the upload is complete. When the upload completes, you can
sign in to Ion Reporter™ Software, then launch an analysis on the new datasets.

IonReporterUploader plugin configuration

The following settings are configured when you set up accounts for the
IonReporterUploader plugin:

Setting Description

Server Type Enable HTTPS.

Display Name Enter a name of your choice. This name can be selected
when a run plan template is created or edited and is visible
to other Torrent Browser users. Use only the
alphanumeric, dash, underscore, and space characters.

Server Enter: 40.dataloader.ionreporter.iontorrent.com

Port Enter: 443

Username Enter your Ion Reporter™ Software username (your email
address)

Password Enter the password you use to sign in to Ion Reporter™

Software
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Setting Description

Default Enable if this account is for automatic analyses in Ion
Reporter™ Software.

Version Select the version for use with each account.

The following settings can be configured when you run the IonReporterUploader
plugin manually:

Note: You can select barcodes for the samples or samples that were used in the
sequencing run. By selecting these barcodes, you can select which samples that you
want to upload to Ion Reporter™ Software. For details, see “Run IonReporterUploader
plugin manually“ on page 179.

Setting Description

Barcode Sample Settings Select the barcodes for the sample or samples used in the
sequencing run that you want to upload to Ion Reporter™

Software.

Select Ion Reporter™

Software account
Select the Ion Reporter™ Software account that you will
use to upload files to Ion Reporter™ Software

Upload Options

BAM Select this option to upload BAM files only

VCF Select this option to upload VCF files only

BAM and VCF Select this option to upload both BAM and VCF files

Advanced Settings For details on these settings, see “Tune Ion Reporter™ Software
speed parameters“ on page 183.

Number of Parallel
Streams

Set the Number of Parallel Streams to Default (the
recommended optimal speed) or select 1-5 to slow down
upload

File Segment Size Set File Segment Size to Default (recommended), or 16MB,
32MB, 64MB, or 128MB
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IonReporterUploader plugin file transfer progress

You can monitor the progress of the transfer of analysis results files from Torrent
Suite™ Software to Ion Reporter™ Software.

To monitor
IonReporterUploader

plugin progress through the
following

See details in

Email The two email notifications for sent for each plugin run:

• When the plugin starts to transfer your files

• When the upload to Ion Reporter™ Software is finished

The notifications are sent to the email address of the Ion
Reporter™ Software user whose authentication token was
used to configure the plugin.

Torrent Suite™ Software “View plugin run status“ on page 116.

Log files “Open a plugin log“ on page 117.

You can view a list of the run reports on which the IonReporterUploader plugin has
been run, the plugin completion status, and the sizes of the plugin output.

1. Sign in to Torrent Suite™ Software.

2. Click  (Settings)4Plugins. The installed plugins are listed.

3. Click  (Actions)4Usage in the row of the IonReporterUploader plugin:

View
IonReporterUploa
der plugin status
details
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You can view the following information from the list of run reports:
• Time that the plugin runs started and ended.
• Status of the plugin run.
• Size of the plugin run result output files.

IMPORTANT! This action permanently deletes the IonReporterUploader plugin
report for a run and cannot be undone.

For details, see “Delete a plugin result“ on page 118.

Tune Ion Reporter™ Software speed parameters

You can adjust speed parameters for the Ion Reporter™ Software plugin to change the
rate at which files are uploaded.

Note: Update these settings only if file transfers from Ion Reporter™ Software plugin
are difficult or slow with the default settings.

1. In Torrent Suite™ Software, in the Data tab, click Completed Runs & Reports.

2. Click Plugins4Select Plugins to Run,
then select IonReporterUploader.

3. Click Advanced Settings.
a. Set the Number of Parallel Streams

to Default (the recommended
optimal speed) or select 1-5 to slow
down upload.

b. Set File Segment Size to Default (recommended), or 16MB, 32MB, 64MB, or
128MB.

Delete
IonReporterUploa
der plugin report
files
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Review IonReporterUploader plugin results

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click IonReporterUploader to view the plugin
results.
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4. From the IonReporterUploader, you can view information related to the data
transfer, including the name of the Ion Reporter™ Server used, the version of Ion
Reporter™ Software that is on the server, the server directory that contains the
uploaded files and the Ion Reporter™ Software organization and user account
that was used. You can also review details about barcoded samples that were
uploaded with IonReporterUploader, or failed to upload.

To do this Click

View error messages associated with the plugin run. Errors

View warnings that contain details about the barcoded
samples used in the plugin run.

Warnings

Show or hide a detailed status of the pre- and post-
processing of the data transfer.

Show detailed
status/Hide detailed
status

Open a report the data transfer in a separate browser tab. Stdout

Open the plugin log files in a separate browser tab. Log

Open a startplugin.json file that contains metadata
used by the plugin.

Input

Download a CSV file that contains a list of the uploaded and
defined samples.

Download CSV list of
samples that are
uploaded and defined
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To do this Click

Download IonReporterUploader of the plugin log files and
other plugin files.

Download IRU logs

Typically the BAM file output of your Torrent Suite™ Software analysis is uploaded to
Ion Reporter™ Software and then Ion Reporter™ Software runs through the following
major analysis phases:

1. Mapping
2. Variant calling
3. Annotation

Torrent Suite™

Software output
and Ion Reporter™

Software analysis
phases
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This table shows how Torrent Suite™ Software output files are used in Ion Reporter™

Software analyses:

Torrent Suite™ Software
output file

Output from this Torrent
Suite™ Software analysis

phase

Input to this Ion Reporter™

Software workflow

BAM file TS analysis pipeline Any except annotation-only

VCF file TS Variant Caller
(variantCaller) plugin

Annotation-only

The Ion Reporter™ Uploader plugin by default uploads both the BAM file and the
VCF file from your Torrent Server to Torrent Suite™ Software.

The following table describes the input and output file types for the analysis phases:

Analysis phase Input file type Output file type

Mapping BAM file (mapped or
unmapped)

Mapped BAM file

Variant calling Mapped BAM file VCF file

Annotation VCF file (with or without
annotations)

Annotated VCF file

Each output file type is required as input to the next analysis phase. In almost all
cases, the Ion Reporter™ Software analysis phases are performed in order.

The exception is the annotation phase. The annotation-only workflow runs this phase
by itself. (All other workflows include the annotation phase as their last analysis
phase.) The annotation-only workflow requires as input a VCF file, which can be
generated from either an Ion Reporter™ Software analysis, an Ion Reporter™ Software
analysis variantCaller plugin analysis, or a different source.
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Rescan a plugin

When you rescan a plugin, the files for the plugin are updated with any changes. For
example, if you uninstalled and reinstalled the plugin, you can rescan the plugin to
ensure that all files from the previous installation were removed.

1. Sign in to Torrent Suite™ Software.

2. Click  (Settings)4Plugins. The installed plugins are listed.

3. Click  Actions4Rescan in the row of the plugin.
You cannot complete other operations in Torrent Suite™ Software until the rescan
is complete.

Note: You can also rescan the output files from the list of reports when you view
the usage for a plugin. For details see, “View IonReporterUploader plugin status
details“ on page 182.

IonReporterUploader command-line utility

You can use the IonReporterUploader command-line utility to transfer results files to
Ion Reporter™ Software and to define samples, based on the transferred files. The
IonReporterUploader command-line utility uses your login ID to transfer run data
from Torrent Suite™ Software to Torrent Suite™ Software. The utility supports these
transfer scenarios:

• Transfer a single BAM or VCF file
• Transfer all results files for a Torrent Suite™ Software analysis
• Transfer results files that are in a single flat folder
• Transfer multiple files that are not restricted to a single folder
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You can later analyze the samples with Ion Reporter™ Software. The
IonReporterUploader command-line utility can be run on your Torrent Server, or can
be run on any standard (and current) computer that runs Linux™ Operating System,
Mac OS™, or Windows™ Operating System. You can enter IonReporterUploader
command-line utility options through command line arguments, or through a
properties file.

Note: IonReporterUploader command-line utility should not be used for uploading
samples from references other than hg19 and GRCh38. Although E-coli and animal
reference genomes can be used in Torrent Suite™ Software, they are not supported in
Ion Reporter™ Software.

The Ion Reporter™ Software can be run on any of these systems:
• Your Torrent Server
• A standard Linux™ machine
• A standard Windows™ (XP or later) machine
• A standard Macintosh™ machine

Note: IonReporterUploader command-line utility supports the upload of combined
Ion Reporter™ Software analysis results that are output by the Combine Alignments
option in the Torrent Suite™ Software Projects tab. The IonReporterUploader plugin
does not support uploading these files.

The IonReporterUploader command-line utility is an alternative to the
IonReporterUploader plugin that is included with Torrent Suite™ Software. For
information on IonReporterUploader plugin, see the Torrent Suite™ Software Help, or
the Torrent Suite™ Software 5.8 User Guide.

This procedure explains how to download and install the IonReporterUploader
command-line utility from Ion Reporter™ Software. The procedure may vary, based on
the operating system of the target computer. In general, decompress the downloaded
directory on your target machine, then copy the directory IonReporterUploader-
cli to a convenient location.

Ideally, you should download the IonReporterUploader command-line utility onto the
computer where it will be run. At a minimum, you must use a computer with the
same operating system.

IMPORTANT! Use only the decompression utility available on your local computer.
Do not decompress files on a different operating system and copy those files to a
computer that uses a different operating system.

1. Sign in to Ion Reporter™ Software, then click Settings ( )4Download Ion
Reporter Uploader.

2. Click the filename IonReporterUploader-cli.zip, then download the file
to the target computer.

3. Extract the downloaded IonReporterUploader-cli.zip file, then copy the
IonReporterUploader-cli directory to a convenient location on the target
computer.

Download
IonReporterUploa
der command-line
utility
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The IonReporterUploader command-line utility irucli is ready to run after you
extract it. Run the IonReporterUploader command-line utility from the
IonReporterUploader-cli bin directory (with the irucli.bat or irucli.sh
script). Instructions to use the IonReporterUploader command-line utility are
downloaded with the utility.

Run Ion Reporter
Uploader
command-line
utility
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Variant calls in Torrent Suite
Software

The variantCaller plugin calls single-nucleotide polymorphisms (SNPs), multi-
nucleotide polymorphisms (MNPs), insertions, deletions (INDELs), and complex
variants in a sample across a reference genome or within a targeted subset of that
reference in Torrent Suite™ Software.

You can set the plugin to run automatically after a sequencing run is completed, or
you can run the plugin manually for completed runs.

When you configure the variantCaller plugin, you can adjust parameter settings to
affect the stringency of the variant calls that are made on your data; adjustments to the
parameters balance the specificity (that is, false-positive calls) and sensitivity (that is,
true-positive calls). See “variantCaller plugin configuration“ on page 194 for more
information.

These parameter settings, when combined with the reference genome that you select,
a target regions file, and a hotspots file, comprise a configuration that you can save,
then use for subsequent runs of the variantCaller plugin. You can also choose a
predefined configuration that is included with Torrent Suite™ Software.

Note: Pre-configured plugin settings are available as predefined or custom
configurations that are available when you configure the variantCaller plugin. Use
these configurations to save significant time setup time. Predefined configurations for
use with the AmpliSeq and AmpliSeq HD research applications can also be
downloaded from ampliseq.com. See “Import panel files and parameters from
AmpliSeq.com“ on page 50.

Run the variantCaller plugin

The variantCaller plugin identifies variants and adds a VCF file to the output that is
available for completed sequencing runs. You can run the variantCaller plugin for
sequencing results in Torrent Suite™ Software.

• If you want to see variant calls immediately after a sequencing run, configure the
variantCaller plugin as part of the Planned Run.

• You can also manually configure and run the variantCaller plugin after the
sequencing run from a completed run report. You must run the plugin manually
after the run, if you want to use a reference genome, target regions file, or
hotspots file, for one or more barcodes, that is specified in the Planned Run.

Note: To get variantCaller plugin results as quickly as possible, set up the plugin to
run automatically.
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To run the variantCaller plugin automatically after the Torrent Suite™ Software
analysis completes, configure the variantCaller plugin to run by default.

Note: If the variantCaller plugin runs automatically, you can still re-run the plugin
manually after a sequencing run is completed. See “Run the variantCaller plugin
manually“ on page 193 for more information.

IMPORTANT! Parameter changes that you make in a Planned Run affect only that
specific run. If you change variantCaller plugin parameter settings in a Planned Run
template, the changes affect all users who create Planned Runs from that template.

1. Click  (Settings)4 Plugins.

2. Ensure that the Enabled checkbox in the row of the variantCaller plugin is
selected.

3. Select the Selected by Default checkbox in the row of the variantCaller plugin
name.
The plugin is now set to perform its function after every sequencing run.

4. (Optional) To disable automatic execution of the plugin, deselect the Selected by
Default checkbox in the row of the plugin.

Note: You must run the variantCaller plugin manually after the run, if you want
to use a reference genome, target regions file, or hotspots file, for one or more
barcodes, that is specified in the Planned Run.

Variants are called for each barcode that is configured to use the specific reference
genome, target regions file and hotspot file that is included in the Planned Run. See 
“Plan step in the workflow bar“ on page 45 for more information. When you
configure the variantCaller plugin in a Planned Run, you cannot change the reference
genome, target regions file, or hotspots file for any barcoded sample. The Planned
Run will use the same parameter file for all barcodes.

You can configure the barcodes and set the variantCaller plugin to run automatically
as part of a Planned Run in Torrent Suite™ Software.

Note: If the variantCaller plugin runs automatically, you can still rerun the plugin
manually after a sequencing run is completed.

IMPORTANT! The variantCaller plugin parameter settings are saved in run templates
but are not saved in Planned Runs. Parameter changes that you make in a Planned Run
affect only that specific run. When you change variantCaller plugin parameter settings
in a Planned Run template, your changes affect all users who create Planned Runs
from that template.

1. In the Plan tab, click Templates, then select a research application in the left
navigation menu.

2. Select an existing Planned Run template from the list. Alternatively, select Add
New Template, or Plan New Run to create a new Planned Run template or
Planned Run.

3. Click Plugins in the workflow bar.

Configure the
variantCaller
plugin to run by
default after every
run

Configure the
variantCaller
plugin to run as
part of a Planned
Run
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4. Select variantCaller plugin, then click Configure.

Note: The variantCaller plugin parameter settings change according to the
selections you make. Default settings might different depending on whether the
sequencing data is from an Ion PGM™, Ion Proton™, Ion S5™, and Ion
GeneStudio™ S5 Systems.

5. Select settings that are appropriate for the sequencing instrument used, the
experiment, and the frequency of the variants of interest. See “variantCaller
plugin configuration“ on page 194 for more information.

6. Click Next, or another tab in the workflow bar to make further changes to your
Planned Run.

7. When all changes to the Planned Run have been made, click Plan in the
workflow bar, then click Plan Run.

The plugin is now set to run after every sequencing run that uses the Planned Run
template or new Planned Run.

You can run the variantCaller plugin on a completed run report in Torrent Suite™

Software. If the sequencing run includes barcodes, you can apply one configuration
that you saved previously to all barcodes, or you can apply a different configuration
for individual barcodes. See “Create a custom configuration for the variantCaller
plugin“ on page 197 for more information.

1. In the Data tab, click Completed Runs & Reports screen, then click the Report
Name link for the completed sequencing run of interest.

2. Click Plugins 4Select Plugins to Run, then click the name of the plugin that
you want to run.

3. In the Select a Plugin to Run dialog box, select the variantCaller plugin, then
click Configure. The Configure Plugin window appears.

Note: The variantCaller plugin parameter settings change according to the
selections you make. Default settings might different depending on whether the
sequencing data is from an Ion PGM™, Ion Proton™, Ion S5™, and Ion
GeneStudio™ S5 Systems.

4. Select settings that are appropriate for the sequencing instrument used, the
experiment, and the frequency of the variants of interest. See “variantCaller
plugin configuration“ on page 194 for more infomation.

5. When your changes are complete, click Submit.

Note: To cancel a plugin run that is in progress, click Stop.

The variantCaller plugin reruns, then applies the changes that you made.

Run the
variantCaller
plugin manually
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1 Configuration
2 Manage Configurations/Barcodes
3 Settings included in a predefined or custom configuration
4 Add panel
5 Add targets
6 Add hotspots
7 Configuration Name
8 Load external parameter file
9 Copy selected setting to Custom

10 Show Advanced Settings

Setting Details

Configuration [1] Select a reusable predefined or a custom configuration for the
variantCaller plugin that includes settings for a Reference
Genome, Targeted Regions, Hotspots, and Parameter Settings.

See “Create a custom configuration for the variantCaller
plugin“ on page 197 for more information.

variantCaller
plugin
configuration
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Setting Details

Manage
Configurations/Barc
odes [1]

Manage and apply configurations for barcodes when you run the
variantCaller plugin manually. See “Apply configuration settings to
specific barcodes“ on page 198 for more information.

(Optional) If you want to run the variantCaller plugin manually for
a limited number of barcodes, select Skip this barcode for the
barcodes that you do not want to include in the plugin run. “Apply
configuration settings to specific barcodes“ on page 198 for more
information.

Chip Type [1] The chip type that is used in the sequencing run. If you change this
option, it affects only the fields that are selected by default in the
variantCaller Configuration screen. It does not affect the
sequencing run.

Library Type [1] Library type options include: Whole Genome, AmpliSeq, AmpliSeq
HD, or TargetSeq.

When Library Type is set to AmpliSeq, read trimming is
automatically applied to remove the primers from reads.

Variant Frequency [1] Variant frequency options include:

• Somatic – This option detects somatic variants at low allele
frequencies.

• Germline – This option detects germline variants that are
expected to be present at low allele frequencies.

• Rare SomaticThis option detects rare somatic variants in
FFPE or cfDNA samples. The option is available if and only if
AmpliSeq HD is selected as the Target Technique in the
Planned Run.

AmpliSeq Panel [1] Panels ordered from ampliseq.com have predefined variantCaller
plugin parameter settings.

For details, see “Import panel files and parameters from
AmpliSeq.com“ on page 50 for more information.

Note: When an Ion AmpliSeq™ panel is selected, the plugin
configuration screen automatically selects Target Regions,
Hotspots, and Parameter Settings files that are for use with the
panel.

Add panel [1] Upload a panel.

Reference
Genome [1]

Reference genome that is for use with variant calling.

Note: If you want to configure barcodes in the run to use the
same genome reference that was used for the current run report,
select the As Specified in the Plan for Each Barcode option. If the
selected reference genome differs from the reference genome that
is included in the Planned Run, the software must realign the data,
which requires more time for the plugin run.
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Setting Details

Targeted Regions Target Regions are the regions of interest for which you want to
call variants. If a target regions file is not provided, the
variantCaller plugin analyzes every position of the reference
genome, which typically takes longer.

If you want to configure barcodes to use the same target regions
file that is included in the current Planned Run, select the As
Specified in the Plan for Each Barcode option.

Note: Before a targeted regions file can be selected, it must be
uploaded from inTorrent Suite™ Software and associated with a
specific reference genome. See “Upload a target regions file“ on
page 240 for more information.

Add targets Upload a target regions file.

Hotspots Hotspots Regions files are BED or VCF files that define variant
alleles of interest. Hotspots Regions files instruct the variantCaller
plugin to include these variant alleles in its output files, including
evidence for a variant and the filtering thresholds that disqualified
a variant candidate. A Hotspots Regions file affects only the
variantCaller plugin, not other parts of the analysis pipeline. If you
don't specify a Hotspots Regions file, the software will only report
the de novo variants that show as present. In contrast, if a
Hotspots Region file is used, the variant calls and the filtering
metrics for each hotspot allele is reported in the output VCF file,
including data for absent or NOCALL variants.

If you want to configure Hotspots Regions files to use the same
Hotspots Regions file that is included in the current Planned Run,
select the As Specified in the Plan for Each Barcode option.

Before a hotspots file can be selected, it must be uploaded from
inTorrent Suite™ Software and associated with a specific reference
genome. See “Upload a hotspots file“ on page 242 for more
information.

IMPORTANT! A carefully designed Hotspot Region file is highly
recommended to optimize the overall performance of variant
calling. Please contact your field bioinformatics specialist (FBS)
for more information.

Add hotspots Upload a hotspots file.
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Setting Details

Parameter Settings Option to use parameter settings that predefined in the
variantCaller plugin, or to use Custom parameter settings. For Ion
AmpliSeq™ experiments, panel templates from AmpliSeq.com
might contain parameter settings that are optimized for the
variantCaller plugin and are available for use during variantCaller
plugin configuration.

• The variantCaller plugin provides generic parameter settings
that are optimized for the selected Chip Type, Library Type,
and Variant Frequency and the parameters settings that are
downloaded from AmpliSeq.com.

• Select Custom to change the advanced parameter settings.
See “variantCaller plugin advanced parameters“ on page 216
for more information.

Load external
parameter file

Option to import a file that contains parameter settings.

Copy selected
settings to Custom

Option to create a Custom parameter setting that is based on a
generic parameter setting. See “Create and use a custom
parameters setting“ on page 200for more information.

Configuration
Name [1]

Option to name and save a custom configuration when changes
are made to the predefined settings.

Show Advanced
Settings

Configure advanced parameter settings. See “variantCaller plugin
advanced parameters“ on page 216 for more information. Hover
your mouse of the field to see tooltips with descriptions of the
advanced settings.

[1] Hidden in sequencing runs that use Tag Sequencing as the target technique.

Create a custom configuration for the variantCaller plugin

You can create a custom configuration for the variantCaller plugin in Torrent Suite™

Software. Later, when you run the plugin manually, you can apply the custom
configuration to the variantCaller plugin run, or to individual barcodes that are
included in the run.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for the completed sequencing run.

2. Click Plugins4Select Plugins to Run.

3. Select the variantCaller plugin, then click Configure.
The variantCaller plugin configuration screen opens.

4. Set plugin configuration parameters. See “variantCaller plugin configuration“ on
page 194 and “Create and use a custom parameters setting“ on page 200 for
more information.

5. Enter a name for the configuration in the Configuration Name field, then click
Save.
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The new configuration is included to the Configuration drop-down list in the
variantCaller plugin configuration screen. You can apply the configuration when you
run the variantCaller plugin manually.

Apply configuration settings to specific barcodes

You can save and retrieve custom configurations, for the variantCaller plugin and
apply these custom configurations to specific barcodes when you run the
variantCaller plugin manually from a completed Torrent Suite™ Software run Report.
By applying specific custom configurations to individual barcodes you can refine your
analysis results.

You can use configurations for barcoded runs to:
• Save a variantCaller plugin configuration that applies to all barcodes.
• Apply one or more saved configurations to individual barcodes.

Note: When you apply saved configurations to specific individual barcodes, you
must run the plugin immediately after you apply the configurations. You can
apply a saved configuration to an individual sample on a chip for each barcode.
Configurations applied to individual barcodes cannot be saved.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
for the completed sequencing run of interest.

2. Click Plugins 4Select Plugins to Run, then in the Select a Plugin to Run dialog,
click variantCaller.

3. In the Configure Plugin dialog, click Manage Configurations/Barcodes, then
click OK.

4. In the Setup tab, you can apply configurations to all barcodes or specific
configurations to individual barcodes.

To Action

Apply the same configuration to
all barcodes in a sequencing run.

In the Set All dropdown list, select the
configuration to apply to all barcodes.

Apply a specific configuration to
an individual barcode.

In the Configuration column, select the
configuration from the dropdown list of available
configurations for each individual barcode.
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5. (Optional) Create a new configuration or edit an existing one.

Action Description

Edit a
configuration

1. Click Edit. The Configure Plugin dialog becomes specific to
the configuration selected.

2. Change the existing selections as desired.

Note: To add a new Panel, Target Regions, or hotspots
file, you will be redirected to the appropriate Settings ( )
page. You must close the Configure Plugin dialog, then
reopen the dialog to access the new file.

3. Click Show Advanced Settings, edit the Parameters as
necessary, then click Hide Advanced Settings when
complete.

4. Click Save.

Delete a
configuration

1. Click Delete.

2. Click OK to confirm.

Create a new
configuration

1. Click Add.

2. Enter a Configuration Name.

3. Make selections from the available dropdown lists.

4. Click Save.
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Create and use a custom parameters setting

You can create a custom parameters setting that you can save and reuse. The custom
parameters setting that you create can be used with a manual run of the variantCaller
plugin. If you want to use a customized parameter file that is designed for your
customized panel or other special requirements, you must create a custom parameter
setting, then run variantCaller plugin manually with the custom parameter setting.

The parameter file in the variantCaller plugin is a JSON text file that contains the
variant calling parameters listed in “variantCaller plugin advanced parameters“ on
page 216.

1. In the Data tab, in the Completed Runs & Reports screen, click on the report
name of the run you want to apply configuration settings to.

2. Click Plugins4Select Plugins to Run, then in the Select a Plugin to Run dialog
box, click variantCaller.

3. In the Parameter Settings section, click Custom.

To . . . Do this . . .

Use an JSON
parameters file that
you have saved on your
computer

1. Click Load external parameter file

2. Browse to the JSON file, then click Open.

Edit a predefined
parameters setting

1. In the Configuration dropdown list, select the
predefined parameter setting that you want to edit.

2. Click Copy selected to Custom.

3. If you agree to save the new custom parameter
setting, click OK.

4. Click Show Advanced Settings to enter changes for
the custom parameter settings.

You can edit the values of the advanced parameter settings. Predefined
parameter settings are in read-only mode and cannot be edited.

The custom parameters setting is now ready to be applied to run results when you
run the variantCaller plugin manually.

Review variantCaller plugin run results

After your variantCaller plugin run completes, you can access variantCaller run
results from the run report page in Torrent Suite™ Software. On the run report page,
in the variantCaller pane you can:

• Review the summary of the variantCaller run for each barcode used.
• Review the library type, reference genome, targeted regions, hotspots file, and

parameter settings that were used in the run.
• Download data files for all barcodes as well as each individual barcode or

sample.
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You can also access the detailed variantCaller plugin summary report for each
barcode or sample from the variantCaller pane on the run report page. In the detailed
variantCaller plugin summary report browser, you can:

• View variant call information by allele for the specific barcode, such as allele
location on the chromosome, allele annotations, coverage metrics, and quality
metrics.

• Review the library type, reference genome, targeted regions, hotspots, and
parameter settings that were used in the run.

• Download BED files and Parameters File used for the specific barcode.
• Download BAM and BAI files for the mapped and TVC-processed reads.
• Download data files for variant calls and covereage for the specific barcode.
• View variant calls in IGV.

variantCaller plugin supports SNPs, MNPs, INDELs, and complex alleles as input
candidates at genomic positions with the target regions file. If the variant is outside of
the target regions, then the variant is not generated as a candidate and is not further
evaluated, even if the variant is specified in the Hotspots file.

1. In the Data tab, click Completed Runs & Reports.

2. In the Completed Runs & Reports list, locate the run of interest, then click the
report link in the Report Name column in the row of the run.

3. In the left navigation menu, click variantCaller to navigate to the variantCaller
results pane.

• If the sequencing run contains barcodes, the plugin report includes a list of
the barcodes that were used and file download options for all barcodes and
each individual barcode.
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Downloads options for all barcodes that were used in the plugin run

Download option Description

VCF.ZIP A compressed directory that contains separate VCF files for
each barcode.

XLS.ZIP A compressed directory that contains separate XLS files for
each barcode.

XLS A file that contains a list of alleles for all barcodes in a tab-
separated file that can be opened by Microsoft™ Excel™.

COV A file that contains the coverage of the variant call results
for all barcodes in tab-separated file format, which can be
opened in Microsoft™ Excel™.

• If the sequencing run does not contain barcodes, the plugin report contains
information for the sample used in the run and the file download options for
the sample.

4. To open the detailed variantCaller plugin summary report for a specific barcode
or sample, click one of the following links in the variantCaller run summary
table:

• Barcode name link in the Barcode name column in a barcoded sequencing
run report.

• Sample name link in the Sample column in a report from a sequencing run
that does not contain barcodes.
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The detailed variantCaller plugin summary report contains variantCaller run
information, results, and the associated files for download that are specific for an
individual barcode or sample.

1

2

3

4

1 Review run information for a specific barcode or sample and download the associated
files.

2 View variants called and their associated allele annotation information, coverage metrics,
and quality metrics. For more information, see “Variant Calls by Allele table“ on page 205.

3 Export the variant data files for troubleshooting. For more information, see “Export files
for troubleshooting“ on page 214.

4 Adjust variantCaller plugin filter settings that were used for the specific barcode or
sample, then save the adjusted parameters to a new configuration. For more information,
see “Save adjusted parameters to a variantCaller plugin configuration“ on page 215.

Download options for an individual barcode or the sample used in the run

Download option Description

Target Regions BED – The BED file that specifies the genomic positions of interest

Hotspot Regions BED – The BED file that specifies the variant alleles of interest

Effective Regions BED – The BED file that specifies the regions actually processed in
the variantCaller run for the sample or barcode (available if read
trimming is enabled)

Parameter Settings JSON – The JSON file that contains the parameter settings used in
the variantCaller run for the sample or barcode

Detailed
variantCaller
plugin summary
report
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Download option Description

Mapped Reads • BAM – The BAM file that is input to Variant Caller Pipeline for
discovering and evaluating variants. Note that realignment
may be applied.

• BAI – The BAI file that contains the index information for the
corresponding BAM file

Torrent Variant
Caller-Processed
Reads

• BAM – The BAM file that is processed by Torrent Variant
Caller. Note that read trimming and read filtering may be
applied. In Tag Sequencing and AmpliSeq HD runs, the BAM
file may contain consensus reads that are obtained by
compressing the reads in the Mapped BAM that originate
from the same DNA molecule.

• BAI – The BAI file that contains the index information for the
corresponding BAM file

Variants Calls • VCF.GZ - The compressed VCF file that contains the variant
calls

• VCF.GZ.TBI - The index file for VCF.GZ

• XLS - The file that contains a list of variant alleles in the tab-
separated file format, which can be opened in Microsoft™

Excel™.

• COV - The file that contains coverage analysis for each variant
call, which can be opened in Microsoft™ Excel™.

Variants + Non-
Variant Coverage

• gVCF.GZ - The bgzip-compressed genome-VCF file that
contains the variant calls

• gVCF.GZ.TBI - The tabix index file for gVCF.GZ

View Variant Calls in
IGV

IGV - The JNLP file that can be opened using IGV to visualize the
variant calls.
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The Variant Calls by Allele table is located in the detailed variantCaller plugin
summary report. The table displays the details about each variant called, including
the allele locus, allele annotation, coverage metrics, and quality metrics for the specific
barcode or sample. You can use the table to find the variant alleles of interest and
information about those allele. You can also export the information to be saved to
your local storage.

1

2

4

3

1 Find the variants of interest by applying filters to the table to narrow down the list of
variants called.

2 Change the display of the table to view allele annotation, coverage metrics, or quality
metrics for each variant. To switch between different displays, you can choose one of the
following tabs.

• View Allele Annotation; see “View allele annotations “ on page 206 for more
information.

• View Coverage Metrics; see “View coverage metrics “ on page 207 for more
information.

• View Quality Metrics; see “View quality metrics“ on page 208 for more information.
3 • Click the column header to sort variant alleles by the values in the column.
4 Export the information associated with the selected variant alleles to an XLS file. The

exported XLS file holds all the information about the selected variants, including the
information listed in the View Allele Annotation, View Coverage Metrics, and View Quality
Metrics tabs. For more information, see “Export variant calls to a file“ on page 208.

Key variant information

Column Description

Position The chromosome (or contig) name in the reference genome, and
the position of the chromosome (or contig) in the one-based
coordinate.

Ref The reference base(s).

Variant Variant allele base(s).

Allele Call The zygosity (Homozygouse or Heterozygous) or type (Absent or
No Call) of the allele that is called by the The zygosity
(Homozygouse or Heterozygous) or type (Absent or No Call) of the
allele all by the variant caller.

Var Freq Frequency of the variant allele.

Variant Calls by
Allele table
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Column Description

Quality Phred-scored quality field. [1] Larger values mean higher
confidence in the call.

Quality is calculated by posterior probability that the variant allele
frequency is greater than the cutoff (min_allele_freq in the
parameter file, if a variant call is made), or posterior probability
that the variant allele frequency is below this cutoff (if a reference
call). The posterior probability that is computed as conditional on
the reads observed includes sampling variability.

Note: Quality score is typically very large for reads strongly
distinguishing variants with good depth, that is, under the model
assumed, evidence is overwhelming for the variant or for the
reference. Marginal values in this field can mean either the reads
do not distinguish the variant well, there is insufficient depth to
resolve, or the observed allele frequency is near the cutoff.

LOD[2] The Limit Of Detection (LOD) at the genome location, estimated
based on the number of detected molecules.

(Optional) PPA An indication (0 or 1) of the variant allele is a Possible Polypoidy
Allele (PPA) or not. The column is available if the parameter
"report_ppa" is set to be 1.

For Torrent Suite™ Software 5.4 and 5.6, heterozygous or
homozygous alleles are labeled as PPA.

For Torrent Suite™ Software 5.8 and later, heterozygous and
homozygous alleles are no longer treated as PPA. Only absent
alleles can be labeled as PPA.

[1] For variants found by Long Indel Assembler, this value is always set to 50.
[2] This column is available only for sequencing runs that use the Tag Sequencing or AmpliSeq HD as the Target 

Technique in the Planned Run. See “Research Application step in the workflow bar“ on page 40 for more 
information.

You can view the following information in the View Allele Annotations tab of the
Variant Calls by Allele table.

Column Description

Allele Call Decision whether the allele is detected (Heterozygous or
Homozygous), not detected (Absent), or filtered (No Call). No Call
and Absent are for hotspot calls only.

Subset Of The name of the called allele that is a strict superset of the two
SNPs. For example, if a called (homozygous or heterozygous) MNP
is composed of two SNPs, then the MNP is considered to be a
strict superset of the two SNPs.

View allele
annotations 
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Column Description

Variant Type The type of the variant called.

• SNP– single nucleotide polymorphism

• IND–insertion

• DEL–deletion

• MNP– multiple nucleotide polymorphism or the substitution
of a block sequence by the block of another length

• COMPLEX– Block substitution of sequence by a block of
unequal length

Allele Source Allele source is called as:

• Hotspot–for alleles included in the hotspots file.

• Novel–for all other alleles.

Allele Name The allele name as defined in the hotspots file. For novel alleles, in
Torrent Suite™ Software 5.4 and later, the name is defined as
tvc.novel.#.

Gene ID The Gene ID as defined in the target regions file.

Region Name The region name as defined in the target regions file.

You can view the following information in the View Coverage Metrics tab of the
Variant Calls by Allele table.

Column Description

Total Read Cov Total read coverage at this position, after downsampling [1]

Read Cov + Total read coverage on the forward strand, after downsampling.

Read Cov - Total read coverage on the reverse strand, after downsampling.

Allele Read Cov The number of reads that contain this allele, after downsampling.

Allele Read Freq [2] The frequency of this allele across all reads.

Total Mol Cov[2] Number of molecules covering this location.

Allele Mol Cov[2] Number of detected molecules containing this allele.

Allele Mol Freq[2] Frequency of molecules containing this allele.

Allele Cov + Allele coverage on the forward strand, after downsampling

Allele Cov - Allele coverage on the reverse strand, after downsampling

Strand bias Discrepancy between allele frequencies on the forward and
reverse strands

[1] Variants calls are made on a sample of reads when coverage is higher than specified in the parameter 
settings file. This is referred to as "downsampling". See downsample_to_coverage in variantCaller plugin 
advanced parameters.

[2] Hidden in sequencing runs that use Tag Sequencing as the target technique.

View coverage
metrics 
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You can view the following information in the View Quality Metrics tab of the
Variant Calls by Allele table.

Note: This tab does not appear in Tag Sequencing runs.

Column Description

Common Signal
Shift

Distance between predicted and observed signal at the allele
locus. [RBI]

Reference Signal
Shift

Distance between predicted and observed signal in the reference
allele. [REFB]

Variant Signal Shift Distance between predicted and observed signal in the variant
allele. [VARB]

Relative Read
Quality

Phred-scaled mean log-likelihood difference between the
prediction under reference and variant hypothesis. [MLLD]

HP Length Homopolymer length.

Context Error + Probability of sequence-specific error on the forward strand
(reported only for deletion variants).

Context Error - Probability of sequence-specific error on the reverse strand
(reported only for deletion variants).

Context Strand Bias Basespace strand bias (reported only for deletion variants).

For candidates that are filtered out, the filtering reason is highlighted in the table.

You can export your variant calls to a tab-separated file that can be opened using
spreadsheet software such as Microsoft™ Excel™. The exported file is named
subtable.xls and has the same columns that are included in the Variant Calls by
Allele table (including columns for all three display options: View Allele
Annotations, View Coverage Metrics, and View Quality Metrics).

View quality
metrics

Export variant
calls to a file
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1. In the Data tab, in the Completed Runs & Reports screen, click on the report
name of the run from which you want to export variant calls to a file.

2. In the left navigation menu, click variantCaller, then open the detailed
variantCaller plugin report for a specific barcode or sample.

• Click the barcode name link in the Barcode name column in a barcoded
sequencing run report.

• Click the sample name link in the Sample column in a report from a
sequencing run that does not contain barcodes.

3. In the Variant Calls by Allele table, select the checkbox in the row of each
variant you want to export, then click the Export Selected.

4. Select Download table file of selected rows, then click OK.
The subtable.xls file is created and dowloaded to your computer.

5. (Optional) View the file and save to your local storage using a descriptive file
name.
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You can troubleshoot results in the variantCaller plugin detailed report to analyze
why expected variants were missed (false negatives) or to examine false positives.
Plugin parameters can be adjusted and the plugin can be rerun. You can also export
troubleshooting results to share them with a field bioinformatics specialist (FBS).

Find false negatives with an alignment viewer

When an expected variant is not called by the variantCaller plugin, an alignment
viewer, such as Integrative Genomics Viewer (IGV) or Ion Reporter™ Genomic Viewer
(IRGV) can help you confirm the absence of the variant in the sample, or help you
understand how to adjust the plugin parameters to enable the plugin to call the
variant. Using the IGV or IRGV can reveal problems such as mismapping or low
coverage. In particular, an alignment viewer lets you visually inspect the coverage of
the region where the variant is expected, and focus attention on the depth of coverage
and the quality of the bases covering the position of the variant. Low coverage or low
base quality can explain a no-call. A genomic viewer can also reveal that variant is
slightly misplaced (especially for INDELs) and therefore not called.

1. On the detailed variantCaller plugin summary report screen, click IGV to open
the viewer.

Troubleshoot
variantCaller
plugin results

Variant calls in Torrent Suite Software
Review variantCaller plugin run results

210 Torrent Suite™ Software 5.10 User Guide



2. In the viewer, select the chromosome where the variant of interest is located,
scroll to the chromosomal position of the variant, then zoom in until you can
read the nucleotide sequence surrounding the variant allele.
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3. Hover over a variant read to view read analytics.

4. Adjust plugin parameters.

5. Rerun the variantCaller plugin.

Find false negatives using the variantCaller plugin report

You can also use built-in variantCaller plugin tools to display and examine call
details.

• If a hotspots file was used:
a. Check that the position of the variant is included in the hotspots file.
b. Check the Variant Calls output table. Values that cause a candidate to be
filtered out are shown in colored cells:
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c. Adjust plugin parameters.
d. Rerun the variantCaller plugin.

• If a hotspots file was not used:
a. Navigate to the variantCaller plugin results directory on the Torrent Server

and open the small_variants_filtered.vcf file.
– Open the detailed report in Torrent Suite™ Software, then click the

Barcode Name link in a report from a barcoded sequencing run. Or, click
the Sample Name link in a report from a non-barcoded sequencing run.
Scroll to, or search for the small_variants_filtered.vcf link. You
can click the link to view the file in the browser or download the file to
your computer.

– On Linux backend, the variantCaller plugin results directory can be
found
at /results/analysis/output/Home/{analysis_report_name}/plugins/variant
Caller/ for non-barcoded runs
or /results/analysis/output/Home/{analysis_report_name}/plugins/variant
Caller/{bar code}/ for barcoded runs.

b. Find the location of the variant, then examine the FR field (filtered reason).
c. Relate the reason to plugin run parameters using the parameter definitions in 

“variantCaller plugin advanced parameters“ on page 216.
d. Adjust plugin parameters.
e. Rerun the variantCaller plugin.

Fix false positives

False positives are usually related to artifacts that create unexpected amplification,
such as a primer-dimer or contamination problems. Some false positives are reported
because of the difficulties inherent with the handling of homopolymer regions.

Use one of the following methods to resolve these issues:
• Adjust parameters that control the homopolymer calls. This can increase the

report of false negatives.
• If you are repeatedly running a panel, manually curate specific sites (positions),

since the false positive tends to occur in the same positions.

Note: Currently, the variantCaller plugin does not support manual curation. Manual
curation is available in the command-line version.

Variant calls in Torrent Suite Software
Review variantCaller plugin run results

Torrent Suite™ Software 5.10 User Guide 213



Export files for troubleshooting

Torrent Suite™ Software includes a tool that helps you determine why variant calls are
unclear in analyses. You can use the Slicer tool to select one or more variant calls, then
export the related data as miniature BAM, BED, and VCF files. You can then share
these files with a field bioinformatics specialist for further review.

Navigate to the variantCaller plugin output table, then follow the steps listed below.

1

2

3

4

5

6

1 Click Show Troubleshooting.
2 Select the variant or variants of interest.
3 Click Export for Troubleshooting.
4 Enter the Expectant Variant.
5 Click Export.
6 Wait for the export process to complete, then click Download the zip.

The compressed directory of miniature BAM, BED, and VCF files is downloaded to
the directory, according to your browser settings.
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Save adjusted parameters to a variantCaller plugin configuration

You can adjust the variantCaller plugin parameters that are used for the barcode, then
save the adjusted parameters to a configuration.

Note: The reference genome, target regions, and hotspots files in the saved
configuration inherit the files that are used to obtain the variantCaller plugin results
for this barcode.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
for the completed sequencing run of interest.

2. In the left navigation menu click variantCaller, or scroll to the variantCaller
results section.

3. Click the barcode name link to open the detailed variantCaller plugin summary
page.

4. Click Show Filter Settings, then adjust the Parameter threshold values.

5. Enter the Configuration Name that stored the adjusted parameters, then click
Save to Configuration.

6. To apply the updated configuration to additional barcodes, run the plugin
manually, then assign the saved configuration with the adjusted parameters to
the desired barcodes.

Variant calls in Torrent Suite Software
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variantCaller plugin advanced parameters

Advanced parameter settings for the variantCaller plugin allow additional
customization of the variant calling algorithm and are for advanced users only.
Contact your field bioinformatics specialist (FBS) if you need assistance.

In general, you can safely customize parameters for SNP calling. For INDEL calling,
changes to the parameters tend to have a significant impact on the number of INDELs
called. As a result, we highly recommend that you consider the trade-off between
sensitivity and specificity for INDEL calls when you optimize customized parameters.

The variant calling pipeline in variantCaller plugin consists of three modules:
FreeBayes, Torrent Variant Caller, and Long Indel Assembler. FreeBayes, as a
candidate generator, generates lists of variant candidates. The lists of candidates are
then evaluated by Torrent Variant Caller to examine the evidence of the variants in
flow space. Yet, some long INDELs may not be properly aligned to the reference
genome and, hence, cannot be discovered and evaluated by FreeBayes and Torrent
Variant Caller, respectively. The Long Indel Assembler aims to call long INDELs of
this type. There is a unification step in the pipeline that merges the variants called by
Torrent Variant Caller and the Long Indel Assembler into one VCF file that is available
to the user.

IMPORTANT! These parameters are recommended for advanced users only.

Advanced parameters for the variantCaller plugin

Parameter Description

X_min_allele_freq X is one of the allele types in {indel, snp, mnp, hotspot}

A variant evaluation parameter: The presence of the allele of the
type is defined by which allele frequency is greater than this value

Allowed values: Decimal between 0 and 1

Suggested trial value: between 0.01 (somatic) and 0.2 (germline)

X_min_variant_score X is one of the allele type in {indel, snp, mnp, hotspot}

A filter parameter: A called allele of the type needs to have a QUAL
score greater than this Phred-scaled value.

Filter reason: quality score.

Related VCF fields: QUAL

Allowed values: decimal values >=0

Suggested trial value: >10

X_min_coverage X is one of the allele type in {indel, snp, mnp, hotspot}

A filter parameter: The location of a called allele of the type needs
to have a coverage greater than this value

Filter reason: MINCOV

Related VCF fields: FRO, FAO

Allowed values: Integers >= 0

Suggested trial value: between 5 and 20

Variant calls in Torrent Suite Software
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Parameter Description

X_min_cov_each_str
and

X is one of the allele type in {indel, snp, mnp, hotspot}

A filter parameter: Minimum coverage required on each strand for
a the type of allele to be called.

Filter reason: PosCov or NegCov

Related VCF fields: FSRF, FSRR, FSAF, FSAR

Allowed values: Integers >= 0

Suggested trial value: >= 3

X_strand_bias X is one of the allele type in {indel, snp, mnp, hotspot}

A filter parameter: A candidate allele of the type will be filtered out
if its strand bias p-value is less than X_strand_bias_pval and its
strand bias is greater than X_strand_bias. The parameter is
critical for filtering out the false positive calls due to the strand-
specific sequencing error.

Filter reason: STDBIAS and STDBIASPVAL

Related VCF field: STB

Allowed values: Decimal numbers between 0.5 (requires perfect
balance on both strands) and 1.0 (tolerates extremely strong
strand bias)

Suggested trial value: 0.95

X_strand_bias_pval X is one of the allele type in {indel, snp, mnp, hotspot}

A filter parameter: A candidate allele of the type will be filtered out
if its strand bias p-value is less than X_strand_bias_pval and its
strand bias is greater than X_snp_strand_bias

Filter reason: STDBIAS and STDBIASPVAL

Related VCF field: STBP

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.01 for strand bias filter, 1 for no strand
bias filter

X_min_var_coverage X is one of the allele types in {indel, snp, mnp, and hotspot}. A
filter parameter: Minimum number of variant coverage after flow-
evaluation required to make the call.

Filter reason: VarCov

Related VCF field: FAO

Allowed values: Integer >=0

Suggested trial value: 3 (TagSequencing or AmpliSeq HD), 0
(other)

downsample_to_cov
erage

Reduce coverage in over-sampled locations to this value to save
computational time

Allowed values: Integers >= 1

Suggested trial value: 400 (germline), 2000 (somatic)

Variant calls in Torrent Suite Software
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Parameter Description

use_fd_param (experimental in Torrent Suite Software 5.4)

A filtering parameter: Use Flow Disruptiveness (FD) instead of
allele types (INDEL, SNP, MNP) as the criterion to select the
parameter set.

If turned on, the (non-FD, weak FD, strong FD) allele applies the
(INDEL, SNP, MNP) parameters, respectively.

If powered on, the (non-FD, weak FD, strong FD) allele applies the
(INDEL, SNP, MNP) parameters, respectively.

Allowed values: 0: do not use FD parameters, 1: use FD
parameters.

data_quality_stringe
ncy

A filter parameter: A called variant needs to have a mean log-
likelihood difference per read greater than this Phred-scaled value

Filter reason: STRINGENCY

Related VCF field: MLLD

Allowed values: Decimal numbers >= 0

Suggested trial value: >= 6.5

filter_unusual_predi
ctions

A filter parameter: A called variant needs to have RBI less than
this value. The parameter is critical for filtering out the false
positive calls due to the strand-specific sequencing error.

Filter reason: PREDICTIONSHIFTx

Related VCF fields: RBI = sqrt(FWDB ^ 2 + REVB ^ 2)

Allowed values: Decimal numbers >= 0

Suggested trial value: 0.3

filter_deletion_predi
ctions

A filter parameter: Filter out a deletion if the observed clusters
deviate from predictions more than this amount

Filter reason: PREDICTIONVarSHIFTx or PREDICTIONRefSHIFTx

Related VCF fields: VARB, REFB

Allowed values: Decimal numbers >= 0

Suggested trial value: 0.2

filter_insertion_pred
ictions

A filter parameter: Filter out an insertion if the observed clusters
deviate from predictions more than this amount.

Filter reason: PREDICTIONVarSHIFTx or PREDICTIONRefSHIFTx

Related VCF fields: VARB, REFB

Allowed values: Decimal numbers >= 0

Suggested trial value: 0.2

Variant calls in Torrent Suite Software
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Parameter Description

min_tag_fam_size An evaluation parameter for Tag Sequencing and AmpliSeq HD
runs only: Minimum number of reads with same molecular tag
required to form a functional molecular family.

Allowed values: Integer >=1

Suggested trial value: 3

min_fam_per_strand
_cov

An evaluation parameter for Tag Sequencing and AmpliSeq HD
runs only: Minimum required coverage of reads on each strand in
a bi-directional functional molecular tag family.

Allowed values: Integers >=0

Suggested trial value: 1

tag_trim_method An evaluation parameter for Tag Sequencing and AmpliSeq HD
only: Requirement of the molecular tag of the read must match
the format specified in the Planned Run.

Allowed values: strict-trim (requires match), sloppy-trim (does
not require match)

Suggested trial value: sloppy-trim

indel_func_size_offs
et

An evaluation parameter for Tag Sequencing and AmpliSeq HD
runs only: requires a family size >= (min_tag_fam_size + this
value) to be functional for calling HP-INDEL.

Allowed values: Integers >=0

Suggested trial value: 0

heavy_tailed A variant evaluation parameter: (2*heavy_tailed-1) is the degree of
freedom of the t-distribution for modeling the heavy tail in signal
residual distribution

Allowed values: Integers >= 1

Suggested trial value: 3

outlier_probability A variant evaluation parameter: probability that a read comes from
none of the models under consideration.

The variantCaller plugin will make NOCALL with filter reason
REJECTION if FXX is too high.

Related VCF field: FXX

Allowed values: Decimal numbers between 0 and 1.0

Suggested trial value: between 0.005 and 0.01

prediction_precision A variant evaluation parameter: The number of pseudo data points
suggesting our predictions match the measurements without bias

Allowed values: Decimal numbers >= 0.1

Suggested trial value: 1.0

Variant calls in Torrent Suite Software
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Parameter Description

max_flows_to_test A variant candidate evaluating parameter: The maximum number
of scoring flows being used.

Allowed values: Integers > 0

Suggested trial value: 10

suppress_recalibrati
on

A variant evaluation parameter: Homopolymer recalibration values
should not be used when set

Allowed values: 0 = enable recalibration, 1 = disable recalibration

Suggested trial value: 0

do_snp_realignment A variant candidate evaluating parameter: Realign reads in the
vicinity of SNP candidates when set

Related VCF content: REALIGNEDx

Allowed values: 0 = do not realign, 1 = realign

Suggested trial value: 0

do_mnp_realignmen
t

A variant candidate evaluating parameter: Realign reads in the
vicinity of MNP candidates when set

Related VCF content: REALIGNEDx

Allowed values: 0 = do not realign, 1 = realign

Suggested trial value: 0

realignment_thresho
ld

A variant candidate evaluating parameter: Maximum allowed
fraction of reads where realignment causes an alignment change

Related VCF content: SKIPREALIGNx

Allowed values: Decimals between 0 and 1

Suggested trial value: 1

min_ratio_for_fd A filter parameter: Claim flow-disruption if the portion of reads
that are flow-disrupted >= this value

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.1

indel_as_hpindel A filter parameter: A flag indicating whether INDEL filters or SNP
filters should be applied to non-HP indels

Allowed values: 0 (false), 1 (true)

hp_max_length A filter parameter: HP indels of more than this length will be
filtered out

Filter reason: HPLEN

Related VCF field: HRUN

Allowed values: Integers >= 1

Suggested trial value: 8

Variant calls in Torrent Suite Software
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Parameter Description

hp_indel_hrun A filter parameter: Define the HRUN for filtering HP-INDEL
variants with lengths specified by 'hp_del_len' and 'hp_ins_len'.

Filter reason: HPINSLEN, HPDELLEN

Related VCF field: HRUN

Allowed values: vector of positive integers (e.g. [1,2,3]) with size
matches 'hp_del_len' and 'hp_ins_len'

Suggested trial value: []

hp_ins_len A filter parameter: Filter out HP-INS variants whose INS length <=
the corresponding entry of this vector if the HRUN is defined in
'hp_indel_hrun'.

Filter reason: HPINSLEN

Related VCF field: HRUN

Allowed values: vector of non-negative integers (e.g. [1,2,3]) with
size matches 'hp_del_len' and 'hp_indel_hrun'

Suggested trial value: []

hp_del_len A filter parameter: Filter out HP-DEL variants whose DEL length
<= the corresponding entry of this vector if the HRUN is defined in
'hp_indel_hrun'.

Filter reason: HPDELLEN

Related VCF field: HRUN

Allowed values: vector of non-negative integers (e.g. [1,2,3]) with
size matches 'hp_ins_len' and 'hp_indel_hrun'

Suggested trial value: []

use_position_bias A filter parameter: Enable the position bias filter when set

Filter reason: POSBIAS, POSBIASPVAL

Allowed values: 0 = disable, 1= enable

Suggested trial value: (AmpliSeq) 1, (other) 0

position_bias A filter parameter: Filter out a variant if the position bias is greater
than position_bias and the position bias p-value is less than
position_bias_pval

Filter reason: POSBIAS, POSBIASPVAL Related VCF field:
POSBIAS

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.75

Variant calls in Torrent Suite Software
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Parameter Description

position_bias_pval A filter parameter: Filter out a variant if the position bias is greater
than position_bias and the position bias p-value is less than
position_bias_pval

Filter reason: POSBIAS, POSBIASPVAL Related VCF field:
POSBIASPVAL

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.05

position_bias_ref_fr
action

A filter parameter: Skip the position bias filter if (reference read
count) / (reference and alt read count) <= this value

Filter reason: POSBIAS, POSBIAS-PVAL

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.05

error_motifs The file name of the error motif file

sse_prob_threshold A filter parameter: Filter threshold for motif-predicted error
probability

Filter reason: NOCALLxPredictedSSE, NOCALLxPositiveSSE,
NOCALLxNegativeSSE

Related VCF fields: SSEP, SSEN

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.02

report_ppa A reporting parameter: Report Possible Polyploidy Alleles (PPA) in
the VCF file and the variant calls in the XLS files.

Related VCF field: PPA

Allowed values: 1 = report PPA, 0 = do not report

Note: This feature is experimental and by default is set to
report_ppa = 0 (do not report).
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The Long Indel Assembler advanced settings parameters control the behavior of the
Long Indel Assembler, a module within the variantCaller plugin.

IMPORTANT! These parameters are recommended for advanced users only.

Parameter Description

kmer_len Size of the smallest k-mer used in assembly

Impact: Increasing values make indel calls less sensitive but more
specific

Allowed values: Integers >= 5

Suggested trial value: 11 and 30

min_var_freq Minimum frequency of the variant to be reported

Impact: Increasing values make indel calls less sensitive but more
specific

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.1 and 0.4

min_var_count Minimum support for a variant to be evaluated

Impact: Increasing values make indel calls less sensitive but more
specific

Allowed values: Integers > 1

Suggested trial value: 3 and 30

short_suffix_match Minimum assembled sequence match on both sides of the variant

Impact: Increasing values make indel calls less sensitive but more
specific

Allowed values: Integers > 2

Suggested trial value: 4 and kmer_len

min_indel_size Minimum size indel reported by assembly

Impact: Increasing values make indel calls less sensitive but more
specific

Allowed values: Integers > 0

Suggested trial value: 2 and 30

max_hp_length Variants containing HP larger than this are not reported

Impact: Increasing values make indel calls more sensitive but less
specific

Allowed values: Integers > 1

Suggested trial value: 2 and 11

Long Indel
Assembler
advanced settings
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Parameter Description

relative_strand_bias Variants with strand bias above this are not reported

Impact: Increasing values make indel calls more sensitive but less
specific

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.6 and 1.0

output_mnv Enables reporting of complex variants

Allowed values: 1 = report complex variants, 0 = don't report

Suggested trial value: 0

These parameters control the behavior of the FreeBayes module, which performs read
filtering and generates lists of variant candidates.

IMPORTANT! These parameters are recommended for advanced users only.

Parameter Description

allow_indels Candidate generation parameter: Allow INDEL candidates to be
generated when set

Allowed values: 0 = does not generate indel candidates, 1 =
generates INDEL candidates

Suggested trial value: 1

allow_snps Candidate generation parameter: Allow SNP candidates to be
generated when set

Allowed values: 0 = does not generate SNP candidates, 1 =
generates SNP candidates

Suggested trial value: 1

allow_mnps Candidate generation parameter: Allow MNP candidates to be
generated when set

Allowed values: 0 = does not generate MNP candidates , 1 =
generates MNP candidates

Suggested trial value: 1

allow_complex Candidate generation parameter: Allow complex variant
candidates to be generated when set

Allowed values: 0 = does not generate complex candidates, 1 =
generates complex candidates

Suggested trial value: 1

FreeBayes
advanced settings
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Parameter Description

gen_min_alt_allele_f
req

A candidate generation parameter: A non-HP-INDEL candidate
needs to have an allele frequency greater than this value in the
pileup

Allowed values:Decimal numbers between 0 and 1

Suggested trial value: 0.02 to 0.15

gen_min_indel_alt_a
llele_freq

A candidate generation parameter: An HP-INDEL candidate needs
to have an allele frequency greater than this value in the pileup

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.02 to 0.15

gen_min_coverage A candidate generation parameter: A variant candidate location
needs to have coverage depth greater than this value

Allowed values: Integers >= 0

Suggested trial value: 6

min_mapping_qv A read filtering parameter: Minimum mapping quality value
required for a read to be counted (for both candidate generation
and variant evaluation)

Allowed values: >= 0

Suggested trial value: 4

read_snp_limit A read filtering parameter: Do not use reads with number of SNPs
above this

Allowed values: Integers >= 0

Suggested trial value: 10

read_max_mismatch
_fraction

A read filtering parameter: Ignore reads with fraction of mismatch
greater than this value

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 1.0

min_cov_fraction A read filtering parameter: Do not use reads with fraction of
covering the best assigned unmerged target region below this.

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.9 (TagSequending and Ampliseq HD), 0
(otherwise)

read_mismatch_limi
t

A read filtering parameter: Do not use reads with number of
mismatches (where 1 gap open counts 1) above this value.

Allowed values: Integers >= 0 (0 disables the filter)

Suggested trial value: 5 (Tag Sequencing and AmpliSeq HD), 0
(other)
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Parameter Comments Recommended
value

tvcargs This field is for internal use "tvc"

tmapargs The desirable arguments for aligning the
BAM file

"tmap mapall . . . -J
25 --end-repair 15 --
do -repeat-clip --
context stage1
map4" (ampliseq),
"tmap" (others)|

unifyargs This field is for internal use "tvcutils unify_vcf"

Variant calls in Torrent Suite Software
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Reference Management

References in Torrent Suite™ Software include the reference genome sequences, barcode
sets, test fragments and other files that filter or restrict genomic sequencing and
analysis to the regions of interest. Before you can use some of these files in sequencing
runs, you must upload or import the files to the Torrent Server that is connected to the
sequencing instrument.

• Reference Sequences
Import preloaded Torrent Suite™ Software validated reference genome sequences,
or a custom reference genome to add them to Planned Runs and Planned Run
templates.

• Obsolete Reference Sequences
Reference sequences become obsolete and are listed in the Obsolete References
Sequences screen after Torrent Suite™ Software is updated with a release that
includes a new TMAP index.

• Target Regions
You must upload these files to add them to your Planned Runs.

• Hotspots
You must upload these files to add them to your Planned Runs. The variantCaller
plugin generates output files that include these positions whether or not a variant
is called, and include evidence for a variant and the filtering thresholds that
disqualified a variant candidate.

• Test Fragments
You can use these known sequences to monitor system characteristics.

• Barcodes
You must upload Ion barcode sets or your own custom barcodes sets for use in
sequencing runs.

• Upload History
Review records of recent uploads of target regions, hotspots, and ampliseq.com
zip files.

Reference sequences

In order to identify genetic variations within a nucleic acid sample, sequencing reads
are aligned to a reference genome sequence. The Torrent Suite™ Software comes
preloaded with reference genome files containing genomic sequences that represent
several species, including two commonly used human genome references – hg19 and
GRCh38. You can also import a custom reference file to use for your sequence
analysis.

Note: As part of the standard analysis process in Torrent Suite™ Software, reads are
aligned to a genomic reference using the TMAP aligner that comes preinstalled on the
Torrent Server. For more information, see “TMAP Modules“ on page 360.
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The Human Genome version 19 (hg19) reference is a human genome reference that is
based on the Genome Reference Consortium's human genome assembly version 37
with patch 5 (GRCh37.p5), and its equivalent UCSC hg19 reference. See the Genome
Reference Consortium's website: ncbi.nlm.nih.gov/grc/human/data for more
information. There are several notable differences between the hg19 reference in the
Torrent Suite™ Software and the GRCh37.p5/UCSC hg19 reference sequences:

• The Y chromosome PAR regions in the hg19 reference are hard masked with 'N',
while the GRCh37.p5 reference Y chromosome PAR regions are unmasked.

• Three nucleotide positions that are masked with 'N' in the GRCh37/UCSC hg19
reference have IUPAC ambiguity codes in hg19 reference sequence.

• The hg19 reference in the Torrent Suite™ Software uses the Revised Cambridge
Reference Sequence (rCRS) for chromosome M, while UCSC hg19 uses the
original chromosome M sequence.

For more information, see genome.ucsc.edu/cgi-bin/
hgGateway?org=human&db=hg19. To download sequence and annotation data, go to
Genome Browser FTP server at hgdownload.soe.ucsc.edu/goldenPath/hg19 or the
Downloads page at hgdownload.soe.ucsc.edu/downloads.html#human.

Hard masked PAR regions in chromosome Y

The mammalian Y chromosome contains regions that are virtually identical to the X
chromosome called pseudoautosomal regions (PARs). These regions allow for
recombination between the sex chromosomes. When the human Y chromosome was
sequenced and assembled, the PAR regions were not sequenced, and therefore were
not included in the assembly. Instead, the corresponding sections from the X
chromosome sequence were copied onto the Y chromosome. This duplication must be
taken into account when performing sequence analysis so that allelic duplication can
be distinguished from other types of duplications such as repeats and segmental
duplication. When the female DNA sample is sequenced, reads from the PAR regions
will align to both the X and the Y PAR sequences. This affects the mapping quality of
the reads in these regions as well as creates issues with variant calling on the gender
chromosomes. For this reason, the PAR sequence on the Y chromosome is replaced
with 'N', or "hard masked", in the hg19 reference. In the GRCh37 reference, the PAR
sequence is unmasked. Hard masking the PAR sequence on the Y chromosome
preserves the PAR coordinates on the Y chromosome and eliminates the duplication
at this locus. The Y chromosome in the hg19 assembly contains two PAR regions that
are taken from the corresponding regions in the X chromosome and have identical
DNA sequences.

Chromosome Y PAR coordinates Corresponding chromosome X PAR
coordinates

10,001–2,649,520 60,001–2,699,520

59,034,050–59,363,566 154,931,044–155,260,560

Three positions with ambiguity codes

Three positions on chromosome 3 are masked with 'N' in the UCSC version of the
hg19/GRCh37 reference genome. These positions have IUPAC ambiguity codes in our
hg19 version:

M – IUPAC code for A or C nucleotides

hg19 reference
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P – IUPAC code for A or G nucleotides

Position IUPAC ambiguity code in
hg19 reference

Hard masked character in
UCSC hg19

60830534 M N

60830763 R N

60830764 R N

Chromosome M reference sequence.

The hg19 reference in the Torrent Suite™ Software uses the Revised Cambridge
Reference Sequence (rCRS) for the Homo sapiens mitochondrial sequence
(chromosome M or chrM) – GenBank accession number NC_012920. UCSC hg19
reference uses the original chromosome M sequence – GenBank accession number
NC_001807. UCSC begins using the rCRS for chromosome M in the GRCh38 (hg38)
assembly.

The following background information is from the UCSC site http://genome.ucsc.edu/
cgi-bin/hgGateway?org=human&db=hg19

"Since the release of the UCSC hg19 assembly, the Homo sapiens mitochondrion sequence
(represented as 'chrM' in the Genome Browser) has been replaced in GenBank with the record 
NC_012920. We have not replaced the original sequence, NC_001807 in the hg19 Genome
Browser. We plan to use the Revised Cambridge Reference Sequence (rCRS) in the next
human assembly release."

The Genome Reference Consortium's human genome assembly version 38 (GRCh38)
is the latest version of the GRC human genome reference. The GRCh38 assembly is
referred to as "hg38" in the UCSC Genome Browser and includes the following
updates to the GRCh37/UCSC hg19 version:

• Alternate sequences for highly variable genes
• Centromere representation
• Sequence updates such as fixed errors, filled gaps, and changes to chromosome

coordinates
• Updated mitochondrial genome sequence (GenBank accession number

NC_012920.1)
• Hard masked PAR regions in chromosome Y

Chromosome Y PAR coordinates Corresponding chromosome X PAR
coordinates

10,000–2,781,479 10,000–2,781,479

56,887,902–57,217,415 155,701,382–156,030,895

For more information, see genome.ucsc.edu/cgi-bin/hgGateway?db=hg38. To
download sequence and annotation data, go to Genome Browser FTP server at 
hgdownload.soe.ucsc.edu/goldenPath/hg38/ or the Downloads page at 
hgdownload.soe.ucsc.edu/downloads.html#human.

GRCh38 reference
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Import reference sequences

Torrent Suite™ Software includes validated reference sequence files that you can
download onto your Torrent Server. You can also import custom reference sequence
files from your local storage or a remote server. After you import the reference
sequence files onto your Torrent Server, the reference sequences are available for use
when you set up Planned Runs and when Torrent Suite™ Software performs data
analysis.

Torrent Suite™ Software provides a list of validated reference genome files that you
can download onto your Torrent Server. These reference files can be easily imported
into the Torrent Suite™ Software using this procedure. After you complete the import,
the references can be used in Planned Runs and data analysis in the Torrent Suite™

Software.

You must be signed in to your Torrent Server as an administrator to have permission
to import reference files.

1. Click  (Settings)4References.

2. Click Import Preloaded Ion References.

The Ion References and Downloads lists are displayed.

3. In the Ion References list, locate the file of interest.

Option Description

Reference Click Import in the row of the file to download a reference.

Annotation Files Then, to download annotation files.

1. Click Import Annotation Files.

2. In the Import Annotation Files dialog box, select the
annotations you want to import, then click Import Selected.

The file import status is displayed in the row of the file in the Ion References list.
When complete, a compressed directory in ZIP file format is added to the
Downloads list and the reference genome is added to the Reference Sequences
table. You can now use the reference genome in a Planned Run.

After the reference genome file is imported, you can edit the reference genome
information, enable the reference for use in Planned Runs, or permanently delete the
reference file from your Torrent Server. For more information, see “View a reference
sequence file“ on page 233.

Import a
preloaded
reference
sequence
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If you want to use a custom reference genome sequence in a Planned Run and data
analysis, you can import a custom reference file into the Torrent Suite™ Software from
your local storage or a remote server location.

IMPORTANT! First time users should review custom reference file rules and
restrictions to avoid uploading errors. For more information, see “Custom reference
sequence guidelines“ on page 232.

1. Click  (Settings)4References.

2. Click Import Custom Reference.

3. In the Add New Reference Genome dialog box.

• Upload a FASTA file from your local storage.
a. Select the Upload File tab.
b. Click Select File, then navigate to and select the file from your local

storage.
c. Click Open.

• Upload a FASTA file from a remote server.
a. Select the Install via URL tab.
b. In the Reference URL (required) field, enter the file path to the reference
file (for example,
http://updates/iontorrent.com/reference_downloads_mm10.zip).

Import a custom
reference
sequence
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4. Complete the information required in the following fields. This informaton is
displayed in various report outputs and the Reference Sequences table.

Field Description

Short name
(required)

Enter a recognizable short form of the genome name. Make
sure the short name does not repeat with other reference
genome files. You can delete any reference genome that you do
not use to allow the short name to be used again for a new
reference genome file. The field accepts any alphanumeric
character and underscore (_).

Description
(required)

Enter a longer, more descriptive reference genome name. The
description usually includes the genus, species, version, and
other identifying reference genome information.

Version (optional) Enter the genome version number and the accession number,
if there is one (for example, "hg19", "gi|39933080|
NC_005296.1").

Notes (optional) Use this field to record any notes about the reference genome.

5. Click Import Reference.
The reference genome and associated information is added to the Reference
Sequences table.

After the reference genome file is imported, you can view and edit the reference
genome information, or delete the reference genome file. For more information, see 
“View a reference sequence file“ on page 233. If you encounter any errors during file
upload, see “Error handling“ on page 233.

Custom reference sequence guidelines

The following are guidelines for preparing a new custom reference genome sequence
file to be imported into Torrent Suite™ Software:

• Download a FASTA format reference genome file and save it to your local
storage. FASTA files can found at ncbi.nlm.nih.gov/genome.

• The file selected for import must have a .fasta extension.
• When working with larger genomes, performance improves if you compress the

FASTA file. The Torrent Suite™ Software supports ZIP and GZIP archive file
formats, provided each archive file contains one FASTA file.

• The variantCaller plugin does not support IUPAC base codes other than A, C, T,
G, and N. When the Torrent Suite™ Software uploads a genome containing other
IUPAC characters, each such character is replaced with N.

• Prepare any related Target Regions, Hotspot files, and Reference Annotation files
to upload with the reference genome file and save them to your local storage. See 
“Target Regions and Hotspots“ on page 237 and “Import reference
sequences“ on page 230 for more information.
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Error handling

Observation Possible cause Recommended action

Reference genome file cannot
be opened

• An invalid FASTA file was
uploaded.

• No FASTA header found at
line 1.

• Genome information text
file may have been deleted.

1. Delete the existing reference sequence
entry.

2. Identify and correct formatting errors in
the FASTA file.

3. Upload the corrected file.

View a reference sequence file

After you import a reference sequence file into Torrent Suite™ Software, you can view
the file properties and review the reference sequence in the FASTA format.

To view the reference sequence file, you must first import the file into Torrent Suite™

Software. For more information, see “Import reference sequences“ on page 230.

1. Click  (Settings)4References.
The Reference Sequences screen opens.

2. Perform one of the following actions to access the reference sequence file
properties screen.

• In the Reference Sequences table, in the Short Name column, click on the
reference sequence file name.

• Click Import Preloaded Ion References, then click complete in the row of the
imported Ion reference file.
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The file properties screen opens.

3. Click on the FASTA file link to view the FASTA format reference sequence in the
browser window.
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Edit reference sequence file properties

After you import a reference sequence file into Torrent Suite™ Software, you can edit
the file properties.

To edit the reference sequence file properties, you must first import the file into
Torrent Suite™ Software. For more information, see “Import reference sequences“ on
page 230.

1. Click  (Settings)4References.
The Reference Sequences screen opens.

2. In the Reference Sequences table, in the Short Name column, click on the
reference sequence file name.
The file properties screen opens.

3. These file properties can be edited:

Property Description

Description Description of the reference.

Version Version number or letter.

Notes Any details.

Enabled References are enabled by default. To disable a reference that is not
being used anymore, deselect Enabled.

Note: You cannot edit the Short Name field. To change or reuse the reference
sequence file short name, you must delete the existing reference sequence file
from your Torrent Server and then upload a new file.

4. Click Save Changes.
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Permanently delete a reference sequence file

After you import a reference sequence file into Torrent Suite™ Software, you can
permanently delete the file from your Torrent Server. Deleting a reference sequence
file is useful if you want to upload a new file using the same Short Name as an
existing file, or you no longer require the reference for your Planned Runs.

1. Click  (Settings)4References.
The Reference Sequences screen opens.

2. In the Reference Sequences table, in the Short Name column, click on the
reference sequence file name.
The file properties screen opens.

3. Click Delete Genome4Yes, Delete It.

IMPORTANT! Recovery of a deleted reference sequence is not supported.

The reference is removed from the Reference Sequences table and is
permanently deleted from your Torrent Server.

Obsolete Reference Sequences

Reference sequences become obsolete and are listed in the Obsolete References
Sequences screen after Torrent Suite™ Software is updated with a release that
includes a new TMAP index.

Torrent Suite™ Software automatically records the libraries that were installed before
the upgrade, then automatically creates the list of obsolete reference sequences.

Note: Each list is different, depending on the reference sequences that you use.
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Target Regions and Hotspots

Target Regions and Hotspots Browser Extensible Data (BED) files supply
chromosome positions or regions as reference information during the analysis of a
sequencing run. These BED files, when applied to a reference sequence in a Planned
Run, or in a variantCaller plugin configuration, perform two functions:

• Target Regions files narrow the analysis to your regions of interest, for example,
regions that are amplified with primer panels in targeted sequencing. When a
target regions file is selected in a Planned Run, the complete Torrent Suite™

Software analysis pipeline, including plugins, is restricted to the regions of the
reference sequence specified in that file. Target regions files use BED file format
only.

• Hotspots files instruct the variantCaller plugin to include loci known to be
frequently altered in its output files, including evidence for a variant and the
filtering thresholds that disqualify a variant candidate. A hotspots file affects the
variantCaller plugin only; not other parts of the analysis pipeline. A hotspots file
is usually a BED file, or it can be a Variant Call Format (VCF) file that is generated
from a BED file by Torrent Suite™ Software during a sequencing run.

Target regions and hotspot files are listed on pages that are accessed from the
Reference Sequences link. When a target regions or hotspots file is uploaded to
Torrent Suite™ Software, it is assigned a specific reference sequence, and is then
available for use when that reference sequence is selected during run planning.

• Target regions BED files provide an option to restrict analysis to regions of
interest. Do not specify a target regions BED file in the Plan step of the Planned
Run workflow if you want variant analysis to span an entire genome. Use the
Whole Genome application with a reference sequence to support whole genome
analysis.

• All regions that are included in the target regions BED file you select are
analyzed. Follow the instructions in “Modify a BED file“ on page 245 (before
uploading your target regions BED file) to delete lines representing regions
containing variants that you do not want to call.

• The BED file coordinates (example: chr2 29443689 29443741) use zero-based
indexing and a half-open interval. The start position is included, and the range
extends up to, but not including, the end position.

• BED files that are used with Ion AmpliSeq™ panels define the internal segment
only, and do not include the primer sequence.

• A BED or VCF file is tied to a specific reference sequence. The coordinates in a
BED or VCF file must match coordinates and the coordinate sorting in the
reference sequence. Torrent Suite™ Software reference sequences are sorted alpha-
numerically (not by a chromosome sort). The BED files and VCF files that you use
with Torrent Suite™ Software references must also use an alpha-numeric sort. If
you upload your own reference genome sequence, the BED and VCF files that
you use with that reference must be sorted by the same method as your reference
file.

• The variantCaller plugin calls variant candidates at hotspot positions with higher
sensitivity than candidates at other positions. You can customize specific
variantCaller parameters separately for hotspot candidates.

Guidelines for
using target
regions and
hotspots files
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• Torrent Suite™ Software accepts VCF files as hotspots files, but the VCF file must
be generated by the variantCaller plugin from a hotspots BED file.

• Target regions and hotspots files for use with Ion AmpliSeq™ panels can be
downloaded with panel files at AmpliSeq.com. For Oncomine™ panel target
regions and hotspots files, contact your field service representative.

You can upload target regions files for use with a specific reference sequence. After
target regions files are uploaded, the files are available when the related reference
sequence is selected for use in a Planned Run. When you select a target regions file in
run planning, the sequencing run results are restricted to the regions of the reference
sequence that is specified in the target regions file.

1. To view the target regions files available on your Torrent Server, click
 (Settings)4References.

2. In the left navigation menu, click Target Regions.
Available target regions files are listed in the Target Regions table.

3. Enter a term in the Search field, or select a reference from the Reference
dropdown list to filter the list.

View and manage
target regions
files
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4. Click a target regions file name to open a Target Regions Details screen that
displays file information, including the number of targets, genes, and covered
bases, description, and notes. Scroll to view original upload information. Enter
any additional information if needed, then click Save Changes.

File information field Target regions detail

Processed File: File name; click to download the BED file to view on
your computer

Reference: Reference genome species

Number of Targets: Number of target regions included in the file

Number of Genes: Number of genes included in the target regions

Covered Bases: Number of bases covered by the target regions

Description: Short description of the file

Notes: (Optional) Additional information

Enabled: Select the checkbox to enable use of the file in Planned
Runs; deselect to prevent use in a Planned Run

5. To delete a file from the Torrent Server, click Delete.

You can upload hotspots files for use with a specific reference. After hotspot files are
uploaded, the files are available when that reference is selected for use in a Planned
Run or variantCaller plugin configuration. When you select a hotspots file in run
planning, the file instructs the variantCaller plugin to report on loci, known to be
frequently altered, in its output files.

1. To view the hotspots files available on your Torrent Server, click
 (Settings)4References.

2. In the left navigation menu, click Hotspots. Available hotspots files are listed in
the table.

View and manage
hotspots files
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3. Enter a term in the Search field, or select a reference sequence from the
Reference dropdown list to filter the list.

4. Click the name of a hotspots file to open a Hotspots Details screen that displays
file information, including the number of loci, description, and notes. Scroll to
view original upload information. Enter any additional information if needed,
then click Save Changes.

File information field Hotspots detail

Processed File: File name; click to download the BED file to view on
your computer

Reference: Reference genome species

Number of Loci: Number of hotspot alleles included in the file

Description: Short description of the file

Notes: (Optional) Additional information

Enabled: Select the checkbox to enable use of the file in Planned
Runs; deselect to prevent use in a Planned Run

5. To delete a file from the Torrent Suite™ Software, click Delete.

You can upload a target regions file from your computer to Torrent Suite™ Software.
Target regions files are BED files only. Supported file extensions are .bed, .zip, and
bed.gz. During file upload, the software validates the BED file, then ensures that the
coordinate regions of the BED file are valid for the selected reference genome. The
new BED file is then available as an option when you create a Planned Run. Your new
file appears in the Target Regions dropdown list in the Plan step of the Planned Run
workflow bar, and also appears in the Target Regions table in the References tab.

IMPORTANT! You must upload target region files that match both the reference
sequence and the reference sequence version. The uploader cannot always detect
mismatch errors. It is your responsibility to avoid the following uploading errors:

· Uploading a BED file for a reference sequence of a different version (for example,
an hg18 BED with an hg19 reference).

· Uploading a BED file for a different species.
· Uploading a hotspots BED file as a target regions BED file.

Upload a target
regions file
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To upload a target regions BED file for use with a reference sequence.

1. Click  (Settings)4References, then click Target Regions in the left navigation
menu.

2. In the Target Regions screen, click Add Target Regions.

3. In the New Target Regions screen, click Select File, then navigate to the file to be
uploaded.

4. Select the reference sequence from the Reference dropdown list.

IMPORTANT!
· Be careful to select the correct reference sequence because the new target

regions file can only be used with this reference.
· The reference sequence must be uploaded and available for selection before a

target regions file can be uploaded.

5. (Optional) Add a description and notes.

Reference Management
Target Regions and Hotspots

Torrent Suite™ Software 5.10 User Guide 241



6. Click Upload Target Regions File.
Wait while the file is validated. The status is updated to Successfully Completed
after the upload finishes. Errors are reported in the Processing Log pane.

Note: For large files, validation can take several minutes. Refresh your browser
to check that validation is complete.

You can upload a hotspots file from your computer to Torrent Suite™ Software.
Hotspots files can be BED or VCF files. Supported file extensions are .bed, .vcf.gz, .zip,
bed.gz, and .vcf.gz. During file upload, the software validates the BED or VCF file,
then ensures that the coordinate regions of the file are valid for the selected reference
sequence. The new BED file is then available as an option when you create a Planned
Run or configure the variantCaller plugin.

IMPORTANT! You must upload BED or VCF files that match both the reference
sequence and the reference sequence version. The uploader cannot always detect
mismatch errors. It is your responsibility to avoid the following uploading errors:

· Uploading a BED or VCF file to a reference sequence of a different version (for
example, an hg18 BED file with an hg19 reference).

· Uploading a BED or VCF file for a different species.
· Uploading a target regions BED file as a hotspots BED file.
· Uploading a hotspots file listing loci not included in a target regions file.

Upload a hotspots
file
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To upload a hotspots BED or VCF file for use with a reference sequence.

1. Click  (Settings)4References, then click Hotspots in the left navigation menu.

2. In the Hotspots screen, click Add Hotspots.

3. In the New Hotspots screen, click Select File, then navigate to the file to be
uploaded.

4. Select the reference sequence from the Reference dropdown list.

IMPORTANT!
· Ensure that you select the correct reference sequence because the new hotspots
file can only be used with this reference.

· The reference sequence must be uploaded and available for selection before a
hotspots file can be uploaded.

5. (Optional) Add a description and notes.
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6. Click Upload Hotspots File.
Wait while the file is validated. The status is updated to Successfully Completed
after the upload finishes. Errors are reported in the Processing Log pane.

Note:
· For large files, validation can take a few minutes. Refresh your browser to

check that validation is complete.
· If you selected a VCF file for upload, the software validates it and converts it

to a BED file.

The new file appears in the Hotspots dropdown list in the Plan step of the Planned
Run workflow bar, and also appears in the Hotspots table in the References tab.

Some types of errors do not appear in the Processing Log section. Major problems
with files can prevent file uploading.

Observation Possible cause Recommended action

File validation cannot be
attempted.

• Incorrect file format

• Incorrect file extension

• The .zip file contains no
files or multiple files

• A corrupted .zip or .gz
file

1. Check for possible
errors in the source
BED or VCF file.

2. Fix the errors, or
replace the file, then
re-attempt the upload.

Uploading errors
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You can modify an existing target regions or hotspots BED file, if necessary, to remove
regions from the file for which you do not want variants called.

If you modify a BED file, you must modify it before it is uploaded to Torrent Suite™

Software. A target regions or hotspots BED file cannot be modified after the file is
uploaded.

To modify a BED file:

1. Copy the BED file, then rename the new file in a way that reflects changes you
make to the regions being analyzed.

2. Open the BED file with a text editor.

3. Delete the lines for regions you do not want.

4. Save the file.

5. Upload the modified file as described in “Upload a target regions file“ or 
“Upload a hotspots file“.

Note:
· If the region (or regions) appears in both your target regions BED file and in

your hotspots BED file, you must delete the line for those regions from both
types of BED file.

· Do not modify a VCF hotspots file. We recommend that you upload it first to
convert it to a BED file before modifying it.

The Browser Extensible Display (BED) format is used for both target regions files and
hotspot files. The Torrent Browser also accepts the Variant Call Format (VCF) for
hotspot files.

BED files are text files with tab-separated fields.

Target regions files format

Target regions files use a BED file format in 3-column, 4-column, 6-column, and
8-column formats.

3-column Target Regions BED File Format

The 3-column BED file format is used when amplicon IDs and gene names are not
known.

The track line is optional. If present, it includes these tab-separated fields:

Field Type Description

Name string A unique design identifier.
Optional.

Description string Description of the design.
Optional.

The following is an example track line:

track name="ASD270245" description="AmpliSeq Pool ASD270245"

Modify a BED file

BED File Formats
and Examples
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In a 3-column target regions BED file, the coordinates lines require the following tab-
separated fields:

Field Type Description

chrom string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart unsigned int64 Starting position of the
feature (zero-based).

chromEnd unsigned int64 Ending position of the
feature (not inclusive). Must
be greater than chromStart.

Partial example of a 3-column target regions BED file:

chr9 133738312 133738379 chr9 133747484 133747542 chr9 
133748242 133748296 chr9 133748388 133748452 chr9 133750331 
133750405 chr9 133738312 133738379 chr9 133747484 133747542 
chr9 133748242 133748296 chr9 133748388 133748452 chr9 
133750331 133750405 chr14 105246407 105246502 chr14 105246407 
105246502 chr14 105246407 105246502 chr2 29432658 29432711

4-column Target Regions BED File Format

The 4-column BED file format is used when gene names are not known and some or
all amplicon IDs are known.

The track line is optional. If present, it includes these tab-separated fields:

Field Type Description

Name string A unique design identifier.
Optional.

Description string Description of the design.
Optional.

The following is an example track line:

track name="ASD270245" description="AmpliSeq Pool ASD270245"

In a 4-column target regions BED file, the coordinates lines require the following tab-
separated fields:
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Field Type Description

chrom string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart unsigned int64 Starting position of the
feature (zero-based).

chromEnd unsigned int64 Ending position of the
feature (not inclusive). Must
be greater than chromStart.

AmpliconID string Amplicon ID. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

Partial example of a 4-column target regions BED file:

chr9 133738312 133738379 amplID73150 chr9 133747484 133747542 
amplID73075 chr9 133748242 133748296 amplID73104 chr9 
133748388 133748452 491413 chr9 133750331 133750405 74743 chr9 
133738312 133738379 73150 chr9 133747484 133747542 73075 chr9 
133748242 133748296 73104 chr9 133748388 133748452 491413 chr9 
133750331 133750405 74743 chr14 105246407 105246502 329410 
chr2 29432658 29432711 34014

6-column Target Regions BED File Format

The 6-column BED file format is used when some or all of the gene names are known.
BED files that are generated by AmpliSeq.com use this 6-column format.

The track line is required in a 6-column target regions BED file. The following is an
example track line:

track name="ASD270245" description="AmpliSeq Pool ASD270245" ? 
type=bedDetail

The track line includes these tab-separated fields:

Field Type Description

Name string A unique design identifier.
Optional.

Description string Description of the design.
Optional.

Type string Must be "bedDetail" (without
quotes). Required.

ionVersion string Introduced in the Torrent
Suite™ Software 4.0 release.
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In a 6-column target regions BED file, the coordinates lines require the following tab-
separated fields:

Field Type Description

chrom string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart unsigned int64 Starting position of the
feature (zero-based).

chromEnd unsigned int64 Ending position of the
feature (not inclusive). Must
be greater than chromStart.

AmpliconID string Amplicon ID. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

ID string Customer-specified ID. If
missing, set to '.'. This field
is not used currently.

GeneSymbol string Gene name. If missing, set
to '.'.

Partial example of a 6-column target regions BED file:

? track name="ASD270249_v1" description="AmpliSeq Pool 
ASD270249" type=bedDetail chr9 133738312 133738379 AM73150 
NM_005157 ABL1 chr9 133747484 133747542 AM73075 NM_005157 ABL1 
chr9 133748242 133748296 AM73104 NM_005157 ABL1 chr9 133748388 
133748452 AM491413 NM_005157 ABL1 chr9 133750331 133750405 
74743 NM_005157 ABL1 chr9 133738312 133738379 73150 NM_007313 
ABL1 chr9 133747484 133747542 73075 NM_007313 ABL1 chr9 
133748242 133748296 73104 NM_007313 ABL1 chr9 133748388 
133748452 491413 NM_007313 ABL1 chr9 133750331 133750405 74743 
NM_007313 ABL1 chr14 105246407 105246502 329410 NM_001014431 
AKT1 chr14 105246407 105246502 329410 NM_001014432 AKT1 chr14 
105246407 105246502 329410 NM_005163 AKT1 chr2 29432658 
29432711 34014 NM_004304 ALK

8-column Target Regions BED File Format

An 8-column BED file format is for Fusion panels.

The additional columns are:

Field Type Description

Score Unsigned int64 Score. If missing, set to "."

Strand string (+ or -) Strand. If unknown, set to
"+".
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BED files generated by AmpliSeq.com custom designs

The track line for BED files generated by AmpliSeq.com custom designs follows the
6-column BED format, but with two additional fields. These additional fields are not
used by Torrent Suite™ Software.

Field Type Description

Name string A unique design identifier.

Description string Description of the design.

Type string "bedDetail" (without quotes).

ionVersion string Introduced in the Torrent
Suite™ Software 4.0 release.
When set to "4.0" or higher,
indicates that the BED file
supports the Extended BED
Detail format.

db string The UCSC Assembly ID.

reference string The Torrent Server
reference ID. Present for
AmpliSeq.com 5.2 and
higher.

color string Code for color track in UCSC
Genome Browser (when
uploaded from
AmpliSeq.com).

priority string Sets the order for color
track in UCSC Genome
Browser (when uploaded
from AmpliSeq.com).
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Hotspots files format

The track line is required in a HotSpots BED file. The following is an example track
line:

The track line includes these tab-separated fields:

Field Type Description

Name string A unique design identifier.
Optional.

Description string Description of the design.
Optional.

Type string Must be "bedDetail" (without
quotes). Required.

db string The UCSC Assembly ID.
Optional.

reference string The Torrent Server
reference ID. Optional for
hg19. Required for GRCh38.

The following is an example track line:

track name="ASD270245" description="HotSpots locations for 
AmpliSeq ASD270245" type=bedDetail db=hg38 reference=GRCh38.p2

In HotSpots BED files, the coordinates lines require the following tab-separated fields:

Field Type Description

chrom string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart unsigned int64 Starting position of the
feature (zero-based).

chromEnd unsigned int64 Ending position of the
feature (not inclusive). Must
be greater than chromStart.

HotSpotName string This ID is either the COSMIC
ID, dbSNP ID, or user-
defined. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"
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Field Type Description

HotSpotAlleles string This field describes the
variant, using this format
(see examples below): REF=
reference_allele ; OBS=
observed_allele ; ANCHOR=
base_before_allele

AmpliconID string Amplicon ID. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

The HotSpotAlleles field

This field specifies the alleles involved in variant calls, using this format:

REF= reference_allele; OBS= observed_allele

Examples:
• A TT insertion with 1-base prior at reference C: REF=;OBS=TT
• A TT deletion with 1-base prior at reference G: REF=TT;OBS=

Notes:
• 6-column format

– The elements can be empty: "REF=;" or "OBS=;". Empty means deletion.
– An additional element ANCHOR=base_before_allele can be provided for

backward compatibility, but is completely optional. In fact, it is
recommended that the ANCHOR key it is NOT provided for TS >= 4.2.

– Insertion alleles should have the same start and end position, and that
position corresponds to a region between two bases. SNV, MNV, deletion,
and complex variants should correspond to the reference bases that are
spanned by the event.

– The REF and OBS should be on the forward genomic strand. There should be
one alternative allele per line.

8-column format
– The +/- strand notation in the hotspot file refers to the orientation of the Ion

AmpliSeq™ design input sequence, not to the reference sequence. REF and
OBS alleles must always be reported on the forward strand of the reference
sequence.

– HotSpotAlleles are always reported based on the allele information from the
positive strand of the reference sequence. Even if the allele strand is negative,
the REF and OBS bases still report the alleles on the positive strand.

For example, if there is a hotspot either on the positive strand or on the negative
strand on a genomic coordinate, the strand information makes no difference to
what is reported on the HotSpotAlleles column. HotSpotAlleles column always
reports the alleles on the positive strand. In the following example, the strands
are different, but the reported alleles are always from the positive strand:
chr 143815007 43815009 ID1 0 - REF=TG;OBS=AA AMPL1
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chr 143815007 43815009 ID2 0 + REF=TG;OBS=AA AMPL2

Partial example of a HotSpots BED file

track name="HSMv12.1" description="AmpliSeq Pool HSMv12.1" 
type=bedDetail

chr1 43815007 43815009 COSM19193 REF=TG;OBS=AA AMPL495041 
chr1 43815008 43815009 COSM18918 REF=G;OBS=T AMPL495041 
chr1 115256527 115256528 COSM585 REF=T;OBS=A AMPL30014 
chr1 115256527 115256528 COSM586 REF=T;OBS=G AMPL30014 
chr1 115256527 115256529 COSM33693 REF=TT;OBS=CC AMPL30014 
chr1 115256527 115256529 COSM30646 REF=TT;OBS=CA AMPL30014 
chr1 115256527 115256530 COSM53223 REF=TTG;OBS=CTT AMPL30014 
chr1 115256528 115256529 COSM583 REF=T;OBS=A AMPL30014 
chr1 115256528 115256529 COSM584 REF=T;OBS=C AMPL30014 
chr1 115256528 115256529 COSM582 REF=T;OBS=G AMPL30014 
chr1 115256528 115256530 COSM12725 REF=TG;OBS=AA AMPL30014 
chr1 115256528 115256530 COSM579 REF=TG;OBS=CT AMPL30014

Note: The REF=;OBS= field is required, as is the track line.

Extended BED Detail format

AmpliSeq.com 3.0 and later uses this format for the following fixed panels:
• CCP
• CFTR
• CHP v2
• Ion AmpliSeq™ Exome

New fixed panels introduced for AmpliSeq.com 3.0 and later also follow this format.
Other panels, and all panels from previous releases, do not use this format.

The Extended BED Detail format contains two additional fields (at the end of each
line):

Name Values Description

Id Any string, if supplied by the
user, or '.'

User-supplied name or id
for the region.

Description key-value pairs separated by
semicolon, or '.' if empty

Contains a '.' or one or more
of the following:

• GENE_ID=

• SUBMITTED_REGION=

• Pool=

These key-value pairs are
described in the next table.

This table describes the key-value pairs that are supported in the Description column:
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Key Description

GENE_ID A gene symbol or comma-separated list of gene symbols. If no
gene symbol is available, this key is absent.

Example: GENE_ID = brca1

Example: GENE_ID = brca1, ret

Pool The Ampliseq.com pool or pools containing this amplicon.

Example: Pool=2

If an amplicon is present in multiple pools, the pools are
delimited with "," a comma, with the primary pool listed first. For
example, if an amplicon is present in pools 1 and 3, and 1 is the
primary pool, the entry is: Pool=1,3.

Single-pool designs do not include the Pool= key-value pair.

SUBMITTED_REGION The region name provided by the user during theAmpliSeq.com
design process. If a region name is not provided, this key is
absent.

Example: SUBMITTED_REGION=Q1

CNV_ID A gene symbol used to specify a copy number region for the cnv
pca algorithm. This will take precedence over the GENE_ID and
once CNV_ID can span multiple GENE_IDs.

CNV_HS A CNV region hotspot. This can be a value of either 0 or 1. A 1 will
report as a hotspot (HS) in the output VCF file from the CNV PCA
algorithm. A 0 will not be reported as HS.

The Extended BED Detail format requires a track line with both type=bedDetail
and ionVersion=4.0. The Torrent Suite™ Software BED validator treats these fields
(Id and Descriptor) as optional.

Examples from BED files in the Extended BED Detail format

This example shows the GENE_ID= and Pool= keys:

track name="4477685_CCP" 
description="Amplicon_Insert_4477685_CCP" type=bedDetail 
ionVersion=4.0 
chr1 2488068 2488201 242431688 . GENE_ID=TNFRSF14;Pool=2 
chr1 2489144 2489273 262048751 . GENE_ID=TNFRSF14;Pool=4 
chr1 2489772 2489907 241330530 . GENE_ID=TNFRSF14;Pool=1 
chr1 2491241 2491331 242158034 . GENE_ID=TNFRSF14;Pool=3

This example is from the CFTR designed.bed file:

track type=bedDetail ionVersion=4.0 
name="CFTRexon0313_Designed" 
description="Amplicon_Insert_CFTRexon0313" 
chr7 117119916 117120070 CFTR_1.91108 . 
GENE_ID=CFTR;Pool=1;SUBMITTED_REGION=1,31 
chr7 117120062 117120193 CFTR_1.38466 . 
GENE_ID=CFTR;Pool=2;SUBMITTED_REGION=1 
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chr7 117120186 117120304 AMPL244371551 . 
GENE_ID=CFTR;Pool=1;SUBMITTED_REGION=1,32

Merged Extended BED Detail format files

In the case of two overlapping records, those records are merged during upload into
Torrent Suite™ Software. An ampersand (&) is the delimiter between multiple values
in merged files.

Example 1

When these two GENE_ID fields appear in overlapping records:

GENE_ID = raf

GENE_ID = brca1

The merged GENE_ID field is:

GENE_ID=raf&brca1

Example 2

When these two GENE_ID fields appear in overlapping records:

GENE_ID = raf

GENE_ID = brca1,ret

The merged GENE_ID field is:

GENE_ID=raf&brca1,ret

The score and strand fields in uploaded BED files

Uploaded BED files are converted to add score and strand columns, with the default
values 0 and +. You see these values in BED files that you download from Torrent
Suite™ Software:

track type=bedDetail name="BRCA1.BRCA2_HotSpots" 
description="BRCA_HOTSPOT_ALLELES" 
allowBlockSubstitutions=true 
chr13 32890649 32890650 COSM35423 0 + REF=G;OBS=A 
AMPL223487194 
chr13 32893206 32893207 COSM23930 0 + REF=T;OBS= AMPL223519297 
chr13 32893221 32893221 COSM23939 0 + REF=;OBS=CCAATGA 
AMPL223519297 
chr13 32893290 32893291 COSM172578 0 + REF=G;OBS=T 
AMPL223521074
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RNA fusions BED file formats and examples

This page describes the target regions Browser Extensible Display (BED) format used
with Ion AmpliSeq™ RNA fusion designs. BED files are text files with tab-separated
fields.

Track line

The track line is required in the target regions BED file. The following is an example
track line:

track name=

"Fusions 2.6"

description=

"AmpliSeq RNA"

type=bedDetail ionversion="4.0"

The track line includes these tab-separated fields:

Field Type Description

Name string A unique design identifier. Optional.

Description string Description of the design. Optional.

Type string Must be "bedDetail" (without quotes).
Required.

ionVersion string Introduced in the Torrent Suite™ Software
4.0 release (AmpliSeq.com 3.0 and higher
fixed panels). When set to "4.0", indicates
that the BED file supports the 
Extended BED Detail format. Optional. This
field relates to BED File format version only,
not the version of panel designs.

Columns

This format includes 8 required columns separated by a tab (\t) character:
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Field Type Description

chrom string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart unsigned int64 Starting position of the
feature ( Insert Start not the
Amplicon Start). Must be
zero-based.

chromEnd unsigned int64 Ending position of the
feature (not inclusive) (Insert
End not the Amplicon End).
Must be greater than
chromStart.

AmpliconID string Amplicon ID. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

Score Unsigned int64 Score.If missing, set to '.'.
This field is not used
currently.

Strand string (+ or -) Strand. If unknown, set to
'+'.

ID string Customer-specified ID. If
missing, set to '.'. This field
is not used currently.

Key-value pairs string Multiple attributes specified
as semi-colon separated
key-value pairs. See below
for specific key-value pairs.
All of these KVPs are
required for Fusions designs
files, but most of these are
optional for other White
Glove designs.

Note: The Genomic (hg19) coordinates provided in the Key-Value pairs must
represent the entire Amplicon sequence. If you want to generate the fusions mapping
reference fasta file from the BED file, all the information that is needed should be
available in the BED file.

The following key-value pairs are supported:
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Key Value Example

TYPE Type of the event. Allowed
values:

• Fusion

• CONTROL or
ExpressionControl

• Driver_Gene or
5p3pAssay

• GeneExpression

• RNA_Hotspot

TYPE=Fusion

FP_TRANSCRIPT_ID Transcript ID for the Five
Prime Gene partner. This
key value pair is only for
Fusion type Targets.

FP_TRANSCRIPT_ID=ENSG
00000156735

TP_TRANSCRIPT_ID Transcript ID for the Three
Prime Gene Partner.(This
field is absent for CONTROL
type amplicons).This key
value pair is only for Fusion
type Targets.

TP_TRANSCRIPT_ID=ENSG0
0000077782

BREAKPOINT Position in the sequence for
the breakpoint. Applicable to
only FUSION Type
amplicons. This position is
number of bases from the
Insert start, not the
Amplicon Start.

BREAKPOINT=56

FP_GENE_ID Name of the Five Prime
Gene partner in the
Fusion.This key value pair is
only for Fusion type Targets.

FP_GENE_ID=BAG4

FP_GENE_STRAND Strand for the Five Prime
Gene partner. Allowed
values are '+' and '-'.This
key value pair is only for
Fusion type Targets.

FP_GENE_STRAND=+

FP_EXON_NUMBER Exon number in the Five
Prime Gene. Use comma
separated values if there the
Amplicon spans multiple
Exons.This key value pair is
only for Fusion type Targets.

FP_EXON_NUMBER=2
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Key Value Example

TP_GENE_ID Name of the Three Prime
Gene Partner in the Fusion.
(This field is absent for
CONTROL type amplicons.)
This key value pair is only
for Fusion type Targets.

TP_GENE_ID=FGFR1

TP_GENE_STRAND Strand for the Three Prime
Gene partner. Allowed
values are '+' and '-'. (This
field is absent for CONTROL
type amplicons.). This key
value pair is only for Fusion
type Targets.

TP_GENE_STRAND=-

TP_EXON_NUMBER Exon number in the Three
Prime Gene.Use comma
separated values if there the
Amplicon spans multiple
Exons. This key value pair is
only for Fusion type Targets.

TP_EXON_NUMBER=6

FP_CHROM Chromosome of the Five
Prime Gene. This key value
pair is only for Fusion type
Targets.

FP_CHROM=chr8

FP_START Start position for the Five
Prime Segments. Use
comma separated values if
there are multiple segment
Starts. This key value pair is
only for Fusion type Targets.

FP_START=38050257

FP_END End position for the Five
Prime Segments. Use
comma separated values if
there are multiple segment
Ends. This key value pair is
only for Fusion type Targets.

FP_END=38050313

TP_CHROM Chromosome of the Three
Prime Gene. (This field is
absent for CONTROL type
amplicons.) This key value
pair is only for Fusion type
Targets.

TP_CHROM=chr8

TP_START Start position for the Three
Prime Segments, Use
comma separated values if
there are multiple segment
Starts. This key value pair is
only for Fusion type Targets.

TP_START=38283673
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Key Value Example

TP_END End position for the Three
Prime Segments. Use
comma-separated values if
there are multiple segment
Ends.

TP_END=38283763

HOTSPOT_POSITION Genomic coordinate of the
hotspot snp covered by the
amplicon. Use comma
separated values if multiple
hotspots are covered by the
amplicon.

HOTSPOT_POSITION=38283
769

CHROM Chromosome name of the
target region. This key is for
all non-fusion type targets.
For Fusion targets, we have
FP_CHROM and
TP_CHROM.

CHROM=chr8

GENE_ID Name of the Gene for non-
fusion type targets. For
Fusion targets, we have
FP_GENE_ID and
TP_GENE_ID.

GENE_ID=LMNA

TRANSCRIPT_ID Transcript Id for non-fusion
type targets. For fusion
targets, we have
FP_TRANSCRIPT_ID and
TP_TRANSCRIPT_ID.

TRANSCRIPT_ID=ENST0000
0389048

GENE_STRAND Strand of the Gene. This key
is for all non-fusion type
targets. For fusion targets,
we have FP_GENE_STRAND
and TP_GENE_STRAND.

GENE_STRAND=+

EXON_NUM Exon number(s) in the Gene.
For fusion targets, we have
FP_EXON_NUM and
TP_EXON_NUM.Use comma
separated values if there the
Amplicon spans multiple
Exons.

EXON_NUM=3,4

START Start position of the Target
segment. Use comma
separated values if there are
multiple segment starts in
genomic space. This key is
for all non-fusion type
targets. For fusion targets,
we have FP_START and
TP_START.

START=53586113,53585786

Reference Management
Target Regions and Hotspots

Torrent Suite™ Software 5.10 User Guide 259



Key Value Example

END End position of the Target
segment. Use comma
separated values if there are
multiple segments in
genomic space. This key is
for all non-fusion type
targets. For fusion targets,
we have FP_END and
TP_END.

END=53586228,53585803

MIN_READ_COUNT Minimum number of reads
needed to call the particular
target as present/absent.
This value is optional and if
present, it will override the
universal minimum read
count threshold (eg: 20).
Example Usage: For EGFR
deletion assay, we would use
a higher read count
threshold (greater than 20).

MIN_READ_COUNT=100

Example BED file entries

BAG4-FGFR1.B2F6 1 156 AMP1 . + . 
TYPE=Fusion;BREAKPOINT=36;FP_GENE_ID=BAG4;FP_ GENE_STRAND=
+;FP_EXON_NUM=2;TP_GENE_ID=FGFR1;TP_GENE_STRAND=-;TP_EXON_NUM=6
;FP_CHROM=chr8;FP_START=3805025 
7;FP_END=38050313;TP_CHROM=chr8;TP_START=38283673;TP_END=382837
63;FP_TRANSCRIPT_ID=ENSG00000156735;TP_TRANSCRIPT_ID=ENSG000000
77782 ? ITGB7.ENCTRL.E14E15 ? 1 ? 132 ? ? AMP99 ? . ? ? 
+ ? . ? TYPE=CONTROL;FP_GENE_ 
ID=ITGB7;FP_CHROM=chr12;FP_EXON_NUM=14,15;FP_START=53586113,535
85786;FP_END=53586228,53585803;FP_GENE_STRA 
ND=-;FP_TRANSCRIPT_ID=ENSG00000139626

Test fragments

Test fragments are known genetic sequences used to measure the quality of your chip
loading and sequencing run. You can include test fragments in your sequencing run
and, after the run completes, review the Details section of the run report to evaluate
the quality of your loading and sequencing run. For example, TF_1 is a single known
sequence fragment that is added along with the customer library at the beginning of
templating and is processed through sequencing. TF_C is already templated on ISPs
and added after enrichment so will only go through the loading and sequencing
portions of the workflow. Test fragments are displayed when there are at least 1,000
high-quality reads, with an 85 percent match against the appropriate template in the
Test Fragment list.
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You can view existing test fragment nucleotide sequences used for quality metrics.

Torrent Suite™ Software provides six test fragments by default: TF_A, TF_B, TF_C,
TF_D, TF_G, and TF_1.

1. Click  (Settings)4 References, then click Test Fragments in the left navigation
menu.
The Test Fragments table appears.

2. In the Test Fragments table, in the Name column, click on a test fragment name
to view the test fragment details, including the complete test fragment sequence.

3. (Optional) Add comments about the test fragment in the Edit Test Fragment
dialog box.

You can add custom test fragments to Torrent Suite™ Software.

1. Click  (Settings)4References, then click Test Fragments in the left navigation
menu.
The Test Fragments dialog box opens.

2. Click Add Test Fragment.

3. In the Add New Test Fragment dialog box, fill out the information in the
following fields.

Option Description

Name Enter a unique name for your test fragment.

Key Enter the test fragment Key using only the uppercase letters: A, T, C,
and G.

Sequence Enter the Sequence using only the uppercase letters: A, T, C, and G.

Enabled Select to enable.

Comments (Optional) Enter any comments about the test fragment.

Note: If you enter an invalid character or duplicate test fragment, you will not be
able to save your changes.

4. Click Save.

Your new test fragment and its details are displayed in the test fragment table.

View test
fragment details

Add a custom test
fragment
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You can edit or delete custom test fragments in Torrent Suite™ Software.

WARNING! Do not modify the test fragment sequences for the test fragments
that are supplied by Torrent Suite™ Software: TF_A, TF_B, TF_C, TF_D, TF_G,
and TF_1. For example, TF_1 is used to assess the quality of bead loading. TF_C
is used to assess the quality of a templating and library matching.

On your own test fragment (not test fragments supplied by Torrent Suite™ Software),
you can make the following edits:

• Change the test fragment name, key, or comments.
• Change the test fragment nucleotide sequence in the Sequence field.
• Change whether or not the test fragment is enabled.

1. Click  (Settings)4References, then click Test Fragments in the left navigation
menu.
The Test Fragments table appears.

2. Click a link in the Name column.
The Edit Test Fragment dialog box appears.

3. To manage the test fragments, perform the following actions in the Edit Test
Fragment dialog box:

• Edit the Name, Key, Sequence, or Comments fields, or select/deselect the
Enabled checkbox, then click Save.

• Click Delete to permanently remove the test fragment from Torrent Suite™

Software.
• Click Cancel to exit the Edit Test Fragment dialog box without saving.

Any changes made appear in the Test Fragments table. Deleted test fragments are
removed from the Test Fragments table.

Barcodes and barcode sets

Torrent Suite™ Software supports sequencing runs in which multiple samples can be
processed, or multi-plexed. A DNA barcode adapter molecule is used to tag a sample
library when it is prepared. The sample is then identified and tracked based on the
barcode.

Barcode adapter sets are used to associate multiple adapter barcodes with each
individual sample when Planned Runs are set up, or when manual runs of Torrent
Suite™ Software plugins are configured. See “Plan step in the workflow bar“ on
page 45 and “Run a plugin manually from the sequencing run report“ on page 115.

During a sequencing run that uses barcodes, Torrent Suite™ Software generates output
files with reads that are associated with the barcodes. The barcoded reads are aligned
against the reference genome, and results are stored in BAM and BAM index (BAI)
files for each barcode. Reads that cannot be classified as into one of the barcodes in the
designated set are grouped into a no-match group; alignment against the reference is
also performed on the no-match group.

Edit or delete a
custom test
fragment
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Alignment metrics for each barcoded read are available in the run reports for
completed sequencing runs. See “Output files“ on page 101 for more information.

A sequencing run on the Ion PGM™, Ion Proton™, Ion S5™, and Ion GeneStudio™ S5
Systems that uses barcodes requires a sample preparation kit that includes a barcode
set or kit, such as the Ion Xpress™ barcode set or Ion Torrent™ Dual Barcode Kit 1–96.
Torrent Suite™ Software includes barcode sets for the latest available barcode kits.

You can create custom sets of barcode adapters with comma-separated value (CSV)
files, then upload these files onto the Torrent Server as barcode sets for use during
sequencing runs. To create the custom barcode set, you can download a sample DNA
barcode set CSV file or an existing DNA barcode set CSV file, customize the DNA
barcode set in the file, and import the custom DNA barcode set to the Torrent Server.

You can also transfer DNA barcode sets between two different Torrent Servers.

IMPORTANT! The creation of custom barcode sets is recommended for advanced
users only. Thermo Fisher Scientific recommends that you contact a field
bioinformatics specialist (FBS) for assistance with custom barcode sets.

You can view barcode ID, barcode and adapter sequences, notes, and barcode type for
individual barcodes in a barcode set.

1. Click  (Settings)4References, then click Barcodes in the left navigation menu.

2. In the DNA Barcodes table, click on the barcode name in the Name column.
A table listing all the individual barcodes within the barcode set and their
associated information appears.

3. Click any column header in bold to sort the display of that column.

If you want to edit the existing barcode set, you can download the barcode set CSV
file, edit the file, then import the revised CSV file into Torrent Suite™ Software. For
more information, see “Download a DNA barcode set CSV file“ on page 263.

You can download a DNA barcode set CSV file and save it on your local storage. This
feature can be used to transfer DNA barcode sets between two different Torrent
Servers. Alternatively, you can download an existing DNA barcode set CSV file,
customize the DNA barcode set, then import the new custom DNA barcode set onto
your Torrent Server.

1. Click  (Settings)4References, then click Barcodes in the left navigation menu.

2. In the DNA Barcodes table, in the Action column, click 
(Actions)4Download.
A CSV file containing DNA barcode information is downloaded.

Save the CSV file to your local storage. You can now transfer this file to another
Torrent Server or edit the file and import the new custom DNA barcode set into
Torrent Suite™ Software. For more information, see “Add a custom DNA barcode
set“ on page 264.

View a DNA
barcode sequence

Download a DNA
barcode set CSV
file
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You can create custom DNA barcode sets and add them to Torrent Suite™ Software for
use in Planned Runs. To add a custom barcode set, you must generate a Comma-
Separated Value (CSV), save the file to your local storage, then import the file into
Torrent Suite™ Software.

All custom DNA barcode set files must have a .csv extension.

1. Click  (Settings)4References, then click Barcodes in the left navigation menu.
The DNA Barcodes table lists all the available custom and system DNA barcode
sets.

2. (Optional) Create a custom DNA barcode set CSV file using an existing DNA
barcode set.

a. In the row of the existing DNA barcode set, click  (Actions)4Download
in the Action column.
A CSV file is automatically downloaded to your computer.

b. Edit the CSV file as described in “DNA barcode set CSV file set-up“ on
page 265, then save it to your local storage.

3. In the Barcodes screen, click Add new DNA Barcodes.

4. In the Add New DNA Barcodes dialog box, in the Barcode Set Name field, enter
a descriptive name for the custom DNA barcode set.

5. (Optional) Create a custom DNA barcode set CSV file using the example CSV file.
a. Click Download the example file.

A CSV file is automatically downloaded to your computer.

b. For each individual barcode in the barcode set, enter the information in each
column as described in “DNA barcode set CSV file set-up“ on page 265.

c. Save the CSV file to your local storage.

6. Click Choose File, select a DNA barcode set CSV file from your local storage,
then click Open.

7. Click Upload & Save.
The custom DNA barcode set is added to the DNA Barcodes table in the
Barcodes screen and is now available to be used in a Planned Run.

Add a custom DNA
barcode set
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DNA barcode set CSV file set‑up

Each row in the CSV file contains information for an individual barcode in the
barcode set.

Column Name Type Description

index Integer A unique index for an individual barcode (e.g., 1, 2,
3,...)

Note: Only numerical characters are accepted in
this field.

id_str String A unique name for an individual barcode entry.
Typically the name of the barcode kit followed by a 3
to 4 digit unique identifier, such as IonXpress_001 or
IonCode_0101.

sequence String (Required) The 5′– barcode sequence.

Note: Upper‑case G, C, A, and T are allowed.

adapter String The portion of the 5′– barcode adapter not used to
identify this barcode. Often referred to as the "stuffer
sequence".

Note: Upper‑case G, C, A, and T are allowed.

annotation -- Use this field for any barcode‑specific notes.

end_sequence String The 3′– barcode sequence.

IMPORTANT! This sequence is required for
libraries that were prepared using dual barcode
technology.

Note: Upper‑case G, C, A, and T are allowed.

end_adapter String The portion of the 3′– barcode adapter not used to
identify this barcode. Often referred to as the "stuffer
sequence".

Note:
· This sequence is available only for libraries that

were prepared using dual barcode technology.
· Upper‑case G, C, A, and T are allowed.
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After you import a custom DNA barcode set into Torrent Suite™ Software, you can
delete it from your Torrent Server if you no longer want to use the set in your Planned
Runs.

IMPORTANT! Do not delete the any system barcode set.

1. Click  (Settings)4References, then click Barcodes in the left navigation menu.

2. Select the barcode set to be deleted.

• In the DNA Barcodes table, in the row of the barcode set to be deleted, click
 (Actions)4Delete.

• In the DNA Barcodes table, in the row of the barcode set, click 
(Actions)4Edit.

• In the DNA Barcodes table, in the Name column, click on the name of the
custom DNA barcode set.

The Confirm Delete Barcode Set dialog opens.

3. Click Delete Barcode Set.

4. Click Yes, Delete! to confirm.
The DNA barcode set is permanently deleted from your Torrent Server.

Upload history

Upload History is a list of the recent uploads of compressed file directories from
ampliseq.com, target regions files, and hotspots files.

Delete a custom
DNA barcode set
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The following information is displayed.

Column Description

Uploaded File File name of the uploaded file.

Type Indicates if the file is a Target Regions,
Hotspots, or ZIP file.

Date The date that the file was uploaded.

Status A report of whether the files was
successfully uploaded.

Any errors that occur during upload will be
shown in this column.
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Data management

To avoid data loss and ensure that sufficient disk space is available on the server, you
can configure Torrent Suite™ Software to automatically archive and delete sequencing
data that are no longer needed.

You can also manually archive or delete data from individual run reports or groups of
reports, or export selected data to a mounted external drive. To understand how disk
space is allocated and how files are managed, you can view disk usage, active data
management jobs, statistics, and detailed logs on each of these activities.

Ion instrument data types

Data that are generated from Ion sequencers consists of the following types of files:
• Signal Processing Input (.dat)
• Basecalling Input (1.wells)
• Output files (.bam, plugin output, etc.)
• Intermediate files

For more details about these file types, see “Analysis pipeline overview“ on page 351.

Recommendations on when to archive each file type are listed in the following table.

File type Details

Signal Processing
Input

Signal Processing Input files (4 files per cycle) consist of the raw
voltage measurement data collected during the sequencing run.

On the Ion PGM™ System, you can reanalyze a run with the Signal
Processing Input file, which is available on the instrument. Keep
the Signal Processing Input data if you want to reanalyze the run
starting from raw signal processing data.

However, on the Ion Proton™ or Ion S5™ Systems, Signal
Processing Input data are used on the instrument, then deleted.
These files are only available on the Torrent Suite™ Software as
thumbnails for the Ion Proton™,Ion S5™ Systems or Ion
GeneStudio™ S5 Systems.
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File type Details

Basecalling Input Signal Processing Input files are converted to a single condensed
Basecalling Input file representing the processed signal.

Keep or archive Basecalling Input data if you want to reanalyze the
run. This can save time and resources because reanalyses use the
Basecalling Input data, rather than the raw Signal Processing
Input data.

On the Ion Proton™, Ion S5™ Systems, and and Ion GeneStudio™ S5
Systems, Basecalling Input data are transferred to the Torrent
Server and are available for reanalyses.

Output files Output files consist of all BAM files, run reports, and plugin
results. It is important to keep and archive these files. Delete
output files only if you are sure that you no longer need the files.

Intermediate files Intermediate files contain information used for debugging runs.
You can delete these files immediately after instrument runs,
without affecting data.

Archive or delete data automatically

To avoid data loss, it is critical that sufficient disk space is available on the server.
Therefore, it is important to have a strategy to monitor disk space and archive or
delete data as needed.

• You can configure your Torrent Server to archive data to a mounted drive
automatically after a data age threshold is met. Data that you assign to be
automatically archived are copied to the designated location, then deleted from
the Torrent Server. Automatic archiving helps to maintain available disk space,
and simplifies management of data that you want to save to another volume.

• You can also configure your Torrent Server to delete data automatically when
thresholds of filled disk space and data age are met. Automatic deletion of files is
important to maintain available disk space, and simplifies removal of data that
are no longer necessary to keep.

• You can assign automated archive or delete actions to each data file category
independently of the others.

• An administrator-level role is required for configuring data management.
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IMPORTANT! When you configure your Torrent Server to delete data automatically,
the data are permanently deleted. You cannot restore data after deletion.

1. In the Data tab, click Data Management, go the Configuration section, then click
Configure.

2. On the Data Management Configuration screen, select an auto-action, or select
Disabled for each file category, then configure:

If you select
this auto action Select these options:

Disabled No selections are necessary—data in the file category must be
archived or deleted manually.

Archive 1. Data Age Threshold (days): Set the number of days that you
want data stored on the server before data are archived.

2. Archive Directory: Select the mounted volume where you want
to store the archive, or click Browse, then navigate to the
mounted volume where you want the archive stored.

Delete 1. Data Age Threshold (days): Set the number of days that data
are stored on the server before data are deleted.

2. Disk Full Threshold (Percent): Set the percentage of disk
space that is filled on the server before data are deleted.

Data management
Archive or delete data automatically
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3. Select the Enabled checkbox to enable the automatic data management you have
configured. Deselect the checkbox to suspend automatic action.

4. Enter an email address in the Email: field to receive notifications for automatic
data management actions.

Note: If you use a Linux™ mail server, you may have access to Postfix, an open-
source Linux™ mail server. Postfix has many configuration options that IT
administrators can use to adjust mail routing parameters. You can find Postfix
documentation at http://www.postfix.org/documentation.html.

5. (Optional) To enable auto-acknowledgement of deletion of Signal Processing
Input data, select the Auto Acknowledge Delete? checkbox. Action is not
required for data deletion to occur.

Note: If you deselect Auto Acknowledge Delete, notifications are sent for each
Signal Processing Input deletion. A reviewer must manually acknowledge each
deletion action before the Signal Processing Input data are deleted.

6. After you have completed the configuration, click Save.

7. (Optional) On the Data Management screen, click Configuration Log in the
Configuration section to view a record of configuration changes.

8. (Optional) To view a record of data management actions (archiving and deleting),
click History.

Import data for data transfers or restoration

You can import data from a mounted storage drive such as an external server or USB
drive. The import function can be used to transfer data between servers or restore
data that has been archived.

Data can only be imported from storage drives that have been mounted on your
Torrent Server. For information about mounting a storage drive, see “Increase file
storage and available disk space“ on page 278.

Note:
· Exported and archived files on a mounted drive can be viewed and analyzed

directly in Torrent Suite™ Software under Completed Runs & Reports, but if you
unmount the storage device, the data will no longer be available. Import files before
unmounting a drive to continue using them.

· Imported files appear as standard data files under Completed Runs & Reports.
· The Import function can only retrieve data files that were previously exported or

archived. For example, if you try to import files from an archive that does not
include Signal Processing Input or Basecalling Input files, these files are not
retrieved.
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To import files:

1. Under the Data tab, click Data Management.

2. In the Data Import section of the screen, click Import.

3. Select a mounted Archive Directory from the dropdown list, or click Browse to
navigate to a particular subdirectory, then click Select.

4. Select the file categories that you want to import with the checkboxes, then click
Import.

View disk usage parameters

In the Data tab, click Data Management, then scroll to the Disk Usage section.
Parameters in the Disk Usage section

Parameter Definition

Keep File space devoted to files that are to be kept.

Used File space being currently used by data files.

Free Space available for storing data files.

Threshold I Threshold above which intermediate files are deleted or archived,
based on the automatic configuration settings.

Threshold S Threshold above which Signal Processing Input files are deleted or
archived, based on the automatic configuration settings.

Threshold B Threshold above which Base Caller Input files are deleted or
archived, based on the automatic configuration settings.

Threshold O Threshold above which Output files are deleted or archived, based
on the automatic configuration settings.

Note: For details regarding automatic deletion and archive creation, see “Archive or
delete data automatically“ on page 269.

View category statistics

In the Data tab, click Data Management, then scroll to the Category Statistics section.
Parameters of the Category Statistics section

Parameter Definition

File Category Group File type (see “Ion instrument data types“ on page 268 for details.)

Total Number of data sets in each file category.

Keep Number of data sets in each file category that are exempt from
data management actions.

Archived Number of data sets in each file category that have been removed
from your Torrent Server by data management archival.
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Parameter Definition

Deleted Number of data sets in each file category that have been removed
from your Torrent Server by data management deletion.

In Process Data sets that are currently archiving/deleting/importing.

Error Error column displays the count of file categories that are
currently in an error state.

Note: If a data management action is rerun on one of these file
categories and completes successfully, then that file category no
longer appears in the error count.

Disk Usage GB used by each file category.

View active data management jobs

You can view runs that are in progress on the Torrent Server.

1. Click the Data tab, click Data Management, then scroll to the Active Data
Management Jobs section.

Details regarding active data management jobs

Parameter Definition

Started On Start date and time of job.

State Status of job/file.

Report name Identifier of job.

Category Identifies the file as one of the following file types.

• Signal Processing Input: Required input files for signal
processing.

• Base calling input: Required input files for base calling.

• Output files: Files for data processing.

• Intermediate Files: Files used for debugging.

File size File size of report.

Destination Destination is the folder for archive or export action on a
report.
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Parameter Definition

User User that started the data management action. For auto-
actions, "dm-agent" is the user.

Comment Free space for notes.

2. (Optional) click a report to see the status of that report.

Monitor the Disk Space Management section for messages that require administrator
action:

Error message Action

Backup drive is full or missing Replace the backup drive.

Error Check the file /var/log/ion/
data_management.log for information
regarding the specific error condition. If
appropriate, report the error to Ion
technical support.

Torrent Suite™ Software performance is affected when a disk partition is more than
95% full. When a Torrent Server or a mounted storage device reaches 95% full (and
again at 99%), a warning is displayed at the top of the Torrent Suite™ Software screen.

*** CRITICAL! /results/: Partition is getting very full - 95% ***

Search for run reports with disk usage status

You can find run reports with searches that are based on disk usage status, such as
whether the data type is archived, or is stored in a local directory. You can also use
other search criteria, including name and report date.

1. In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Enter a search term or select for the following criteria:

• Search names
• Report date
• File type settings that are configured as Keep, are stored in the Local

directory, Archived, Deleted, In-process, or contain an Error for each file
type:

– SigProc (Signal Processing)
– Basecalling (Basecalling input)
– Output
– Intermediate

3. After you select the filters, click Go.

Error messages

Disk full message
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Run reports that match the criteria that you use in the search are listed in the Disk
Space Management table.

Keep run report data

You can prevent data from being deleted for individual run reports.

1. In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Find the report, then select the checkbox under the Keep column next to each file
category in that row.

If Keep is enabled, the data file will not be deleted. Instead, an error occurs if a user
tries to confirm a deletion of run report data.

Manually export run data

You can manually export run data to a storage device that is mounted on the Torrent
Server. When you export the data, it is copied from the Torrent Server to the archive
location. The data remains on the Torrent Server, and the run results listed in the
Completed Runs & Results screen continue to link to the data on the Torrent Server
(see “Increase file storage and available disk space“ on page 278 for more
information).

1. In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Select the checkboxes to the left of the report names that contain the run data that
you want to export, then click Process Selected.
To export data from only one run report, you can click Settings ( )4Actions to
the right of the report name.

3. In the dialog, click the checkbox to the left of each File Category for the type of
data that you want to export, then click Export Selected.

4. Click Browse to select an export directory from the list of mounted storage
devices.

5. (Optional) Enter a comment.

6. Click Confirm.
The data for the file categories of the selected run reports are copied to the
external hard drive. The data are also available in the local hard drive run results
directory.
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Manually archive run data

You can manually archive run data to storage device that is mounted on the Torrent
Server. When you archive the data, it is moved from the Torrent Server to the archive
location. The run results listed in the Completed Runs & Results screen link to the
data on the archive storage device as long as that device remains mounted on the
Torrent Server. For details, see “Increase file storage and available disk space“ on
page 278.

To manually archive run data:

1. In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Select the checkboxes to the left of the report names that contain data that you
want to archive, then click Process Selected.
To archive data from only one run report, you can alternatively click Settings
( )4Actions to the right of the report name.

3. In the dialog, click the checkbox to the left of each File Category for the type of
data that you want to archive, then click Archive Selected.

4. Click Browse to select an archive directory from the list of mounted storage
devices.

5. (Optional) Enter a comment.

6. Click Confirm.
The data in the file categories of the selected run reports are moved to the archive
location.
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Manually delete run data

You can manually delete run data from the Torrent Server.

Note: For details about automatic deletion of run data, see “Archive or delete data
automatically“ on page 269.

IMPORTANT! Use this procedure only if you are sure that you no longer require
access to the run data. After you delete data, it cannot be restored.

1. In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Select the checkboxes to the left of the report names that contain the run data that
you want to delete, then click Process Selected.
If you want to delete data from only one run report, you can click Settings
( )4Actions to the right of the report name.

Note: If Keep is enabled, the data will be kept on the local hard drive. If you try
to delete data, you will receive an error.

3. In the pop-up window, click the checkbox to the left of each File Category for the
type of data that you want to delete, then click Delete Selected.

4. (Optional) Enter a comment.

5. Click Confirm.
The data for the file categories of the selected run reports is permanently deleted
from the Torrent Server.

View the data management actions log

You can view a log for each run report that describes each change that is made to data
management settings.

1. In the Data tab, click Data Management.

2. Scroll to the Disk Space Management section.

3. Find the report for which you want to view the data management actions log.
See “Search for run reports with disk usage status“ on page 274 for details about
how to search for a run in the Disk Space Management section.
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4. Click  (Actions)4View Log.
A new screen containing chronological list of actions taken for this run report
opens. The date of the action, name of the user, and any comments are displayed.

5. Click Close to return to the Data Management page.

Increase file storage and available disk space

You can increase file storage space for data and results files with a Torrent Storage™

NAS device, your own network access storage (NAS) device, or a USB drive.

After one or more of these storage drives has been installed and configured, you can
use the drive to save data locally in the lab, transfer data between servers, store data
with disk failure tolerance, and expand storage space.

Storage method Description

Torrent Storage™ NAS
device

A field service engineer typically installs this device. It
attaches directly to a Torrent Server, Ion S5™ Instrument,
or Ion GeneStudio™ S5 System, or can connect over a local
network. After installation, it must be mounted on the local
server as described in “Connect to a Torrent Storage™ NAS
device“ on page 281.

Your own NAS device Similar to the Torrent Storage™ NAS device, but typically
installed by your own system administrator.

USB Drive Attaches directly to a Torrent Server or Ion S5™

Instrument. After installation, it must be mounted on the
local server as described in “Mount a USB drive“ on
page 278.

Mount a USB drive

To mount a USB drive (either an external hard drive or large flash drive), a working
knowledge of Linux™ command line and a basic understanding of disk drives and
partitions are necessary.

Torrent Server is an Ubuntu™ server, which does not mount external hard drives
automatically. To address this need, the ion-usbmount utility is included with
Torrent Suite™ Software. This utility automatically mounts attached USB drives in
the /media directory. If ion-usbmount does not mount a particular USB drive
automatically, follow these steps to mount the drive manually.

Note: These instructions only provide an overview of the required steps, and can be a
helpful reminder if you are new to the Linux™ operating system. We recommend that
a system administrator perform the Linux™ mount and unmount procedures. For

USB drives
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more detailed instructions and background information, see the Ubuntu™

documentation: https://help.ubuntu.com/community/Mount/USB.

1. Before connecting a USB drive, enter the following command to see a list of the
drives in the system: sudo fdisk -l
The local hard drive usually has a name such as /dev/sda, as in the following
example:

ionadmin@itw-test01: ~$ sudo fdisk -l

Disk /dev/sda: 500.1 GB,
500107862016 bytes
255 heads, 63 sectors/track, 60801
cylinders
Units = cylinders of 16065 * 512 = 
8225280 bytes
Sector size (logical/physical) : 512
bytes / 512 bytes
Disk identifier: 0x0004366b

Device Boot Start End
Blocks Id System
/dev/sdal * 1 37
291840 83 Linux
Partition 1 does not end on 
cylinder boundary.
/dev/sda2 37 60802
488092673 5 Extended
/dev/sda5 37 60802
488092672 8e Linux LVM

2. Connect the USB drive.

Data management
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3. Wait approximately 10 seconds, then reenter: sudo fdisk -l.
The new USB drive appears in the list. The name of the USB drive is
usually /dev/sdb or /dev/sdc, depending on the number of drives installed.
The partition is a number that is added to the name of the physical drive. For
example, the first partition on drive /dev/sdc would be called /dev/sdc1. In
the following example, there is a 2-GB partition (1953512001 blocks) attached to
the system that is named /dev/sdb1. It is configured with a Linux™ partition. (If
the drive was formatted on Windows™, it is either a FAT or an NTFS partition).

ionadmin@itw-test01:/$ sudo fdisk -l

Disk /dev/sda: 500.1 GB, 
500107862016 bytes
255 heads, 63 sectors/track,
60801 cylinders
Units = cylinders of 16065 *
512 = 8225280 bytes
Sector size
(logical/physical): 512 bytes 
/ 512 bytes
I/O size (minimum/optimal) :
512 bytes / 512 bytes
Disk identifier: 0x0004366b

Device Boot Start End
Blocks Id System
/dev/sdal * 1 37
291840 83 Linux
Partition 1 does not end on 
cylinder boundary.
/dev/sda2 37 60802
488092673 5 Extended
/dev/sda5 37 60802
488092672 8e Linux LVM

Disk /dev/sdb: 2000.4 GB,
2000398934016 bytes
255 heads, 63 sectors/track,
243201 cylinders
Units = cylinders of 16065 * 
512 = 8225280 bytes
Sector size
(logical/physical): 512 bytes
/ 512 bytes
I/O size (minimum/ optimal) :
512 bytes / 512 bytes
Disk identifier: 0x5786fcfb

Device Boot Start End
Blocks Id System
/dev/sdb1 1 243201
1953512001 83 Linux
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4. If the drive has a Windows™ FAT or NTFS partition, reformat the drive as an ext3
partition to preserve the Linux™ file information, as follows.

IMPORTANT! Be careful to format the correct hard drive.

a. Enter sudo mkfs.ext3 <your_device>. For example:

sudo mkfs.ext3 /dev/sde5

b. Label the partition on the external USB drive. To label the partition, enter the
following:

sudo e2label <your_device_place> <partition_label>.?

For example, the external drive that is connected in /dev/sdbl is labeled as
'TS_Backup1':

sudo e2label /dev/sdb1 TS_Backup1

It is important to provide a different label name to each partition to avoid
error when multiple external USB drives are connected to the Torrent Server
at the same time.

5. Ensure that the external USB drive mounts automatically. Disconnect the external
USB drive, then reconnect it. Wait approximately 10 seconds. The external USB
drive appears under the Services tab in the Torrent Suite™ Software.

Unmount a USB drive

Before disconnecting a USB drive, we recommend that you unmount it first, to ensure
that all data have been written to disk. If you pull out the USB connection without
unmounting the USB drive first, there is a high risk of data loss.

To unmount a USB drive, enter the following command in the command line of your
Torrent Server: sudo umount /dev/sdb1 /media/external.

Initial setup of your Torrent Storage™ NAS device is provided by your field service
engineer. If the device is moved or disconnected for any reason (e.g., a power outage),
this section provides instructions for an administrator-level user to reconnect the
device to a Torrent Server.

• If the Torrent Storage™ NAS device connects directly to the Torrent Server, see 
“Connect directly to a Torrent Storage™ NAS device“ on page 282.

• If the device connects over a network to the Torrent Server, see “Connect over a
network to a Torrent Storage™ NAS device“ on page 283.

Connect to a
Torrent Storage™

NAS device
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Connect directly to a Torrent Storage™ NAS device

If your Torrent Server, Ion S5™ Instrument, or Ion GeneStudio™ S5 System is
connected directly to your Torrent Storage™ NAS device, use the following steps to
mount the device.

Note: You must be signed in as an administrator-level user to perform these steps.

1. In the Torrent Suite™ Software, click Settings ( )4About, then confirm that the
Torrent Suite™ Software version is 5.2 or later.

Note: To update your software, see “Update Torrent Suite™ Software“ on
page 286.

2. Click Settings ( )4Configure, then scroll to Torrent Storage.

3. Locate the IP address of the Torrent Storage™ NAS device in the Select a
TorrentNAS Device list. It may take several seconds for the list to populate.

Note: If the Torrent Storage™ NAS device is not automatically detected in
≤1 minute, confirm that the correct network ports are connected, then click
Refresh List.

4. Select the IP address of the device in the Select a TorrentNAS Device list.

5. Select a volume on the device under Select a Share Volume, then click Add
Volume.

The storage volume is connected to the server and is listed in the Currently Mounted
Volumes list.

Data management
Increase file storage and available disk space

282 Torrent Suite™ Software 5.10 User Guide



Connect over a network to a Torrent Storage™ NAS device

If your Torrent Server, Ion S5™ Instrument, or Ion GeneStudio™ S5 System is installed
on the same network as your Torrent Storage™ NAS device, use the following steps to
mount the device.

Note: You must be signed in as an administrator-level user to perform these steps.

1. In Torrent Suite™ Software, click Settings ( )4About, then confirm that the
Torrent Suite™ Software version is 5.2 or later.

Note: To update your software, see “Update Torrent Suite™ Software“ on
page 286.

2. Click Settings ( )4Configure, then scroll to Torrent Storage.

3. Enter the IP address of the Torrent Storage™ NAS device in the ...or enter an IP or
hostname here field, then press the Enter key.

4. Select a volume on the device under Select a Share Volume, then click Add
Volume.

The storage volume is connected to the server and is listed in Currently Mounted
Volumes.

Data management
Increase file storage and available disk space

Torrent Suite™ Software 5.10 User Guide 283



Monitor the Torrent Storage™ NAS device

You can check the status of a Torrent Storage™ NAS device in Torrent Suite™ Software.

1. Click Settings ( )4Services.

2. Scroll to the Torrent NAS Info section to view information on Torrent Storage™

NAS devices that are attached to your server through a network, including
available storage capacity, usage, and health of the device.
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Software administration

Administrative privileges allow you to configure Torrent Suite™ Software, administer
Torrent Server databases, manage user accounts, backup and restore data, and enable
remote monitoring. An ionadmin account is required for the procedures in this
section.

Note: An ionuser account does not include sufficient privileges for these
procedures.

Stop a sequencing run

Use the following procedure to stop an analysis job for a run that has started but not
completed.

1. Click  (Settings)4Services.

2. Scroll down to the Active Jobs section, find the Name for the sequencing Run
that you want to stop. The Status Message column indicates job is running.

3. Click Terminate for the sequencing Run that you want to stop.

4. In the confirmation dialog, click Yes to end the run, or click No for the analysis
job continue.

5. Refresh your browser to update the
information in the Active Jobs
section. The run is removed from the
Active Jobs list, which displays No
active jobs if no other runs are
active.

6. In the Data tab, click Completed Runs & Reports.
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The status is TERMINATED next to the
name of the sequencing Run that you
stopped.

Note: You can always start a new
analysis run.

Torrent Suite™ Software updates

The instructions in this section describe how to update your Torrent Suite™ Software
to a new version.

IMPORTANT! Additional steps and procedures might be required, depending on the
type of Torrent Suite™ Software upgrade. For complete instructions, see the latest
Release Notes on the Thermo Fisher Scientific product.

IMPORTANT! To ensure compatibility between the software and instruments, you
must also upgrade your instruments after the Torrent Suite™ Software upgrade is
complete.

Updates to Torrent Suite™ Software cause the software web services to restart. Ensure
that no sequencing runs are active on the server or are queued to start.

IMPORTANT! These procedures require an administrative (ionadmin) account. A
user account such as ionuser does not include sufficient privileges for these
procedures.

1. Sign in to Torrent Suite™ Software with your Administrator account.

2. Click  (Settings)4Configure.

Update Torrent
Suite™ Software
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3. Scroll to the Database Administration section, then click Admin Interface.

If you are prompted to Sign in, use your ionadmin account.
The Site administration page opens.

4. Click Update Server in the Management Actions section:

The Update Torrent Suite page opens with information on available software
versions, including whether updates are available.

5. Click Activate to power on website maintenance.

6. Click Check to check for updates.

7. If software updates are available, click Update Server to update Torrent Suite™

Software on the server.

8. When the software update is complete, click Back to Main Site, then click 
(Settings)4About.

9. Review the Torrent Suite™ Software version number in the Releases list to ensure
that it reflects the update that you completed.

10. To ensure that the Torrent Suite™ Software upgrade is complete, and
that the software is ready to run analysis programs, click 
(Settings)4Services.
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11. Under Status in the Services, review all services to ensure that each is running.

IMPORTANT! To ensure compatibility between the software and instruments,
you must also upgrade sequencing instruments after the Torrent Suite™ Software
upgrade is complete.

To check if there are any new products, plugins, or instrument updates, open the
Updates Page.

Note: To update Torrent Suite™ Software, see “Update Torrent Suite™ Software“ on
page 286.

1. Click  (Settings)4Updates and the Updates Page appears.

2. Determine if any updates listed are relevant to your work.

• To update products, see “Enable off-cycle product updates“ on page 289.
• To update plugins, see “Update off-cycle release plugins“ on page 290.
• To manually install update files, see “Install off-cycle bundles without

Internet Access“ on page 290.

You can prevent users from installing updates to Torrent Suite™ Software. Use this
procedure to lock the current version of Torrent Suite™ Software.

1. Sign in with your Administrator account.

2. Click  (Settings)4Configure.

Check for off-
cycle updates

Lock current
Torrent Suite™

Software version
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3. Scroll to the Database Administration section, then click the Admin Interface
link.

If you are prompted to Sign in, use your Administrator account.

4. Click the Update Server link in the Management Actions section.

Software versions that are currently available are listed and the area below the
list indicates whether updates are available. For example, No updates indicates
that updates are not available.

5. In the Software Versions list, click the Lock current TS software version
checkbox to prevent accidental updates to your software:

You can add new kits, chips, templates, plugins and Ion Chef scripts that are released
outside of the regular software release cycle.

When you learn of a new product that you would like to use, check to see if a software
update is available.

1. Sign in to Torrent Suite™ Software as administrator.

2. Click  (Settings)4Updates.

3. Scroll down to the Update Products section at the bottom of the screen.

4. Select the desired new product and click Update.
Your installed version of Torrent Suite™ Software is updated to include the new
products that you selected.

Enable off-cycle
product updates
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You can add new plugins that are released outside of the regular software release
cycle.

When you learn of a new plugin that you would like to use, check to see if an update
is available.

1. Sign in to Torrent Suite™ Software as administrator.

2. Click  (Settings)4Updates.

3. Scroll down to the Update Plugins section at the bottom of the screen.

4. Select the new Torrent Suite™ Software plugin that you want to install and click
Update.
Your installed version of Torrent Suite™ Software is updated to include the new
plugin that you selected.

If your Torrent Server is not connected to the Internet, follow the steps below to
manually install updates.

1. Request USB device from your Thermo Fisher Scientific representative or
Technical Support.

2. Insert the USB device into your Torrent Server.

3. Click  (Settings)4Updates and the Updates page appears.

4. Under Manual Upload, click Click to Upload and Install.

5. Follow prompts to upload the compressed folder.

The section that follows explains how to manage user accounts from the Torrent
Suite™ Software Site Administration screen.

1. Click  (Settings)4Configure.

2. Scroll to the Database Administration section, then click the Admin Interface
link.

If you are prompted to Sign in, use your Administrator account.

Update off-cycle
release plugins

Install off-cycle
bundles without
Internet Access

Manage Torrent
Suite™ Software
user accounts
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Option Description

Add Click Add to add new users.

Change Check Change to modify user accounts.

Open the Site Administration screen

Administrator-level users can modify default settings for sequencing runs, using tools
in the Site Administration screen.

IMPORTANT! Use extreme caution when modifying any of the settings in this screen.
Fields that are set to incorrect values may corrupt the database or produce
unpredictable results. Check with your Field Application Scientist or Field
Bioinformatics Specialist if you need to change any of the settings or complete any of
the procedures that are available through this administrative tool.

1. Click  (Settings )4Configure.

2. In the Configure screen, scroll down to the Database Administration section.
Click the Admin Interface link to access the database administration functions.

3. If you are prompted to sign in, enter your administrator user name and
password, then click Sign in.

The Site administration screen in the Ion Web portal opens. After you have made
changes, click Back to Main Site at the top of the screen to return to the software.
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Approve or reject a new user account

New users can request accounts on the Torrent Suite™ Software sign on screen. An
administrator must approve each request before the new account is active. An
administrative account is required to approve or reject each user account request.

A message about new user registrations that are pending opens when you sign in as
an administrator.

IMPORTANT! Use extreme caution when modifying any of the settings in this screen.
Fields that are set to incorrect values may corrupt the database or produce
unpredictable results. Check with your Field Application Scientist or Field
Bioinformatics Specialist if you need to change any of the settings or complete any of
the procedures that are available through this administrative tool.

1. In the message for the new pending registration, click Account Management.

The User Registration section shows the pending requests for new user
accounts:

Note: Alternatively you can check for new user registrations if you click 
(Settings)4Accounts, then go to the User Registrations section in the User
Profile/Account Information screen.

2. Review the new user registration request and choose from the following.

Option Description

Approve the
registration.

Click Approve to approve the account for the new user,
then click Yes, Approve.

Reject the registration. Click Reject to approve the account for the new user, then
click Yes, Reject.

The user account is added to the list of user accounts in the Torrent Suite™ Software
Site Administration screen. For details, see “Manage Torrent Suite™ Software user
accounts“ on page 290.

After you have made changes, click Back to Main Site at the top of the screen to
return to the software.
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Modify a user

Administrator-level (Superuser) users can modify the access level for an existing user
(Staff), using tools in the Site administration screen.

1. Click  (Settings)4Configure.

2. In the Configure screen, scroll down to the Database Administration section.
Click the Admin Interface link to access the database administration functions.

3. If you are prompted to sign in, enter your administrator user name and
password, then click Sign in.
The Site administration screen in the Ion Web portal opens.

4. In the Users line of the main Site administration menu, click Change.

5. On the Select user to change screen, click the Username of the user you want to
change. User names can be filtered, selected to the right, according to: By staff
status, By superuser status or By active status.

6. Use the Change user dialog to modify user information, such as user name,
password, first and last name, email address, or Active/unactive status. Confirm
permissions are selected as follows for Staff and Superusers:

Option Description

Staff (User) Active

Superuser (Administrator) Active, Staff and Superuser

WARNING! Do not modify Groups or User permissions categories. Do
not click Staff or Superuser individually. Staff and Superuser must both
be unchecked for Staff user, but both must be checked for Superuser.

7. Select one of the Save options at the bottom of the screen to save your changes.

The user account is modified.

After you have made changes, click Back to Main Site at the top of the screen to
return to the software.
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Delete a single user account

Administrator-level users can delete a user account, using tools in the Site
administration screen.

1. Click  (Settings)4Configure.

2. In the Configure screen, scroll down to the Database Administration section.
Click the Admin Interface link to access the database administration functions.

3. If you are prompted to sign in, enter your administrator user name and
password, then click Sign in.
The Site administration screen in the Ion Web portal opens.

4. In the Users line of the main Site administration menu, click Change.

5. On the Select user to change page, click the Username of the user to be deleted.

6. At the bottom-left of the Change user page, click Delete.

7. Ensure that you want to delete the user by clicking Yes, I'm sure.

The user is deleted.

After you have made changes, click Back to Main Site at the top of the screen to
return to the software.

Delete multiple user accounts

Administrator-level users can delete multiple users, using tools in the Site
administration screen.

1. Click  (Settings)4Configure.

2. In the Configure screen, scroll down to the Database Administration section.
Click the Admin Interface link to access the database administration functions.

3. If you are prompted to sign in, enter your administrator user name and
password, then click Sign in.
The Site administration screen in the Ion Web portal opens.

4. In the Users line of the main Site administration menu, click Change.

5. On the Select user to change page, check the checkbox for each users you want
to delete.
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6. Click the dropdown list, then select Delete selected users:

7. Click Go:

8. Ensure that the list of users you want to delete is correct by clicking Yes, I'm sure.
If you do not want to delete the user, click the back arrow on your browser.

On the Select user to change page, the list of users confirms your deletions.

After you have made changes, click Back to Main Site at the top of the screen to
return to the software.
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Create a new administrator account to change a password

You can change your password by creating an new superuser account, then changing
the user account password.

IMPORTANT! 

Use extreme caution when modifying any of the settings in this screen. Fields that are
set to incorrect values may corrupt the database or produce unpredictable results.
Check with your Field Application Scientist or Field Bioinformatics Specialist if you
need to change any of the settings or complete any of the procedures that are available
through this administrative tool.

1. Run the following commands: cd /opt/ion/iondb ./manage.py
createsuperuser in the command prompt.

2. After the new superuser account has been created, click 
(Settings)4Configure.

3. In the Configure screen, scroll down to the Database Administration section.
Click the Admin Interface link to access the database administration functions.

4. If you are prompted to sign in, enter your newly created user name and
password, then click Sign in.
The Site administration screen in the Ion Web portal opens.

5. Select the Users section under Auth:

Note: If you sign in with an ionuser account, the Auth section does not
appear .

6. Select the account that you want to change the password for.

7. Click Change password form:
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8. Enter the new desired password, then click Change Password:

You can now use your new password with your user account.

After you have made changes, click Back to Main Site at the top of the screen to
return to the software.

Disk usage

It is critical that sufficient disk space is available on the server to avoid data loss. If
needed, it is important to have a strategy that periodically monitors disk space and
archives or deletes data. For details on how to check disk space on the server, see 
“View disk usage parameters“ on page 272.
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Add customer support contacts

1. Click  (Settings)4Configure.

2. Add the information for a customer support contact and an IT contact in your
organization, then click Save Contacts.
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Change the displayed server name

You can change the server name that appears in the Torrent Suite™ Software. By
default, this name is Torrent Server. This change affects only the server name that
is shown in the Torrent Suite™ Software, and the default bookmark name that appears
in the browser when a bookmark is created.

1. Click  (Settings)4Configure, then scroll to the Customize Site Name section.

2. Enter the name of your choice, then click Save Name.
The server name that is displayed for the Torrent Browser is changed.

Change the time zone for the Ion Torrent™ Server

1. Click  (Settings)4Configure.

2. Scroll to Change Timezone, select a region and a time zone, then click Save Time
Zone.

3. () Click Auto Detect Timezone, then click Save Time Zone.

The new time zone takes effect immediately on the Ion Torrent™ Server.
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RAID Info

The RAID Info section shows the status of physical drives on an attached Torrent
Storage device (Dell PowerVault MD1200):

The Show Details link opens a popup with details of the RAID drives (only one
shown here):
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Refresh your browser to see changes in status. This information is not updated
automatically.

Set up Ion Mesh

Ion Mesh is a feature in Torrent Suite™ Software that allows you to form a network
between Torrent Servers.

Note: Torrent Servers must be running the same software version.

When using Ion Mesh, you can:
• view all runs of interest across multiple Torrent Servers on the same data page.
• transfer Planned Runs between sequencers connected to different Torrent Servers.
• track reagent and cartridge usage across Ion Chef™ flexible workflows from
different Ion Chef™ instruments connected to different Torrent Servers

Follow these steps to connect (link) or disconnect (unlink) your Torrent Server to
another Torrent Server.

1. In the any tab, click  (Settings), then click Ion Mesh.
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2. Select one of the following options.

Option Action

Link a selected Torrent
Server

Select a Torrent Server from the dropdown menu, then
click Link Selected TS.

Manually link a Torrent
Server

Click Link TS Manually.

Edit the nickname of a
linked TS

Click  (Actions) in the row of the Torrent Server you
want to edit, then click Edit.

Enable/Disable a
Torrent Server

• To enable a Torrent Server: select the checkbox in the
Enable column of the Configure Mesh table in the row
of the Torrent Server.

• To disable a Torrent Server: deselect the checkbox in
the Enable column of the Configure Mesh table in the
row of the Torrent Server.

Note: Disabling a Torrent Server hides that Torrent
Server from Planned Runs actions and Data menus so the
unlinked Torrent Server cannot be utilized by the Torrent
Suite™ Software.

Unlink a Torrent Server
from Ion Mesh

Click  (Actions) in the row of the Torrent Server you
want to unlink, then click Unlink.

Note: Unlinking a Torrent Server permanently removes
that Torrent Server from Ion Mesh.

3. Enter the following information in the Setup Mesh Computer dialog.

Parameter Definition

Hostname/Address Host name or address of the server.

Note: If linking a selected Torrent Server, this field is
automatically populated and cannot be edited.

Nickname A common name that is assigned to the Torrent Server.

Username Your username.

Password Your password.

4. Click Setup.
The linked and enabled Torrent Servers are available to be used in the Planned
Runs and the data from the linked and enabled Torrent Servers can be viewed on
the same Data page.
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Prior to viewing runs on multiple servers, you must first connect the servers using Ion
Mesh. See “Set up Ion Mesh“ on page 301 for more information.

1. In the Data tab, click Completed Runs and Reports.

2. Select one or more Torrent Servers that
you want to view data from in the Server
dropdown list.

Notice that the server name is now
reflected in the Run Name column. Your
results across multiple sequencers are
ready for your review

Prior to transferring Planned Runs, first connect the Torrent Servers using Ion Mesh.
See “Set up Ion Mesh“ on page 301 for more information.

1. In the Plan tab, click Planned Runs.

2. Locate the row of the Planned Run you want to transfer, then click 
(Actions)4Transfer.

3. Select the Torrent Server you want to receive the Planned Run.

To use the flexible workflow feature and enable cartridge use tracking between
Torrent Servers across multiple Ion Chef™ instruments, Torrent Servers must be linked
in an Ion Mesh configuration. For further information on how to link Torrent Servers
in an Ion Mesh setup, see “Set up Ion Mesh“ on page 301. For more information on
configuring a flexible workflow on the Ion Chef™ instrument, see the Ion 550™

Kit − Chef User Guide (Pub No. MAN0017275).

IMPORTANT! If you have Torrent Servers connected in an Ion Mesh configuration,
and the connection to one Torrent Server is disrupted or lost, cartridge tracking
between servers is disabled. In this situation, an error message appears if you attempt
to start a run. The run is not allowed to start because cartridge use status is not
trackable. Ion Mesh communication must be restored to verify cartridge use status
before the run can start.

1. In the Data tab, click Completed Runs & Reports.

2. Click a completed report.

3. In the run report, scroll down to Details section and select Chef Summary and
S5 Consumable Summary tabs to track the cartridge use.

View sequencing
runs on multiple
sequencers with
Ion Mesh

Transfer a
Planned Run to a
Torrent Server
with Ion Mesh

Track Ion Chef™

flexible workflows
for Ion 550™ chips
with Ion Mesh
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View network settings

The Network Settings page also describes the following ports and remote sites in its
Remote System Summary section:

Click the View Network Settings link to see information about the Ion Torrent™

Server:

The Network Settings page also describes the following ports and remote sites in its
Remote System Summary section:
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Data backup and restore locations

The Torrent Server maintains the following types of data in separate locations:

Data type Storage location

Ion PGM™ and Ion S5™ Sequencer, and Ion
GeneStudio™ S5 Systems data

/results/< instrument_ name>
directory, by default.

Ion Proton™ Sequencer data /rawdata/<Proton_Name> directory,
by default.

Report data /results/analysis/output/Home
directory, by default.

Database records PostgreSQL database

The nightly backup of the database is created automatically, then stored for 30 days.

The following instructions delete the current database.

• To restore the database, you need a complete working Torrent Server installation.
The two scenarios for restoring a database are:

a. Installing a new Torrent Server from the Torrent Server installation disk due
to migrating the database to a new server or needing to reinstall the server.

b. Replacing the database on an existing Torrent Server, possibly because the
database is corrupted and you want to restore a previous version.

• To restore the database from the backup file, execute these commands on the
Torrent Server:

{{# copy the backup file to the server and decompress it 
gzip -d iondb.20100711_142442.backup.gz 

# stop the Torrent Server background processes 
sudo /etc/init.d/ionCrawler stop 
sudo /etc/init.d/ionJobServer stop 
sudo /etc/init.d/ionPlugin stop 
sudo /etc/init.d/celeryd stop 

# login as user postgres
sudo su postgres 

# restart the service to clear database connections
 /etc/init.d/postgresql restart 

# drop the existing iondb database
dropdb iondb 

# create a new empty database 
psql <<-EOFdb CREATE DATABASE iondb; 
GRANT ALL PRIVILEGES ON DATABASE iondb to ion; 
\q EOFdb
 
# import data
psql -e iondb < iondb.20100711_142442.backup 

Restore the
PostgreSQL
Database
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# logout of user postgres
exit 

# start the Torrent Server background processes 
sudo /etc/init.d/ionCrawler start 
sudo /etc/init.d/ionJobServer start 
sudo /etc/init.d/ionPlugin start 
sudo /etc/init.d/celeryd start}}

Occasionally, there is a django error after completing the import data step.
If an error is displayed on the browser UI, repeat the following steps:

a. Drop database.

b. Create database.

c. Import data.

Axeda™ Remote System Monitoring (RSM)

The Axeda™ RSM (Remote System Monitoring) agent is a software component that is
installed automatically on the Torrent Server and Ion S5™, Ion PGM™, and Ion
Proton™, and Ion GeneStudio™ S5 Systems through the software update process.

Approximately every 60 seconds, this agent sends a heartbeat message to Thermo
Fisher Scientific. This information is used to track the deployment and software
configuration of machines in the field.

Data is collected in the Axeda™ monitoring database, where Thermo Fisher Scientific
Technical Support personnel can review the information that agents collect. Because
the heartbeat message is sent many times an hour, Technical Support can quickly see
the following:

• If a machine is online
• The software versions
• Some technical details about the instrument such as temperature and hard drive

status.

The agent also allows Thermo Fisher Scientific personnel to log in remotely to the Ion
S5™, Ion PGM™, Ion Proton™, and Ion GeneStudio™ S5 Systems and the Torrent Suite™

Software, which is required for system support. Without remote access, Thermo
Fisher Scientific Field Application Scientists cannot access, view, and troubleshoot
problems regarding machine performance.

Overview
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To support fully the Ion Torrent™ Server and Ion Torrent™ sequencers, remote
monitoring must be provided using Axeda® Remote System Monitoring software
enabled, and able to reverse ssh into the boxes. This requirement means that the Ion
sequencers and Torrent Servers be connected to the Internet with outbound
connections that are permitted on the following ports:

Port Required Use

22 Yes Start reverse SSH tunnel for
remote troubleshooting

80 Yes Download updates from 
http://
updates.iontorrent.com and 
http://
us.archive.ubuntu.com

123 Yes (UDP) NTP access to the
Internet, incoming and
outgoing.

443 Yes Enable sending of basic
status information to the
remote monitoring server.

The IonReporterUploader
plugin also requires port 443
to transfer data to Ion
Reporter™ Software.

5432 No Remote access to
PostgreSQL database.

Field names, data types, and examples of the data being collected are described in the
following tables. This information is sent automatically from the Torrent Server and
Ion S5™, Ion PGM™, Ion Proton™, and Ion GeneStudio™ S5 Systems back to Thermo
Fisher.

Event Name Type Sample Value

TS.Config.biosversion String 6.00

TS.Config.configuration String standalone

TS.Config.hostname String Ion-torrent-server

TS.Config.ipaddress String 10.45.3.246

TS.Config.mode String Master

TS.Config.serialnumber String 1SMJFP1 ( Dell™ service tag)

TS.Contact.IT Contact String email, phone

TS.Contact.Lab Contact String email, phone

Port assignments

Data automatically
collected by the
RSM agents

Torrent Server
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Event Name Type Sample Value

TS.Experiment String chip type, flow count, run type,
bedfile, barcode count, seq s/n

TS.GPU String No problems

TS.host String Ion-torrent-server

TS.HW.HD./results Analog 58.99

TS.Location.City String Rockville

TS.Location.Org-Name String Unknown

TS.Location.Postal-Code String Unknown

TS.Location.State String Unknown

TS.Location.Street-Address String Unknown

TS.Nexenta<n>_lic_days_left String 180

TS.Nexenta<n>_lic_status String license status

TS.Nexenta<n>_machine_sig String 5EDI8L9NA

TS.Nexenta<n>_UUID String 44454c4c-5900-1046-8048-
b2c04f533532

TS.Nexenta<n>_vol<v> String pool1 size=32.5T allocated=860G
free=31.7T capacity=2%
health=ONLINE

TS.Nexenta<n>_vol<v>_d<d> String c0t5d1 health=ONLINE
vendor=SEAGATE
product=ST6000NM0034
serial=Z4D1XT26 size=6TB

TS.Server.celerybeat String ok/offline/error

TS.Server.celery_diskutil String ok/offline/error

TS.Server.celery_periodic String ok/offline/error

TS.Server.celery_plugins String ok/offline/error

TS.Server.celery_slowlane String ok/offline/error

TS.Server.celery_transfer String ok/offline/error

TS.Server.celery_w1 String ok/offline/error

TS.Server.dhcp String ok/offline/error

TS.Server.ionCrawler String ok/offline/error

TS.Server.ionJobServer String ok/offline/error

TS.Server.ionPlugin String ok/offline/error
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Event Name Type Sample Value

TS.Server.ntp String ok/offline/error

TS.Server.RabbitMQ String ok/offline/error

TS.Server.RSM_Launch String ok/offline/error

TS.Server.tomcat String ok/offline/error

TS.TYPE String TS1

TS.Version.alignment String 1.42-0

TS.Version.analysis String 1.40-0

TS.Version.dbreports String 1.95-3

TS.Version.docs String 1.15-1

TS.Version.referenceLibrary String 1.6-1

TS.Version.tmap String 0.0.19-1

TS.Version.tsconfig String 1.3-9

Event Name Type Sample Value

Instrument.Event.LastExperiment String R_2011_04_22_15_34_58_usr_S-1

Instrument.Event.Pressure Analog 0 (chart)

Instrument.Event.ValveBoard String Valve Board not accessible

Valve Board Down Stream Errors

Valve Board Up Stream Errors

Instrument.Event.RunAborted String Run aborted

Instrument.Event.LostChipCon String Lost chip connection, run aborted

Instrument.Event.UBoot String U-boots don’t match

Instrument.Event.Kernel String Kernels don’t match

Instrument.Event.ResultsDrive String Results drive not accessible

Instrument.Event.BootDrive String Bad boot drive detected

Instrument.Event.DataDrive String Bad data drive detected

Instrument.HW.HD1 Analog 34.001 (chart)

Instrument.InstrumentName String Stork

Instrument.Pressure Analog 10.2 (chart)

Instrument.Temperature Analog 27.06 (chart)

Instrument.TYPE String PGM1

Ion PGM™ data
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Event Name Type Sample Value

Instrument.Version.Board String 4 A.1

Instrument.Version.Datacollect String 180

Instrument.Version.driver String 31

Instrument.Version.fpga String 70

Instrument.Version.Graphics String 15

Instrument.Version.LiveView String 268

Instrument.Version.OS String 12

Instrument.Version.Scripts String 16.3.58

Ion S5™, Ion Proton™, and Ion GeneStudio™ S5 System data are divided into these
categories:

• DataCollect - These items come from the instrument configuration file.
• RunData - These items reflect parameters from the last Auto pH or sequencing

run.
• Status - These items reflect the current instrument parameters.
• System - These items provide parameters related to the operating system

supporting the instrument.
• Version - These items provide the version numbers for the various software

packages installed on the instrument.

In addition, two items (InstrumentState, Type) are not placed in any category.

The number and names of these entries are subject to change across software releases.

Data Item Name Type Sample value

Alarm.* String Various hardware alarm messages

BIOS.BIOS Analog 5350

DataCollect.FlowsSinceClean Analog 400

DataCollect.RunsSinceClean Analog 1

Event.CleanCompleted String Clean completed

Event.DatacollectStarted String Datacollect Started

Event.InstrumentMustBeInitialized String Instrument must be initialized

Event.PostRunCleanHasNotBeenRun String Post Run Clean has not been run

InstrumentState String Idle

RunData.a1a2 String R_2016_02_17_13_01_08_user_F4
--145 W1.dat dffffe cntArry 9 0 0 9

RunData.AutoPhFinal Analog 7.660635

Ion S5™, Ion
Proton™, and Ion
GeneStudio™ S5
System data
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Data Item Name Type Sample value

RunData.AutoPhInitial Analog 6.321023

RunData.AutoPhIterations Analog 4

RunData.AutoPhResult String Pass

RunData.AutoPhTotalW1Volume Analog 1.0

RunData.ChipGain Analog 1.066389

RunData.ChipPixelAverage Analog 8241

RunData.ChipPixelsInRange Analog 164698460

RunData.ChipPixelsPinnedHigh Analog 0

RunData.ChipPixelsPinnedLow Analog 676

RunData.ChipTemp Analog 81.826172

RunData.CpuTemp0 Analog 53

RunData.CpuTemp1 Analog 74

RunData.efuse String **********L:Q6C841,W:
4,J:WC2012C00086-C00272,P:
16,C:PT4,F:F6,Y:4,X:0,B:3,SB:31,B:
1P,N:
343*****************************
********

RunData.FpgaMasterTemp Analog 113

RunData.FpgaSlaveTemp Analog 118.4

RunData.GpuTempC Analog 82

RunData.LastAutoPhRealPh Analog 766

RunData.LastAutoPhRef Analog 745

RunData.LastAutoPhTarget Analog 770

RunData.R1pH Analog 7.00

RunData.R2pH Analog 7.00

RunData.R3pH Analog 7.00

RunData.R4pH Analog 7.00

RunData.W1pH Analog 8762

RunData.W2pH Analog 7619

RunData.W3RefpH Analog 7.45

Status.HDPctFull Analog 0.823612
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Data Item Name Type Sample value

Status.SsdPctFull Analog 6.220454

System.CpuUsagePct Analog 7

System.Date String 2013-01-0

System.FreeMemoryKB Analog 129951948

System.Hostname String d1.ite

System.IpAddress String 10.25.3.150

System.PhysMemTotalGB Analog 128

System.Time String 03:42:58 PM GMT

TYPE String Proton1

Version.Datacollect String 3371

Version.DiskImage String 2015_06_04

Version.Graphics String 80

Version.KernelRelease String 3.13.9-ionrt1

Version.LiveView String 2166

Version.OIA String 5203

Version.OS String 17

Version.Reader FPGA String 3d400109

Version.Reader FPGA1 Analog 33400109

Version.Reader Woddr FPGA String 3400043

Version.Reader Woddr FPGA1 String 340004b

Version.RSM String 24

Version.Scripts String 2.0.63

Version.S5 Release Analog 5.2

Version.S5 Script String 0.1.13

Version.TSLink String 1.0.2r5

Version.Valve FPGA String c010
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When there is a problem with the Ion sequencer or Torrent Server, the Axeda™ RMS
agent allows Thermo Fisher Scientific support personnel to remotely:

• Collect log files from the system for review.
• Restart the device.
• Upgrade software.
• Provide a remote login connection to the device for further diagnostic work.

When a problem with an Ion S5™, Ion PGM™, Ion Proton™, Ion GeneStudio™ S5
System, or Torrent Suite™ Software is reported, Thermo Fisher Scientific service and
support tries to solve the problem by telephone or email. If remote access is required
for additional troubleshooting, a member of Thermo Fisher Scientific service and
support requires authorization from the technical contact to initialize a remote
connection. Only after getting authorization does Thermo Fisher Scientific personnel
proceed with remote troubleshooting. After the problem is resolved, you are notified.
Additional authorization is required before starting any further remote help.

Troubleshoot Torrent Server

These troubleshooting recommendations apply to system level issues such as
networking, disk space, and system load.

Remote access for
troubleshooting
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Access the Crawler and Jobs Server page:

Click  (Settings)4Services.

If these processes are not running, run information is not updated and analysis
reports are not generated. If this occurs, there is no risk of data loss but the Crawler
and Jobs Server processes should always be running. The Archive process only runs
if archiving has been configured.

If a process is not running, a Down or Offline reason is displayed in the Services
screen. An example is "The crawler is offline".

Click  (Settings)4Services.
The following table lists the background processes that run on Torrent Suite™

Software:

Process Program Startup Script Description

Crawler crawler.py ionCrawler Searches for new
runs from the Ion
PGM™, Ion Proton™,
Ion S5™, or Ion
GeneStudio™ S5
Sequencers and puts
run information into
the database so that
they appear in the
Torrent Browser
Data > Completed
Runs & Reports
page.

Job Server serve.py ionJobServer Sends analysis jobs
to the Sun Grid
Engine (SGE).

Plugin Server ionPlugin.py ionPlugin Sends plugin jobs to
the Sun Grid Engine
(SGE).

Celeryd manage.py celeryd A background job
processor for
Django.

Check crawler and
job server status
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Queue status

Click the Queue Status link in the Active Jobs section to open a table of SGE queue
activity:

Currently, there is no method to restart a process using the Torrent Browser. The
easiest approach is to is to shutdown and restart the server. Before restarting the
server, make sure that no Ion PGM™ or Ion Proton™ Sequencers are uploading data to
the server, otherwise the file transfer is interrupted.

After restarting a process, it continues from the point where it was interrupted, and
no more user interaction is needed.

1. Before restarting the server, ensure that no Ion PGM™ or Ion Proton™ Sequencers
are uploading data to the server, otherwise the file transfer is interrupted.

2. Shutdown and restart the server

3. (Optional) Restart the processes using the scripts located in the /etc/init.d
directory. For example, use the following command to restart the Crawler:

user@svr:/etc/init.d$ sudo /etc/init.d/ionCrawler restart 
Stopping crawler Starting crawler pid = 26025

4. Verify that the processes are running using the ps ax | grep py command or
the Torrent Browser UI.

Note: If the processes do not continue to run after being restarted, contact your
Ion Torrent™ representative for assistance.

Restart services
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There can be many reasons for network connectivity or name resolution to fail. Use
the following procedure to try to resolve connectivity and name resolution problems:

If you cannot reach the Torrent Server an IP address, you are likely to need help from
the site IT administrator who understands how the local network is configured.

1. Click  (Settings)Configure.

2. In the Configure screen, scroll down to the Database Administration section.
Click Admin interface link to access the database administration functions.

3. If you are prompted to sign in, enter your administrator user name and
password, then click Sign in.
The Site administration screen in the Ion Web portal opens.

4. Scroll down to Management Actions, then select the Network Settings line. The
Torrent Browser performs several network checks:

5. Verify that the Torrent Server is configured correctly by reviewing the Torrent
Server deployment instructions.

6. Find the IP address of the Torrent Server as described in “Verify Torrent Server IP
address“ on page 316.

After you are finished, click Back to Main Site at the top of the screen to return to the
software.

The Torrent Server is configured out-of- the-box to automatically get an IP address
from the DHCP server on the network. Unless the local IT administrator has
specifically assigned an IP address in advance, you will not know what the current IP
address is.

The Torrent Server has several Ethernet ports on the back. Make sure your site
network is connected to the port labeled LAN, called eth0 in Linux™ terminology. The
Ethernet port are identified as eth0, eth1, ..., for as many ports as are available. On
Torrent Server, eth0 is the only port connected to your network and is configured by
DHCP.

Verify network
connectivity and
name resolution

Verify Torrent
Server IP address
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To determine the IP address assigned to eth0, login and type: ifconfig eth0. This
displays the following output:

ionadmin@ion-torrent-server:~$ ifconfig eth0

eth0 Link encap:Ethernet HWaddr 00:1b:21:5b:bb:44

inet addr:192.168.1.123 Bcast:192.169.4.255 Mask:255.255.255.0

inet6 addr: fe80::21b:21ff:fe5b:bb44/64 Scope:Link

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

RX packets:209970726 errors:0 dropped:0 overruns:0 frame:0

TX packets:419252947 errors:0 dropped:0 overruns:0 carrier:0

collisions:0 txqueuelen:1000

RX bytes:14131928595 (14.1 GB) TX bytes:607398487997 (607.3 GB)

Memory:fbea0000-fbec0000

Your IP address is the inet addr:

inet addr:192.168.1.1 Bcast:192.169.4.255 Mask:255.255.255.0

Another useful check is the line beginning with UP, which indicated the interface is
active and working:

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

If the eth0 port is not available, it is possible the Ethernet cable is connected to a
network, so you will not see the word UP:

BROADCAST MULTICAST MTU:1500 Metric:1

If an IP address is assigned, the interface is likely to work. If no IP address is assigned
and the interface is not UP, you may need to get help from your site IT administrator.

If you are still concerned about network connectivity, you can test that different
desktops are able to successfully ping the server IP address. If you are not able to
ping the server from the desktops that need to access the Torrent Browser running on
the server, contact your site IT administrator.
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The Torrent Server uses the Linux™ Network Time Protocol (NTP) program to
synchronize its time with another time server. By default, the Torrent Server is
configured to synchronize its time service to a trusted time service on the Internet.
This requires that the network configuration permits the NTP network protocol to
connect to that time service on the Internet.

The Torrent Server can also act as a time server for Ion PGM™ and Ion Proton™

Systems. However, if the server is not able to synchronize with the trusted time
service, it does not act as a time server for the systems (Torrent Server does not
forward potentially incorrect information to other machines).

If the network configuration is blocking the NTP protocol from reaching the Internet,
the Torrent Server and theIon PGM™ and Ion Proton™ Systems are not be able to
synchronize time.

Your site network administrator is probably aware of this connectivity restriction, and
it is likely that IT has a time server in the network.

Do not delete the data from the Ion PGM™ orIon Proton™ Sequencer until you are
confident that the data is present on the Torrent Server , the analysis is successful, and
the Analysis Report has been generated successfully.

1. Verify that all files successfully transferred from the Ion PGM™ and Ion Proton™

Sequencers to the Torrent Server.

2. (Optional) Manually transfer files by going to the Data Management4 Re-
transfer, then select the an option for any of the runs in question. You can then
safely re-transfer data.

After the root cause of a major problem is identified, the following more intrusive
action may be needed:

• Replace failed hard disk drive
• Downgrade software packages
• Reinstall software
• Modify config files
• Add, modify, or delete database information

Please contact your Ion Torrent™ representative for assistance before you attempt any
of these steps.

Troubleshoot and
configure the time
service

Verify file transfer

Further
investigation and
problem
resolution
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You can download an archive that Customer Support can use to diagnose Torrent
Suite™ Software issues. The Customer Support Archive contains log files and other
technical data about your Torrent Suite™ Software and analysis runs.

Note: Under some circumstances, you can use the FieldSupport plugin to generate an
archive for use by Customer Support. For details, see “FieldSupport plugin“ on
page 144.

Generate a Customer Support Archive

1. Under the Data tab, in the Completed Runs & Reports screen, click the link for
your completed analysis run.

2. In the Run Summary, click the Plugin Summary link, or scroll down to the
Plugin Summary. Click the Support tab.

3. Click Download.

A compressed archive is downloaded to the directory that you use to download files
from the browser. This location will depend on your browser settings. You can
attached this archive to an email for Customer Support.

Note: Torrent Server is not able to access the customer support server automatically.
If you would like to upload files directly, contact your support representative and ask
how to enable Customer Support Archive upload for your Torrent Server.

Customer Support Archive contents

The tables in this section describe the files included in a Customer Support Archive.
Files for optional modules (such as recalibration) only appear if the optional module
is run.

In the top level directory:

File Description

alignment.log Log of the final TMAP alignment process

< RunName>_< AnalysisReportName>
.alignment.summary

Text format summary of sample alignment
final results

alignment.summary Text format summary of sample alignment
final results (same as the file < RunName>_
< AnalysisReportName>
.alignment.summary, but with a predictable
file name)

backupPDF.pdf PDF file of the analysis report and plugin
results (similar to the output of the
Download as PDF button on a run report)

Controller Live View log of user activity on the
sequencing instrument

debug Log from data collect, the background data
acquisition module

Customer support
archive
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File Description

DefaultTFs.conf List of known Test Fragment sequences and
their bases

drmaa_stderr_block.txt Analysis pipelin eerror log for the block
being executed by Sun Grid Engine

drmaa_stdout.txt Log of events after primary analysis

drmaa_stdout_block.txt Analysis pipeline output log for the block
being executed by Sun Grid Engine

explog.txt Initial run s settings needed for Torrent
Browser analysis when being exported from
instrument

explog_final.txt Final run s settings needed for Torrent
Browser analysis when being exported from
instrument

InitLog.txt Instrument auto pH log

InitValsW2.txt pH log of the W2 solution

InitValsW3.txt pH log of the W3 solution

RawInit.txt Contains initialization data output

sysinfo.txt Torrent Browser system software settings

TF.alignment.summary Summary of test fragment alignment
results in text file

uploadStatus Log of metrics being uploaded to the
Torrent Browser

version.txt Torrent Suite™ software versions used for
the analysis report

In the basecaller_results directory:

File Description

basecaller.log Log file for the basecaller analysis module

datasets_basecaller.json A JSON-format file of the settings needed
for basecaller to analyze the sample data

datasets_pipeline.json A JSON-format file of the settings needed
by the pipeline to run the basecallermodule

datasets_tf.json A JSON-format file of the settings needed
for basecaller to analyze the Test
Fragments

< RunName>_< AnalysisReportName>
.quality.summary

A quality summary of basecaller unaligned
reads/bases after filtering and trimming
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File Description

quality.summary Same as above, but with a predictable file
name

TFStats.json A JSON-format file ofTest Fragments
results statistics

In the basecaller_results/recalibration directory:

File Description

alignment.log Log of the TMAP alignment process during
base recalibration

alignmentQr_out.txt Log file from the TMAP analysis module

In the basecaller_results/unfiltered.trimmed directory:

File Description

alignment.log Log of the TMAP alignment process based
on unfiltered and trimmed reads

< RunName>_< AnalysisReportName>.
alignment.summary

Text format summary of sample alignment
results for unfiltered and trimmed reads

alignment.summary Text format summary of sample alignment
results for unfiltered and trimmed
reads(same as above, but with a predictable
file name)

datasets_basecaller.json A JSON-format file of the settings needed
for basecaller to analyze the sample data,
when generating the raw BAM file

< RunName>_< AnalysisReportName>
.quality.summary

The basecaller unfiltered and trimmed
reads/bases quality summary

quality.summary The basecaller unfiltered and trimmed
reads/bases quality summary (same as
above, but with a predictable file name)

In the basecaller_results/unfiltered.untrimmed directory:

File Description

alignment.log Log of the TMAP alignment process based
on unfiltered and trimmed reads

< RunName>_< AnalysisReportName>.
alignment.summary

Text format summary of sample alignment
results for unfiltered and untrimmed reads

alignment.summary Text format summary of sample alignment
results for unfiltered and untrimmed
reads(same as above, but with a predictable
file name)
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File Description

datasets_basecaller.json A JSON-format file of the settings needed
for basecaller to analyze the sample data,
when generating the raw BAM file

< RunName>_< AnalysisReportName>
.quality.summary

The basecaller unfiltered and untrimmed
reads/bases quality summary

quality.summary The basecaller unfiltered and untrimmed
reads/bases quality summary (same as
above, but with a predictable file name)

In the sigpror_results directory:

File Description

analysis.bfmask.stats Analysis statistics of wells in the bead find
stage (the bfmask is a set of bit flags for
each well, indicating the contents of each
well)

avgNukeTrace_ATCG.txt ATCG key signal measurements

avgNukeTrace_TCAG.txt TCAG key signal measurements

bfmask.stats Summary statistics of wells in the bead find
stage

processParameters.txt Parameter settings for analysis signal
processing

separator.bftraces.txt Matrix data to separate between live wells
and empty wells during bead find phase

separator.trace.txt Matrix data to separate between live wells
and empty wells

sigproc.log Log file for the analysis module

In the sigpror_results/dcOffset directory:

File Description

dcOffset.txt background model parameter values of
dcOffset

In the sigpror_results/NucStep directory:

The files in this folder contain background model parameter values based on the
location of the well in the chip.
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File

NucStep_frametime.txt

NucStep_inlet_head.txt

NucStep_inlet_empty.txt

NucStep_inlet_empty_sd.txt

NucStep_inlet_step.txt

NucStep_middle_head.txt

NucStep_ middle_empty.txt

NucStep_ middle_empty_sd.txt

NucStep_ middle_step.txt

NucStep_outlet_head.txt

NucStep_ outlet_empty.txt

NucStep_outlet_empty_sd.txt

NucStep_outlet_step.txt
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System diagnostics information can help in troubleshooting network, disk space, and
system status problems.

To access system diagnostics information, click  (Settings)4About:
Scroll down to the More Information and
Assistance section and click System
Support Diagnostics:
The diagnostics page has Network, System,
and Data sections. A small section of each is shown here:

View system
support
diagnostics
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Use Instrument Diagnostics to investigate chip and sequencing instrument problems,
such as pH levels.

1. To access the Instrument Diagnostics information, click  (Settings)4About:

2. Scroll down to the More Information and Assistance
section, then click the Instrument Diagnostics link:

The Instrument Diagnostics page lists the sequencing
instruments that are associated with each of your results partitions. Passed and
failed analysis runs are shown for each instrument.
The InitLog.txt file includes diagnostic measurements and if possible presents a
probable cause and suggests next steps.

View instrument
diagnostics
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3. To investigate a failed run, click the View log link for that run:
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The InitLog.txt file opens for that run on the instrument:
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Administration with command-line utilities

Use the following procedure to monitor disk space if the Torrent Browser is not
available, or you want to use a command-line utility:

1. Log into the server using an ssh client:

$ ssh ionadmin@ion-torrent-server 
$ password: ionadmin

2. Enter the df command to display partitions and disk utilization:

Most growth is seen in the /results directories, which is where Ion Torrent™

data are stored.

The Use% column indicates how much space is being used.

IMPORTANT! If there is insufficient space on the Torrent Server, data files are
retained on the Ion PGM™ and Ion Proton™ Sequencers until space becomes available.

You can also monitor disk space through the Torrent Browser. For details, see “View
disk usage parameters“ on page 272.

Monitor disk
space
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Use the following command to change the hostname:

sudo TSconfig --change-hostname

You must restart the server after the hostname is changed. This command
automatically restarts the server.

Use the following command to change the time zone:

sudo TSconfig --configure-timezone

Use the following command to add an HTTP proxy:

sudo TSsetproxy

Set the proxy address and authentication according to the following prompts:

1. Enter http proxy address: Enter the proxy address. (If no address is
entered, you are prompted to exit the program.)

2. Enter http proxy port number [3128]: Enter a port number or carriage
return to accept the default, 3128, port number.

3. Enter the username for proxy authentication: Enter a username. If
you do not enter a username, no authentication is set.

4. Enter the password for proxy authentication: Enter a password. If
you do not enter a password, no authentication is set.

A proxy address confirmation message is displayed:

http_proxy is set to http://username:password@proxyAddress

The recommended usage is to enter the command sudo TSsetproxy, as shown above,
and be prompted for each value. You can however use the TSsetproxy arguments
instead:

Usage: TSsetproxy [option]... --address Proxy address (example:
                'http://proxy.net') --port Proxy port number 
(default: 3128) --username
                Username for authentication --password 
Password for authentication --remove Removes
                proxy setting --debug,-d Prints script 
commands when executing (set -x) --demo
                Prints what changes would be executed only. No 
changes are made --help,-h Prints
                command line args --version,-v Prints version

Change the
hostname

Change the time
zone

Add an HTTP
proxy

Software administration
Administration with command-line utilities

Torrent Suite™ Software 5.10 User Guide 329



1. Connect to your Torrent Server host, using ssh, and verify that the Crawler and
Job Server services are running:

ps -aux | grep py

This should show active crawler.py and serve.py processes.

2. Run a test analysis of the provided cropped data set and review the resulting
report.

Alternate checks
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Screen descriptions

User and account settings screen

How to… Learn more about…

“Approve or reject a new user account“ on
page 292

“Link your Torrent Server account to
AmpliSeq.com“ on page 51

Analysis Parameters screen

How to… Learn more about…

“Create and select an analysis parameter
set“ on page 348

“The Command Line Args (Advanced)
tab“ on page 349
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Configure screen

How to… Learn more about…

“Add customer support contacts“ on
page 298

“Torrent Suite™ Software updates“ on
page 286

“Change the displayed server name“ on
page 299

“Update Torrent Suite™ Software“ on
page 286

“Manage Torrent Suite™ Software user
accounts“ on page 290

“Modify a user“ on page 293

“Delete multiple user accounts“ on
page 294

“Delete a single user account“ on page 294

“Archive or delete data automatically“ on
page 269

“Lock current Torrent Suite™ Software
version“ on page 288

“Change the time zone for the Ion Torrent™

Server“ on page 299

“Create a new administrator account to
change a password“ on page 296

Screen descriptions
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Ion Reporter configuration screen

How to… Learn more about…

“Set up an account for IonReporterUploader
plugin“ on page 173

“IonReporterUploader plugin
configuration“ on page 180

“Automatically transfer Torrent Suite™

Software output to Ion Reporter™

Software“ on page 175

“IonReporterUploader plugin file transfer
progress“ on page 182

“Manage the Ion Reporter™ Software
workflow list“ on page 178

Ion Reporter™ account setup
troubleshooting in “Ion Reporter account is
not configured“ on page 175

“View IonReporterUploader plugin status
details“ on page 182

“Torrent Suite™ Software output and Ion
Reporter™ Software analysis phases“ on
page 186

“Delete IonReporterUploader plugin report
files“ on page 183

“Tune Ion Reporter™ Software speed
parameters“ on page 183

Plugins screen

How to… Learn more about…

“Install or upgrade plugins“ on page 111 “Manage plugins for data analysis“ on
page 111

“Enable an installed plugin“ on page 112 “Pre-installed plugins“ on page 120

“Configure a plugin to run by default after
every run“ on page 114

“Plugin configuration“ on page 113

“Run a plugin manually from the
sequencing run report“ on page 115

“Uninstall a plugin“ on page 112

“Rescan a plugin“ on page 119

“Configure plugins globally“ on page 113

Screen descriptions
Ion Reporter configuration screen
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Product and plugin updates

How to… Learn more about…

“Check for off-cycle updates“ on page 288 “Torrent Suite™ Software updates“ on
page 286

“Enable off-cycle product updates“ on
page 289

“Update off-cycle release plugins“ on
page 290

“Install off-cycle bundles without Internet
Access“ on page 290

Screen descriptions
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References Sequences screen

How to… Learn more about…

“Import a preloaded reference
sequence“ on page 230

“Reference sequences“ on page 227

“Import a custom reference sequence“ on
page 231

“hg19 reference“ on page 228

“View a reference sequence file“ on
page 233

“GRCh38 reference“ on page 229

“Edit reference sequence file properties“ on
page 235

“Obsolete Reference Sequences“ on
page 236

“Permanently delete a reference sequence
file“ on page 236

“Target Regions and Hotspots“ on page 237

“View and manage target regions files“ on
page 238

“Guidelines for using target regions and
hotspots files“ on page 237

“View and manage hotspots files“ on
page 239

“Hotspots files format“ on page 250

“Upload a target regions file“ on page 240 “Test fragments“ on page 260

“Upload a hotspots file“ on page 242 “Barcodes and barcode sets“ on page 262

“View test fragment details“ on page 261 “Upload history“ on page 266

“Add a custom test fragment“ on page 261

“Edit or delete a custom test fragment“ on
page 262

“View a DNA barcode sequence“ on
page 263

“Download a DNA barcode set CSV file“ on
page 263

“Add a custom DNA barcode set“ on
page 264

“Delete a custom DNA barcode set“ on
page 266

Services screen

How to… Learn more about…

“Check crawler and job server status“ on
page 314

“Alternate checks“ on page 330

“Restart services“ on page 315

Screen descriptions
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Planned Runs screen

How to… Learn more about…

“Manage Planned Runs“ on page 65 “Plan and execute an instrument run“ on
page 32

“Manually change an Ion Chef™ Instrument
run status“ on page 67

“Planned Run templates“ on page 32

“Transfer a Planned Run to another Torrent
Server“ on page 70

“Planned Run status“ on page 67

“Execute a Planned Run on a sequencer“ on
page 68

Samples screen

How to… Learn more about…

“Create a Sample Set manually“ on page 17 “Sample information“ on page 20

“Import samples with a CSV file“ on page 19 “Sample attributes“ on page 22

“Create an Ion AmpliSeq™ on Ion Chef™

Sample Set“ on page 29
“Plan by Sample Set“ on page 55

“View Ion AmpliSeq™ library preparation on
an Ion Chef™ System run“ on page 26

“View Sample Set attributes“ on page 22

“Add a sample attribute“ on page 23

“Manage sample attributes“ on page 24

“Find a Sample Set“ on page 26

“Edit a Sample Set“ on page 27

“Delete a Sample Set“ on page 28

“Sort Sample Sets“ on page 27

“Create a Planned Run with Sample
Sets“ on page 56

Screen descriptions
Planned Runs screen
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Templates screen

How to… Learn more about…

“Create a Planned Run from a template“ on
page 35

“Plan and execute an instrument run“ on
page 32

“Create a custom Planned Run
template“ on page 34

“Steps in the workflow bar“ on page 37

“Export a Planned Run template“ on
page 48

“Import a Planned Run template“ on
page 48

“Import panel files and parameters from
AmpliSeq.com“ on page 50

“Search for a template“ on page 54

“Save a Planned Run template to
Favorites“ on page 55

“Create a Planned Run for mixed samples
with a template“ on page 59

“Create multiple Planned Runs“ on page 61

“Transfer a Planned Run to another Torrent
Server“ on page 70

Runs in Progress screen

How to… Learn more about…

“Monitor the sequencing run“ on page 72 Sequencing run metrics in “Monitor the
sequencing run“ on page 72

“Review the Planned Run settings“ on
page 75

“View data for runs in progress“ on page 73

“Auto Refresh the Monitor tab“ on page 74

Ion Chef screen

How to… Learn more about…

“Monitor an Ion Chef™ run“ on page 73

“Auto Refresh the Monitor tab“ on page 74

Screen descriptions
Templates screen
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Completed Runs & Reports screen

How to… Learn more about…

“Manage Completed Runs and Reports“ on
page 76

“Test fragments“ on page 260

“Search for a Run report“ on page 76 “Create an Ion AmpliSeq™ on Ion Chef™

Sample Set“ on page 29

“Change the default alignment
reference“ on page 78

“Reanalyze a run“ on page 76

“Add or change barcoding for a completed
run report“ on page 80

“Reanalyze a run“ on page 76

“Edit a Run report“ on page 79

“View plugin run status“ on page 116

“Set the Completed Runs & Reports page to
automatically refresh“ on page 81

“Failed status for a run“ on page 81

Screen descriptions
Completed Runs & Reports screen
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Run Report

How to… Learn more about…

“Open a run report“ on page 95 “Quality following alignment“ on page 93

“Review unaligned reads“ on page 97 “Aligned read length calculation“ on
page 94

“Review aligned reads“ on page 100 “Alignment“ on page 94

“Download output files“ on page 102 “Reads used for alignment“ on page 95

“View and download barcode reports“ on
page 102

“Predicted quality (Q20)“ on page 95

“View software versions used in a run“ on
page 110

“Unaligned reads metrics“ on page 97

“Download run report PDF“ on page 103 “Aligned reads metrics“ on page 100

“View consumables used in a completed
run“ on page 105

“Output files“ on page 101

“View the summary for an Ion Chef™

run“ on page 105
“Details about completed runs“ on page 104

“View analysis details for a completed
run“ on page 108

“Get technical support files“ on page 108

Screen descriptions
Run Report
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Projects screen

How to… Learn more about…

“Add a project to a Planned Run“ on page 84

“Add selected results to another project“ on
page 84

“Download a CSV file of metrics“ on page 88

“Remove result sets from project“ on
page 92

“Search for projects by name“ on page 83

“Organize run results with projects“ on
page 82

“Combine aligned reads from multiple run
reports“ on page 87

“Compare reports of runs in a project“ on
page 85

“Manage data for result sets in projects“ on
page 87

Screen descriptions
Projects screen
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Data Management screen

How to… Learn more about…

“Archive or delete data automatically“ on
page 269

“Ion instrument data types“ on page 268

“Import data for data transfers or
restoration“ on page 271

“Data management“ on page 268

“View disk usage parameters“ on page 272 “Dataflow file sizes“ on page 345

“View category statistics“ on page 272

“View active data management jobs“ on
page 273

“Search for run reports with disk usage
status“ on page 274

“Keep run report data“ on page 275

“Manually export run data“ on page 275

“Manually archive run data“ on page 276

“Manually delete run data“ on page 277

“View the data management actions log“ on
page 277

“Increase file storage and available disk
space“ on page 278

“Connect to a Torrent Storage™ NAS
device“ on page 281

“Monitor the Torrent Storage™ NAS
device“ on page 284

Screen descriptions
Data Management screen
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Per-Base Quality Score System

The Ion Torrent™ per-base quality score system uses a Phred-like method to predict
the probability of correct base call. The prediction is based on the quality of the base
incorporation signal that was used for generating the base calls. The sequencers'
quality score system uses a set of 6 predictors whose values are correlated with the
probability of a base miscall.

A Phred lookup table is used for converting the values of predictors to error
probabilities. The lookup table is generated by training on a representative data set in
customer configuration. The lookup table is re-trained for each software release and is
shipped as part of the software package. Quality scores are published in the BAM file.

Torrent software uses the following six predictors that are correlated with empirical
base call quality:

Predictor Description

P1 Penalty Residual: A penalty based on the difference between
predicted and actual flow values. Computed by the base caller.

P2 Local Noise: Noise (defined as the maximum absolute difference
between the flow value and the nearest integer) in the immediate
neighborhood (plus/minus 1 base) of the given base.

P3 High-Residual Events: Number of high-residual flows in the 20-
flow window around the flow containing the base. A flow has high
residual when the normalized difference between the observed
and model-predicted signal exceeds 0.4 or falls below –0.4. The
more high-residual flows in the window, the lower quality the base
call.

P4 Multiple Incorporations: Number of incorporated bases in this
flow. Length of the homopolymer. For multiple incorporations of
the same nucleotide in one flow, the last base in the incorporation
order is assigned a value equivalent to the total number of
incorporations. All other bases in the sequence of the multiple
incorporations are assigned the value 1.

P5 Environment Noise: The average signal noise (defined as the
absolute difference between the flow value and the nearest
integer) in the neighborhood (plus/minus 5 bases) of the given
base.

P6 State Inphase: Live polymerase in phase.

Quality Score
Predictors
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The six quality predictors are calculated for each base. Other predictors (not described
here) are computed from the corrected flow values generated by the base caller.

The corresponding per-base quality value is located by finding the first line in the
lookup table for which all six calculated predictors are less than or equal to the
predictor values in the table. This process occurs automatically as part of the standard
analysis.

The Phred lookup tables are stored in the /opt/ion/config directory on Torrent Server.
The Torrent Server supports separate phred tables for each type of chip (Ion 314™

Chip, Ion 316™ Chip, Ion 318™ Chip, and Ion PI™ Chip), named phredTable.314,
phredTable.316, phredTable.318 , and phredTable.p1.1.17 respectively.

The per-base quality along with all other read information is written to the unmapped
BAM file.

The per-base quality scores are reported in the QUAL field.

The quality scores are on a phred-10*log_10(error rate) scale.
References

1. Brockman et al. (2008): "Quality scores and SNP detection in sequencing-by-
synthesis systems." Genome Res. 18: 763-770.References

2. Ewing B, Hillier L, Wendl MC, Green P. (1998): "Base-calling of automated
sequencer traces using phred. I. Accuracy assessment." Genome Res. 8(3):
175-185.

3. Ewing B, Green P. (1998): "Base-calling of automated sequencer traces using
phred. II. Error probabilities." Genome Res. 8(3):186-194.

Ion Torrent™ BAM format

Ion Torrent™ BAM files follow the conventions of the SAM/BAM Format Specification
Working Group. SAM stands for Sequence Alignment/Map.

The purpose of this section is to highlight specific Ion Torrent™ conventions and the
meaning of custom tags.

Ion Torrent™ conventions:
• Run ID: Every TS analysis gets a run ID, a 5-character string consisting of upper

case letters and numbers, assigned. A reanalysis of a specific run will get a
different run ID assigned. Example: 0JU8V.

• Read Group ID: For non-barcoded runs the read group ID is equal to the run ID.
For barcoded runs it is a combination of the run ID and the barcode name,
separated by a dot. Example: 0JU8V.IonXpress_001.

• Key Sequence (KS): For non-barcoded runs, the Key Sequence tag is the Ion
Torrent™ library key (TCAG). For barcoded runs the KS tag entry includes the
barcode sequence and the barcode adapter sequence if barcode trimming is
enabled.

• Reverse Key Sequence (sk): For dual-barcoded runs, the Reverse Key Sequence
tag includes the end barcode adapter sequence and the end barcode sequence.
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• SAM record (read) names: Read names are a combination of the run ID and the
chip coordinates of the well that produced the read. The coordinate values are 5-
digit numbers and are given in the order row and the column, separated by a
colon. Example: 0JU8V:01308:00107.

• BAM header comment lines (CO): Comment lines in the BAM header are used to
store base calibration information, or information about the 3' adapter sequences.

Ion Torrent uses a collection of custom tags to store sequencing and alignment
information useful for downstream processing. In general, custom BAM tags starting
with Z or Y are written by the BaseCaller and BAM tags starting with X stem from
TMAP. As a consequence, tags starting with Z or Y are present both in aligned and
unaligned BAM files whereas tags staring with X appear only in aligned BAM files.

Tag Type Description

XA Z The algorithm that produced this mapping and from what
stage. The format is the algorithm name and the zero-
based stage (separated by a dash).

XM i Target Length, i.e., number of reference bases spanned by
the alignment.

XS i The alignment score of next-best sub-optimal mapping.

ZA i Number of library insert bases, where the library insert is
defined as the sequence after the 5' trimmed region
(sequence in tags KS, ZK, ZT, ZE), and before the 3'
trimmed region (sequence belonging to the 3' adapter, and
the content of the tags SK, YK, YT, YE). Only present if a 3'
adapter was found.

ZB i Number of overlapping adapter bases. (Only present if a 3'
adapter was found.)

ZC B:i A vector of the following four values (only present if a 3'
adapter was found):

Field 1: The zero-based flow during which the first base of
the adapter was incorporated (same as ZG)

Field 2: The zero-based flow corresponding to the last
insert base

Field 3: Length of the last insert homopolymer

Field 4: Zero-based index of adapter type found.

ZF i The zero-indexed flow position corresponding to the first
template base after 5' trimmed region.

ZG i The zero-based flow during which the first base of the
adapter was incorporated. (Only present if a 3' adapter was
found.)

ZM B:s Normalized signals, which include phasing effects. Stored
as floor(256*value)

Custom SAM
Recorder Tags
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Tag Type Description

ZP B:f Estimated phase parameters for the read. The values are
stored in the order: CF (carry forward), IE (incomplete
extension), and DR (droop).

ZT Z The trimmed 5’ unique molecular tag sequence. Only
written if a tag was trimmed.

YT Z The trimmed 3’ unique molecular tag sequence. Only
written if a tag was trimmed.

ZE Z The 5’ trimmed sequence removed by the extra-trim-
left command. Only written if a sequence was trimmed.

YE Z The 3’ trimmed sequence removed by the extra-trim-
right command. Only written if a sequence was trimmed.

ZK Z The trimmed 3' portion of read group specific identifiers
that can vary within a read group. Only written if a tag was
trimmed.

YK Z The trimmed 3' portion of read group specific identifiers
that can vary within a read group. Only written if a
sequence was trimmed.

Dataflow file sizes

The Ion Torrent™ dataflow involves the transfer of raw sequencing data from the Ion
GeneStudio™ S5 Prime, Ion S5™ XL, Ion PGM™, or Ion Proton™ sequencer to the
Torrent Server for analysis and reporting.

The following tables show a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite™ Software version, chip type, and kit type.
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The following table shows a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite™ Software version, chip type, and kit type.

Step Resulting
file type

Ion 510™

Chip
Ion 520™

Chip
Ion 530™

Chip
Ion 540™

Chip
Ion 550™

Chip

Read
Capacity

-- 2.5 M 5 M 15-20 M 60-80 M 100-130 M

Signal
Processing
Input

DAT 65 GB 125 GB 310 GB 2 TB 1 TB*

Signal
Processing
Output

WELLS 9 GB 18 GB 45 GB 180 GB 330 GB

Base
Calling
Output

Unaligned
BAM

3 GB 8 GB 23 GB 85 GB 100 GB

Aligned
Output

Aligned
BAM

3 GB 7 GB 20 GB 55 GB 90 GB

* Data compression enabled.

The following table shows a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite™ Software version, chip type, and kit type.

Step Resulting file
type Ion 510™ Chip Ion 520™ Chip Ion 530™ Chip

Read Capacity -- 2.5 M 5 M 15-20 M

Signal
Processing
Input

DAT 110 GB 210 GB 530 GB

Signal
Processing
Output

WELLS 15 GB 30 GB 75 GB

Base Calling
Output

Unaligned BAM 6 GB 12 GB 30 GB

Aligned Output Aligned BAM 5 GB 10 GB 25 GB

Torrent Suite™

Software 5.10 and
200 bp kit on the
Ion GeneStudio™

S5 Plus System,
Ion GeneStudio™

S5 Prime System,
and Ion S5™ XL
System

Torrent Suite™

Software 5.10 and
400 bp kit on the
Ion GeneStudio™

S5 Plus System,
Ion GeneStudio™

S5 Prime System,
and Ion S5™ XL
System
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The following table shows a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite™ Software version, chip type, and kit type.

Step Resulting file
type Ion 318™ Chip Ion 316™ Chip Ion 314™ Chip

Flows -- 900 900 900

Raw image
acquisition

DAT 396 GB 246 GB 52 GB

Image
processing

WELLS 31.4 GB 18.4 GB 3.5 GB

Signal
processing and
base calling

BAM 6.8 GB 4.5 GB 0.65 GB

CAUTION! File sizes vary depending on the number of flows, the number of
wells generating signal, and the number of library reads available. Your file
sizes may be different. An unmapped BAM file format is used in pipeline steps
before alignment.

The following table shows a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite™ Software version, chip type, and kit type. The following
table shows a high-level view of the dataflow. File sizes for Torrent data depend on
the Torrent Suite™ Software version, chip type, and kit type.

Step Resulting
file type Ion Proton™ Chip Ion 318™

Chip
Ion 316™

Chip
Ion 314™

Chip

Flows -- 500 500 520 520

Raw image
acquisition

DAT 2.7 TB 225 GB 135 GB 30 GB

Image
processing

WELLS 219 GB 16.4 GB 9.0 GB 2.0 GB

Signal
processing
and base
calling

BAM 44 GB 4.2 GB 3.1 GB 0.5 GB

CAUTION! File sizes vary depending on the number of flows, the number of
wells generating signal, and the number of library reads available. Your file
sizes may be different. An unmapped BAM file format is used in pipeline steps
before alignment.

Torrent Suite™

Software4.x and
400 bp kit on the
Ion PGM™

Sequencer

Torrent Suite™

Software4.x and
200 bp kit on the
Ion Proton™

Sequencer
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Create and select an analysis parameter set

You can copy an existing analysis parameter set, and then customize the settings and
save it as a new parameter set.

1. Click  (Settings)4Analysis Parameters:
In the Analysis Parameters screen, factory parameters are denoted by "Ion
Torrent" in the Source column.

2. To filter the parameter sets by chip type, select your chip type from the All Chips
menu.

3. Identify the parameter set that you want to copy, then click  (Actions)4Copy
in the table row for that set.

4. In the Copy Analysis Parameters dialog, enter a parameter name and
description, and make any changes. Click Save.

Your new analysis parameter set is available in the Analysis Parameters table.
The Source column lists the name of the user that created it.

Reference
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Note: Click  (Actions)4View in the row of the analysis parameter set to view
the details for that parameter set in the list.

5. You can select the custom analysis parameter set for use in a Planned Run or
reanalysis of a completed run:

Option Description

Create a Planned
Run or a custom
Planned Run
template

In the Plan tab of the workflow bar, under the Analysis
Parameters section of the screen, click Details+, and then
select Custom and select the parameter set from the
dropdown menu.

Note: You must first specify a chip type for the Planned Run
(under Kits in the workflow bar) before you can select the
custom parameter set.

Reanalyze a
completed run

For details, see “Reanalyze a run“ on page 76.

See “TMAP examples“ on page 361 for steps to open the run report log and search for
the TMAP command. (The analysis must be completed before you can find the
command.)

The Command Line Args (Advanced) tab

An example Advanced Options page is shown here:

Find the TMAP
command for a
specific analysis
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Setting Description

Beadfind args Beadfind module command line arguments. Should not be
modified unless instructed by Ion Torrent™ Technical
Support.

Analysis args Analysis command line arguments. Should not be modified
unless instructed by Ion Torrent™ Technical Support.

Pre Basecaller args for
calibration

BaseCaller command line arguments. See Basecaller
arguments for information on --barcode-mode, --
barcode-cutoff, and --barcode-filter. Other
Basecaller arguments should not be modified unless
instructed by Ion Torrent™ Technical Support.

This field is used only if a Base Calibration Mode other
than 'No Calibration' is used.

Recalibration Args Recalibration command line arguments.

Basecaller args BaseCaller command line arguments. See Basecaller
arguments for information on --barcode-mode, --
barcode-cutoff, and --barcode-filter. Other
Basecaller arguments should not be modified unless
instructed by Ion Torrent™ Technical Support.

Alignment Args Arguments for the TMAP aligner.

(Replaces the TMAP Args field that appears in previous
releases.)

Overview of BaseCaller and Barcode Classification

This page discusses BaseCaller operations in general and issues around BaseCaller
parameters, barcode classification, and filtering and trimming.

The settings of BaseCaller parameters control barcode classification as well as filtering
and trimming.

Barcodes are short base sequences that during library preparation are placed between
the library key and the read. The barcode sequences provide a mechanism to
distinguish and identify reads from different samplesduring data analysis.

The use of barcodes allows multiple samples to be sequenced together on one chip
during a sequencing run, and still have the run's read data be analyzed separately
afterward as distinct samples.

This diagram shows the placement of the barcode sequence, as well as the library key
and adapters, with the read sequence (which is labeled "Template Bases"). The key is
on the 5' end.

About barcodes

Reference
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This example shows the location of the barcode sequence in both base space and flow
space, using barcode IonPress_001 as an example:

The beginning steps of the Torrent Suite™ Software analysis pipeline are shown below:

Steps:

1. The sequencing instrument generates DAT files of electrical signals' raw traces.
2. The signal processing step converts the raw traces into a single number per flow

per well, in the 1.wells file.
3. The BaseCaller converts the 1.wells file information into a sequence of bases and

writes the sequence into an unaligned BAM file.
4. The BAM file is passed to TMAP for alignment.

The signal processing step also marks several types of low-quality reads:
• Polyclonal reads (reads with two template beads instead of one)
• Reads with high signal processing residual (indicating an ambiguous signal

value)
• Reads that do not contain a valid library key

Thesignal processing step marks these problematic reads but does not remove them.

Analysis pipeline
overview
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In addition to creating a sequence of bases from the 1.wells file information, the
BaseCaller module also performs read filtering and read trimming.

Notes on read filtering:
• Filters out low-quality reads that were marked during signal processing.
• Filters out reads that fail basecalling filters.
• Filtered out reads do notappear in the BAM file. The BaseCaller keeps counts of

these reads but there is no record of specific reads that are filtered out.

Notes on read trimming:
• Removes certain bases from the read for quality reasons.
• The read appears in the BAM file.
• The removed bases do not appear in theBAM file.

These are the steps performed in the BaseCaller:

1. Remove low-quality reads that were marked during the signal processing step.
2. Do base calling:

1. From the signal values, create the sequence of bases.
2. Estimate the base quality value for each base.

3. Do barcode classification:

1. Assign each read to a barcode.
2. Trim the barcode sequence away if --trim-barcodes=on is specified.

(The default is 'on').
4. Trim 5' unique molecular tag (only done if --trim-barcodes=on).
5. Trim extra bases at the 5' end. Controlled by --extra-trim-left (default is 0,

meaning no extra trimming).
6. Filter out reads that are too short. Controlled by --min-read-length and --

trim-min-read-len.
7. Filter out reads that do not have the correct library key. Can be turned off by --

keypass-filter.

1. Trim 3’ unique molecular tag (only done if P1 adapter was found).
2. Trim extra bases on the 3’ end. Controlled by --extra-trim-right (default is 0,

meaning no extra trimming. Only done if P1 adapter was found).
8. Trim the P1 adapter (at the 3' end).
9. Perform quality trimming. Affect ed by --trim-qual-window-size and --

trim-qual-cutoff.

Notes about quality trimming:
• The purpose of quality trimming is to identify where quality issues begin at the

end of a read. We try to identify when bases fall below a quality threshold and
trim both those bases and a bit before those bases.

• The parameter --trim-qual-window-size sets the window size for quality
trimming. The algorithm slides through the sequence of bases and, each time the
window shifts, computes the mean Base QV value for all bases in the window.

• If the mean Base QV value for all bases in the window falls below a threshold (set
the by parameter --trim-qual-cutoff, default 16), then we trim all bases
from the center of the window at that time to the 5' end.

Overview of
BaseCaller
functionality
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Notes about barcode classification and barcode filtering

Barcode classification determines which barcode group a read is assigned to. Barcode
classification is done for each read immediately after base calling.

Barcode filtering determines if a specific barcode is included in the run report or is
filtered out. Barcode filtering works on the barcode groups as a whole

Barcode classification metrics are available in the file basecaller_results/
datasets_basecaller.json in the Torrent Suite™ Software analysis directory.

This file contains information about all barcodes, no matter whether they appear in
the run report or are filtered out. This information describes the numbers of barcodes
that would be included or discarded if you reanalyze with certain changed BaseCaller
settings.

A sample of this file is shown here. Later examples in this page use this file:

"IEXL3.IonXpress_033": { "Q20_bases": 98859279, 
"barcode_adapter": "GAT", "barcode_bias": [ 0.026, -0.028, 
-0.034, 0.011, -0.019, -0.001, 0.072, -0.061, 0.103, -0.008, 
-0.062, 0.110, -0.021, 0.001], "barcode_distance_hist": 
[ 907546, 50122, 10793, 4498, 5342 ], "barcode_errors_hist": 
[ 949782, 24584, 3935 ], "barcode_match_filtered": 162, 
"barcode_name": "IonXpress_033", "barcode_sequence": 
"TTCTCATTGAAC", "description": "1T 058a0112 Lib6457 0bp lr2 
lr226b04", "filtered": false, "index": 33, "library": "hg19/
IonXpress_033", "platform_unit": "PGM/318/IonXpress_033", 
"read_count": 978301, "recalibrate": true, "sample": "None", 
"total_bases": 109292583 },

Read count

The read_count field shows how many reads were assigned to this barcode.

"read_count": 978301,

Filtered

The filtered field is true if this barcode is filtered out and false if the barcode
appears on the run report.

? "filtered": false,

Barcode errors histogram

The barcode errors histogram shows the number of reads with difference levels of
basecalling errors in this barcode:

• First field: The number of reads that have 0 basecalling errors (949782 in this
example). This is the number of reads that perfectly match this barcode (in base
space).

• Second field: The number ofreads that have one basecalling error(24584 in this
example).

• Third field: The number of reads that have two basecalling errors(3935in this
example).

Troubleshooting
Barcode
Classification
Issues

Explanation of
fields in the
BaseCaller JSON
file
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From the 3935 value with 2 basecalling errors, we know that if we reanalyze with the
number of allowed errors set to 1 instead of 2, then 3935 fewer reads will be assigned
to this barcode.

? "barcode_errors_hist": [ 949782, 24584, 3935 ],

This histogram is typical of a real barcode. A large majority of reads are perfect
matches, a few have one error, and a smaller number have two errors.

If the pattern is reversed (with very few perfect matches, some reads with one error,
and many reads with 2 errors), we suspect that this is probably a fake barcode.
Barcode distance histogram

The barcode distance histogram shows, in signal space, the number of reads at various
squared residual distances between the predictedsignal and the observed signal.

The distance fields are given in 0.2 increments:
• The first field gives the number of reads with a squared residual distance of

between 0 and 0.2.
• The second field gives the number of reads with asquared residual distance of

between 0.2 and 0.4.
• The third field gives the number of reads with a squared residual distance of

between 0.4 and 0.6, etc.

Smaller distances reflect better matches of the read to barcode. Larger distances reflect
poorer matches.

This example reflects the pattern that is typical of a real barcode:
• The most reads have shorted distance residuals.
• Fewer reads have larger distance residuals.
• The entry 5342 in the fifth field tells us that reducing --barcode-cutoff to 0.8

would cause those 5342 reads not to be assigned to a barcode.

? "barcode_distance_hist": [ 907546, 50122, 10793, 4498, 
5342 ],

Barcode match filtered

The barcode_match_filtered field gives the number of reads that perfectly
match the barcode in base space and also are filtered out because they do not meet the
separation criteria in signal space. The signal for these reads are in-between two
barcodes and are not close enough to either barcode to be assigned.

? "barcode_match_filtered": 162,
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Barcode bias

The barcode_bias values show the mean signal deviation by flow: how much the
observed signal is off from the expected signal. Low bias values, for example with the
value shown here, are indications of good signal.

Bias values around 0.33 indicate a signal that is about a third of a base off. Values near
0.5 indicate a signal that is half a base off. Values in this range indicate a problem with
the sequencing run or with the barcode classification.

? "barcode_bias": [ 0.026, -0.028, -0.034, 0.011, -0.019, 
-0.001, 0.072,? -0.061, 0.103, -0.008, -0.062, 0.110, -0.021, 
0.001],

BaseCaller arguments

This section describes select arguments used with the BaseCaller module.

This page describes BaseCaller parameters that are available when you reanalyze a
completed run.

Note: The default BaseCaller parameters are tuned for Ion Torrent™ data. In most
cases, you do not need to modify these settings. Modifying these parameters is
recommended for advanced users only.

However, if you use a custom barcode set, please see the cautions and requirements in
Design Custom Barcodes. Correct parameter settings require knowledge of your
barcode's distances in signal space. The BaseCaller defaults are optimized for the
IonXpress barcode set, and likely are not correct for a custom barcode set.

When you reanalyze a run, other parameters are also listed in the BaseCaller
arguments field. These parameters are for internal use please do not change or
remove these fields.

Note: Barcode classification is the process by which reads are assigned to one of the
barcodes present in one analysis run. Correct barcode classification is important
because a classification error results in a read being assigned to the wrong barcode,
which in turn leads to the read beinganalyzed as belonging to a wrong sample.

Barcode classification determines which barcode group a read is assigned to. Barcode
classification is done for each read immediately after base calling.

Barcode filtering determines if a specific barcode is included in the run report or is
filtered out. Barcode filtering works on the barcode groups as a whole.

BaseCaller
Parameters
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This table lists the more common BaseCaller parameters relating to barcode
classification. (All parameters listed in this table are barcode classification
parameters.)

Parameter Default Description

--barcode-cutoff 1.0

(Float)

Maximum distance allowed in barcode matches. A
threshold that sets the stringency for barcode
matches. Lower values require more exact matches
when assigning reads to barcodes. Higher values
allow less exact matches.

Reads that have a distance greater than this value
are counted as barcode no-matches.

--barcode-mode 2

(Integer)

Allowed values: 1, 2

• 1: A barcode is scored by comparing each read
sequence to each barcode sequence in a flow
space alignment. Errors in each flow are
summed over the length of the barcode
flows.Then any barcode with a number of errors
equal to or less than the --barcode-cutoff
value can be considered, and the barcode with
the fewest errors with respect to the input
sequence is the matching barcode.(The default
in 4.0, known as hard decision classification.) 2:
Barcode classification is based on signal
information,specifically on the squared distance
between the measured signal and the predicted
barcode signal. (The default in 4.4, known as
soft decision classification.)

Note: --barcode-mode 0 is no longer
supported.

--barcode-
separation

2.5

( Float)

This setting controls how much ambiguity in barcode
assignment you want to tolerate, by investigating the
distances to the both the closest barcode and to the
next closest barcode. A read is rejected if the
difference in these two distances is less than the --
barcode-separation setting.

Note: --barcode-separation has no effect
when --barcode-mode is set to 1.

Barcode
classification
parameters
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Parameter Default Description

--barcode-
filter-postpone

1 Allowed values: 0, 1, 2

• 0: Keeps the 4.0 behavior: b arcode filtering is
done independently on each block. This is the
default for all Ion PGM™ analyses and also for
Ion Proton™ thumbnail (which only consist of a
single block) processing and base calibration
training stage processing.

• 1: BaseCaller does barcode pre-filtering at a
10x lower frequency threshold (10 times more
lenient). B arcode filtering is done on the chip's
full information as a whole, after the 96 blocks
are merged into one. This is the default for Ion
Proton™ full-chip (not thumbnail) analyses.

• 2: The BaseCaller does not do any barcode pre-
filtering. All barcode classification happens
after the 96 blocks are merged into one. (The
setting "2" is slower than the setting "1". "2"
creates more files and involves more processing
than "1".)

Note: We do not recommend that you change this
parameter. Instead accept the pipeline defaults
(which are different for Ion PGM™ and Ion Proton™

analyses).

--barcode-filter 0.01

(Float)

Barcode frequency threshold to be reported in the
UI. The relative frequency of a barcode is the number
of assigned reads divided by number of reads
assigned to the most frequent barcode.

Set to 0.0 to turn this filter off. The setting 0.0 causes
all barcodes in the barcode set to be reported in the
UI, including barcodes with no or very few reads,
provided that the barcode group has at least --
barcode-filter-minreads number of reads.
(Typically barcodes with no or very few reads are not
relevant to your analysis and should be filtered out.)

--barcode-
filter-minreads

20

(INT)

Threshold for the minimum number of reads in a
barcode group, for that group to be reported in the
UI.

--trim-barcodes on Trim barcode and barcode adapter. If off, disables all
other 5’ trimming.

--barcode-
adapter-check

0.15 Validate barcode adapter sequence. The parameter
given is the maximum allowed squared residual per
flow. This feature reduces barcode set cross
contamination, e.g., between the IonXpress and
IonCode barcode sets. (0=off)
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Notes about the --barcode-cutoff parameter with --barcode-mode 1:
• 0 is the most restrictive setting. --barcode-cutoff 0 allows only reads that

perfectly match a barcode in base space.
• The setting 0 works with any barcode set (both Ion Torrent™ sets and custom

barcode sets).
• Do not set --barcode-cutoff greater than 2 with the IonXpress barcode set.

Values greater than 2 relax the classification rules and allow incorrect barcode
assignments.

A rule of thumb for the maximum --barcode-cutoff setting is based on the
minimum distance of the barcode set in flow space:

T he minimum distance for the IonXpress barcode set is 5. Then the maximum
recommended value for --barcode-cutoff is 2 for analyses that use the IonXpress
barcode set.

Notes about the --barcode-separation parameter:
• Larger values (close to the minimum distance of the code) require more strict

matching of the predicted signal for a read to be assigned to a barcode.
• Smaller values (for example, 0.2 and below) allow barcode assignment with an

expanded tolerance for errors. For example in the extreme case of separation=0,
the measured signal may be right in between two predicted barcode signals.

• If --barcode-separation is set at or above the minimum distance of the
barcodes in flow space, no reads at all are assigned to a barcode.

• If --barcode-separation is set close to the minimum distance of the barcodes
in flow space, very few reads are assigned to a barcode.

• If --barcode-separation is too small, the risk of cross contamination
increases. More ambiguous reads are forced into a barcodeassignment (with a
higher rate of error in these assignments).

A rule of thumb for a good --barcode-separation setting is one half of the
minimum distance of the barcode set in flow space:

The cutoff setting

The separation
setting
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This table lists the public BaseCaller parameters that are available for you to modify.
However, please note that the defaults for these parameters are optimized for most
scenarios and in most cases the default settings are recommended.

Parameter Default Description

-d, or

--disable-all-filters

off When on, disables all filtering and
trimming and overrides other
filtering and trimming settings.

-k, or

--keypass-filter

on When on, filters out reads that do
not both produce a signal and
match the library key (or the test
fragment key).

--min-read-length 25

(Int)

F ilters out reads less than this
minimum read length.

This filter screens out poor reads
early on to avoid wasting
processing time on them. See also
--trim-min-read-len, which
sets the minimum length
threshold that is applied after
trimming.

--prefix-mol-tag Empty Base structure of 5’ unique
molecular tag (ACGTN bases) to
be trimmed after the barcode
adapter.

--suffix-mol-tag Empty Base structure of 5’ unique
molecular tag (ACGTN bases) to
be trimmed before P1 adapter.

--extra-trim-left 0

(Int)

Trims this number of bases
beyond the barcode adapter and
the 5' unique molecular tag (if
applicable).

--extra-trim-right 0 Trims this number of bases at the
3' end of the template before the 3'
unique molecular tag (if
applicable) and the P1 adapter.
Only done if P1 adapter was found.

--trim-adapter-cutoff 16

( Float)

A score cutoff value.

Smaller values correspond to
more stringent adapter search and
larger values to less stringent
adapter search.

Set to 0 to turn off.

--trim-adapter-min-match 6

(Int)

The minimum number of P1
adapter bases required in order to
trim the P1 adapter.

Other public
parameters
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Parameter Default Description

--trim-qual-window-size 30

( Int)

Window size for quality trimming.

--trim-qual-cutoff 16

( Float)

Cutoff for quality trimming.

Set to 100 to turn off. When set to
100, no reads are filtered out due
to this parameter.

--trim-min-read-len 25

(Int)

Filters out any readsthat fall below
this minimum read length after
anytrimming step. By default it is
initialized with the value of 'min-
read-length'.

BaseCaller filters

The BaseCaller module and its parameter settings control these types of filtering:
• Keypass
• Quality trimming
• Adapter trimming

With these examples:
• Do not remove the string "BaseCaller" from the Basecaller Args field.
• Do not change BaseCaller parameters other than those listed in the basic table or

the public table (unless specifically directed to do so by Ion).

TMAP Modules

The Torrent Mapping Alignment Program (TMAP) is a sequence alignment software
program optimized specifically for Ion Torrent™ data. TMAP generally operates in
two phases: initial mapping, when the read sequences are roughly located in the
reference genome, and alignment refinement, when each particular position of the
read is aligned to the corresponding position in the reference. TMAP is capable of
running mapping/alignment cycles iteratively applying different algorithms and
parameters to the reads that were not aligned at earlier iterations. In a typical
workflow, just one mapping/alignment iteration is used. TMPA can use several
mapping algorithms, each with its own best application. TMAP's current default is
map4.

The alignment refinement phase includes initial alignment using Smith-Waterman or
Needleman-Wunch algorithms, and a number of optional alignment refinement
stages that are designed to compensate for specific systematic biases of the sequencing
process. Thus, the reads can be re-aligned for better homopolymer alignment (--
context option); the portions with likely phasing errors can be realigned with low
indel scores (--do realign option); the long indels at the edges of amplicons can be
salvaged with --end-repair option); the tandem repeats can be clipped from the
read 3' tail (--do-repeat-clip option); the alignment can be clipped from the read
signals rather than called bases (--final-flowspace option).

Examples of
BaseCaller
parameters usage
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When you reanalyze a run, you can optionally change both the TMAP module ( map1,
map2, map3, map4, or mapvsw) and also change the module's parameters.

Note: The default TMAP parameters are tuned for Ion data. In most cases, you do not
need to modify these settings. Modifying these parameters is recommended for
advanced users.

This table lists the mapping alternatives supported by TMAP. The map4 module is the
default. (Other modules are not run unless specifically called, for instance on the
Reanalyze page.)

Click the module name link to see the options supported for that module.

Module Description

map1 BWA-short reads mapping

• Very fast at finding perfect matches

• Very slow at finding a set of matches
with up to two mismatches

map2 BWA-long / BWASW reads mapping

map3 Simplified SSAHA, based on a k-mer lookup
table

map4 Based on the BWA fastmap routine

Searches for the maximum exact matches
between the reads and reference

Mapvsw A vectorized implementation of Smith-
Waterman

• A single mapping strategy that is twice
as fast as the other modules

• Modified to improve specificity

Mapall A command to quickly map short
sequences to a reference genome.

See “TMAP examples“ on page 361 for steps to open the run report log and search for
the TMAP command. (The analysis must be completed before you can find the
command.)

This example is the current default setting. Only the map4 module is used.

tmap mapall ? -f /results/referenceLibrary/tmap-f3/hg19/
hg19.fasta -r /<server_path>/results/analysis/output/Home/
Auto_user_G35-685--R65832-110mM_K2SO4-
OT_salts-0630_24057_58335/IonXpress_057_rawlib.bam -v -Y -u --
prefix-exclude 5 -o 2 stage1 map4

Mapping modules

Find the TMAP
command for a
specific analysis

TMAP examples
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This example is the previous TMAP default. This example uses the modules map1,
map2, and map3, in that order. Progressively more reads are mapped by each module.

tmap mapall  f <FASTA_file> -v -Y -u --prefix-exclude 5 stage1 
map1 map2 map3

Option alternate option Type Default Description

-f --fn-fasta FILE [ no default ] FASTAreference
file

-r --fn-reads FILE Standardinput
(stdin)

The reads file
name

-i --reads-format STRING Unknown The reads file
format(fastq | fq
| fasta | fa |sam
| bam)

-s ---fn-sam FILE Standardoutput
(stdout)

The SAM file
name

--bam-start-vfo INT 0 Sets the starting
virtual file
offsets that limit
the range of
BAM reads to
process

-A --score-match INT 1 Score for a
match

-M --pen-mismatch INT 3 Mismatch
penalty

-O --pen-gap-open INT 5 Indel start
penalty

-E --pen-gap-
extension

INT 2 Indel extension
penalty

-G --pen-gap-long INT -1 Long
indelpenalty

Global options
used by all TMAP
modules

Reference
TMAP Modules

362 Torrent Suite™ Software 5.10 User Guide



Option alternate option Type Default Description

-Q --pairing INT 0 The insert
pairing:

• 0 Do not
perform
pairing

• 1 Mate
pairs (-S 0 -
P 1)

• 2 Paired
end (-S 1 -P
0)

INT -1

INT -1

FLOAT -1.0

FLOAT -1.0

This page describes the parameters for the TMAP map1 module. The map1 module
implements BWA-short reads mapping and has these characteristics:

• map1 is very fast at finding perfect matches
• map1 is very slow at finding a set of matches with up to two mismatches

Note: The map1 module is not the current default for TMAP.

Options supported with the TMAP map1 module (all are optional):

--seed-length INT 32
The k-mer length to

seed CALs (-1 to
disable)

--seed-max-diff INT 2 The maximum
number of edits in
the seed

--seed2-length INT 48 The secondary seed
length (-1 to disable)

--max-diff NUM 0.04 The maximum
number of edits or
false-negative
probability assuming
the maximum error
rate

--max-error-rate FLOAT 0.02 The assumed per-
base maximum error
rate

Global pairing
options

TMAP map1
Options
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--seed-length INT 32
The k-mer length to

seed CALs (-1 to
disable)

--max-mismatches NUM 3 The maximum
number of or (read
length) fraction of
mismatches

--max-gap-opens NUM 1 The maximum
number of or (read
length) fraction of
indel starts

--max-gap-
extensions

NUM 6 The maximum
number of or (read
length) fraction of
indel extensions

--max-cals-deletion INT 10 The maximum
number of CALs to
extend a deletion

--indel-ends-bound INT 5 The number of bps
from the end of the
read

--max-best-cals INT 32 Optimal CALs have
been found

--max-nodes INT 2000000 The maximum
number of alignment
nodes

--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length INT -1 The maximum
sequence length to
examine (-1 to
disable)

Option Type Default Description
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This page describes the parameters for the TMAP map2 module. The map2 module
implements BWA-long / BWASW reads mapping.

Note: The map2 module is not the current default for TMAP.

Options supported with the TMAP map2 module (all are optional):

Option Type Default Description

--max-seed-hits INT 1024 The maximum
number of hits
returned by a seed

--length-coef FLOAT 5.5 The coefficient of
length-threshold
adjustment

--max-seed-intv INT 6 The maximum
seeding interval size

--z-best INT 1 The maximum
number of top-
scoring nodes to
keep on each
iteration

--seeds-rev INT 5 The number of seeds
to trigger reverse
alignment

--narrow-rmdup INT false Remove duplicates
for narrow SA hits

--max-chain-gap INT 10000 The maximum gap
size during chaining

--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length INT -1 The maximum
sequence length to
examine (-1 to
disable)

TMAP map2
Options
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This page describes the parameters for the TMAP map3 module. The map3 module
implements a simplified SSAHA, based on a k-mer lookup table.

Note: The map3 module is not the current default for TMAP.

Options supported with the TMAP map3 module (all are optional):

Option Type Default Description

--seed-length INT -1 The k-mer length to
seed CALs (-1 to
disable)

--max-seed-hits INT 20 The maximum
number of hits
returned by a seed

--hit-frac FLOAT 0.2 The fraction of seed
positions that are
under the maximum

--seed-step INT 8 The number of bases
to increase the seed
for each seed
increase iteration (-1
to disable)

--hp-diff INT 0 The single
homopolymer error
difference for
enumeration

--fwd-search Boolean false Use forward search
instead of a reverse
search

--skip-seed-frac FLOAT 0.2 The fraction of a
seed to skip when a
lookup succeeds

--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length INT -1 The maximum
sequence length to
examine (-1 to
disable)

TMAP map3
Options
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This page describes the parameters for the TMAP map4 module. The map4 module is
based on the BWA fastmap routine and searches for the maximum exact matches
between the reads and reference.

Note: The map4 module is the current default for TMAP.

Options supported with the TMAP map4 module (all are optional):

Option Type Default Description

--seed-step INT 8 The number of bases
to increase the seed
for each seed
increase iteration (-1
to disable)

--hit-frac FLOAT 0.2 The fraction of seed
positions that are
under the maximum

--min-seed-length INT -1 The minimum seed
length to accept hits
(-1 to disable)

--max-seed-length INT 48 The maximum seed
length to accept hits

--max-seed-length-
adj-coef (-1 to
disable)

FLOAT 2.0 maximum seed
length adjustment
coefficient (-1 to
disable)

--max-iwidth INT 20 The maximum
interval size to
accept a hit

--max-repr INT 3 The maximum
representative hits
for repetitive hits

--rand-repr INT false Choose the
representative hits
randomly. Otherwise
uniformly

--use-min Boolean false When seed stepping,
try seeding when at
least the minimum
seed length is
present. Otherwise,
use the maximum
seed length.

TMAP map4
Options
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Option Type Default Description

--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length INT -1 The maximum
sequence length to
examine (-1 to
disable)

This page describes the parameters for the TMAP mapvsw module. The mapvsw
module implements a vectorized implementation of Smith-Waterman.

Note: The mapvsw module is not the current default for TMAP.

Options supported with the TMAP mapvsw module (all are optional):

Option Type Default Description

--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length INT -1 The maximum
sequence length to
examine (-1 to
disable)

The TMAP alignment refining phase is organized as a pipeline of optional processing
stages, each controlled by a specific set of options. The following stages are available
(given in the order of their optional invocation):

Option Description

Flow space realignment Performs alignment of the sequence of read flow signals
to simulated reference flow signal. Turned on with --
final flowspace flag.

Context-based realignment Realigns read with reduced cost of indels within
homopolymers. Turned on with --context flag.

Local realignment with
reduced gap cost

Realigns specific zones that are likely to contain errors
associated with signal phasing using reduced gap cost.
This helps to reduce false positive variants in low
complexity zones. Turned on with --do-realign flag.

Long indel salvage Realigns zones adjacent to the read ends while allowing
for longer indels. Helps to find long indels continued
beyond the ends of the amplicons. Turned on by specifying
long indel gap penalty (-G option).

TMAP mapvsw
Options

TMAP alignment
refinement
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Option Description

End repair Extends the alignment beyond the amplicon edges where
suitable. Also trims alignment tails below given mismatch
ratio. This is a simplified and often better performing
version of the long indel salvage option. It is turned on by
specifying --end-repair <MM> option on TMAP command
line where <MM> is the maximum allowed mismatch
percentage at the alignment edge. End repair is typically
used together with --J option (max adapter bases for soft
clipping), recommended usage is --end-repair 25-J
15).

Bed file The bed file specification, given with --bed-file ​
file_name>​ option, provides TMAP with the amplicon
boundary coordinates. This is used by end-repair to extend
gaps over amplicon edges. It also alters the way mapping
scores are calculate: the reads mapped within amplicon
boundaries are given a 12-point boot in MAPQ, and thus
are preferred over the alternative mapping locations
outside of the amplicon set.

5' softclip removal Removes soft clips from the 5' end of the alignment if
introduced by end-repair; on by default. Turned off with
--er-5clip flag.

3' tandem repeat clipping Clips tandem repeats from 3' end of the reads. Helps
reduce variant detection errors in tandem repeat zones.
Turned on with --do-repeat-clip flag.
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Documentation and support

Customer and technical support

Visit thermofisher.com/support for the latest in services and support, including:
• Worldwide contact telephone numbers
• Product support, including:

– Product FAQs
– Software, patches, and updates
– Training for many applications and instruments

• Order and web support
• Product documentation, including:

– User guides, manuals, and protocols
– Certificates of Analysis
– Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,
contact the manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.thermofisher.com/us/en/home/global/
terms-and-conditions.html. If you have any questions, please contact Life
Technologies at www.thermofisher.com/support.
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Glossary

Number of Ion Sphere™ Particles at 50+ bp at Q10.

Number of Ion Sphere™ Particles at 50+ base pairs at Q17.

ISPs that carry DNA insert length of less than 8 bp.

The aligned length of a read at a given accuracy threshold is defined as the greatest
position in the read at which the accuracy in the bases up to and including the
position meets the accuracy threshold. For example the AQ17 length of a read is the
greatest length at which the read error rate is 2% or less. The "perfect" length is simply
the longest perfectly aligned segment. For all of these calculations the alignment is
constrained to start from position 1 in the read - in other words, no 5′ clipping is
permitted.

The number of bases covered by reads aligned to the reference sequence.

Torrent Server API (Application Programming Interface) can be used to access
database records on a Torrent Server. Torrent Server APIs are compliant with REST
(Representational State Transfer) architectural constraints and can be used to retrieve
all available information about sequencing run results and plugin data, and create
Planned Runs using third party software solutions.

An AQ score defines read accuracy when compared to the reference sequence. The
discrepancy can be biological (real variant) or technical (sequencing error). For
example, an AQ score of 17 represents 2% aligned read error rate, while an AQ score
of 20 represents 1% aligned read error rate when compared to the reference sequence.

The average number of reads of all targeted reference bases.

The average number of reads of all targeted reference bases that were read at least
once.

Binary Aligned/Mapped file - BAM file - contains aligned reads sorted by reference
location. BAM file is the binary form of the SAM (Sequence Alignment/Map) file.

50Q10 Reads

50Q17 Reads

Adapter dimer
(ISPs)

Aligned read
length

Aligned reads

API

AQ Score /
Alignment Quality
Score

Average base
coverage depth

Average base read
depth

BAM file
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There are several applications for barcodes in Torrent Suite™ Software. Libraries can
be barcoded with unique nucleic acid sequence identifiers. Library barcodes are used
by the Torrent Suite™ Software during data analysis to sort the sequencing results
from sequencing reactions that contain combined libraries. Chips and sample tubes
also contain unique numeric barcodes that aid in the setup of the experimental
workflow by the Torrent Suite™ Software.

Signal Processing Input files are converted to a single condensed Basecalling Input file
that represents the processed signal. Basecalling input files are required files for
basecalling.

The percentage of chip wells that contain live ISPs. The percentage value considers
only potentially addressable wells. Bead loading is calculated as No. of Loaded
ISPs ÷ No. of potentially addressable wells.

Browser Extensible Data file - BED file - defines chromosome positions or regions.

Abbreviation for "base pair(s)".

The percentage of tumor cells in a given sample.

An ISP is clonal if all of its DNA fragments are cloned from a single original template.
All fragments on such a bead are identical and they respond in unison as each
nucleotide is flowed in turn across the chip.

Copy Number Variation (CNV) is the variation in copy number of any given gene
between two samples.

Control nucleic acid sequences can be added to DNA or RNA samples to facilitate
post-sequencing data analysis. Two types of control sequences can be used during
sample preparation. ERCC RNA Spike-In Mix is used with RNA samples to achieve a
standard measure for data comparison across gene expression experiments. Ion
AmpliSeq™ Sample ID Panel, comprised of nine specially designed primers, can be
added prior to template amplification to generate a unique ID for each sample during
post-sequencing analysis.

A Comma-Separated Values (CSV) file, is a text file in which each line represents a
data record with information fields separated by a comma. CSV files are easily
opened using spreadsheet software, such as Microsoft™ Excel™ or OpenOffice.org
Calc, where each comma-separated field is listed in a separate column.

A user-created Planned Run template. Custom templates can be created based on a
System template and modified to fit the user's specific needs.

Nucleic acid sequence data that is assembled from sequencing reads without the aid
of a reference genome library sequence.

Wells on the chip that do not contain an ISP.

Barcode

Basecalling input
file

Bead loading

BED file

bp

Cellularity (%)

Clonal (ISPs)

CNV

Control Sequence

CSV file

Custom Template

DeNovo Assembly

Empty wells
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Predicted number of Live ISPs that have a key signal identical to the library key
signal. The percent enrichment value reported is the number of loaded ISPs that are
Library ISPs, after taking out the Test Fragment ISPs.

A text file that holds nucleotide sequence information.

A text file that holds a list of nucleotide sequence reads generated with quality scores
for each read.

A data filtering parameter that is used instead of INDEL, SNP, and MNP.

Number (and percentage) of reads, passing all filters that are recorded in the
unmapped BAM file. This value may be different from the Total number of reads
located in the Library Summary Section due to specifications associated with read
trimming beyond a minimal requirement resulting in total number of reads being
slightly less than Final Library Reads.

The order in which the chip is exposed to each particular dNTP. Flow order selected
on Ion PGM™ or Ion Proton™ Sequencer: Samba =
TACGTACGTCTGAGCATCGATCGATGTACAGC; [Default]Regular = TACG. The
"regular" flow order adds bases most rapidly to sequenced molecules but is
vulnerable to phase errors. The Samba flow order consists of a 32-base sequence,
repeated. This flow order resists phase errors by providing opportunities for out-of-
phase molecules to catch up and is designed to sample all dimer (nucleotide pair)
sequences efficiently. Samba is the default flow order because it improves sequencing
accuracy for longer reads by resisting phase errors.

Progress of the sequencing run expressed as number of total flows completed. For
example, a sequencing run set to 500 flows will show 250/500 flows in the status
column of the Runs in Progress table when the sequencing run is half way done.

A "flow" is the event of exposing the chip to one particular dNTP, followed by a
washing step.

A target technique used for detection and annotation of gene fusions (or translocation
of genetic material) in samples.

A BED or a VCF file that defines regions in the gene that typically contain variants
and enables Torrent Variant Caller to identify if a specific variant is present or absent.
Hotspot Regions file instructs the Torrent Variant Caller to include these positions in
its output files, including evidence for a variant and the filtering thresholds that
disqualified a variant candidate. A Hotspot Regions file affects only the variantCaller
plugin, not other parts of the analysis pipeline. If you don't specify a Hotspot Regions
file, the software will only tell you the difference between your sequence and the
reference genome.

A template preparation technique that uses non-emulsion isothermal reaction to
clonally amplify DNA onto an ISP surface.

Enrichment (%)

FASTA file

FASTQ

FD (Flow
Disruptiveness)

Final Library
Reads

Flow Order

Flow Transfer

Flows

Fusions

Hotspot Regions
file

IA (Isothermal
Amplification)
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Insertion or deletion of bases in the genome of an organism.

Intermediate files contain information used for debugging runs.

A network of Torrent Servers that allows the users to:
• view all runs of interest across multiple Torrent Servers on the same data page.
• transfer Planned Runs between different connected Torrent Servers.
• perform Ion Chef™ flexible workflows for 550 chip across different Ion Chef™

instruments connected to different Torrent Servers since Torrent Suite™ Software
can track reagent/cartridge usage across multiple Torrent Servers that are a part
of the same Ion Mesh .

Ion Sphere Particles (ISPs) are particles that contain multiple bound copies of the
same DNA fragment.

Average 1-mer signal in the library key.

Number of Live ISPs that have a key signal identical to the library key signal.

A short known sequence of bases used to distinguish the library fragment from
the test fragment (for example: "TCAG").

The Laboratory Information Management System (LIMS) is used for recording
sequencing metadata. Entered text is associated with the Torrent Suite™ Planned Run
and can be extracted using APIs for LIMS consumption.

Number of wells that contain an ISP with a signal of sufficient strength and
composition to be associated with the library or Test Fragment key.

ISPs with low or unrecognizable signal.

Sequencing reads that have been mapped to the reference sequence.

Average raw accuracy of 1-mers at a specific position in the read.

Multiple Nucleotide Polymorphism (MNP) is a genetic mutation in an allele that
differs from the reference allele of the same length by >1 nucleotide.

Sequencing reads mapped to any target region of the reference. A read is considered
to be on target if at least one aligned base overlaps a target region. A read that
overlaps a targeted region but where only flanking sequence is aligned, for example,
due to poor matching of 5′ bases of the read, is not counted.

Output files consist of all BAM files, run reports, and plugin results.

The digital instructions for the sequencing instrument that contain specifications for
sample preparation, sequencing, data export, and post-sequencing data analysis.

INDEL

Intermediate files

Ion Mesh

ISPs

Key Signal

Library ISPs

Library Key

LIMS Meta Data

Live ISPs

Low Quality ISPs

Mapped Reads

Mean Raw
Accuracy

MNP

On target reads

Output files

Planned Run
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A reusable experimental design (digital protocol) for the sequencing instrument that
holds specifications for sample preparation, sequencing, data export, and post-
sequencing data analysis. Planned Run templates can be used to create many Planned
Runs.

ISPs that carry clones from two or more templates.

ISPs that carry insert length of less than 8 base pairs.

A person or a sample that is serving as a starting point for the genetic study. Denoting
the proband aids in establishing relationships within a group. In medical genetics, the
proband is the first affected family member who seeks medical attention for a genetic
disorder.

Phred Quality score - Q Score - is used to measure the accuracy of the nucleotide
sequence generated by the sequencing instrument. Q Score represents the probability
that a given base is called incorrectly by the sequencer.

Predicted error rate of 10%.

Predicted error rate of 2%.

The number of bases that have a Q Score of ≥17 in a given sequencing output.

Predicted error rate of 1%.

The number of bases that have a Q Score of ≥20 in a given sequencing output.

The length of called reads measured in base pairs.

The sequence of a section of a unique fragment obtained after the end of the
sequencing process.

A consensus nucleotide sequence that represents the genome of a particular species.
The results from a sequencing run are compared to the reference library to identify
sequence variants.

Defines related samples within a Sample Set. In Torrent Suite™ Software, related
samples are designated by the same relationship group number.

Sequence Alignment Map (SAM) is a text-based output file that stores biological
sequences aligned to a reference sequence.

Genetic material from one source (for example: DNA from one patient).

Signal Processing Input files consist of the raw voltage measurement data collected
during the sequencing run. These files are required to re-analyze the run from Signal
Processing.

Planned Run
template

Polyclonal (ISPs)

Primer dimer
(ISPs)

Proband

Q Score

Q10

Q17

Q17 bases

Q20

Q20 bases

Read length

Read(s)

Reference library

Relationship group

SAM file

Sample

Signal Processing
Input files
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Single Nucleotide Polymorphism (SNP) is a genetic mutation in an allele that differs
from the reference allele of the same length by one nucleotide.

Genetic mutations that cause a change in the organism's chromosome structure, such
as insertions, deletions, copy number variations, duplications, inversions, and
translocations.

System Signal-to-Noise Ratio.

A Planned Run template that comes pre-loaded on the Torrent Suite™ Software.
System templates are designed to facilitate the user in creating a Planned Run or a
customized Planned Run template for a specific research application. System
templates cannot be deleted from the Torrent Server.

Summary statistics for targeted base reads of the reference. A base covered by
multiple target regions is only counted once per sequencing read.

A BED file that specifies all the regions that a panel represents such as the amplified
regions that are used with target sequencing. The complete Torrent Suite™ Software
analysis pipeline, including plugins, is restricted to only these specified regions
instead of analyzing the entire reference library.

Known nucleotide sequence that is used to monitor system characteristics.

Number (and percentage) of Live ISPs with a key signal that is identical to the Test
Fragment key signal.

The nucleotide sequence that is used to identify test fragment reads.

Signal strength of the first three bases of the TF Key.

Total number of filtered and trimmed reads independent of length reported in the
output BAM file.

A binary file that contains unaligned or unmapped reads.

Nucleotide bases covered by reads that are not aligned to the reference.

The percentage of bases in all targeted regions (or whole genome) covered by at least
0.2x the average base coverage depth.

Usable reads consist of library ISPs that pass the polyclonal, low quality, and primer
dimer filter.

Variant Call Format (VCF) file specifies the variant of interest and its location. This file
stores only the differences between the BAM file and the reference file.

SNP

Structural variants

System SNR

System template

Target base
coverage

Target Regions file

Test Fragment (TF)

Test Fragment
ISPs

TF Key / Test
Fragment Key

TF Key Peak
counts

Total reads

uBAM file

Unaligned reads

Uniformity of base
coverage

Usable Sequence /
Usable Reads
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Number of wells that were determined to be "positive" for the presence of an ISP
within the well. Wells containing ISPs have a delayed pH change due to the presence
of an ISP slowing the detection of the pH change from the solution.

Microsoft™ Excel™ format of a VCF file.

Wells with ISPs

XLS file
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